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About This Guide

CAUTION! ABBREVIATED SAFETY ALERTS. Hazard symbols and hazard
types specified in procedures may be abbreviated in this document. For the
complete safety information, refer to the instrument user guide.

IMPORTANT! Before using this product, read and understand the information in the
instrument user guide.

Revision history

Revision Date Description
A October 2013 New document
Purpose

The QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments Getting
Started Guide functions as both a tutorial and as a guide for performing your own
experiments on the QuantStudio™ 6 and 7 Flex Instruments.

Note: For differences between the QuantStudio™" 6 System and the QuantStudio" 7
System, refer to the QuantStudio™ 6 and 7 Flex Real-Time PCR Systems Maintenance and
Administration Guide (Pub. no. 4489821).

Prerequisites

This getting started guide is intended for personnel who have been specifically trained
by Life Technologies. The manufacturer is not liable for damage or injury that results
from use of this manual by unauthorized or untrained parties.

This guide uses conventions and terminology that assume a working knowledge of the
Microsoft® Windows® operating system, the Internet, and Internet-based browsers.

Note: First-time users of the QuantStudio " 6 and 7 Flex Real-Time PCR System
Software, please read Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR
System Software Experiments thoroughly. The booklet provides information and general
instructions that are applicable to all the experiments described in this binder.
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About This Guide

How to use these booklets as tutorials

How to use these booklets as tutorials

Each booklet in this guide provides a tutorial for running an example experiment
using QuantStudio™" 6 and 7 Flex Real-Time PCR System Software and the example
data provided on the installation CD. The following booklets are provided:

Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software
Experiments — introductory information and experiment workflow common to all
experiments.

QuantStudio™™ 6 and 7 Flex Real-Time PCR System Software Getting Started Guide for
Standard Curve Experiments — designing, running, and analyzing a Standard Curve
experiment.

QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Getting Started Guide for
Relative Standard Curve and Comparative Cp Experiments — designing, running, and
analyzing Relative Standard Curve and Comparative Ct experiments.

Note: This booklet also provides information on setting up, running, and
analyzing a gene expression study of two Comparative Cy experiments.

QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Getting Started Guide for
Genotyping Experiments — designing, running, and analyzing a Genotyping
experiment.

QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Getting Started Guide for

Presencel/ Absence Experiments — designing, running, and analyzing a Presence/
Absence experiment.

QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Getting Started Guide for
Melt Curve Experiments — designing, running, and analyzing a Melt Curve
experiment.

QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments - Appendixes
— common information such as ordering information, additional documentation,
and glossary.

Note: In all booklets, the term “experiment” refers to the entire process of
performing an experiment, including setup, run, and analysis.

How to use the guides with your own experiments

Assumptions

Each booklet contains instructions specific to an example experiment provided on the
installation CD. However, you can use the booklets as guides for your own
experiments; tips for running your own experiments are provided at various points in
each booklet.

This guide assumes that you have access to the example experiments provided with
the software.

Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments
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How to access an example experiment

How to access an example experiment

Start the Double-click E]" - (QuantStudioTM 6 and 7 Flex Real-Time PCR System Software
QuantStudio™ 6 shortcut) to access the Home screen, shown in the following image.
and 7 Flex
Software
File Edit Instrument Analyss Tools Help
[E2] New Experiment - | [ Qpen... =l Save - _; ’__(}Impnrt... \x | B

applied

QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Pﬁs)h/?tems

Experiment ":“Q ’ M Analyze
W\ Setup QuickStart i Experiment
T New Gene
o y Template “' Instrumentt g Expression

Console ¢ | Study
@ ReadiApp

ﬁHome
Open an example 1. In the Home screen, select Open from the toolbar.
experiment 2. Navigate to the examples folder. The default path is: <drive>:\ Program

Files\ Applied Biosystems\ QuantStudio 6 and 7 Flex

Software \ examples\ QS6Flex or <drive>:\ Program Files\ Applied

Biosystems\ QuantStudio 6 and 7 Flex Software \ examples\ QS7Flex.

where, <drive> is the computer hard drive on which the QuantStudio™ 6 and 7
Flex Real-Time PCR System Software is installed. The default installation drive
for the software is the C: drive.
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About This Guide
How to access an example experiment

3. Select an example experiment file to open, then click Open.

Experiment type Example experiment file name
Standard Curve QS6_96-Well Standard Curve Example.eds
QS6_384-Well_Standard Curve Example.eds
QS7_TagMan_Array_Standard Curve Example.eds

QS7_TagMan_Array_RNaseP_Example.eds
QS7_384-Well_Standard Curve Example.eds
QS7_96-Well Standard Curve Example.eds

Relative Standard QS6_96-Well Relative Standard Curve Example 2.eds

Curve QS6_96-Well Relative Standard Curve Example.eds
QSé_384-Well_Relative Standard Curve Example 2.eds
QS6_384-Well_Relative Standard Curve Example.eds
QS7_96-Well Relative Standard Curve Example 2.eds
QS7_96-Well Relative Standard Curve Example.eds
QS7_384-Well_Relative Standard Curve Example 2.eds
QS7_384-Well_Relative Standard Curve Example.eds

Comparative Cy QS6_96-Well Comparative Ct Example.eds
QS6_384-Well_Comparative Ct_Example_1.eds
QS6_384-Well_Comparative Ct_Example_2.eds
QSé_384-Well_Comparative Ct_Example.eds
QS7_96-Well Comparative Ct Example.eds
QS7_384-Well_Comparative Ct_Example_1.eds
QS7_384-Well_Comparative Ct_Example_2.eds
QS7_384-Well_Comparative Ct_Example.eds
QS7_TagMan_Array_Comparative_Ct_Example.eds

Multiplex QS6_96-Well Multiplex Example.eds
QS6_384-Well_Multiplex_Example.eds
QS7_96-Well Multiplex Example.eds
QS7_384-Well_Multiplex_Example.eds

Genotyping QS7_96-Well SNP Genotyping Example.eds
QS7_384-Well_SNP_Genotyping_Example.eds
QS6_96-Well SNP Genotyping Example.eds
QS6_384-Well_SNP_Genotyping_Example.eds

Presence/Absence QS6_384-Well_Presence-Absence_Example.eds

QS6_96-Well Presence-Absence Example.eds
QS7_96-Well Presence-Absence Example.eds
QS7_384-Well_Presence-Absence_Example.eds

8 Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments



About This Guide
A note on system security

Experiment type Example experiment file name

Melt Curve QS6_96-Well SYBR Green PCR w Melt Example.eds
QS6_384-Well_SYBR_Green_PCR_with_Melt_Example.eds
QS6_384-Well_SYBR_Green_Melt_Example.eds
QS6_384-Well_Melt_ Example.eds
QS7_96-Well SYBR Green PCR w Melt Example.eds
QS7_384-Well_SYBR_Green_PCR_with_Melt_Example.eds
QS7_384-Well_SYBR_Green_Melt_Example.eds
QS7_384-Well_Melt_ Example.eds

Note: In addition to the example experiment files, the following user sample files are
located at: C:\Program Files\ Applied Biosystems\ QuantStudio 6 and 7 Flex
Software\ examples\ User Sample Files

* Barcode template files

* Copy-paste example file

¢ Custom Sample Properties files
* Sample setup files

¢ Import custom fields file

e Export files

For more information on using the above files, see Chapter 2, “Experiment Shortcuts”
on page 53.

A note on system security

The Security, Auditing, and e-Signature (SAE) feature in QuantStudio" 6 and 7 Flex
Real-Time PCR System Software enables role-based access control to enforce data
integrity and authentication of users logging into the system, to strengthen system
security. The feature tracks actions performed by users on experiments, templates, and
studies, and it tracks changes to the SAE settings. You can enable or disable this feature
to accommodate your security needs.

To enable or disable the feature, from the toolbar select Tools » Security » Settings.

For more information on the SAE feature, please refer to the instrument user guide.

User attention words

Five user attention words may appear in this document. Each word implies a
particular level of observation or action as described below:

Note: Provides information that may be of interest or help but is not critical to the use
of the product.

IMPORTANT! Provides information that is necessary for proper instrument operation
or accurate chemistry kit use.

Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments 9
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User attention words
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CAUTION! Indicates a potentially hazardous situation that, if not avoided, may
result in minor or moderate injury. It may also be used to alert against unsafe
practices.

WARNING! Indicates a potentially hazardous situation that, if not avoided,
could result in death or serious injury.

DANGER! Indicates an imminently hazardous situation that, if not avoided,
will result in death or serious injury.

Except for IMPORTANTS, the safety alert words in user documentation appear with an
open triangle figure that contains a hazard symbol. These hazard symbols are identical
to the hazard symbols that are affixed to the instrument. See the “Safety” appendix for
descriptions of the symbols.

Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments



General Experiment Information
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Chapter 1 General Experiment Information and Instructions

Set up an experiment

Note: For more information about any of the topics discussed in this guide, access the
Help from within QuantStudio'" 6 and 7 Flex Real-Time PCR System Software by
pressing F1, clicking €2 in the toolbar, or selecting Help » QuantStudio™ 6 and 7 Flex
Real-Time PCR System Software Help.

Set up an experiment

Define experiment
properties

12

Note: To start the QuantStudio™ 6 and 7 Flex Software, see “Start the QuantStudio™ 6
and 7 Flex Software” on page 7.

All experiments require the same general setup tasks; individual booklets supply
specific parameters. The following procedures outline general steps to take to set up an
experiment.

Access QuantStudio'" 6 and 7 Flex Software and click NJ (Experiment Setup). Click
Experiment Properties to access the Experiment Properties screen.

Define experiment name and type
1. Enter a unique experiment name in the Experiment Name field. The default is a
date and time stamp, which you can change. For example, 2010-04-12 173730.

* Enter a name that is descriptive and easy to remember. You can enter up to
100 characters.

* You can only use the alpha-numeric, hyphen (-), underscore ( _ ), and spaces
() characters.

Note: Ensure each experiment name is unique. If you have named two different
experiments with the same name, you cannot run them on the same instrument.
You will receive the following error message when attempting to start the run:

Failed to Start Ru x|

@ Unable ta start the run,
The experiment already exists, Delete the experiment before starting the run,

N

(Optional) Enter or scan the barcode on the reaction plate. You can enter up to 100
characters in the Barcode field.

w

(Optional) Enter a user name to identify the owner of the experiment. You can
enter up to 100 characters in the User Name field.

4. (Optional) Enter comments to describe the experiment.

5. Select the instrument type you are using to run the experiment
* QuantStudio™ 6 Flex System
* QuantStudio™ 7 Flex System

6. Select the block type you are using to run the experiment
¢ 384-Well Block
» Array Card Block (only applicable to the QuantStudio™" 7 Flex System)

Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments



Chapter 1 General Experiment Information and Instructions 1
Set up an experiment

¢ 96-Well Block (0.2mL)
¢ Fast 96-Well Block (0.1mL)

7. Select the experiment type:
¢ Standard Curve
* Relative Standard Curve
* Comparative Cp (AACy)
* Melt Curve
¢ Genotyping

e Presence/Absence

Select the reagent

Select the reagent you are using to detect the target sequence:
e TagMan® Reagents
* SYBR® Green Reagents
¢ Other

Note: If you select SYBR® Green as the reagent, then you have the option of
including a melt curve for that experiment.

Define the instrument run properties

1. Select the ramp speed for the experiment:
¢ Standard
¢ TFast
2. For Genotyping and Presence/Absence experiments, select the options for the
data collection to include in the experiment run:

* Pre-PCR Read - to include data before amplification occurs. Use the data
collected during pre-PCR read to normalize fluorescence data collected
during post-PCR read.

e Amplification - to include real-time data.
* Post-PCR Read - to include data after amplification has taken place.

3. For the Melt Curve experiment, select the Include PCR check box, to include
PCR.

Review the analysis settings

Analysis Settings are different for each experiment type. The software analyzes the
data using the default analysis settings. If the default analysis settings in the
QuantStudio™ 6 and 7 Flex Software are not suitable for your own experiment, you
can change the settings in the Analysis Settings dialog box and save the changed
analysis settings to the Analysis Settings Library

Note: For information on Analysis Settings Library, refer to Booklet 7, QuantStudio™ 6
and 7 Flex Real-Time PCR System Software Experiments - Appendixes.

Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments 13



Chapter 1 General Experiment Information and Instructions
Set up an experiment

Enter the reagent information

In the Reagent Information panel you can enter detailed reagent information,
including the part number, lot number, and expiration date of the reagents you will
use in your experiment. This information can be entered before setting up your
experiment or starting your calibration run.

1. In the Reagent Information panel, click New to add a line for reagent details, or
Delete to remove an existing one.

2. Click within the first four fields to enter your reagent Type, Name, Part Number,
or Lot Number, respectively:

3. Click the Expiration Date field, and click the "down arrow" to display the current
month's calendar. Select the reagent's expiration date from that month, or click the
"forward arrow" to select a future date.

Save the experiment

Save the experiment. The default file name (.eds extension) is the experiment name
that you entered when you set up the experiment and saved it for the first time.
Changes to the experiment name after the first save do not update the file name. To
change the file name, select File » Save As.

The following is an image of the Experiment Properties screen for a Standard Curve
experiment:

Experiment: QS6_QuantStudio_384-Wel... Type: Standard Curve Reagents: TagMan® Reagents

How do you want to identify this experiment?

* Experiment Name: |QS6_QuantStudio_384-Well_Standard_Curve_Example Comments: |Standard Curve Example

Barcode:

User Name: |[Example User

~
~

Which instrument type are you using to run the experiment?

‘ v QuantStudio™ 6 Flex System | [ QuantStudio™ 7 Flex System ]

Which block are you using to run the experiment?

'

384-well

:| [ 96-well (0.2mL) ] [ Fast 96-Well (0.1mL) ]

What type of experiment do you want to set up?

v

Standard Curve

| [ Relative Standard Curve ] [ Comparative Cr (AACT) ] [ Melt Curve }

{

Genotyping

] [ Presence/ Absence ]

Which reagents do you want to use to detect the target sequence?

s

TagMan® Reagents

| [ SYBR® Green Reagents ] [ Other ]

What properties do you want for the instrument run?

{

Standard

] | s Fast |

Mew

What is the reagent information?

Type MName Part Number Lot Number Expiration Date
Master Mix ‘TagMan Fast Universal PCR Master Mix [4984571 1208155 12-31-2013
14 Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments
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Set up an experiment

Define targets, Use the Define screen to define targets, samples and biological replicates for your
samples, and experiment.

biological replicate  Note: You can start a run without these definitions, but there will be no real-time data
groups (data will not be visible) in the amplification plots (the amplification plots can be seen

only after you have set up the plate).

1. Click Define to access the Define screen.

2. Define targets.

Note: For Genotyping experiments, use this screen to specify the number of SNP
assays to include in the experiment. For more information on defining SNP
assays, refer to Booklet 4, QuantStudio™ 6 and 7 Real-Time PCR System Software
Getting Started Guide for Genotyping Experiments.

a.
b.

f.

Click New to add targets and define them.

In the target table, click a cell in the Target Name column for the target, then
enter your target name. The default name is Target 1.

. Select the Reporter and Quencher from the respective drop-down menu.

Note: The default reporter and quencher dyes used depend on the reagent
selected during experiment setup. For example, if TaqMan@® is the selected
reagent, the default reporter FAM and default quencher is NFQ-MGB.

. Select the target Color from the drop-down menu.

(Optional) Click Save to Library to save the newly added or existing edited
targets to the target library.

Note: Use the targets from the Target Library to avoid re-entering the
information. Refer to Appendix B, Supplemental Information in Booklet 7,
QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments -
Appendixes for information on target libraries.

(Optional) Click Import from Library to add targets from the target library.

3. Define samples.

a.
b.

Click New to add samples and name them.

In the samples table, click a cell in the Sample Name column for the sample
to define and enter your sample name. The default sample name is Sample 1.

Select the sample Color from the drop-down menu.

(Optional) Click Save to Library to save the newly added or existing edited
samples to the sample library.

Note: Use the samples from the Sample Library to avoid re-entering the
information. Refer to Appendix B, Supplemental Information in Booklet 7,
QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments -
Appendixes for information on sample libraries.

(Optional) Click Import from Library to add samples from the sample
library.

4. (Optional) Define biological replicates.

a.

In the Define Biological Replicates Groups table, click New to add biological
replicate group and name them. You can enter up to 100 characters in this
field.

Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments 15
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Set up an experiment

b. Select the Color from the drop-down menu.

c. Click in the Comments column to add comments for that biological replicate

group.

5. Select the Passive Reference dye from the drop-down menu.

6. Define custom task name.

Note: The Custom Task Name panel is visible only when the Hide the custom
task name definition and assignment UI check box under the Setup tab in the
Preferences dialog box is unselected.

The following is an image of the Define screen for a Standard Curve experiment:

Targets

Mew  Savetolibrary  ImportfromLibrary  Delete

Target Name Reporter Quencher Color

RINAge P FAM « |NFQ-MGB - | “ |

Samples

Mew  Savetolibrary  Import from Library

Sample Name Color
5K ~
10K ~

r’, Impart from File

Biological Replicate Groups

Biological Group Name Color Comments

Passive Reference

ROX ~

Custom Task Name

Mew  Delele

MName Color

lcon Char

Assign targets,
samples, and
biological replicate
groups

assays.

Use the Assign screen to assign targets, samples, and biological replicate groups to
wells in the reaction plate. For Genotyping experiments, use this screen to assign SNP

Note: You can start a run without these assignments, but there will be no real-time

data in the amplification plots (the amplification plots can be seen only after you have

set up the plate).

1. Click Assign to access the Assign screen.

2. Assign targets.

a. Select wells using the plate layout or the well table on the Assign screen.

b. Select a target and assign its task, in the plate, from the drop-down menu.

Depending on the experiment type, options are:

16 Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments
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Set up an experiment

Experiment type Legend Tasks
Standard Curve U Unknown
S Standard
N Negative Control
Relative Standard Curve u Unknown
Standard
N Negative Control
Comparative CT Unknown
N Negative Control
Genotyping u Unknown
1/ Positive Control Allele 1/ Allele 1
2/2 Positive Control Allele 2/ Allele 2
1/2 Positive Control Allele 1/ Allele 2
N Negative Control
Presence/Absence U Unknown
| Internal Positive Control
N Negative Control
A Blocked Internal Positive Control
Melt Curve Unknown
N Negative Control

3. Assign Samples.

a. Select wells using the plate layout or the well table on the Assign screen.

b. Select the check box next to the sample to assign to the selected wells.

Note: You can assign only one sample to a well. If the selected wells contain
mixed assignments (indicated by a [ ), remove existing sample assignments
before you make the new sample assignment.

4. Assign Biological Replicate Groups.

a. Select wells using the plate layout or the well table on the Assign screen.

b. Select the check box next to the biological replicate group to assign to the

selected wells.
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The following is an image of the Assign screen for a Standard Curve experiment:

Well Table

*, Define and Set Up Stardards

Targets
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Assign targets, As shown below, you can also paste assignment information from an *.xIs file into the
samples, and plate layout of the QuantStudio™ 6 and 7 Flex Software for wells with single targets.

biological replicate  Note: You must select the header and the Well Number column while copying
groups - alternate  information from the *.xIs file.

procedure Note: Any of the columns not copied are treated as NULL values for those columns.
| B1 - ﬁl Sample
A B c [ E F G H

1 well Sample Biological Group Target Task Dyes Quantity Comments
2 1 5K RNaseP UNKNOWN FAM-NFQ-MGB

3 2 5K RNaseP UNKNOWN FAM-NFQ-MGEB

4 3 SK RNaseP UNKNOWN FAM-NFQ-MGBE

5 4 SK RNaseP UNKNOWN FAM-NFQ-MGBE

] 5 5K RMNaseP UNKNOWN FAM-NFQ-MGB

7 = 5K RNaseP UNKNOWMN FAM-NFQ-MGB

8 7 5K RNaseP UNKNOWN FAM-NFQ-MGB

9 8 5K RNaseP UNKNOWN FAM-NFQ-MGEBE

10 9 SK RNaseP UNKNOWN FAM-NFQ-MGBE

11 10 SK RNaseP UNKNOWN FAM-NFQ-MGBE

12 11 5K RNaseP UNKNOWMN FAM-NFQ-MGE

13 12 5K RNaseP UNKNOWN FAM-NFQ-MGB

14 13 5K RNaseP UNKNOWN FAM-NFQ-MGEB

15 14 SK RNaseP UNKNOWN FAM-NFQ-MGBE

16 15 SK RMNaseP UNKNOWN FAM-NFQ-MGE

* Copy and paste

|, Define and Set Lip Standards <

Targets —————— (&) 3

Expsnd Al
Expand Al

lame

Riiasep [ v
O| |Target1] ~ v

# Well | Sample | Biological Group | Target Task Dyes "1 Quantity =Comments

1A RMase?  UNKHOWN FAM-NFQ-MGB A
2 m RHase?  UNKHOWN FAM-NFQ-MGB
3 m Riase?  UNKHOWN FAM-NFQ-MGB
4 A4 RHase?  UNKHOWN FAM-NFQ-MGB
5 A5 RMase?  UNKHOWN FAM-NFQ-MGB
6 A6 Riase?  UNKHOWN FAM-NFQ-MGB
7 A RHase?  UNKHOWN FAM-NFQ-MGB
8 A8 RMaseP  UNKHOWN FAM-NFQ-MGB
) Riase?  UNKHOWN FAM-NFQ-MGB
0 A0 s RHase?  UNKHOWN FAM-NFQ-MGB
samples ———— (&) |y 4y g RMase?  UNKHOWN FAM-NFQ-MGB
12 A2 K RHaseP  UNKHOWN FAM-NFQ-MGB
- 13 M3 Riase?  UNKHOWN FAM-NFQ-MGB
14 A4 S RHase?  UNKHOWN FAM-NFQ-MGB
O 15 A5 K RMase?  UNKHOWN FAM-NFQ-MGB
;16 AlS
17 A7
18 Al8
19 At9
20 A2
2 A1
2 AR
23 A
24 A
Biological GrOUDS m—— ] 5 B
2% B2
7 B
8 B4
29 B
30 B
B
2 B
3 B
M4 Bl0
35 Bl
36 B12
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Note: An example copy and paste file is provided with the QuantStudio™ 6 and 7 Flex
Real-Time PCR System Software and is located at C:\Program Files\ Applied
Biosystems\ QuantStudio 6 and 7 Flex Software \ examples\ User Sample Files.

where, <drive> is the computer hard drive on which the QuantStudio™ 6 and 7 Flex
Software is installed. The default installation drive for the software is the C: drive.

Define the run Use the Run Method screen to set up the run method for your own experiments in the
method QuantStudio™ 6 and 7 Flex Software.

Note: Refer to the Booklet 7, QuantStudio™ 6 and 7 Real-Time PCR System Software
Experiments - Appendixes for information on analysis settings.

1. Click Run Method to access the Run Method screen.

Note: You can save multiple run methods to the Run Method Library for later
use. Refer to Appendix B, Supplemental Information in Booklet 7, QuantStudio™ 6
and 7 Flex Real-Time PCR System Software Experiments - Appendixes for information
on run method libraries.

2. Enter a number for the reaction volume per well. See “Instrument consumables”
on page 17 for maximum reaction volumes for the consumables supported by the
QuantStudio™ 6 and 7 Flex Software.

3. In the Graphical View tab, review and, if necessary, edit the run method.

* Make sure that the thermal profile is appropriate for your reagents.

¢ Edit the default run method or replace it with one from the run method
library included in the QuantStudio™ 6 and 7 Flex Software.

¢ Enable data collection by clicking .

Note: Enabling data collection is especially useful when you later need to
analyze data collected in real-time during the various stages.

¢ [Edit the ramp rate. You can increase or decrease the ramp rate for a stage.
Note: Ramp rates are decimal numbers from 0.015—3.4.

¢ Edit the PCR Stage.
— Change the Number of Cycles for the PCR stage.

— Select the Enable AutoDelta check box, to increase or decrease the
temperature and/or hold time for each subsequent cycle or to change
the Starting Cycle for AutoDelta. Enabling AutoDelta displays the &
icon. Click the AutoDelta Off 4 icon to change the AutoDelta settings
for the cycling stage in the AutoDelta Settings dialog box. Then, click
Save Setting to display the AutoDelta On A icon.

x

AutoDelta Settings For Cycling Stage

AutcDelta Temperature: |+ vl II 0.01 3:

Walid AutoDelta Temperature Range: -2.27 to 0,12

AutoDelta Time: I + 'l FEH

Starting Cycle: 1

Save Setting W
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Note: If you selected SYBR® Green as the reagent, the Melt Curve stage
automatically appears in the Run Method screen. If you delete the Melt
Curve Stage section from the protocol, then the melt curve is active in
the Add Stage drop-down menu.

4. (Optional) Complete the tasks on the Optical Filters tab:

IMPORTANT! Do not alter the optical filters for system dyes. This feature is
optional when you use custom dyes, where you can select a filter set to match the
profile of the dye. For more information on how to select the appropriate filter set,
contact Life Technologies.

By default, the Optical Filters tab is not visible. To show the Optical Filters tab, go
to Tools » Preferences, and select the Show optical filters for run method check
box under the Default tab.

Setup T Export T Display Format r SMTP Settings T Motification Settings ]
DeFaults Startup Print 1

Experiment

@ Sclect the default folders, the default black type, and whether to show optical filters in the run method.

Data Folder: C:\Applied Biosystems\QuantStudio 6 and 7 Flex Software\User F|Ies\Exper|m| Browse
Import Folder: C:\Applied Biosystems\QuantStudio 6 and 7 Flex Software\User Files\Wmport [m
Instrument Type: QuantStudio ™ 7 Flex System -

Block Type: 384-Well Block v

Decimal Places to Show:|3

Show optical filters for run method |

[ I Jro Jcoreer]

e To add a new filter set to the filter set library, click Save.

¢ Toload a saved filter set, click Load.

e To go back to the original filter set combinations, click Revert to Defaults.
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Prepare reactions

Supported
reagents

Precautions while
preparing
reactions

Materials required
while preparing the
dilutions

22

Life Technologies supports the following reagents for experiments performed with the
QuantStudio™ 6 and 7 Flex Software.

Reagent Experiment type

TagMan® reagents e Standard Curve

¢ Relative Standard Curve
e Comparative Cy (AACy)
¢ Genotyping

* Presence/ Absence
SYBR® Green reagents e Standard Curve

¢ Relative Standard Curve
 Comparative Cy (AACy)
e Melt Curve

Other reagents e Standard Curve

¢ Relative Standard Curve
e Comparative Ct (AACq)
¢ Genotyping

* Presence/ Absence

e Melt Curve

™

Note: The QuantStudio ~ 6 and 7 Flex Software can accommodate other reagents, but
performance claims have not been tested by Life Technologies.

* Do not prepare the reactions on a wet table. Wet surfaces lead to contamination of

your reactions.
* Wear appropriate protective eyewear, clothing, and powder-free gloves.

* Use the appropriate consumables. The quality of pipettors and tips and the care
used in measuring and mixing dilutions affect data accuracy.

¢ Perform dilutions exactly as instructed. Mistakes or inaccuracies in making the
dilutions directly affect the quality of results.

¢ Use a permanent marker or pen to mark a tube and the side of a plate or array
card. Do not use fluorescent markers.

* Ensure that the arrangement of the PCR reactions matches the plate layout
™

displayed in the QuantStudio ~ 6 and 7 Flex Software.

¢ DI water or DEPC water
* Microcentrifuge tubes

* Dipettors

¢ DPipette tips

¢ Vortex mixer

¢ Centrifuge

* Sample stock
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Standard stock
Reaction mix components

Plate or array card

Include excess volume in your calculations to provide excess volume for the loss
that occurs during reagent transfers.

Use TE butffer or water to dilute the standards and samples.
Prepare the reagents according to the manufacturer’s instructions.

Keep the dilutions and assay mix protected from light, in the freezer, until you are
ready to use it. Excessive exposure to light may affect the fluorescent probes or
dyes.
Prior to use:

— Mix the master mix thoroughly by swirling the bottle.

— Resuspend the assay mix by vortexing, then centrifuge the tube briefly.

— Thaw any frozen samples by placing them on ice. When thawed, resuspend
the samples by vortexing, then centrifuge the tubes briefly.

Do not allow the bottom of the reaction plate to become dirty. Fluids and other
contaminants that adhere to the bottom of the reaction plate can contaminate the
sample block(s) and cause an abnormally high background signal.

Correct Incorrect

Liquid is at the bottom of Not centrifuged with enough force
the well. or

Not centrifuged for enough time

* Place the reaction plate or array card at 4°C and in the dark until you are ready to

load it into the instrument.

If you use optical adhesive film to seal your reaction plates, seal each reaction plate as
follows:

Note: The sealing instructions are applicable to 384-well and 96-well reaction plates.

1.

Load the reaction plate using the plate layout described in “Assign targets,
samples, and biological replicate groups” on page 16.

Note: For 96-well reaction plates, place the reaction plate onto the center of the
96-well base, then perform this step. Ensure that the reaction plate is flush with
the top surface of the 96-well base.

Remove a single optical adhesive film (film) from the box. Bend both end-tabs
upward. Hold the film backing side up.
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3. In one swift movement, peel back the
white protective backing from the
center sealing surface. Do not touch the
center sealing surface.

IMPORTANT! Improper peeling of the
optical adhesive film may result in
haziness, but it will not affect results.
Haziness disappears when the film comes into contact with the heated cover in
the instrument.

4. Holding the film by the end-tabs, lower the film onto the reaction plate (adhesive
side facing the reaction plate). Ensure that the film completely covers all wells of
the reaction plate.

5. Applying firm pressure, move the applicator
slowly across the film, horizontally and
vertically, to ensure good contact between the
film and the entire surface of the reaction plate.

6. Using the applicator to hold the edge of the film in place, grasp one end of the
end-tab and pull up and away sharply. Repeat for the other end-tab.

Note: Ensure clean removal of both end-tabs
from the dotted line. Improper peeling of the
end-tab can cause sticking of plate on the heated
cover assembly.

7. To ensure a tight, evaporation-free seal, repeat
step 5. Applying firm pressure, run the edge of
the applicator along all four sides of the outside
border of the film.

Note: Optical adhesive films do not adhere on contact. The films require the
application of pressure to ensure a tight, evaporation-free seal.
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8. Inspect the reaction plate to ensure that all wells are sealed. You should see an
imprint of all wells on the surface of the film. The perforated tab should be
completely torn off to avoid plates from sticking to the instrument after a run.

IMPORTANT! Remove all excess adhesive from the perimeter of the optical adhesive
cover. When the film is applied, the glue from the optical adhesive cover can adhere to
the edges of the plate. If the excess glue is not removed, the plate may adhere to the
sample block of the QuantStudio™ 6 or 7 Instrument.

Fill and seal the Fill and spin the array card
array card

IMPORTANT! Wear powder-free gloves while preparing the Arrays.

1. Remove an array card from its box and place it on a clean, dry surface.
2. Using a permanent marker, mark the side of the empty array cards.

3. Transfer the experiment-related chemistries and solutions into the port of the
array card.

For each transfer:
a. Place the array card on a lab bench, with the foil side down.

b. Load 100 pL of fluid into a pipette.
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c. Hold the pipette in an angled position (~45 degrees) and place the tip into the
fill port. The fill port is the larger of the two holes on the left side of the fill
reservoir.

Vent
port

d. Dispense the fluid so that it sweeps in and around
the fill reservoir toward the vent port. Pipet fluid
into the fill reservoir, but do not go past the first

stop of pipettor plunger when pipetting the @ﬁ}%ﬁ&
reagents into the array card, or you may blow the %ﬁ(&\fﬁg{&\fﬁ?
solution out of the port. J %}A@({\\j

&
/\
Z

IMPORTANT! Do not allow the tip to contact and possibly damage the coated
foil beneath the fill port.

4. Place the filled array card(s) into a centrifuge array —Filled array
card carrier clip and place empty array card(s) in the
remaining slots. Confirm that the labels on the buckets

and clips are oriented in the same direction. Thig

—Empty
3. array

A |l

IMPORTANT! Balance the loads in opposite buckets in the centrifuge.

5. Place the filled carrier clips into the centrifuge buckets.
Ensure that the array card fill reservoirs and bucket
and clip labels face outward when loaded into the
centrifuge. Balance the loads in opposite buckets.

IMPORTANT! You must run the centrifuge with all four buckets in place and each
of the two carriers filled with the array card. Place empty array cards into unfilled
slots.

6. Close the centrifuge cover, then spin the array card(s) for 1 minute at 1200 rpm.
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7. When the run is finished, stop the centrifuge, then spin the array card(s) again for
1 minute at 1200 rpm.

IMPORTANT! Do not try to save time by doing one spin for 2 minutes. The two
sets of ramps are important for a good fill into the array card.

8. When the second run is finished, open the centrifuge and check that the fluid
levels in the reservoirs of each array card have decreased by the same amount.
Also, check for the formation of bubbles in all wells and note possible problems.

Correct Incorrect

i B B T 5 @ A i B D) T 5 © 7 @ T B b q 5 ® 7 B
E‘J
@@ & W& @& | e @&

9. If necessary, centrifuge the array card(s) for an additional minute to fill any
unfilled wells. Do not exceed three 1-minute runs or centrifuge the array card for
longer than 1 minute at a time.

Note: Contact Life Technologies for more information on loading an array card.

Seal the array card(s)

1. With the carriage (roller assembly) of the Array Card Staker/ Sealer in the Start
position, place a filled array card into the fixture with the foil side up so that the
fill reservoirs are the farthest away from the carriage.

2. Press down on all four corners of the array card
to ensure that it is fully seated within the
fixture.

Alignment pins

3. Use the two alignment pins in the fixture to position the array card correctly.
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Capping and
uncapping the 96-
well reaction tubes
and tube strips

28

4. Seal the array card by running the carriage slowly over it. Run the carriage over
the array card in one direction only. Do not apply downward force on the carriage
as you move it forward over the card.

5. Remove the sealed array card from the fixture and trim the fill reservoirs from the
array card assembly using scissors. Trim the foil array card so that the edge is
even with the plastic carrier.

IMPORTANT! Completely remove the fill reservoirs from the array card so that the
edge is free of residual plastic. The plastic from the fill reservoirs that extends beyond
the edge of the card can prevent the card from seating properly on the sample block
and affect amplification.

Correct Incorrect

¢ @ @ | 7 @ @

IMPORTANT! As you seal the remaining filled array cards, store them in a dark place
until you are ready to use them. The fluorescent dyes in the array card are
photosensitive. Prolonged exposure to light can diminish the fluorescence of the dye.

WARNING! Use the flat caps for the 0.2 mL tubes and 0.1 mL tubes. Rounded
caps can damage the heated cover.

Note: Ensure that you secure the caps on the tubes and tube-strips tightly to avoid
sample evaporation.
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If you use the 96-well MicroAmp® Optical 8-Tube Strips or MicroAmp® Optical Tubes
without Cap, use the MicroAmp® Cap Installing Tool and use the following
instructions:

e Applying the MicroAmp® Optical 8-Cap Strip or MicroAmp® Optical Tubes
without Cap to the tubes

¢ Removing a cap string from a plate

Required materials:
e MicroAmp® Cap Installing Tool
* MicroAmp® Optical 8-Tube Strips or MicroAmp® Optical Tubes without cap
e MicroAmp® Optical 8-Cap Strip

(A~~~ A~~~ ~)

Grooved side for flat

——
cap strips
Recessed cups | I
for rounded
cap strips
L. ]

S
eesessen )

MicroAmp® Cap Installing Tool

Apply the MicroAmp® Optical 8-Cap Strip (flat)

1. Grasp the Cap Installing Tool so that the grooved
side is exposed.

2. Hold the strip of caps over the tube strip or the row
of tubes.

3. Use the grooved side (shown) of the Cap Installing
Tool to push and seat each cap firmly in place. Use a
rocking motion to properly seat each cap.

Remove a cap string from a plate

The MicroAmp® Cap Installing Tool is also used for
removing the MicroAmp® Optical 8-Cap Strip from the 96-well optical plates and tray/
retainer assemblies. To remove the cap or cap strip:

Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments 29



1 Chapter 1 General Experiment Information and Instructions
Start the experiment

1. Insert the small protrusions on the side of the Cap
Installing Tool under the webbing between the caps on
a cap strip.

2. Slowly pry the strip from the plate or Tray/Retainer
assembly.

Start the experiment

To start an experiment:
1. Prepare the instrument for use as shown below.
2. Load the reaction plate or array card into the instrument, as shown on page 33.

3. Run the experiment as shown on page 34.

Prepare the Start the QuantStudio™ 6 or 7 Instrument

instrument for use 1. Touch anywhere on the touchscreen to determine if the QuantStudio'" 6 or 7

Instrument is in standby mode.

Does the touchscreen display the Standby screen after you touch it?
* Yes — The instrument is ready for use. Go to step 3 below.
* No - Go to step 2 to power on the instrument.

2. Toggle the power button on the rear of the QuantStudio'" 6 or 7 Instrument, then
wait for it to start.

The QuantStudio™ 6 or 7 Instrument is ready to use when the touchscreen
displays the Main Menu.

3. Power on the monitor.

4. Power on the computer:
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a. Press the computer power button, then wait for it to start.
b. When the Login screen appears, enter your user name and password, then
click OK.
5. Start the QuantStudio™ 6 and 7 Flex Software:
a. From the desktop, double-click &ﬂ'- QuantStudio™ 6 and 7 Flex Software.

Note: If the shortcut is not present on the desktop, select Start »
All Programs » Applied Biosystems » QuantStudio™" 6 and 7 Flex Software
» QuantStudio™ 6 and 7 Flex Software to start the software.

IMPORTANT! If the QuantStudio'" 6 and 7 Flex Software will not start,
confirm that no other instances of the instrument control software are open.
If any instance of the software is open, close it before starting the
QuantStudio™™ 6 and 7 Flex Software.

b. From the Login dialog box, enter your user name and password, then
click Log In.

Login 3]

Enter your user name and password to log in.

User Name:

Password:

Exit Application

Note: If the QuantStudio' 6 and 7 Flex Software displays the License
Central screen after you log into the software, your license file may be

corrupt. Contact Life Technologies support to obtain a replacement license
file.

Add the instrument to the My Instruments group

Before you can use the QuantStudio™ 6 or 7 Instrument, you must add the instrument
to the “My Instruments” group in the QuantStudio™" 6 and 7 Flex Software.

1. Power on the instrument and start the software as explained in “Start the
QuantStudio™ 6 or 7 Instrument” on page 30.

2. From the QuantStudio™ 6 and 7 Flex Software Home tab, click @ Instrument
Console.

3. From the Instrument Console, confirm the instrument state:

a. Confirm that the instrument icon appears in the My Instruments group.
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b. Confirm that a green check box appears in the upper-right corner of the
instrument icon.

Remaove from

efiestn My Instruments

Manage Instrurment

Display Group: |Rejilst Filtered by: [RSjeld=1 -

@,

Q57_0009
READY

On the Network

4. If your instrument does not appear within the My Instruments group, add it as
follows:

a. From the Instrument Console, select your QuantStudio™ 6 or 7 Instrument
from the list of instruments on the network.

b. Click Add to My Instruments.

412 QuantStudio™ 6 and 7 Flex Real-Time PCR System Software v1.0

File Edit Instrument Analysis Tools Help

[E] New Experiment - | 5 Open... £ Close B £ &

On the Network (1)

Note: The details for a QuantStudio'™ 6 or 7 Instrument in the My Preferred list
can be exported even if the network connection has been interrupted. The
exported details from the disconnected instrument would contain the data most
recently downloaded from the instrument before the interruption.

Enable or change the Notification Settings

You can configure the QuantStudio " 6 and 7 Flex Software to alert you by email when
the QuantStudio™ 6 or 7 Instrument begins and completes a run, or if an error occurs
during a run.

Note: For details on using the Notification Settings feature, refer to the instrument
user guide.
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Load the reaction CAUTION! PHYSICAL INJURY HAZARD. During instrument operation, the
8 p
plate or array card temperature of the sample block(s) can exceed 100°C. Keep your hands away

into the instrument until the sample block(s) reaches room temperature.

IMPORTANT! Wear powder-free gloves when you handle the reaction plate or array
card.

IMPORTANT! Plates and array cards should be loaded and unloaded by operators who
have been warned of the moving parts hazard and have been adequately trained.

1. Eject the QuantStudio " 6 or 7 Instrument tray by doing either of the following:
e From the QuantStudio'" 6 or 7 Instrument touchscreen, touch .
e From the QuantStudio™ 6 and 7 Flex Software, select Instrument
» Instrument Console, select your instrument icon, then click Open Door.
2. Load the reaction plate or array card into the plate adapter. When you load the
reaction plate or array card, ensure that:
*  Well Al is positioned at the top-left of the tray for any of the plate formats.

* The barcode (for any of the plate formats) is facing the front of the
instrument.

¢ If using reaction tubes or tube strips, make sure you use adaptors. The
adaptors are attached to the plate transport arm. The tray containing the
tubes or tube strips must be placed on the adaptor and not into the sample
block directly.

IMPORTANT! For optimal performance with partial loads, load at least 16
tubes in one of the following arrangements. You can load empty tubes if you
do not have enough reaction volume to load the required number of tubes:
Adjacent columns of 8 tubes, using rows A through H. For example, use
wells in columns 6 and 7 (rows A through H).

Or

Adjacent rows of 8 tubes, using columns 3 through 10. For example, use
wells in row D (columns 3 through 10) and row E (columns 3 through 10).

3. Close the QuantStudio'" 6 or 7 Instrument tray by doing either of the following:
e From the instrument touchscreen, touch E

e From the Instrument Console screen, click Close Door.
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Start the
experiment
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IMPORTANT! Ensure that instrument calibration is up-to-date. If a calibration has
expired, you will get a warning when you start a run. For information on calibrating
the QuantStudio™ 6 or 7 Instrument, refer to instrument user guide.

IMPORTANT! Do not attempt to open the access door during the run. The door is
locked while the QuantStudio™ 6 or 7 Instrument is in operation.

Note: Ensure each experiment name is unique. If you have named two different
experiments with the same name, you cannot run them on the same instrument. You
will receive the following error message when attempting to start the run:

Failed to Start Run x|
@ Unable ta start the run,
The experiment already exists, Delete the experiment before starting the run,

If you do not want to delete the existing experiment, rename the duplicate experiment
and then proceed to the run.

You can run the experiment in either of the following two ways:
e Start the experiment from the QuantStudio" 6 and 7 Flex Software

* Start the experiment from the QuantStudio™ 6 or 7 Instrument touchscreen

Note: The example experiments in each of the getting started guide booklets start a
run from the QuantStudio' " 6 and 7 Flex Software.

Start the experiment from the QuantStudio™ 6 and 7 Flex Software

1. In the QuantStudio™ 6 and 7 Flex Software, click @' Runin the navigation
pane.

IMPORTANT! Ensure that the *.eds file you created is open before you start a run.

2. Click START RUN. Select the instrument for the run from the My Instruments
drop-down menu.

IMPORTANT! If the preferred instrument for running the experiment is not
present under My Instruments or the custom group, or if it is unavailable, clicking
START RUN does not display instrument names in the drop-down menu. See
“Add the instrument to the My Instruments group” on page 31 for instructions on
adding an instrument to the My Instruments group.

Run Status

' START RUM ¥

Fosmirajs1i01

SGEAGUSANKIDOL

enggd
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Start the experiment from the QuantStudio™ 6 or 7 Instrument touchscreen

1.

7.

Touch the QuantStudio™" 6 or 7 Instrument touchscreen to awaken it.

Note: If the touchscreen is not at the Main Menu screen, touch n .
In the Main Menu screen, touch Browse Experiments.

In the Browse screen, touch i Folders, to display the folders containing the
experiment setup files.
Touch any of the folder names to display the experiments in that folder.

Note: You can create and save new experiments from the QuantStudio™ 6 or 7
Instrument touchscreen, or transfer experiments created and saved in the
QuantStudio™ 6 and 7 Flex Software to folders in the QuantStudio™ 6 or 7
Instrument touchscreen via a USB flash drive.

In the Experiments screen, select the desired experiment, then: to view or edit the
experiment before starting the run.

* Touch dasiall View/Edit, then go to step 6 to view or edit the experiment
before starting the run.

¢ Touch M Save and Start Run, then go to step 7 to start the run
immediately.
(Optional) Modify the experiment parameters as needed.

a. In the Edit Experiment screen, you can use the:

. Add and Delete buttons to add and delete a stage or
step to the thermal profile.

. Add Melt Curve button to add a melt curve to the thermal
profile.

¢ Save button to save the experiment you modify.
b. In the Save Experiment screen, touch each field to edit the:
¢ Experiment name
¢ Folder to save the experiment
* Reaction volume
* Barcode Number
* Notes
When finished, touch M Save & Start Run to start the experiment.

In the Start Run screen, touch each field as needed to modify the associated
parameter, then touch .i — i Start Run Now to start the experiment.

Monitor the Note: If the connection between the QuantStudio™ 6 and 7 Flex Software and the

experiment QuantStudio™ 6 or 7 Instrument is disrupted while running an experiment, remove
and then add the instrument to the My Instruments list in the Instrument Console. You
may then resume monitoring the experiment.
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You can monitor an experiment run in three ways:

From the Run screen of the QuantStudio™ 6 and 7 Flex Software, while the
experiment is in progress, as shown below.

From the Instrument Console of the QuantStudio'" 6 and 7 Flex Software (to
monitor an experiment started from another computer or from the QuantStudio™
6 or 7 Instrument touchscreen) as described in “From the QuantStudio™" 6 and 7

Flex Software Instrument Console” on page 36.

From the QuantStudio™ 6 or 7 Instrument touchscreen, as described in “From the
QuantStudio™ 6 or 7 Instrument touchscreen” on page 40.

From the QuantStudio™ 6 and 7 Flex Software Run screen

1.

Click Amplification Plot from the Run Experiment Menu to monitor the
amplification plot of the experiment you are running,.

Note: For Melt Curve experiments, click Melt Curve Plot from the Run
Experiment Menu.

Click Temperature Plot from the Run Experiment Menu to monitor the
temperature plot of the experiment you are running.

From the QuantStudio™ 6 and 7 Flex Software Instrument Console

1.

2.
3.

In the Instrument Console screen, select the icon of the instrument that you are
using to run the experiment.

Click Manage Instrument.

On the Instrument Manager screen, click Monitor Running Instrument.

You can view the progress of the run in real time from the Run screen. During the run,
periodically view the Amplification Plot, Temperature Plot and Run Method (see page
37, 38, and 38 respectively) available from the QuantStudio'™ 6 and 7 Flex Software for
potential problems.

To... Action

Stop the run e |n the QuantStudio™ 6 and 7 Flex Software, click STOP

RUN.
¢ In the Stop Run dialog, click one of the following:
- Stop Immediately to stop the run immediately.

- Stop after Current Cycle/Hold to stop the run after
the current cycle or hold.

- Cancel to continue the run.

View amplification data | Select Amplification Plot.

in real time

See “To monitor the Amplification Plot” on page 37.

View temperature data Select Temperature Plot.

for the run in real time

See “To monitor the Temperature Plot” on page 38.

View progress of therun | Select Run Method.

in the Run Method
screen

See “To monitor the Run Method” on page 38.
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To... Action

Enable/disable the Select or deselect Enable Notifications.
Notification Settings

See “Enable or change the Notification Settings” on page 32.

Note: The individual experiment booklets provide illustrations of the different
experiments in real time.

Note: For Melt Curve experiments, click Melt Curve Plot from the Run Experiment
Menu.

The following is an image of the Run screen for a Standard Curve experiment:

Run Status

BT ] Estimated Time Remaining:13 min 23 sec Instrument Name: FOSMIRAJS1L02
Run Status: | Running [1Enable Notifications
3 5 A B By = Cover 105°C

£ A @ 2 L W sample 60°C

Block 60°C
Temperature Plot

Temperature

o Temperature Plot
Wi W2 0008 00mE  00n 00ezes wzw | Gozss | W32 G00naE  WO0hW 0004 was "
Time View |5 Minutes v

Fxed View []

To monitor the Amplification Plot

To view data in the Amplification Plot, click Amplification Plot from the Run
Experiment Menu, select the Plate Layout tab, then select the wells to view.

The Amplification Plot screen allows you to view sample amplification as your
instrument collects fluorescence data during a run. If a method is set up to collect real-
time data, the Amplification Plot screen displays the data for the wells selected in the
Plate Layout tab. The plot contrasts normalized dye fluorescence (ARn) and cycle
number.

The Amplification Plot screen is useful for identifying and examining abnormal
amplification, including;:

* Increased fluorescence in negative control wells.

* Absence of detectable fluorescence at an expected cycle (determined from
previous similar experiments run using the same reagents under the same
conditions).

Note: If you notice abnormal amplification or a complete absence of fluorescence,
refer to the instrument user guide to troubleshoot the error.
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To monitor the Temperature Plot

To view data in the Temperature Plot screen, click Temperature Plot from the Run
Experiment Menu.

During a run, the Temperature Plot screen displays the temperatures of the sample
block(s), the heated cover, and samples (calculated) in real-time.

To... Action

Add or remove temperature plots Select Cover or Sample Block to view the
presence of the associated data in the plot.

Change the time to display in the plot From the View drop-down menu, select the
amount of time to display in the plot.

Display a fixed time window during the | Select Fixed View.

Instrument run If the entire plot does not fit in the screen, the

screen is not updated as the run progresses. For
example, if you select 10 minutes from the View
drop-down menu, the plot will show data for 10
minutes. If the Fixed View is:

e Deselected, the plot updates as the run
progresses even after 10 minutes.

e Selected, the plot does not update as the run
progresses even after 10 minutes.

The Temperature Plot screen can be useful for identifying hardware failures. When
monitoring the Temperature Plot screen, observe the Sample and Block plots for
abnormal behavior.

* The Sample and Block plots should mirror each other approximately. A
significant deviation of the plots may indicate a problem.

* The Cover plot should maintain the constant temperature specified in the
method. A departure from the constant temperature may indicate a problem.

Note: If you notice abnormal temperatures, refer to the instrument user guide to
troubleshoot the error.

To monitor the Run Method

To view data in the Run Method screen, click Run Method from the Run Experiment
Menu.

The Run Method screen displays the run method selected for the run in progress. The
software updates the Run Status field throughout the run.

To... Action

Change the number of cycles In the Adjust # of Cycles field, enter the number
of cycles to apply to the Cycling Stage.

Add a melt curve stage tothe end | Select Add Melt Curve Stage to End.
of the run

Add a Hold stage to the end of the | Select Add Holding Stage to End.
run
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To... Action

Apply your changes Click Send to Instrument.

If an alert appears, click the error for more information and troubleshoot the problem
as explained in the QuantStudio™ 6 and 7 Flex Software Help (click €2 or press F1).

Editing the run method during a run

You can edit the run method while an experiment run is in progress on the Run
Method screen from the Setup menu.

1. Increase or decrease the number of cycles by entering the cycle number in the
Adjust # of Cycles box.

Note: Ensure that you select the stage for which you want to increase or decrease
the number of cycles in the graphical view of the run method. The Adjust # of
Cycles box appears disabled if the corresponding stage is not selected.

2. Select the appropriate check box to add a melt curve stage, holding stage, or
infinite hold stage respectively, to the end of the run.

3. Click Send to Instrument.

Edit Run Method

Adjust # of Cycles:
[ Add Mel Curve Stage to End
[] Add Holding Stage to End

[] Add Infinite Hold to End

Send to Instrument
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Run Data Report
Experiment Name: Q56_QuantStudio_384-Wel Standard_Curve_Example

To view the run data

After a run is complete, you can view a run report by clicking View Run Data. The
View Run Data screen displays information about the completed run, as in the
following image from a Standard Curve experiment:

Start Time: 02-01-2010 22:25:14 5GT

Stop Time:

02-01-2010 23:07:07 5GT

Run Duration: 41 minutes 52 seconds

User Mame: DEFAULT

Instrument Hame:
Firmware Version:

Software Version: N/A

Instrument Serial Mumber: 278880018

Sample Volume: 10.0

Cover Temperature: 105.0

Instrument Type:

Block Type: 384-Well Block

Errors Encountered:

40

The run report data helps in:

¢ Comparing two experiments of the same type run on two different instruments.

* Troubleshooting. For example, after a firmware upgrade, you can compare an

experiment run before and after the upgrade to determine if the upgrade affected

performance.

From the QuantStudio™ 6 or 7 Instrument touchscreen

The touchscreen displays the method for the experiment, the date and time at which
the run started, the time remaining in the run, and other information.

To...

Action

Display the time

elapsed and the time

remaining in the run

Touch the © Time View tab, then touch Experiment View
tab to return to the Run Method screen.

Stop the run

Touch m STOP to stop the protocol run immediately.

View the Events Log

Touch @ to view the list of run events that occurred during the
run. Touch @ again to close the event list.

The run method on the QuantStudio™ 6 or 7 Instrument touchscreen looks like this:
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Experiment View

@ Time View Ht]  Experiment View
Run Started: July 06 2013 - 05:48PM Sample: 0.0 °C
Reaction Volume: 20 pL Heated Cover [Set Point): 105.0 °C (105.0 °C)
Time Remaining: 01:15:39
Stage 1 Stage 2
X1 3 of 40
95.0 °C 95.0 °C

- 10:00 0:15 N\ po.0%c
—— 1:00
2:00 a

July 06 2013 - 05:48PM o
Heated cover reached target temperature.

Time View
®© Time View t]  Experiment View
Run Started: July 06 2013 - 05:48PM Sample: 95.0 °C
Reaction Volume: 20 pL Heated Cover [Set Point): 105.0 °C (105.0 °C)
Stage /Step fCycle: 1/2/1
@ Remaining Time . Elapsed Time
July 06 2013 - 05:48PM o
Heated cover reached target temperature.
Unload the When your QuantStudio™ 6 or 7 Instrument displays the Main Menu screen, unload
instrument the reaction plate from the instrument and transfer the experiment data to the

computer for analysis.

Unload the reaction plate or array card

C CAUTION! PHYSICAL INJURY HAZARD. During instrument operation, the
temperature of the sample block(s) can exceed 100°C. Allow the consumable to
cool to room temperature before removing.
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When the QuantStudio'" 6 or 7 Instrument displays the Main Menu screen, you can
unload the plate or array card as follows:

1.

After the run, touch E on the QuantStudio"" 6 or 7 Instrument touchscreen or
click Open Door in the Instrument Console screen of the QuantStudio™ 6 and 7

Flex Software to eject the plate or array card.

Remove the reaction plate or array card from the instrument tray and dispose of it
according to your laboratory regulations.

Touch E on the QuantStudio™" 6 or 7 Instrument touchscreen or click Close
Door to retract the plate adapter back into the instrument.

If the QuantStudio " 6 or 7 Instrument does not eject the plate, remove the plate as
follows:

a. Power off the QuantStudio™ 6 or 7 Instrument.

b. Wait for 15 minutes, then power on the QuantStudio™ 6 or 7 Instrument and
eject the plate.

c. If the plate does not eject, power off and unplug the QuantStudio™ 6 or 7
Instrument, then open the access door.

d. Wearing powder-free gloves, reach into the QuantStudio™" 6 or 7 Instrument
and remove the plate from the heated cover, then close the access door.

Transfer You can transfer the experiment results in either of the following two ways:

experiment results

Download the experiment from the QuantStudio™ 6 or 7 Instrument over the
network

When the QuantStudio™ 6 or 7 Instrument completes a experiment without a
connection to the QuantStudio™ 6 and 7 Flex Software, the software allows you to
download the results from the instrument through the network connection.

1.

5.

42

In the QuantStudio™ 6 and 7 Flex Software, select Instrument » Instrument
Console.

Select the instrument icon of the QuantStudio™" 6 or 7 Instrument from the My
Instruments list, then click Manage Instrument to open the Instrument Manager.

Note: If the Manage Instrument button is inactive, add your QuantStudio™ 6 or 7
Instrument to the My Instruments group as explained in “Add the instrument to
the My Instruments group” on page 26.

From the Instrument Manager, click Manage Files, then click File Manager.

From the File Manager screen, download the file(s):

a. From the Folders field, select the folder that contains the files that you want
to download.

b. From the Experiments field, select the files to download. To select multiple
files, Ctrl-click or Shift-click files in the list.

c. From the Folders field, select the folder that contains the files that you want
to download.

From the Save dialog box, select the folder to hold the experiment results and
click Save. The experiments folder is located at:
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C:\ Applied Biosystems\ QuantStudio 6 and 7 Flex Software\ User
Files\ experiments

Transfer the experiment from the QuantStudio™ 6 or 7 Instrument to the
computer via a USB drive:

1. Plug a USB drive into the USB port below the touchscreen.

IMPORTANT! Do not use the USB ports on the rear panel of the QuantStudio™ 6 or
7 Instrument. The rear USB ports are only for use by Life Technologies personnel
to service the instrument

2. Touch the QuantStudio™ 6 or 7 Instrument touchscreen, to awaken it.
3. If the touchscreen is not at the Main Menu screen, touch n .

4. From the Main Menu of the QuantStudio™ 6 or 7 Instrument touchscreen, touch
[B] Collect Recults Collect Results to save the data to the USB drive.

5. Select one or multiple experiments (by touching them). Then touch
Save to USB to copy selected experiments to the USB drive.

Note: If your instrument cannot find the USB drive, remove the USB drive, then
try again. If the instrument still does not recognize the USB drive, try another USB
drive.

6. Touch n to return to the Main Menu.

7. Remove the USB drive from your instrument, then connect it to one of the USB
ports on your computer.

8. In the computer desktop, use the Windows explorer to open the USB drive.

9. Copy the example experiment file to:

C:\ Applied Biosystems\QuantStudio 6 and 7 Flex Software\ User
Files\ experiments
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Review experiment results

About analysis
results

To override
calibration
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Immediately after a run, the QuantStudio'" 6 and 7 Flex Software automatically

analyzes the data using the default analysis settings, then displays the Amplification
Plot screen.

Note: For auto-analysis of data, after a run, go to Tools » Preferences » Experiment
and select the Auto Analysis check box.

To reanalyze the data, select all the wells in the plate layout, then click Analyze.

Each experiment file (.eds) stores the calibration data from the QuantStudio™" 6 or 7
Instrument it was run on. The calibration data can affect the analysis results of an
experiment.

If you have run multiple experiments on different QuantStudio" 6 or 7 Instruments
and prefer the analysis results from a particular instrument, then you can choose to use
the calibration data from another QuantStudio™ 6 or 7 Instrument.

To use the calibration data of another experiment

1. Open the experiment file (.eds), in which you want to import the calibration data
from another QuantStudio™ 6 or 7 Instrument, in the QuantStudio™ 6 and 7 Flex
Software.

2. Go to Analysis » Override Calibration » Use Calibration From Another File....

File Edit Instrument | Analysis | Tools  Help
Analysis Settings...

I Cose -—y_" Impart... = &% Create Slide..

Analyze

Cwverride Calbration »

e Calibration From Another File...

0

3. Browse to experiment file (.eds) from which you want to use the calibration data.

Revert To Criginal Calibration ll

Note: You can choose to override the calibration data in an experiment with the
calibration data of any other experiment type; however the calibration data being
used must be from the same instrument type, QuantStudio'" 6 Instrument or the
QuantStudio™ 7 Instrument. Calibration data from an experiment in the
QuantStudio™ 7 Instrument can be used to override calibration data of an
experiment in the QuantStudio™ 6 Instrument, but not vice-versa.

4. Click Open.

To revert to the original calibration data

1. Open the experiment file (.eds), in which you want to import the original
calibration data, in the QuantStudio" 6 and 7 Flex Software.

2. Go to Analysis » Override Calibration » Revert To Original Calibration.

_ File Edit Instrument | Analysis | Tools  Help

ialv=Eleetino=2y I Cose -—y_" Impart... = &% Create Slide..

Analyze

Cwverride Calbration »

e Calibration From Another File...

0

| Revert To Criginal Calibration
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The experiment file will display analysis results as per the calibration data of the
QuantStudio™ 6 or 7 Instrument that the experiment was run on.

To display wells To display specific wells in the analysis plots, select the wells in the Plate Layout tab:

¢ To select wells of a specific type, use the Select Wells With drop-down menus:
Select Sample, Target, or Task, then select the sample, target, or task name.

¢ To select a single well, click the well in the plate layout.

¢ To select multiple wells, click and drag over the desired wells, press Ctrl-click, or
press Shift-click in the plate layout.

e To select all the wells, click the upper left corner of the plate layout.

The following is an image of the plate layout for a Standard Curve experiment:
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¢ |dr @ @ e @re Gre @re @r: O O Ore O Ok e s e Qe e O O O O O e
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o | D5 Er.. Hr. He. He Hee @re [ @re Os. @k Ok Ok O s e e e D e e O O Ok
¢ |@r. @5 @ee Gr Gre Gre @re @r: O O Or O @Ore e e e e e O O O O O Qe
¢ |@e. @e @e. @e @ee Gre @ @ O O O O O e e e e e 0 e O O O e
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wels: [0 288 E 80 [ 16 0 Empty

Summary: wells in Plate: 284 Wells Set Up: 384 wels snalyzed: 294 wels Flagged: 0 wiells Omitted by Analysis: 0 wells Omitted Manually: 0 Samples Used: 2 Targets Used: 1

To display multiple Use the Multiple Plots View screen to display up to four plots simultaneously. To
plots navigate within the Multiple Plots View screen, from the Experiment Menu pane,
select Analysis » Multiple Plots View.

* To display four plots, click 392 Show plots in a 2 X 2 matrix.

e Similarly, to display two plots in rows, click = Show plots in two rows. and to
display two plots vertically, click ||| Show plots in two columns.

e To display a specific plot, select the plot from the drop-down menu above each
plot display.
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results

The following is an image of the Multiple Plots View screen for a Standard Curve
example experiment:
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Set Up: 384 Analyzed: 384 Flagged: 0 Ormitted by Analysis: 0 Ornitted Manually: 01 Samples Used: 2 Targets Used: 1

e Click 2 to expand the view of a plot, displayed on the left-hand side of the screen.

o Click < to expand the view of the Plate Layout or Well Table displayed on the
right-hand side of the screen.

Use the Plot Properties dialog box on the Analysis screen to edit plot settings such as
the font and color of the plot text, and the labels on the X axis and Y Axis.

1. Click on the Analyze screen (the icon appears above the plot) to open the Plot
Properties dialog box

2. Edit the settings under the General, X Axis, and Y Axis tab.

* C(lick the General tab to edit the plot title text, font, or color. You can also

select whether to show the plot title.

Click the X Axis tab to edit the x axis label text, font, or color; select the tick
marks and tick mark labels to display; and select the range to display.

Click the Y Axis tab to edit the y axis label text, font, or color; select the tick
marks and tick mark labels to display; and select the range to display.

3. Click OK.
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To save current You can change the Plot Settings for the different analysis plots, and save them as

settings as default ~ defaults.

Select the Save current settings as the default check box on the respective plot screens
under the Analysis Experiment Menu.

Plot Settings
Flot Type: |£\Rn s Cycle 'I Graph Type: ILDg vl Plot Color: |We|| 'I

||_ Sawe current settings as the default |

To publish the
analyzed data To...

Save a plot as an image file

Click

Print a plot

[&] [#]

Copy a plot to the clipboard

=)

I ==
I
[1

Print a report
p b Prit Repart..,,

Export data

To... Go to Then

Print the plate layout | File » Print... Select the background color, and
click Print

Create slides File » Send to PowerPoint... Select the slides for your
presentation, and click Create
Slides

Print a report File » Print Report... Select data for the report, and
click Print Report

Export an experiment

About exporting an  The Export feature of QuantStudio™ 6 and 7 Flex Software allows you to export:

experiment
Data type Description

Plate setup files for future experiments Plate setup files contain setup information
such as the well number, sample name,
sample color, target name, dyes, and other
reaction plate contents.
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Export procedure
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Data type

Description

Analyzed data in different formats for
further analysis

The data can be exported in the
QuantStudio™ 6 and 7 format, QuantStudio™
Dx/ ViiA™ 7 format, the 7900 SDS format, and
the RDML format.

e The 7900 format is applicable only to
Standard Curve, Relative Standard Curve,
Genotyping, Presence/Absence, and Melt
Curve experiments.

¢ The RDML export format is applicable
only to Standard Curve, Relative Standard
Curve, Comparative Cy, and Melt Curve
experiments. The RDML format is
available only in a single file format.

¢ For Standard Curve experiments, you can
also export the analyzed data from the
QuantStudio™ 6 and 7 Flex Software to the
external applications, TagMan® Protein
Expression Data Analysis Software and
CopyCaller® Software if they are installed
on your computer before the
QuantStudio™ 6 and 7 Flex Software is
installed. The applications appear in the
Tools menu.

Gene Expression studies

These are used to carry out a comparative
analysis.

1. Open the experiment file that contains the data to export, and from the

Experiment Menu, click E Export.

Note: If you want the data to be exported automatically after analysis, select the
Auto Export check box during experiment setup or before running an

experiment.

2. Select the format for exported data:

* QuantStudio™ 6 and 7 Format - Supports .txt, .xls, and .xIsx data.
* QuantStudio™ Dx/ ViiA™ 7 Format - Supports .txt, .xls, and .xIsx data.

* 7900 Format - Supports only .txt data, where:

— Single experiments are exported in the SDS 2.4 detector centric export
format of the 7900 Sequence Detection System.

— Studies are exported in the SDS 2.3 RQ manager detector centric export
format of the 7900 Sequence Detection System

¢ RDML Format - RDML (Real Time Data Markup Language) - Supports only

xml type of data.
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3. Select to export all data in one file or in separate files for each data type.
* One File - All data types are exported in one file.
— If you select the *.xIs format, a worksheet is created for each data type.
— If you select the *.txt format, the data are grouped by data type.

* Separate Files - Each data type is exported in a separate file. For example, if
you select three different data types Results, Amplification, and
Multicomponent to export, three separate files (one each for Results,
Amplification, and Multicomponent) are created. You can select the type of
file (*.xlIs, *.xIsx or *.txt) to export from the File Type drop-down menu.

Note: You cannot use an exported *.xIs or an *.xIsx file when importing plate
setup information.

4. (Optional) Select the Open file(s) when export is complete check box to
automatically open the file when export is complete.
5. Enter a file name and location.
a. Enter a name for the export file in the Export File Name field.

b. Enter the Export File Location. Click Browse if you do not want to save the
export file in the default export folder.

Note: To set up the Export File Location, go to Tools » Preferences, and
select the Export tab. You can select the Use Last File Location or Use
Default Folder check box.

T Print ]

Motification Settings

Experiment

Starkup

Expork Display Format SMTP Settings

@ Select the default export location.

() Use Last File Location
(%) Use Default Folder !C:mpplied Biosystems\QuantStudio 6 and 7 Flex Software\User FiIes\Eprrtl-

[Restors Defouits [ o |
[ | Jox Jlcancel

6. Select the data to export:

Select... To export...
Sample setup Well, sample name, sample color, and target name of
samples in the plate
Raw data Raw fluorescence data for each filter, for each cycle
Amplification data Amplification results, such as Cy values, Rn, or ARn
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Select... To export...
Multicomponent data Fluorescence data for each dye, for each cycle
Results Results information, such as Ct values, Rn, or calls
Technical Replicate Technical replicates information, such as Sample name,
Results (Tech. Rep. Target name, Task, or RQ
Results)
Biological Replicate Biological replicates information, such as Biogroup

Results (Bio. Rep. Results) | name, Target name, Task, or RQ

Clipped Data Information that is unique to the 7900 format. Data from
the last three raw data points per step (clipped from the
rest). The three data points are averaged to give you the
final fluorescence data value for each step.

Reagent Information Information about the reagent selected for the
experiment

Note: Results data are not available for export until the run status is complete and
the data are analyzed.

Note: The Technical Replicate Results, Biological Replicates Results, and Clipped
Data are available only in Relative Standard Curve and Comparative Ct
experiments.

7. (Optional) For Standard Curve experiments, select the external application,
TagMan® Protein Expression Data Analysis Software or CopyCaller® Software
if either Software is installed on your computer.

Note: For more information on the TagMan® Protein Expression Data Analysis
Software or CopyCaller® Software, contact Life Technologies.

8. (Optional) After you have defined the export properties or after moving the table
headings order, you can save those export settings as an export set by clicking
Save Export Set As. Later you can import the heading order into another file by
clicking Load Export Set.

Note: It is advisable to keep the default order of the table headings if you are
using the external Life Technologies applications, TagMan® Protein Expression
Data Analysis Software or CopyCaller® Software for further analysis.

9. Click Start Export.
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Export an experiment

The following is an image of the Export screen for a Standard Curve experiment:

Format : |QuantStudio™ 6 and 7 v| Export Data To: (8 One Flle () Separate Files

Open file(s) when export is complete

Export File Location: |C:mpplied Biosyste ms\QuantStudio 6 and 7 FIexSnf’t\'ﬂar| Export File Name: |QS6_QuantStudio_38 d-WeII_Standard_Curve‘ File Type: |F_§_‘] (%txt) v

Sample Setup

Skip Empty

[] Ran Data Amplification [ Multicomponent: Results

[ Skip Omitted Wi

W

Select Content
elect Lonten well Well Position Sample Name Target Name Task
All Fields b 1AL RNAse P NTC
2A2 RNAse P STANDARD
wel 343 RNAse P STANDARD
Well Position 4 A4 RNAse P STANDARD
5A5 RNAse P STANDARD
Sample Name 6 A RNAse P STANDARD
747 5K RNAse P UNKNOWN
Target Name 8 A8 5K RNAse P UNKNOWN
9AQ 5K RNAse P UNKNOWN
Task 10 A10 5K RNAse P UNKNOWN
Reporter - 11 A11 5K RNAse P UNKNOWN
12 A12 5K RNAse P UNKNOWN
Quencher 13 A13 5K RNAse P UNKNOWN
14 Al4 5K RNAse P UNKNOWN
cT 15415 5K RNAse P UNKNOWN
16 A6 10K RNAse P UNKNOWN
€t Mean 17 A17 10K RNAse P UNKNOWN
CtsD 18 Al8 10K RNAse P UNKNOWN
¥ = |

Reporter
FAM
FAM
FAM
FAM
FAM
FAM
FAM
FAM
FAM
FAM
FAM
FAM
FAM
FAM
FAM
FAM
FAM
FAM

Quencher H
NFQ-MGB ~
HFQ-MGB 290
HFQ-MGB 28
HFQ-MGR 77
NFQ-MGB 26
HFQ-MGB 25
HFQ-MGB 27
HFQ-MGR 77
NFQ-MGB 27
HFQ-MGB 27
HFQ-MGB 27
HFQ-MGR 77
NFQ-MGB 27
HFQ-MGB 27
HFQ-MGB 27
HFQ-MGR 26
NFQ-MGB 26
HFQ-MGB 26 v

¥

File

Start Export | Save Export Set As || Load Export Set || Delete Export Set

The following is an image of the exported file when opened in Notepad:

JuantStudio_384-Well_Standard_Curve Fxample_data.txt - Notepad

it Format

View Help

[ Block Type =
Calibration

5

Experiment
software' exam,
* Experiment
# Experiment
Experiment
Instrument
Instrument
Instrument
passive Ref
quantificati

3

IEEEEEEE

stage/ Cycl
User Name

[sample setup
well well
Reporter

@ O L

signal smoothing on

3g84-well Block

gackground is expired = ve

= calibration Background performed on = Ol 29-2010

* Calibration HRM MELTDOCTOR is ex;nred = Yes

* calibration HRM MELTDOCTOR performed on = 01-14- 2010

# Calibration Normalization FAM-ROX is exp'lr“ed

# calibration Normalization FAM-ROX performed on 01 29-2010
# Calibration Normalization VIC-ROX is expired =

* Calibration Mormalization VIC-ROX perﬁ]rmed on 01—29—2010
* Calibration Pure Dye FAM is expired = ve

* calibration pure Dye FAM performed on = 01 29-2010

# Calibration Pure Dye MELTDOCTOR is exp'lr“ed = Yes

# calibration Pure Dye MELTDOCTOR performed on = 01-14-2010
# calibration pure Dye NED is expired = ves

= calibration Pure Dye NED performed on = 12-28-2009

* calibration Pure Dye ROX is expired = ves

* calibration pure Dye ROX performed on = 01 29-2010

# Calibration Pure Dye SYBR is expired = ve

# calibration Pure Dye SYER performed on = 12 28-2009

# Calibration Pure Dye TAMRA is expired = ves

# calibration Pure Dye TAMRA performed mn = 12-28-2009

* calibration Pure Dye VIC is expired =

# Calibration Pure Dye VIC performed on = 01—29—2010

# Calibration ROI is expired Yes

# calibration RoOI performed on = 01-29- 20].0

#* calibration uniformity is expired =

* calibration uniformity performed on = 01—29—2010

* Chemistry = TAQMAN

“ pate Created = 2013-07-04 15:54:47 PM SGT

# Experiment Barcode = NA

# EXperiment Comment = NA

File Name = C:‘Program Files‘\applied Biosystems‘QuantStudio & and 7 Flex
ples'Q56FTex’qs6_384-well_standard_curve_Example. eds
Name = Q56_Quantstudio_384-well_standard_curve_Example
Run End Time = 2010-02-01 15:02:10 PM SGT
Type = standard curve
Name = NA
serial Number = 278880018
pe = Quantstudio(TM) & Flex System
erence = ROX
ion cycle Method
= tru
e where Ana'\ysws is performed =

Stage 2, Step 2

1
Position  sample Name sample Color Biogroup Name  Biogroup Color Target Name Target Color Task
quencher Quantity comments
RNAse P "RGB(139,189,249)" NTC FAM NFQ-MGE
RNAse P "RGB(139,189,249)" STANDARD FAM NFQ-MGB "1, 250.000"
RNAse P "RGB(139,189,249)" STANDARD FAM NFQ-MGB "2, 500. 000"
RNAse P "RGB(139,189,249)" STANDARD FAM NFQ-MGB 5, 000. 000"
RNASe P "RGB(139,189,249)" STANDARD FAM NFQ-MGE 10, 000.000"
RNASe P "RGB(139,189,249)" STANDARD. FAM NFQ-MGE 20, 000.000"
5K "RGB(122,193,241)" RNAse P "RGB(139,189,249)" UNKNOWN FAM NFQ-MGE
5K "RGB(132,193,241)" RNAse P "RGB(139,189,249)" UNKNOWN FAM NFQ-MGE
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Experiment Shortcuts

This chapter provides you with shortcuts to use in the QuantStudio™ 6 and 7 Flex
Software after you have learned experiment basics.

You can reuse experiment settings and plate setup information by: directly importing
and editing a template, using the QuickStart feature with a template, importing
experiment setup information, or importing a sample definition file; you can also
prepare several experiments at once or create a new experiment using the ReadiApp
feature.

The chapter covers:

B Using experiment templates. ............ ... i 53

Run an experiment with QuickStart ....................... o 57
B Import plate setup for an experiment . ............. ... .. 58
B Import sample information. .............. .. i 59
B Create an experiment using ReadiApp........... ...t 62

Using experiment templates

To create a
template

You can use a template (.edt) to create a new experiment. Templates are useful when
you want to create many experiments with the same experiment parameters.

You can create an experiment from a template from the QuantStudio™ 6 and 7 Flex

Software and from the QuantStudio™ 6 or 7 Instrument touchscreen.

Note: To access the QuantStudio™ 6 and 7 Flex Software example templates, navigate
to the templates folder located at <drive>:\ Program Files\ Applied
Biosystems\ QuantStudio 6 and 7 Flex Software \ examples\ User Sample Files.

where, <drive> is the computer hard drive on which the QuantStudio™ 6 and 7 Flex

Software is installed. The default installation drive for the software is the C: drive.

1. Login to the QuantStudio™ 6 and 7 Flex Software and, from the Home screen,
open an existing experiment, or create a new experiment.

Note: To create a new experiment using the Experiment Setup, see “Set up an
experiment” on page 12.
2. Select File » Save As Template.

Note: The information saved in a template includes plate setup information
(defined targets and samples, plate assignment of targets and samples), reagent
information, thermal protocol, and analysis settings such as quantification cycling
method.

3. Enter a file name, select a location for the template, then click Save and & Close.

You can use that experiment as a template for similar experiments.
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To create a new
experiment using a
template

To create an
experiment using a
template on the
QuantStudio™ 6 or
7 Instrument
touchscreen

54

. From the Home screen, click _,_-f Template.

Locate and select the template file, then click Open.

A new experiment is created using the setup information from the template.
Confirm that the following are correct before you prepare the reactions and run
the experiment:

* Experiment properties (experiment name, experiment type, block type,
reagent, run properties)

¢ Plate definitions (targets, samples, and biological replicates)
¢ Plate assignments (targets, samples, and biological replicates)

* Run method (thermal protocol)

4. Proceed to preparing reactions, running the experiment, and analyzing the data.

You can run experiments using templates from the QuantStudio™" 6 or 7 Instrument
touchscreen by importing the templates from the QuantStudio™ 6 and 7 Flex Software
instrument console or a USB drive. You can also modify the experiment parameters in
the templates as per your requirement.

To edit a template before running the experiment

1.

Touch gl New on the View Templates screen to create a new experiment
from the existing template.

Note: Select a template before you touch New.

Edit the experiment parameters in the Create New Experiment screen.

Touch Save & Exit to save and exit the experiment or touch M Save
& Start Run to save and start an experiment run.

To run a pre-existing template

1.

Touch View Templates on the Home screen of the
QuantStudio™ 6 or 7 Instrument touchscreen.

Select a pre-existing template from the templates list on the View Templates
screen.

Touch View to see the run profile before you start a run.

After confirming the template setup is correct, touch ‘ to go back to View
Templates screen. Touch Start Run.
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Using experiment templates

Use a template to Use the batch experiment utility to create multiple experiment files from the same
create a batch of template without using Experiment Setup.

experiments 1. In the menu bar, select Tools » Batch Experiment Setup. The following is an
image of the Batch Experiment Setup Utility dialog box:

3 Batch Experiment Setup Utility [%]

"p; Provide input files, select the file naming convention, and export location, then dick Create Experiments .

1. Import Files

* Experiment Template File: |Ii0 6 and 7 Flex Software\examplesi\User Sample Files\QSS_QuantStudio_SEQ-WQII_Standard_Curve_E)Gmp\e.edt|

Assay Information FiIe:| |
Plate Setup FiIe:| |

2. Barcode(s) and Naming Convention

Create Experiment Fles Using: () Barcode: | | Browse
® Specify Number of Files:

Fle Name Format: | attribute include Custom Name Field: | |
Custom Name Field

Plate Barcode | Move Up File Name Preview:

D Custom Mame Field_ID
==

3. Export Location

* Export Setup Files to: |
Create Experiments

2. Select the file(s) to use to create the new experiments:
a. Click Browse in the Experiment Template File field.

Note: To use one of the example setup files, browse to <drive>:\Program
Files\ Applied Biosystems\QuantStudio 6 and 7 Flex
Software\ examples\ User Sample Files

b. Locate an *.edt file to import, then click Select.

c. (Optional) Repeat steps 2a and 2b for the remaining setup file types to import
(Assay Information File (*.txt or *.xml), Plate Setup File (*.txt)).
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3. Select the option to create experiment files. The selected option determines the
number of experiment files created:

Specify Number of Files - Enter a number from 1 to 100.

Barcode - Click Browse and select a Barcode File (*.txt) to import. The
software automatically adds the Plate Barcode attribute to the file name
format. The number of experiments created equals the number of barcodes
present in the barcode file.

Note: A Barcode File contains one barcode per line. An example Barcode File
looks like the following image:

B BarCode_Template 384Wb.txt - Notepad (_ (O] x|
File Edit Faormat Wiew Help

Barcoda (384W) =]
A3DISTINT
A3035YWU
A3D3SYINY
AZOIEVIA
A3DIETINK
A30ISVIYT
A303SYWZ
A30D3EYHO
A3035TXL
A303STHZ
A3D3SYW
A3035Y
A3035TINK
A3D3STIWL
A3035VIM

AZ0OZEYNO
AZOIEYWP
AZOZEYWR
AZ0IEYWS
AZ0I5YINH
AZOSTYWG
AZOIEYWE
AZ0ZEYWD
AZ0ISYWC

[

4. (Optional) Edit the file name format. Use the File Name Preview to verify your
settings.

Select the check box to include or exclude the Custom Name Field attribute
from the file name. If included, click the Custom Name Field and enter up to
100 letters and/or numbers to identify the batch of experiments.

Note: The file name can contain a total of 100 characters, including all file
name attributes.

Click Move Up or Move Down to change the order of the selected file name
attributes.

5. Select the location for the experiment files to be created:

a.
b.

Click Browse in the Export Setup Files to: field.

Review the location for the experiment files. Navigate to a new location if
you do not want to export the experiment files to that folder, then click
Select.

6. Click Create Experiments. A confirmation message appears when the batch of
experiments has been created.
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Run an experiment with QuickStart

You can use a template to run an experiment with the QuantStudio™™ 6 and 7 Flex
Software QuickStart feature:

QuickStart from 1. Prepare the reactions.
. TM
the QuantStudio ™ 6 2. Log in to the QuantStudio™" 6 and 7 Flex Software and, from the Home screen,
and 7 Flex click =) QuickStart to access the QuickStart dialog box.
Software

3. In the QuickStart dialog box, enter or select the:
a. Instrument icon of the instrument to perform the run on.
b. Experiment name.
c. Experiment template file.

d. (Optional) Barcode and User Name for the experiment.

4. (Optional) To review the experiment or to make changes to any of the experiment
parameters, click Experiment Setup.

The following is an image of the QuickStart dialog box:

£ QuickStart X

:’Q Select an instrument and an experiment template file to run a new experiment. Load the reaction plate into the instrument, then click Start Run. ?,j

Q57_0009 QS6_0008 __|
READY READY v

@ a

Enter Experiment Name and Location

* Experiment Name: i2013-0?-04 160106 | Location: |'e\User Files\Experiments\2013-07-04 160106 .eds|

~

Barcode (Optional): | |Comment5 (Optional):

User Mame (Optlnnal]:| | v

Select Experiment Template
* Experiment Template File:| v!

Samples

Sample
==

You rmay import a plate setup file or a sample definition text file. Alternatively, you may
directly edit the sample names in the table to the left, or copy and paste sample names
from a spreadsheet,

Experiment Setup l START RUM J Cancel

5. Proceed to running the experiment and analyzing the data.

Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments 57



Chapter 2 Experiment Shortcuts

Import experiment setup

QuickStart from
the QuantStudio™ 6
or 7 Instrument
touchscreen

You can QuickStart an experiment from the QuantStudio™ 6 or 7 Instrument
touchscreen in the following ways:

e Start an experiment using a pre-defined template.

e Start an experiment with a pre-defined short-cut button.

Start an experiment using a pre-defined template

You can use a pre-existing template from the default experiments folder or use a
custom template from another folder to start a run.

Start an experiment with a pre-defined short-cut button

The QuantStudio™ 6 or 7 Instrument touchscreen displays up to 18 shortcut buttons to
templates or folders that contain experiments to be run. The shortcut buttons are
present under MY SHORTCUTS on the Home screen. To start a run, touch any of the
pre-defined experiment or folder buttons.

To create a shortcut button for a preferred experiment or a folder that contains
experiments:

1. Touch Settings to open the Settings Menu.

2. Touch Set Up Shortcuts to list the Shortcut Targets.

3. On the Shortcut Targets list screen, select an existing template Shortcut Target
button or an unused button.

4. Touch Set Shortcut. If you selected an unused button, then touching Set Shortcut
will list out the templates and folders to set the shortcut for.

5. Under the [H From Templates tab, select the templates for which you are
creating the shortcut button.

6. (Optional) Create a shortcut button to show the templates or experiments in a
particular folder for quick access, from those listed under the From Folders tab.
You can touch Edit to create or edit shortcut buttons.

Import experiment setup

Import plate setup
for an experiment

58

You can import the plate setup for a new experiment from an exported file with one of
the following formats:

* *.txt - Text format

e *xml - XML format

* *.csv - Comma separated values format

* *.eds - EDS file format

e *edt- EDS template files format

¢ *.sdt - Sequence Detection System (SDS) template files format
* *.sds-7900 v2.4 format

IMPORTANT! Make sure the file you select contains only plate setup data and that the
experiment types match.
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Note: For instructions on exporting an experiment, see “Export an experiment” on
page 47.

To Import the plate setup data:
1. Create a new experiment or open an existing experiment.

2. In the Experiment Setup screen, select File » Import Plate Setup or access the
Import drop-down menu in the toolbar and select Import Plate Setup.

3. Click Browse, locate and select the file to import, then click Select.

Note: To use one of the example setup files, browse to C:\Program Files\ Applied
Biosystems\ QuantStudio 6 and 7 Flex Software \ examples\ User Sample Files

Import Plate Setup |

Select the plate setup file to import, then click Start Import. gj

Select File:

4. Click Start Import. The setup data from the exported text file is imported into the
open experiment.

Note: If your experiment already contains plate setup information, the software
asks if you want to replace the plate setup with the data from the import file.
Click Yes to replace the plate setup.

5. After importing plate setup information, use Experiment Setup to set up your
experiment, and then run the experiment.

Note: You can import plate setup information from a 96-well plate into a 384-well
plate, provided that the file you are importing the information from is a .txt file.

Import sample You can import sample information from a sample definition file to include in the plate

information setup for your experiment. A sample definition file is a comma-delimited file (*.csv) or
a tab-delimited text file (*.txt) that contains the following setup information: well
number, sample name, and custom sample properties.

Note: Make sure that the sample definition file you select contains only sample
information.

Create a sample definition file
1. Open a text editing program such as Notepad.

2. Enter the following column headers in the first row (press the Tab key between
each entry if you are saving the file as *.txt or enter a comma between each entry if
you are saving the file as *.csv):

e Well
* Sample Name

* (Optional) Column header names for up to 32 user-defined custom fields (for
example, Custom 1, Custom 2, etc.)
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3. For each subsequent row, enter the well number, press the Tab key or enter a
comma, then enter the sample name. Optionally, press the Tab key, then enter the
custom properties for the sample.

4. Save the file with the .txt or .csv file extension.

An example sample definition, saved with the .csv extension, file looks like this:
A B | ¢ | o | E | F | & | H ]

1 el Sample Name 1D Age Sex YWeight  HairColor | Sroker
2| 1 Zample 1 1 22 Female 25 black es
3| 2 Sample 2 2 25 Male 26 brawn Mo
4 3 Sample 3 3 45 Female S0 blonde  Yes
48| 4 Sample 4 4 31 Male 33 red es
B 5 Sample 5 5 29 Female 46 grey Mo
7 G Sample & g 26 Male 35 black Mo
8 | 7 Sample 7 7 31 Female 33 black es
9 g Sample 3 g 32 Male 67 black Mo
1o 9 Sample 9 9 32 Female 55 brawn es
AN 10 Sample 10 10 33 Male 44 blonde  Yes
12 11 Sample 11 11 34 Female 25 red Mo
13 12 Sample 12 12 34 Male 26 grey Mo
14 13 Sample 13 13 35 Female a0 black es
15 14 Sample 14 14 35 Male 33 black Mo
= 15 Sample 15 14 36 Female 46 black es
17 16 Sample 16 16 36 Male 35 brawn es
=l 17 Sample 17 17 37 Female 33 blonde Mo
18 18 Sample 18 13 37 Male 67 red Mo
a0 19 Sample 19 19 38 Female 55 grey Yes
21 20 Sample 20 20 35 Male 44 black Mo

Import sample information from a sample definition file

1. Create a new experiment or open the experiment to receive the setup data (select
File » Open, select the file to open, then click Open).

2. From the open experiment, select File » Import Plate Setup.

3. Click Browse to browse your computer for a sample definition text file (*.csv).
After you locate the file and select it, click Select.

Note: To use one of the example setup files, browse to C:\Program Files\ Applied
Biosystems\ QuantStudio 6 and 7 Flex Software \ examples\ User Sample Files

Click Start Import.

5. If your experiment already contains plate setup information, the software asks
you if you want to replace the plate setup with the data from the file. Click Yes to
replace the plate setup information.

The samples appear in the Samples table for the experiment. All samples and well
assignments in the experiment are replaced with those in the file. If defined, the
custom sample properties also appear in the Well Table of the Analysis Section, and
also in the Plate Layout tooltips in both the Setup and Analysis screens. The custom
fields can be exported with the results data.

Note: You cannot edit the custom sample properties from within the Well Table. To
modify this information, edit the custom fields in the sample definition file and import
the file again. All of the sample information in the experiment is replaced with the
information in the new file.
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The following is an image of the Assign screen with information from the above
sample definition file:

| ™. Define and Set Up Standards

Targets

_.Target 1

T 0 B ) »

Sample: Sarmple 1
5 Custom Property:
ID: 1
Age: 22
— Sex: Female
Weight: 25
HairColor: black
[< Smoker: Yas b

| |eamoie 10 =l
Biological Groups —o— a7

4 | of

wels: [ o EHo o 364 Empty

The following is an image of the Well Table in the Analysis section:

Il Table

3| Plate Layout

# | Well | | CcT CT Mean CT SD | Quantity |Quant\ty..‘|Quant\ty...| Comments 1D | Age | Sex | Weight | HairColor | Smoker
1 AL 1 22 Fernale 3 black ves =
2 A2 2 25 Male 26 brown Mo

2 A3 2 45 Fernale 50 blonde es

4 Ad 4 31 Male 33 red es

S AS S 29 Female 48 arey Mo

6 A6 & 26 Male 35 black Ma

7 A7 7 31 Femnale 3B black Yes

8 A8 E =2 Male 67 black Mo

9 A9 9 32 Female 5 brown Yes

10 AlD 10 3 Male 44 blonde es

11 A1l 11 34 Female 25 red Mo

12 ALZ 12 24 Male 26 grey Mo

13 A12 13 ) Female S0 black Yes

14 Al4 14 35 Male: 33 black Mo

15 AlS 15 26 Female 48 black ves

16 AlG 16 36 Male 35 brown Yes

17 AL7 17 7 Fernale 33 blonde Ma

18 AlB 13 37 Male 67 red Mo

19 Al9 13 =) Female 35 arey ‘es

20 AZ0 20 38 Male 44 black Mo

21 A21

22 AZ2

23 A23

24 424

25 Bl

26 B2

27 B3

28 B4

29 BS

30 B&

31 B

32 BB

33 B9

34 B1O

35 Bll =
T ™

Well Summary: In Plate: 384 Set Up: 384 Analyzed: 384 Flagged: 0 Omitted by Analysis 0 Omitted Manually: 0 Samples Used: 384 Targets Used: [
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Create an experiment using ReadiApp

62

You can use the ReadiApp feature to set up an experiment in the QuantStudio'" 6 and
7 Flex Software. The ReadiApp feature provides a shortcut to create experiments for
the assays purchased from Life Technologies.

The default ReadiApp templates available in the QuantStudio™ 6 and 7 Flex Software
include:

3.
4,

TagMan® Gene Signature Array Cards
Custom TaqMan® Array Cards
TagMan® Gene Expression Assays
TagMan® Drug Metabolism Assays
TagMan® Array MicroRNA Cards
TagMan® Copy Number Assays (CNV)
TagMan® SNP Genotyping Assays

. Login to the QuantStudio™ 6 and 7 Flex Software and, from the Set Up menu on

the Home screen, click ReadiApp.

Click the assay to use to set up an experiment.

Note: Click Cancel to exit the ReadiApp dialog box.

12 ReadiApp

Select your Experiment:

[ TagMan® Array MicroRNA Cards ] [ TagMan® Gene Signature Array Cards ]
[ TagMan® Copy Number Assays (CNV) ] [ Custom TagMan® Array Cards ]
[ TagMan® SNP Genotyping Assays ] [ TagMan® Gene Expression Assays ]

[ TagMan® Drug Metabolism Assays ]

=

A new experiment is created using the setup information from the template.

(Optional) Edit the experiment properties.

Proceed to preparing reactions, running the experiment, and analyzing the data.
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guidelines for preparing 23
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E

entering reagent information 14
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experiment
exporting 47
preparing reactions 22
reviewing results 44
setting up 12
shortcuts 53
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starting 30
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experiment properties, defining 12
experiment setup, import 58
experiment templates, using 53
experiment type 13
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Genotyping 13
Melt Curve 13
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experiment, starting 34
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Clipped Data 50

Multicomponent data 50

Raw data 49

reagent information 50

Results 50

Sample setup 49

Technical Replicate Results (Tech. Rep.

Results) 50

exporting

exporting experiments 47

saving export data as 50

selecting export data 49

H

heated cover 38

import experiment setup 58
importing experiment data

plate setup 58

sample information 59
installation CD 6
instrument

adding to My Instruments 31
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preparation for use 30 preparing 22
preparing for use 30 reagent
instrument run properties, defining 13 information 14
instrument type selection 13
QuantStudio 6 Flex System 12 reagent information, entering 14
QuantStudio 7 Flex System 12 reagent, selecting 13
instrument, starting 30 reagents, selecting
supported reagents 22
M SYBR® Green Reagents 13

TagMan® Reagents 13

materials for dilutions
. reporter 15
master mix 23 L
results, reviewing 44
melt curve 13
L . roller assembly 27
monitoring the experiment 35 . .
multiple plots, displaying 45 run properties, defining 20
plep playms Run screen 36

My Instruments group 31 View Run Data 40

N S

notification settings, enable or change 32 sample block(s) 38

NULL, values in well assignments 19 sample definition file, creating 59

sample information, importing 59

0 samples

P
optical adhesive film 23 assigning 17, 19
overriding calibration data 44 defining 15

selecting reagents 13
P shortcuts, experiments 53

starting the experiment 34

passive reference 16 starting the instrument 30

PCR Stage, editing during experiment design 20 storage conditions, photosensitive 28

plate adapter 33 system security 9
plate setup data, importing 58 Y
plot properties 46 T

tab-delimited text file, for sample definitions 59
Q targets
assigning 16, 19
defining 15

preparing instrument for use 30

QuantStudio™ Dx/ ViiA™ 7 Format 48

quencher 15 template

QuickStart 53, 57 creating batch of experiments from template 55
thermal profile 20

R transferring experiment results 42

ramp speed 13

RDML Format 48 U

reaction plate, sealing 23 unloading an experiment 41

reaction tubes and strips, capping and uncapping 28 USB

reactions drive 43

precautions 22
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About Standard Curve Experiments

B Beforeyoubegin......... ... 5

B About the exampleexperiment ............. ... ... o i 6

IMPORTANT! First-time users of the QuantStudio™ 6 and 7 Flex Real-Time PCR
System Software please read Booklet 1, Getting Started with QuantStudio™ 6 and 7 Flex
Real-Time PCR System Software Experiments and Booklet 7, QuantStudio™ 6 and 7 Flex
Real-Time PCR System Software Experiments - Appendixes of this binder thoroughly. The
booklet provides information and general instructions that are applicable to all the
experiments described in this binder

Note: For more information about any of the topics discussed in this guide, access the
Help from within QuantStudio™" 6 and 7 Flex Real-Time PCR System Software by
pressing F1, clicking €) in the toolbar, or selecting Help » QuantStudio™ 6 and 7 Flex

Real-Time PCR System Software Help.

Before you begin

Assemble required
components

PCR Options

QuantStudio™ ¢ and 7 Flex Real-Time PCR System Software Getting Started Guide for Standard Curve
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The Standard Curve method is used for determining absolute target quantity in
samples. With the standard curve method, the software measures amplification of the
target in samples and in a standard dilution series. Data from the standard dilution
series are used to generate the standard curve. Using the standard curve, the software
interpolates the absolute quantity of target in the samples.

¢ Sample - The tissue group that you are testing for a target gene.

¢ Standard — A sample that contains known quantities of the target; used in
quantification experiments to generate standard curves.

¢ Standard dilution series — A set of standards containing a range of known
quantities. The standard dilution series is prepared by serially diluting standards.

* Replicates — The total number of identical reactions containing identical samples,
components, and volumes.

* Negative controls — Wells that contain water or buffer instead of sample template.
No amplification of the target should occur in negative control wells.

When performing real-time PCR, choose between:

¢ Singleplex and multiplex PCR (below)
and
¢ 1-step and 2-step RT-PCR (page 6)



Chapter 1 About Standard Curve Experiments
About the example experiment

Singleplex and Multiplex PCR

You can perform a PCR reaction using either:

Singleplex PCR - In singleplex PCR a single primer set is present in the reaction
tube or well. Only one target or endogenous control can be amplified per reaction.
or

Multiplex PCR - In multiplex PCR, two or more primer sets are present in the
reaction tube or well. Each set amplifies a specific target or endogenous control.

Typically, a probe labeled with FAM™ dye detects the target and a probe labeled
with VIC® dye detects the endogenous control.

IMPORTANT! SYBR® Green reagents cannot be used for multiplex PCR.

= O L [0 Target Primer Set

=

s 3 o (O Endogenous Control
a Primer Set

) ~~ cDNA
Singleplex PCR Multiplex PCR

1- and 2-Step RT-PCR

You can perform reverse transcription (RT) and PCR in a single reaction (1-step) or in
separate reactions (2-step). The reagent configuration you use depends on whether
you are performing 1- or 2-step RT-PCR:

1-step RT-PCR- In 1-step RT-PCR, RT and PCR take place in one buffer system.
Using one buffer system provides the convenience of a single-tube preparation
for RT and PCR amplification. However, you cannot use Fast PCR master mix or
the carryover prevention enzyme, AmpErase® UNG (uracil-N-glycosylase), to
perform 1-step RT-PCR.

2-step RT-PCR - 2-step RT-PCR is performed in two separate reactions: First,
total RNA is reverse-transcribed into cDNA, then the cDNA is amplified by PCR.
This method is useful for detecting multiple transcripts from a single cDNA
template or for storing cDNA aliquots for later use. The AmpErase® UNG
enzyme can be used to prevent carryover contamination.

Note: The Standard Curve example experiment is designed for singleplex PCR,
where every well contains a primer/probe set for a single target; the reactions are
set up for a 2-step RT-PCR.

About the example experiment

To illustrate how to perform Standard Curve experiments, this guide leads you
through the process of designing and performing an example experiment. The
example experiment represents a typical setup that you can use to quickly familiarize
yourself with the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software.

The objective of the Standard Curve example experiment is to determine the quantity
of the RNase P gene in two populations.

QuantStudio™ & and 7 Flex Real-Time PCR System Software Getting Started Guide for Standard Curve
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Chapter 1 About Standard Curve Experiments

About the example experiment

In the standard curve example experiment:

The samples are genomic DNA isolated from two populations.
The target is the RNase P gene.

One standard curve is set up for the RNase P gene (target). The standard used for
the standard dilution series contains known quantities of the RNase P gene.
Because a single target is being studied, only one standard curve is required.

Note: In experiments where multiple targets are being studied, a standard curve
is required for each target.

Three replicates of each sample and each dilution point in the standard curve are
performed to ensure statistical significance.

The experiment is designed for singleplex PCR, where every well contains a
primer/probe set for a single target.

Reactions are set up for 2-step RT-PCR.
Primer/probe sets are from Life Technologies RNase P assay.

Note: The human RNase P FAM"™ dye-labeled MGB probe is not available as a
TagMan® Gene Expression Assay. It can be ordered as a Custom TagMan® Gene
Expression Assay (Part no. 4331348).

QuantStudio™ ¢ and 7 Flex Real-Time PCR System Software Getting Started Guide for Standard Curve 7
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About the example experiment

8 QuantStudio™ & and 7 Flex Real-Time PCR System Software Getting Started Guide for Standard Curve
Experiments



Design the Experiment

This chapter explains how to design the example experiment from the Experiment
Setup menu.

This chapter covers:

B Define the experiment properties. ............ ... ... 9
B Define targets, samples, and biological replicates. ......................... 10
B Assign targets, samples, and biological groups............. ... ... oo 11
B Setuptherunmethod....... ... ... .. i 13
B For moreinformation. .......... ... ... i 14

Note: To automatically export the analyzed data to a specified location, select the Auto
Export task from the Export screen, before running the experiment. For more
information on Auto Export, refer to Chapter 2 in Booklet 1, Getting Started with
QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments.

Define the experiment properties

Click Experiment Setup » Experiment Properties to create a new experiment in the
QuantStudio™ 6 and 7 Flex Software. Enter:

Field or selection Entry
Experiment Name QSé_QuantStudio_384-Well_Standard_Curve_Example
Barcode Leave field empty
User Name Example User
Comments Standard Curve example
Instrument type QuantStudio™ 6 Flex System
Block 384-Well Block
Experiment Type Standard Curve
Reagents TagMan® Reagents
Ramp speed Fast
Reagent Information NA

Save the experiment.

QuantStudio™ ¢ and 7 Flex Real-Time PCR System Software Getting Started Guide for Standard Curve 9
Experiments



Chapter 2 Design the Experiment

Define targets, samples, and biological replicates

Your Experiment Properties screen should look like this:

Experiment: QS6_QuantStudio_384-Wel... Type: Standard Curve Reagents: TagMan® Reagents

How do you want to identify this experiment?

* Experiment Name: [QS6_QuantStudio_384-Well_Standard_Curve Example Comments: [Standard Curve Example -~
Barcode:
User Name: [Example User ~

Which instrument type are you using to run the experiment?

| QuantStudio™ 6 Flex System | [ QuantsStudio™ 7 Flex System ]

| 384-well | [ 96-well (0.2mL) ] [ Fast 96-well (0.1mL) ]

[ Standard Curve | [ o T T ] [ Comparative Cr (AACT) ] [ Melt Curve ]

[ Genotyping ] [ Presence/Absence ]

Which reagents do you want to use to detect the target sequence?

| TagMan® Reagents | [ SYBR® Green Reagents ] [ Other ]
What properties do you want for the instrument run?
[ standard ] | Fast |

What is the reagent information?

Mews

Type Name Part Number Lot Number Expiration Date

Define targets, samples, and biological replicates

Click Define to access the Define screen. Enter:

1. Targets

Target name Reporter Quencher Color

RNaseP FAM NFQ-MGB

2. Samples

Sample name Color

5K

10K

3. Dye to be used as a Passive Reference

ROX
4. Custom Task Name
Not applicable
10 QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Getting Started Guide for Standard Curve
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Chapter 2 Design the Experiment
Assign targets, samples, and biological groups

Your Define screen should look like this:

Drelete

Save to Library  Import from Library

Target Name Reporter Quencher

RMNAgze P FAM  |NFQ-MGB

Drelete

g 1port from File

Sample Name

SK w

10K -

Biological Replicate Groups

Biological Group Name Color Comments

Passive Reference

ROX v

Custom Task Name

Color Icon Char

Note: This example experiment does not define biological replicate groups. Leave
Biological Replicate Groups blank.

Assign targets, samples, and biological groups

Click Assign to access the Assign screen.

1. Define and set up standards.

a. Click Define and Set Up Standards on the Assign screen.

b. Select a target.

Field

Select

Select a target for this standard curve

RNaseP

c. Define the standard curve.

Field

Enter

# of Points

# of Replicates

16

Starting Quantity

1250.0

Serial Factor

2X

d. Select and arrange wells for the standards.

QuantStudio™ ¢ and 7 Flex Real-Time PCR System Software Getting Started Guide for Standard Curve
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Chapter 2 Design the Experiment

Assign targets, samples, and biological groups

Field Select

Use Wells Let Me Select Wells

e. Click Apply, and then Close.
Your Define and Set Up Standards dialog box should look like this:

42 Define and Set Up Standards E‘

t\i Select a target from the list of targets in the reaction plate. Define the standard curve, select wells for the standards, then dick Apply. Repeat for each standard curve in the reaction plate, then dick Close to return to plate setup.

Select a target

* Select the target for this standard curve: |RNaseP v

Define the standard curve = Required

* # of Points: }5 W (5 Recommended)
* # of Replicates: 13 ‘ (3 Recommended}
* Starting Quantity: }1.[] \ (Enter the highaest or lowest standard quantity for the standard curve.)
* Serigl Factor: !1:5 V‘ (Select 2 value from 1:10 to 10x.)
5 Points X 3 Replicates = 15 Required Wells

Select and arrange wells for the standards

Arrange standards in: () Columns () Rows

Use Wells: ) Automatically Select Wells for Me (&) Let Me Select Wells

1 2z 3 4 5 6|76 o w0]u[1z]13]14]15[1e]17[18]19 20 21 [22 2324 | T ek T s S e WA
a Vels electe Vels
B A2,A3,A4,A5,AG,B2,B3,B4,B5,B6,C2,C3,C4,C5,C6,02,D3,D4,D5,06,E2,E3,E4,E5,E6,F2, F3, F4,F5,F6,62,
z G3,64,G5,G6,H2,H3,H4,H5, H6, 12,13, 14,15,16,12,13,14,15,16,K2, K3, K4, K5,K6, L 2,L 3,14, L5,L6, M2, M3, M4,
s 15,M6,N2,N3,14,H5,1l6,02,03,04,05,06,P2,P3,P4,P5,P6
:
G
H
I
;
™M
M
o
I [ [
2. Assign targets and samples.
Target Well Task Quantity Sample
name number name
RNaseP | A1 -P1 Negative None None
(column 1)
RNaseP | A2 - P2 Standard 1250 None
(column 2)
RNaseP | A3 - P3 Standard 2500 None
(column 3)
RNaseP | A4 - P4 Standard 5000 None
(column 4)
RNaseP | A5 - P5 Standard 10000 None
(column 5)
12 QuantStudio™ & and 7 Flex Real-Time PCR System Software Getting Started Guide for Standard Curve
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Chapter 2 Design the Experiment
Set up the run method

Target Well Task Quantity Sample

name number name

RNaseP | A6 - P6 Standard 20000 None
(column 6)

RNaseP | A7 - P15 Unknown Determined 5K
(columns by run
7 -15)

RNaseP A16 - P24 Unknown Determined 10K
(columns1 by run
6 - 24)

Your Assign screen should look like this:

Plate Layout

", Define and Set Up Standards

Targets

Well Table

I T v | [TETz sl slel7els mlu =lnlw]nsle vle &lalalzls o]
| 39 3 0 0 CE 0 0 0P CER O C
o I 3 519 5 5 S CE 00 ) CEP 0 CER 0 R 0
o0 [ o 0 0 0 0 CE Y N
o |0 o0 0 0 N
— = | | 7% 30 o o ) 0 0 O 2
'_|l‘EK | E]..zi.‘3..3.‘3..3..m.m..m.‘m..m.‘m‘.m..m.m..mum..m.‘m‘.m..m.m..mum..
1 Jiox | (s |0 3 I [ 0 0 CE 0 0 CE) 0
[+ | o0 0 N
¢ | [ 3 0 Y E C EECC C Y
> o0 [ o o 0 0 CE Y
- ¢ o [ o 0 0 C 0 CE Y
%ﬁ—@ | o 0 NP 0 Y CE
| [ 0 0 0 Y C 0 C Y
[ 0 [ 0 0 0 CE Y N
o o [ 0 0 0 0 CE Y
» | o0 o 0 CE RN 0 Y
_Wells:mzsﬂ [SERET 0 Empty

Set up the run method

Click Run Method to access the Run Method screen. Set the thermal profile under the
Graphical View tab. Enter:

* Reaction Volume Per Well: 20 uL
* Thermal Profile

QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Getting Started Guide for Standard Curve
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Chapter 2 Design the Experiment
For more information

Stage Step Ramp rate | Temperature Time
Hold Stage Step 1 1.9°C/s 95°C 20 seconds
PCR Stage Step 1 1.9°C/s 95°C 1 second
Number of Cycles: 40 | Step 2 1.6°C/s 60°C 20 seconds
(default)
Enable AutoDelta:
Unchecked (default)
Starting Cycle:
Disabled when Enable
AutoDelta is unchecked
Your Run Method screen should look like this:
Run Method
Reaction Yolume per Well: l—ZEI L
Hold Stage PCR Stage
Nurnber of Cydes: |4D :’
7 Enahle AutoDelta
Starting Cycle: m
B 95,0 °C 95.0 °C
e 18 °Cfs oot
75| 1R Cfs
60.0 “C
.9 =Cfs 00:20
50 "C_|
] tept Stept Step2
Legenr; -
[ Data Collection On ~ = Data Collection Off A AutcDefta On A AutoDelta OFf
For more information
For more information on... Refer to... ATV
number
Consumables Chapter 1 in Booklet 1, Getting Started with QuantStudio™ é and 7 4489822
Flex Real-Time PCR System Software Experiments
Appendix A in Booklet 7, QuantStudio™ 6 and 7 Flex Real-Time PCR
System Software - Appendixes
14 QuantStudio™ & and 7 Flex Real-Time PCR System Software Getting Started Guide for Standard Curve
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Chapter 2 Design the Experiment
For more information

For more information on... Refer to... Publication
number
Using other quantification Booklet 3, Running Relative Standard Curve and Comparative Cy Chapter 1 in
methods Experiments. Booklet 1,
Getting Started
with

QuantStudio™ 6
and 7 Flex Real-
Time PCR System
Software
Experiments

Appendix A in
Booklet 7,
QuantStudio™ 6
and 7 Flex Real-

Time PCR System
Software -
Appendixes
Amplification efficiency Amplification Efficiency of TagMan® Gene Expression Assays 127AP05-03
Application Note
Using Alternative Setup Chapter 3 in Booklet 1, Getting Started with QuantStudio™ é and 7 4489822

Flex Real-Time PCR System Software Experiments

QuantStudio™ ¢ and 7 Flex Real-Time PCR System Software Getting Started Guide for Standard Curve
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For more information
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Prepare the Reactions

Assemble required materials ........ ... 17
Prepare the sample dilutions ............... ... ... . o il 17
Prepare the standard dilutionseries ................... ... ... .. oo 18
Prepare the reaction mix (“cocktail mix”)........... ... ... ... L. 19
Prepare the reactionplate . ....... ... ... ... . 19
For more information.......... ... . i 22

Assemble required materials

Items listed in Booklet 1, Getting Started with QuantStudio™ 6 and 7 Flex Real-Time
PCR System Software Experiments

Samples - Human Raji cell line-derived cDNA samples (100 ng/uL)
Example experiment reaction mix components:

- TaqMan® Fast Universal PCR Master Mix

— RNase P Assay Mix (20X) (Part no. 4316831)

Note: Fast Universal Master Mix is not recommended to be used with the 96-well
(0.2 mL) reaction plates or reaction tubes and tube strips sealed with caps.

Prepare the sample dilutions

To determine the quantity of the RNase P gene in the example experiment, dilute the
samples (as directed below) before adding the samples to the final reaction mix.

The stock concentration of each sample is 100 ng/uL. After dilution, the sample Popl
has a concentration of 6.6 ng/uL and Pop 2 has a concentration of 3.3 ng/uL. Add 2uL
to each reaction.

Use this table for sample dilution volumes for the example experiment.

Samole Stock Sample Diluent | Totalvolume
nar:e concentration volume volume of diluted
(ng/pL) (uL) (uL) sample (pL)
Pop1 100.0 25 355 380
Pop2 100.0 12.5 367.5 380

Note: For your own experiment, adjust the input amounts of the template depending
on the template type and target abundance.

QuantStudio™ ¢ and 7 Flex Real-Time PCR System Software Getting Started Guide for Standard Curve 17
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Chapter 3 Prepare the Reactions

Prepare the standard dilution series

1. Label a separate microcentrifuge tube for each diluted sample:
e Popl
e Pop2

2. Add the required volume of water (diluent) to each empty tube:

Tube Sample name Diluent volume
(uL)
1 Pop 1 355
2 Pop 2 367.5

3. Add the required volume of sample stock to each tube:

Tube Sample name Sample volume
(pL)
1 Pop 1 25
2 | Pop2 12.5

4. Vortex each diluted sample for 3 to 5 seconds, then centrifuge the tubes briefly.

5. Place the diluted samples on ice until you prepare the reaction plate.

Prepare the standard dilution series

The standard concentration in stock is 20,000 copies/uL:

. Source Diluent Total Standard
Standard name Dilution X
(labeled tube) point Source volume volume volume conce_ntratmn
(pL) (pL) (pL) (copies/pL)

RNase P Std. 1 1 (20,000) Stock 18 18 36 10,000
RNase P Std. 1 2 (10,000) Dilution 1 18 18 36 5,000
RNase P Std. 1 3 (5,000) Dilution 2 18 18 36 2,500
RNase P Std. 1 4 (2500) Dilution 3 18 18 36 1250
RNase P Std. 1 5 (1250) Dilution 4 18 18 36 625

1. Prepare five standard dilutions:

Note: For dilution 1, first vortex the stock for 3 to 5 seconds, then centrifuge the
RNase P Std. 1 tube briefly before pipetting stock into the tube.

For each dilution:

a. Use a new pipette tip to add 18 pL of source to the tube containing the
standard.

b. Vortex the tube for 3 to 5 seconds, then centrifuge the tube briefly.

18 QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Getting Started Guide for Standard Curve
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Chapter 3 Prepare the Reactions 3
Prepare the reaction mix (“cocktail mix”)

Place the standards on ice until you prepare the reaction plate.

Prepare the reaction mix (“cocktail mix”)

For the RNase P assay (Standard Curve example experiment), the following table lists
the universal assay conditions (volume and final concentration) for using the TagMan®
Fast Universal PCR Master Mix.

Volume for 384
- Volume for 1 M
Reaction component - reactions + 10% excess
reaction (pL)
(pL)
TagMan® Fast Universal PCR Master Mix Kit 5 2115
RNase P Assay (20X) 0.5 2115
Water 3.5 1480.5
Total reaction mix volume 9 3807
1. Label an appropriately sized tube for the reaction mix: RNase P Reaction Mix.
2. Add the required volumes of each cocktail mix component to the tube.
Note: Do not add the sample or standard at this time.
3. Mix the cocktail thoroughly by gently pipetting up and down several times, then
cap the tube.
4. Centrifuge the tube briefly to remove air bubbles.
5. Place the cocktail mix on ice until you prepare the reaction plate.

Note: You can separately add the sample to the reaction plate, as opposed to preparing
individual reaction mixes for each sample.

Prepare the reaction plate

Exampl_e The reaction plate for the Standard Curve example experiment contains:
experiment e A MicroAmp® Optical 384-Well Reaction Plate
reaction plate e Reaction volume: 20 uL/well
components e 288 Unknown wells m
e 80 Standard wells £
* 16 Negative control wells N
QuantStudio™ ¢ and 7 Flex Real-Time PCR System Software Getting Started Guide for Standard Curve 19
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Chapter 3 Prepare the Reactions

Prepare the reaction plate

The following is an image of the plate layout:

1 z [ s [ 4 [ s [ & [ 7 [ 8 [ o [ 1 [tz [13 [ 14 [ 15 [ 16 [ 17 [ 18 [19 [ [ a [z [z [ 2 |
s (W | EHr Heell [ Bre el e @ e @ @es me Ee e e mes O e e @ mes e me ORS ml=
v (D [EHe Heel e Hed e e e e e Tes e e e e e des e @ e e e e e Td:
?DR‘.. S S CE S NS ER Sl o Ol o [ o R o i R e G i o (Sl o e Sl (R o R [ Rl o [ [
;DR‘.. He EHe Hrl Br Er @des e e [ e e e e dee e @es e e e e e @ @des e
?DR‘.. S S CE S NS ER Sl o Ol o [ o R o i R e G i o (Sl o e Sl (R o R [ Rl o [ [
?DR‘.. He EHe Hrl Br Er @des e e [ e e e e dee e @es e e e e e @ @des e
:DR‘.. S S CE S NS ER Sl o Ol o [ o R o i R e G i o (Sl o e Sl (R o R [ Rl o [ [
?DR‘.. Ee e Hrel Br Bl @es e e [@e e e e @ee e e e e e @D e mee e e
I_DR‘.. S LS EE S S ER S o G R o o R o sl G o R G R o [l o o R R R [ Rl o [ [
]
K
L
M
M
o
P

Clrs | Ere Hrel e EBredl Ere [@es [ e e [@ee e e @es e e e e e e @es e @e @ e
WS EE S S S G S G o s o G G G g v [ R o [ o i (G i Rl [ [l o el R o
Clrs | Ere Hrel e EBredl Ere [@es [ e e [@ee e e @es e e e e e e @es e @e @ e
WS EEN S S S S G o s o [ o e G i g o (G [ o [ o g [GR i o [e [GRl o El e o E
Clrs Erw Hrel e el Ere [@es @ee @deD @ee e @ed @es e Ee e e e @ e e @e @ @k
WS EEN S S S S G o s o [ o e G i g o (G [ o [ o g [GR i o [e [GRl o El e o E
Clrs Erw Hrel e el Ere [@es @ee @deD @ee e @ed @es e Ee e e e @ e e @e @ @k

wels: [T 288 [E 8o [[] 16 0 Empty

To prepare the 1. Prepare the negative control reactions for the target:
reaction plate a. To an appropriately sized tube, add the volumes of reaction mix and water
components listed below.
- n Reaction mix | Watervolume
Tube Reaction mix
volume (uL) (uL)
1 RNase P reaction mix 157.5 17.5

b. Mix the reaction by gently pipetting up and down, then cap the tube.
c. Centrifuge the tube briefly to remove air bubbles.

d. Add 10 pL of the negative control reaction to the appropriate wells in the
reaction plate.

2. For each replicate group, prepare the standard reactions:

a. To appropriately sized tubes, add the volumes of reaction mix and standard
listed below.

20 QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Getting Started Guide for Standard Curve
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Chapter 3 Prepare the Reactions

Prepare the reaction plate

Standard Reaction Reaction mix SR
Tube . i Standard volume
reaction mix volume (uL)
(uL)
1 RNase P RNase P 157.5 RNase P 17.5
Std 1 reaction Std 1
mix
2 RNase P RNase P 157.5 RNase P 17.5
Std 2 reaction Std 2
mix
3 RNase P RNase P 157.5 RNase P 17.5
Std 3 reaction Std 3
mix
4 RNase P RNase P 157.5 RNase P 17.5
Std 4 reaction Std 4
mix
5 RNase P RNase P 157.5 RNase P 17.5
Std 5 reaction Std 5
mix

b. Mix the reactions by gently pipetting up and down, then cap the tubes.
c. Centrifuge the tubes briefly to remove air bubbles.

d. Add 20 pL of the standard reaction to the appropriate wells in the reaction
plate.

3. For each replicate group, prepare the reactions for the unknowns:

a. To appropriately sized tubes, add the volumes of reaction mix and sample
listed below.

Reaction Samole
Unknown Reaction mix P
Tube . . Sample volume
reaction mix volume (uL)
(uL) K
1 RNase P RNase P 1422 pop1 158
pop1 reaction mix
2 RNase P RNase P 1422 pop2 158
pop2 reaction mix

b. Mix the reactions by gently pipetting up and down, then cap the tubes.
c. Centrifuge the tubes briefly to remove air bubbles.

d. Add 10 pL of the unknown (sample) reaction to the appropriate wells in the
reaction plate.

4. Seal the reaction plate with optical adhesive film.

5. Centrifuge the reaction plate briefly to remove air bubbles.
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3 Chapter 3 Prepare the Reactions
For more information

. Confirm that the liquid is at the bottom of each well of the reaction plate. If not,

centrifuge the reaction plate again at a higher speed and for a longer period of

time.

For more information

. Until you are ready to perform the run, place the reaction plate at 4°C, in the dark.

For more information on... Refer to... Publication
number
Assigning the reaction plate Chapter 2 in Booklet 1, Getting Started with QuantStudio™ é and | Chapter 1 in
components 7 Flex Real-Time PCR System Software Experiments Booklet 1,
Getting Started
with

QuantStudio™ 6
and 7 Flex Real-
Time PCR System
Software
Experiments

Appendix A in
Booklet 7,
QuantStudio™ 6
and 7 Flex Real-
Time PCR System
Software -
Appendixes

Sealing the reaction plate

Chapter 2 in Booklet 1, Getting Started with QuantStudio™ é and
7 Flex Real-Time PCR System Software Experiments

Chapter 1 in
Booklet 1,
Getting Started
with
QuantStudio™ 6
and 7 Flex Real-
Time PCR System
Software
Experiments

Appendix A in
Booklet 7,
QuantStudio™ 6
and 7 Flex Real-
Time PCR System
Software -
Appendixes
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Start the run

Monitor the run

Run the Experiment

This chapter explains how to run the example experiment on the QuantStudio'" 6 or 7
Instrument.

This chapter covers:
B o Startthe run. . ... e 23
B Monitor the run. . ... .. 23

IMPORTANT! Run the experiment at the same ambient temperature at which you
calibrated the instrument. Extreme variations in ambient temperature can affect the
heating and cooling of the instrument and influence experimental results.

IMPORTANT! Do not attempt to open the access door during the run. The door is
locked while the QuantStudio™ 6 or 7 Instrument is in operation.

1. Open the Standard Curve example file that you created using instructions in
Chapter 2.

2. Load the reaction plate into the instrument.

3. Start the run.

Monitor the example experiment run:

e From the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software using the
Run screen, while the experiment is in progress.

e From the Instrument Console of the QuantStudio™ 6 and 7 Flex Real-Time PCR
System Software (to monitor an experiment started from another computer or
from the QuantStudio™ 6 or 7 Instrument touchscreen).

e From the QuantStudio™™ 6 or 7 Instrument touchscreen.
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From the
Instrument
Console of the
QuantStudio™ 6
and 7 Flex Real-
Time PCR System
Software

Monitor the run

Amplification Plot

Amplification Plot

Chapter 4 Run the Experiment

1. In the Instrument Console screen, select the instrument icon.

2. Click Manage Instrument or double-click on the instrument icon.

3. On the Manage Instrument screen, click Monitor Running Experiment to access

the Run screen.

View the Amplification Plot

You can view the progress of the run in real time. During the run, periodically view all
the three plots available from the QuantStudio'™ 6 and 7 Flex Real-Time PCR System

Software for potential problems.

Click Amplification Plot from the Run Experiment Menu, select the Plate Layout tab,

then select the wells to view.

The following is an image of the Amplification Plot screen as it appears at the end of
the example experiment.
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Chapter 4 Run the Experiment
Monitor the run

View the Temperature Plot
Click Temperature Plot from the Run Experiment Menu.

The following is an image of the Temperature Plot screen as it appears during the
example experiment.

Temperature Plot Current Temperatures
e o —p [m v [ cover
P paHpRE|"E
~ s
Temperature Plot -+ Block

115
110
108 4 —— - B S S —ir

100

Temperature

15
10
5

Temperature Plot

o
00:00:.00 00.04:10 00:02:20 00:12:30 00:16:40 00:20:50 00:25:00 00:20:10 00:33:20 00:37:30 00:41:40 00:45:50 00:50:00 00:54:10 00:58:20 View 1 Hawur =
Time

Fixed Wiew [
Cl »

Note: The Sample temperature displayed in the Current Temperatures group is an
estimated value.
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Chapter 4 Run the Experiment
Monitor the run

View the Run Method

Run Method

Click Run Method from the Run Experiment Menu.

The following is an image of the Run Method screen as it appears in the example

experiment.

Adijust # of Cycles:

I 4dd Melt Curve Stage to End

7 &dd Holding Stage to End

[T Add Infinite Hold to End

el

Hold Stage PCR Stage
MNumber of Cycles: |4D :I
[T Enable AutoDelta
Starting Cycle: |1 3
100 °C_|
95,0 °C 95,0 °C
00:20 19°Cfs o001
75 °C_| 1% °Cfs
60.0 °C
] 00:20
50 T_|
25 °C__|
0|
Stept Step1 Step?
4
Legend
{ Data Collection On * = Data Collection Off A AutcDefta On A AutoDelta Off

Run Data Report
Experiment Name:

Start Time:

Stop Time:

Run Duration:

User Name:

Instrument Narme:
Firmware Version:
Software Version:
Instrument Serial Mumber:
Sample Volume:

Cover Temperature:

Block Type:

Errors Encountered:

View the run data

Click View Run Data from the Run Experiment Menu.

The following is an image of the View Run Data screen as it appears in the example

experiment.

QuantStudio_384-Wel_Standard_Curve_Example
02-01-2010 22:25:14 5GT

02-01-2010 23:07:07 SGT

41 minutes 52 seconds

DEFAULT

N A
278880018
10.0

105.0
384-well Block
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From the
QuantStudio™ 6 or
7 Instrument

Chapter 4 Run the Experiment
Monitor the run

You can also view the progress of the run from the QuantStudio™ 6 or 7 Instrument
touchscreen.

The following are images of the Run Method screen on the QuantStudio'™ 6 or 7

touchscreen Instrument touchscreen:
Experiment View
@ Time View Ht]  Experiment View
Run Started: July 06 2013 - 05:48PM Sample: 0.0 °C
Reaction Volume: 20 pL Heated Cover [Set Point): 105.0 °C (105.0 °C)
Time Remaining: 01:15:39
Stage 1 Stage 2
X1 3 of 40
95.0 °C 95.0 °C
. 10:00 0:15 N\ 50.0 °C
50.0 °C 1:00
2:00 )
July 06 2013 - 05:48PM o
Heated cover reached target temperature.
Time View
®© Time View tH|  Experiment View
Run Started: July 06 2013 - 05:48PM Sample: 95.0 °C
Reaction Yolume: 20 pL Heated Cover [Set Point): 105.0 °C (105.0 °C)
Stage /Step /Cycle: 1/2/1
@ Remaining Time : Elapsed Time
July 06 2013 - 05:48PM 0
Heated cover reached target temperature.
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Chapter 4 Run the Experiment
Monitor the run
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Review Results and Adjust
Experiment Parameters

In Section 5.1 of this chapter you review the analyzed data using several of the analysis
screens and publish the data. Section 5.2 of this chapter walks you through the process
of modifying experiment parameters to troubleshoot problems with experiment
results before rerunning an experiment.

This chapter covers:

Section 5.1 Review Results ........ooiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiin, 31
B Analyze the example experiment. . .......... ... ..o i 31
View the Standard Curve Plot ......... ... ... .. ... . i 31

B Assess amplification results using the Amplification Plot................... 33
B Identify well problems using the Well Table .............................. 39
B Confirm accurate dye signal using the Multicomponent Plot................ 42
B Determine signal accuracy using the Raw DataPlot ....................... 44
B Review the flagsinthe QCSummary ............ ..o, 46
B Formoreinformation.......... ... .. i 47
Section 5.2 Adjust parameters for re-analysis of your own experiments. ........ 49
B Adjust analysissettings. . ... 49
B Improve Cp precision by omittingwells................ ... ... . o o 52
B For more information. . ...............uiuuuiii 53
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Chapter 5 Review Results and Adjust Experiment Parameters
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Section 5.1 Review Results

Analyze the example experiment

1.

Section 5.1 Review Results
Analyze the example experiment

Open the example experiment file that you ran in Chapter 4.

2. Click Analyze. The software analyzes the data using the default analysis settings.

Note: You can also access the experiment to analyze from the Home screen.

View the Standard Curve Plot

Purpose

To view and assess
the Standard Curve
Plot

The Standard Curve Plot screen displays the standard curve for samples designated as

™

standards. The QuantStudio ™ 6 and 7 Flex Real-Time PCR System Software calculates
the quantity of an unknown target from the standard curve.

The purpose of viewing the standard curve for the example experiment is to identify:

-_—

Slope and amplification efficiency
R2 value (correlation coefficient)

Cr values

From the Experiment Menu pane, select Analysis » Standard Curve.

Note: If no data are displayed, click Analyze.

Display all 384 wells in the Standard Curve Plot screen by clicking the upper left
corner of the plate layout in the Plate Layout tab.

Enter the Plot Settings:
Menu Selection
Target All
Plot Color Target
E Check (default]
(This is a toggle button. When the legend
is displayed, the button changes to Hide
the plot legend.)
4. View the values displayed below the standard curve.
Menu Selection
Slope -3.289
R2 0.997
Amplification efficiency 101.414%
Error 0
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Chapter 5 Review Results and Adjust Experiment Parameters
View the Standard Curve Plot

5. Check that all samples are within the standard curve. In the example experiment,
as shown in the following image, all samples (blue dots) are within the standard
curve (red dots).

Standard Curve

Plot Settings
Target [all hd Flot Color ITarget VI
= N 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24
Save current settings as the default
N el e N L HE N N H B M HE R i i R
o — MAAmEmEa A AAAAAAAAAAAARARARA AR
£ P a iy ;
< [ S E S A S A AR A Rl R Rt A Al Al A A R Al Al A
Standard Curve o [ A A AR AR A A A A A A
30.5 | A A A A A
30.0
. - A S E S S S A AN A A R R Rl A Al Al A A A Al Al A
. 20 < [N A A AR A R R A A A A A A Al A
Q 25
280 B M el e e e B B B U B B U B H B B B
78 1 [ S A A A A A A A A A A A
270
285 B Nt BT T B T B B B L B B H B B B L
o o o ) o0 o v || AR AR A A A A A A A A
Quantity
L [ A A A A A A A
w [ S S A A A A A AR A A A A A Al
Targek: RNAse P Slope: -3.289 Y-Inter: 40.743 RZ,: 0.997 Eff%: 101.414 Error: 0
Torget; Slope: Flnter; 8 Eio: Erros; M et St Re s B B U B B B B D R D B B L L
o [ SEETEN S SR A A R A A A A A
Legend - [ A S A AR A R R R A A A A AR A Al
M standard [l Urknown Urknown (Flagged)
wels: [ 288 [E 8o [ 16 0 Empty
well Summary: In Plate; 354 Set Upi 364 Analyzed: 304 Flagged: 0 Omitted by Analysis: 0 Omitted Manwally: 0 Samples Used: 2 Targets Used: 1

6. Check the Cy values:
a. Click the Well Table tab.
b.

C.

From the Group By menu, select Replicate.

Look at the values in the Cy column. In the example experiment, the Cp
values fall within the expected range (>8 and < 35).

Plate Layout e
EEXTE] oo v

Shaowy in Table ¥

Expand &ll [= Collapze Al

# | well | Orrif: | Flag Sample Ma...| Target Na... Task Dyes | CT | CT Mean | CT D | Quanitity | Quantity ... |Quant\ty SD| Comments |
17 a7 @ =
18 Als r 10K RMAse P UNKMOWN - FAM-NFQ-... 27.638 27.678 0.0% 96626597 9,414.6558 572,472
19 Al9 r 10K RhAse P UNKMOWN - FAM-NFQ-... 27.627 27 678 009 9738641 9,414.655 572472
20 AZ0 r 10K RHAse P UNKMOWN - FAM-NFQ-... 27.684 27.678 009 9352924 9,414.608 S72.472
21 A2l r 10K Rhbse P UNKMOWN - FAM-NFQ-... 27,601 27,678 009 9913167 9,414.608 S72.472
22 AZ2 r 10K RHAse P UNKMNOWN - FAM-NFQ-... 27.778 27.678 009 8758838 9,414.608 S72.472
23 A23 r 10K Rhfse P UNKMOWMN - FAM-MFC. 27.738 27.678 009 5884947 G9,414.608 S72.472
24 AZ24 r 10K RhAse P UINKTCIATY 27.78 27.678 009 8744812 9,414.608 572472
40 El6 r 10K RNAze P UINKMOWMN 27,731 27,678 009 9051594 9,414,608 S72.472
41 B17 r 10K RNAze P UNKMNOWN . 27.653 27.678 009 9559844 9,414,608 572472
42 E18 r 10K RNAse P UINKMNOWMN . 27.654 27,678 009 9485763 0,414,508 S72.472
43 EB19 r 10K RNAze P UNKMNOWN . 27.576 27.678 009 1008783 9,414,508 572472
44 B20 r 10K RNAse P UINKMNOWMN . 27.674 27,678 009 9420996 9,414,508 S72.472
45 B21 r 10K RNAse P UNKINOWWMN . 27713 27678 009 9154339 9,414,508 S72.472
46 B22 r 10K RNAse P UNKMNOWWMN . 27.688 27,678 009 9331501  9,414.508 S72.472
47 B23 r 10K RNAse P UMNETOWN . 27731 27678 009 90545931 9,414.608 372472
42 E24 r 10K RNAse P LINKMOIAT . 27.733 27,678 009 9041301 5,414.608 572,472
&4 Cl6 r 10K RMAse P LINKMOWN 27.75 27.678 0.09 892964 9,414.608 572,472
B5 C17 r 10K RhAse P UMK 27.651 27.678 009 9575573 9,414.655 572472
B6 C18 r 10K RHAse P UINKTNCWAT 27.636 27.678 0.0% 9677329 9,414.655 572,472
57 C19 r 10K Rhbse P UNKMOWN - FAM-NFQ-... 27.562 27,678 009 10,188.251 9,414.608 S72.472
B8 C20 r 10K RHAse P UNKMNOWN - FAM-NFO-... 27.62 27.678 009 9780859 9,414.608 S72.472
9 21 r 10K Rhfse P UNKMOWN - FAM-NFQ-... 27.634 27.678 009 9,554.062 9,414.698 372472
70 Cz22 r 10K RhAse P UNKMOWMN - FAM-NFQ-... 27.606 27.678 009 9883035 9,414.698 S72.472
71 23 r 10k RHAze P UNKMOIAN - FAM-NFQ-... 27.631 27.678 009 9710744 9,414,508 572472 =
— - - 4 LUTEEE ) TINIARISWAIRD F kA RIES AT e Eale =l nonn MoAnm AnE MoAdA Enn E7maATA
well Summary: In Plate: 384 St Up: 384 Analyzed: 384 Flagged: 0 Omitted by Analysis: 0 Omitted Manually: O Samples Uzed: 2 Targats Usad: 1
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Section 5.1 Review Results 5
Assess amplification results using the Amplification Plot

Tips for analyzing When you analyze your own standard curve experiment, look for:

your own * Slope and amplification efficiency values — The amplification efficiency is
experiments calculated using the slope of the regression line in the standard curve. A slope
close to — 3.3 indicates optimal, 100% PCR amplification efficiency. Factors that
affect amplification efficiency:
— Range of standard quantities — For accurate and precise efficiency
measurements, use a broad range of standard quantities, 5 to 6 logs
(10° to 100 fold).
— Number of standard replicates — For accurate efficiency measurements,
include replicates to decrease the effects of pipetting inaccuracies.

— PCR inhibitors — PCR inhibitors in the reaction can reduce amplification
efficiency.

* R2values (correlation coefficient) — The R? value is a measure of the closeness of
fit between the regression line and the individual Ct data points of the standard
reactions. A value of 1.00 indicates a perfect fit between the regression line and
the data points. An R? value >0.99 is desirable.

* Cy values — The threshold cycle (Cr) is the PCR cycle number at which the
fluorescence level meets the threshold.

— A Cgvalue >8 and <35 is desirable.

— A Cpvalue <8 indicates that there is too much template in the reaction.

— A Cyvalue >35 indicates a low amount of target in the reaction; for C values
>35, expect a higher standard deviation.

If your experiment does not meet the guidelines above, troubleshoot as follows:

*  Omit wells (see “Improve Cy precision by omitting wells” on page 52).
Or

¢ Rerun the experiment.

Assess amplification results using the Amplification Plot

Amplification plots  The Amplification Plot screen displays amplification of all samples in the selected
available for wells. There are three plots available:

viewing * ARnvs Cycle - ARn is the magnitude of normalized fluorescence signal generated
by the reporter at each cycle during the PCR amplification. This plot displays ARn
as a function of cycle number. Use this plot to identify and examine irregular
amplification and to view threshold and baseline values for the run.

* Rnvs Cycle — Rn is the fluorescence signal from the reporter dye normalized to
the fluorescence signal from the passive reference. This plot displays Rn as a
function of cycle number. Use this plot to identify and examine irregular
amplification.

* Cyvs Well - Cyis the PCR cycle number at which the fluorescence meets the
threshold in the amplification plot. This plot displays Ct as a function of well
position. Use this plot to locate outlying amplification (outliers).

Each plot can be viewed as a linear or log10 graph type.
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5 Chapter 5 Review Results and Adjust Experiment Parameters
Assess amplification results using the Amplification Plot

Purpose The purpose of viewing the amplification plot for the example experiment is to
identify:
¢ Correct baseline and threshold values
¢ OQutliers
View the 1. From the Experiment Menu pane, select Analysis » Amplification Plot.
Amplification Plot Note: If no data are displayed, click Analyze.

2. Display the RNase P wells in the Amplification Plot screen. Click the Plate Layout
tab. Enter the Plot Settings:

Menu Selection

Select Wells With Target » RNaseP

A

B Iy = e P M- Ee s o iy gy B o iy i o iy oy o iy i B o iy i iy
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D (I N e L L i R e P s L e, R o B, EE s, R o B, R R o By R B o, B B B, B R, B, B

E [ e e P e s Ee s oy e, iy, oy e, iy, o i, i, oy ey L, B oy ey L, B Ly iy

E P e e e e s i ey B, e e g e B iy B B ey B B, B B B

G (I B s L L i e P s L e, R o R, EER e, R o B, R R o, By P B, B B B, P R, PR, B

H [ e e P e s Ee s oy e, iy, oy e, iy, o i, i, oy ey L, B oy ey L, B Ly iy

1 P e e e e s i ey B, e e g e B iy B B ey B B, B B B

] I B s L Ll i o e P s R e, R o R, EER s, R o B, R R o By R B, B B B, B R B, B

K IR P e e e e o e e e, e e, e e By e e ey B B ey B B, P B B B

L P e e e e s i ey B,y e, e g ey e iy B B iy B B, B B B,

M I s L L i R e B s i e, R o R o, EER e, R o B, R R o By R B, B B BRI G, P R B, B

N IR P e e e e o e e e, e e, e e By e e ey B B ey B B, P B B B

o Iy = e P M~ FHEe s o iy g B o iy o B o iy oy iy L B o iy i iy

P IR e e e e e s i, ey B, e e g ey B, iy B B ey B B, B B B

wels: [[] 288 [ 80 [ 16 0 Empty
well Summary: In Plate: 354 Set Up: 384 Anahyzed: 384 Flagged: O Oritked by Analysis: 0 Ornitted Marwally: 0 Samples Used: 2 Targets Used: 1

3. In the Amplification Plot screen, enter:

Menu Select
Plot Type ARn vs Cycle
Plot Color Well (default)
E Check (default)

(This is a toggle button. When the legend
is displayed, the button changes to Hide
the plot legend.)

4. View the baseline values.

a. From the Graph Type drop-down menu, select Linear.
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5.

Section 5.1 Review Results

Assess amplification results using the Amplification Plot

Select the Baseline check box to show the start cycle and end cycle.

Verify that the baseline is set correctly: The end cycle should be set a few
cycles before the cycle number where significant fluorescent signal is
detected. In the example experiment, the baseline is set correctly.

Amplification Plot <]
Plot Settings
Plot Type: [aRn vs cycle =] Graph Type: [Linear =] Piat Colar: fwvell 2
I Save current settings a the default

Amplification Plot

£ P oAy

cyele
Options
Target: [RhAse P v | Threshold: ¥ Auta [1195751 ¥ utn Baseline

Show: [~ Threshold — W Baseline Start: Wel B Target 4 Baseline End: wel W Target 4

Well Summary: InPlate: 384 et Up: 334 Analyzed: 354 Flagged: 0 Omitted by Analysis: Omitted Marwsly: 0 Samples Used: 2 Targats Used: L

View the threshold values.

Menu Select

Graph Type Log

Target RNaseP

a. Select the Threshold check box to show the threshold.
b. Verify that the threshold is set correctly. In the example experiment, the

threshold is in the exponential phase.

Amplification Plot
Plot Settings

Piot Type: [aRn vs Cycle x| Graph Typesjlog  »| Plot Color: fwell [

[ Save current settings as the default

Amplification Plot

196751

ARn
°

Options
Target: RiAse P | Threshold: ¥ auto [0196751 ¥ Auto Baseline

Show: M Threshold — I Baseline Start: Wel B Target 4 Baseline End: Well (M Target <

well Summary: InPlate: 334 Satup: 384 Analyzad: 384 Flagged: 0 omited by Analysis: 01 omitted Manually: 0 Samples Used: 2 Targets Used: 1
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5 Chapter 5 Review Results and Adjust Experiment Parameters
Assess amplification results using the Amplification Plot

6. Locate outliers:
a. From the Plot Type drop-down menu, select Ct vs Well.

b. Look for outliers from the amplification plot. In the example experiment,
there are no outliers for RNase P.

Amplification Plot <]
Plot Settings
Plot Type: [cr vs wel =] Graph Type: [linear =] Piat Colar: fwvell 2
I Save current settings a the default

Amplification Plot

a0 - > - “ v . . -+

35

* A % et g

Ve - n ‘_"‘"——\"‘b— Seme m L wae .

25 H
© 20

15

0

H

0

5 10 1520 25 30 35 40 45 50 55 60 65 70 75 60 65 80 5 301358400 pra
Well Number

Options
Target: [RNAse P~ | Threshold: 7 Auto 0196751 ¥ Auta Baseline

Show: [T Threshold — B Baseline Start: Well B Target 4 Baseline End: wel W Target 4

Well Summary: InPlate: 384 et Up: 334 Analyzed: 354 Flagged: 0 Omitted by Analysis: Omitted Marwsly: 0 Samples Used: 2 Targats Used: L

Tips for analyzing When you analyze your own standard curve experiment, look for:
your own
experiments

Outliers

* A typical amplification plot — The QuantStudio"" 6 and 7 Flex Real-Time PCR
System Software automatically calculates baseline and threshold values based on
the assumption that the data exhibit a typical amplification plot. A typical
amplification plot has four distinct sections:

— Plateau phase
— Linear phase
— Exponential (geometric phase)

— Baseline
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Section 5.1 Review Results 5
Assess amplification results using the Amplification Plot

The following is an image of a typical amplification plot:

Amplification Plot
Plot Settings

[~ Save current settings as the default

Piot Typs: [ARn vs Cycle x| Graph TypetfLag =] Plot Colar: [wel =l

0196751

0.0m

Options

Amplification Plot

Target: RNAse P | Threshold: W Auto [0196751

Show: W Threshold = [ Baseline Start: Well B0 Target 4 Baseline End: wWell (B Target £

¥ Auto Baseline

well Summary: In Plate: 384 Set Lip: 354

Analyzed: 384 Flagged: 0 Omitted by Analysis: ) Onnitted Manually: 0 Samples Used: 2 Targets Used: 1

IMPORTANT! Experimental error (such as contamination or pipetting errors) can
produce atypical amplification curves that can result in incorrect baseline and
threshold value calculations by the QuantStudio'™ 6 and 7 Flex Real-Time PCR
System Software. Life Technologies recommends that you examine the
Amplification Plot screen and review the assigned baseline and threshold values
for each well after analysis.

Correct threshold values:

Threshold Set Correctly 1

The threshold is set in the
exponential phase of the

o1

;
amplification curve. 0.196751

ARN

Threshold settings above or
below the optimum increase
the standard deviation of the
replicate groups.

Cycle

OB B N B M X MW M

QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Getting Started Guide for Standard Curve
Experiments
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Chapter 5 Review Results and Adjust Experiment Parameters
Assess amplification results using the Amplification Plot

Threshold Set Too Low

The threshold is set below the
exponential phase of the
amplification curve. The
standard deviation is
significantly higher than that
for a plot where the threshold
is set correctly. Drag the
threshold bar up into the

exponential phase of the curve.

Threshold Set Too High

The threshold is set above the
exponential phase of the
amplification curve. The
standard deviation is
significantly higher than that
for a plot where the threshold
is set correctly. Drag the
threshold bar down into the

exponential phase of the curve.

ARN

0.1

001 4

0.001

Cycle

e Correct baseline values:

Baseline Set Correctly

The amplification curve begins
after the maximum baseline.

Baseline Set Too Low

The amplification curve begins
too far to the right of the
maximum baseline. Increase
the End Cycle value.

14 16 18 Ko =z 24 ] n o= 2y ] &
Cycle

LR I T T - BT - T T T R - R

Cycle

QuantStudio™ & and 7 Flex Real-Time PCR System Software Getting Started Guide for Standard Curve

Experiments



Section 5.1 Review Results 5
Identify well problems using the Well Table

Baseline Set Too High 0

The amplification curve begins
before the maximum baseline.
Decrease the End Cycle value.

AT ]

2
N2

0.001

Wi Wh L)
8 a8 10 12 14 18 18 n = ) 2%
Cycle

If your experiment does not meet the guidelines above, troubleshoot as follows:

Omit wells (see “Improve Ct precision by omitting wells” on page 52).
Or

Manually adjust the baseline and/or threshold (see “Adjust analysis settings” on
page 49).

Identify well problems using the Well Table

The Well Table displays data for each well in the reaction plate, including;:

The sample name, target name, task, and dyes

The calculated threshold cycle (Cr), normalized fluorescence (Rn), and quantity
values

Comments

Flags

Purpose The purpose of viewing the well table is to identify:

View the well table

QuantStudio™ ¢ and 7 Flex Real-Time PCR System Software Getting Started Guide for Standard Curve

Experiments

-_

Quantity values
Flags

Cr values (including Ct standard deviation)

From the Experiment Menu pane, select Analysis, then select the Well Table tab.
Note: If no data are displayed, click Analyze.

Use the Group By drop-down menu to group wells by a specific category. For the
example experiment, group the wells by replicate, flag, or C value.

Note: You can select only one category at a time.

39



5 Chapter 5 Review Results and Adjust Experiment Parameters
Identify well problems using the Well Table

To group by replicate

From the Group By drop-down menu, select Replicate. The software groups the
replicate wells: negative controls, standards, and samples. In the example experiment,
note that the quantity values within each replicate group are similar.

Note: In the example experiment, the Quantity, Quantity Mean, and Quantity SD
columns have been moved from their default locations to the beginning of the Well
Table. To move a column, click and drag on the column heading.

e

Plate Layout 3

win Table ¥ 2 e y Expand All

Target Name
# | Wil | Ot | tity Mean | Quantity SO | Sarmiple Name | Target Mame | Task | | Cr C1 Mean Crsp | Cc
T Sample Name a o - :‘
= a3 r Task 0414608  572.47210K RNAsa P UNKNOWH . 27.731 27.678 0.09
24 A24 r s 0414608 S72.47210€ RiBse P UNKNOWN . 27.652 27.678 009
40 Bl6 r 0414608 572.47210¢ RiAse P LNKNOWH . 27664 27,678 0.09
41 B17 r Dye 0414608 572.47210K RNAse P UNKNOWH . 27,576 27.678 0.09
42 B18 r Flag 9,414.698 572,472 10K RMAze P UNKNOWR . 27.674 27.678 0.09
4 B9 r & 0414608  572.47210K RNAse P UNKNOWN . 27713 27,678 0.09
44 B20 r coments 0414608  S72.47210€ Rigse P UNKNOWH . 27.688 27.678 009
45 B21 r 9,414.698 572,472 10K RMase P UNENOWYR . 27731 27.678 0.09
46 B22 r UslBoston Bon) 9,414,608 572472 10K RNAsa P UNKNOWH . 27,733 27.678 0.09
47 B23 r el Postion (Calumn) 0414608 S72.47210€ RiBse P UNKNOWN . 27.75 27.678 009
48 B24 r None 0414608 S72.47210¢ RiAse P LNKNOWH . 27651 27,678 0.09
84 C16 r 0577320 0414608 S72.47210€ RiBse P UNKNOWN . 27.636 27.678 009
65 C17 r 10,188.251 9,414.698 572,472 10K RMase P UNKNOWYR . 27.562 27.678 0.09
66 C18 r 5,780,859 0414608 S72.47210K RNbse P UNKNOWN . 2762 27.678 0.09
&7 c19 r 9,554,062 0414608 S72.47210€ RiBse P UNKNOWH . 27.654 27678 009
88 20 r 9,883,055 0414608  572.47210€ Ribse P UNKHOWH . 27.606 27,678 0.09
69 Co1 r 9,710.744 0414608  572.47210K RNAsa P UNKNOWH . 27631 27.678 0.09
70 c22 r 9,489,336 0414608 S72.47210€ RiBse P UNKNOWN . 27.664 27.678 009
71 23 r 5,705,506 0414608 S72.47210¢ RiAse P LNKNOWH . 27631 27,678 0.09
72 o4 r 9,340,664 0414608 S72.47210€ RiBse P UNKNOWN . 27.685 27.678 009
88 D16 r 10,197,494 9,414.698 572,472 10K RMase P UNKNOWYR . 27.961 27.678 0.09
89 D17 r 10,077 892 0414608 S72.47210K RNbse P UNKNOWN . 27.578 27.678 0.09
w0 D18 r 9,934,107 0414608  S72.47210€ RiBse P UNKNOWH . 27.5% 27678 009
o1 big r 5,700.193 0414608  572.47210¢ RNAse P LNKNOWH . 27632 27,678 0.09
%2 D2 r 9,638.235 0414608  572.47210K RNAsa P UNKNOWH . 27.641 27.678 0.09
93 D21 r 10,246.75 9,414,698 572,472 10K RMAze P UNKNOWR . 27.954 27.678 0.09
04 D22 r 5,866,359 0414608  572.47210¢ RNAsa P UNKNOWN . 27.757 27,678 0.09
o5 D23 r 8,459,933 0414608  S72.47210€ Rigse P UNKNOWH . 27.828 27.678 009
95 D24 r 7,764,318 9,414.698 572,472 10K RMase P UNENOWR . 27.95 27.678 0.09
112 E16 r 10,065,235 0414608 572.47210K RNAsa P UNKNOWH . 2758 27.678 0.09
113 E17 r 9,139,208 0414608  S72.47210€ RiBse P UNKNOWH . 27.718 27678 009
114 E18 r 5,806,181 0414608 572.47210¢ RNAse P LNKNOWH . 27617 27,678 0.09
115 E19 r 9,142.86 0414608  572.47210K RNAsa P UNKNOWH . 27.717 27.678 0.09
116 E20 r 9,424.23 9,414,698 572,472 10K RMAze P UNKNOWR . 27.673 27.678 0.09
117 E21 r 8,763.623 0414608  572.47210€ RNAsa P UNKNOWN . 27777 27,678 0.09
K| |
Well Summary: In Plate: 384 Set Ups 384 Analyeds 354 Flagged: 0 Omitted by Analysis: 0 ritted Marualy: 0 Samples Used: 2 Targets Used: 1

The well table looks like this:

»| Plate Layout Well Tal

in Table ¥ urells W " Epand Al 8 Co

# Well | omit sample ...| Target... | Task Dyes cr Cr Mean | CT SD Quantity | Quantit... | Quantit... | Comme.

10K oW -
16 A6 ] 10K RAse P UNKNOWN FAMNFQ-.. 26.302 26.907 0.080 ©,550.178 0,533.951  524.797
17 AL7 0 10K RNASe P UNKNOWN FAM-NFQ-.. 26.807 26.907 0.080 9,523232 9,533.951  524.797
18 Al8 0 10K RAse P UNKNOWN FAMNFQ-.. 26.955 26.907 0.080 0,206.665 0,533.951  524.797
19 A19 0 10K RNAse P UNKNOWN 26.840 26.907 0.080 ©9,912.618 0,533.951  524.797
20 A20 | 10K RNAsE P UNKNOWN 26.982 26.907 0.080 9,028357 9,533.951  524.797
21 A2t 0 10K RAse P UNKNOWN 26.907 0.080 8977218 9,533.951  524.797
22 A22 0 10K RNAse P UNKNOWN 26.907 0.080 0,080.458 0,533.951  524.797
23 A23 0 10K RNASE P UNKNOWN 26.907 0.080 9,074.082 9,533.951  524.797
24 A4 0 10K RNAse P UNKNOWN 26.907 0.080 0,464.632 0,533.951  524.797
40 B16 | 10K RNAsE P UNKNOWN 26.907 0.080 ©9,459.534 9,533.951  524.797
41 B17 0 10K RAse P UNKNOWN 26.907 0.080 10,267.638 0,533.951  524.797
42 B18 0 10K RNAse P UNKNOWN 26.907 0.080 ©9,407.755 0,533.951  524.797
43 819 0 10K RNASEP  UNKNOWN 26.907 0.080 ©9,308513 0,533.951  524.797
44 820 0 10K RAse P UNKHOWN 26.907 0.080 9410605 0,533.951  524.797
45 B21 0 10K RNAse P UNKHOWN 26.907 0.080 9,219.866 9,533.951  524.797
46 B2 0 10K RNASE P UNKNOWN 26.907 0.080 9,240.837 9,533.951  524.797
47 823 0 10K RNAse P UNKNOWN 26.907 0.080 9,092.796 0,533.951  524.797
48 B24 | 10K RNAsE P UNKNOWN 26.907 0.080 ©9,763.808 9,533.951  524.797
64 Ci6 0 10K RAse P UNKNOWN 26.907 0.080 09728589 9,533.951  524.797
65 C17 0 10K RNAse P UNKNOWN 26.907 0.080 10,107.170 9,533.951  524.797
66 C18 0 10K RNASEP  UNKNOWN 26.907 0.080 ©9,554.092 0,533.951  524.797
67 Ci9 0 10K RAse P UNKNOWN FAMNFQ-.. 26.922 26.907 0.080 0422722 9,533.951  524.797
68 C20 0 10K RNAse P UNKNOWN FAM-NFQ-.. 26.863 26.907 0.080 ©9,820851 9,533.951  524.797
60 C21 0 10K RAse P UNKNOWN FAMNFQ-.. 26.821 26.907 0.080 10,112306 ©9,533.951  524.797
70 c22 0 10K RNAse P UNKNOWN 26.907 0.080 0423139 0,533.951  524.797
71 C23 | 10K RNAsE P UNKNOWN FAM-NFQ-. 26,907 0.080 9,704.001 9,533.851  524.797
72 C24 0 10K RNAse P UNKNOWN FAMANFQ 26.907 0.080 0,244.182 9,533.951  524.797
88 D16 0 10K RNAse P UNKNOWN FAMNFQ-. 26,907 0.080 10,254792 0,533.951  524.797
89 D17 0 10K RNASE P UNKNOWN FAMANFQ 26.907 0.080 10,130.240 9,533.951  524.797
20 DI8 0 10K RNAse P UNKHOWN FAMNFQ 26.907 0.080 ©9,898.796 0,533.951  524.797
o1 DI 0 10K RNAse P UNKNOWN FAM-NFQ 26,907 0.080 9712068 9,533.951  524.797
92 D20 0 10K RAse P UNKNOWN FAMNFQ-.. 26.309 26.907 0.080 9,507.545 0,533.951  524.797
93 D21 0 10K RNAse P UNKNOWN FAMNFQ-.. 26.792 26.907 0.080 10,321.120 0,533.951  524.797
o4 D22 | 10K RNAse P UNKNOWN FAM-NFQ-.. 26.964 26.907 0.080 9,143233 9,533.951  524.797

95 D23 0 10K RAse P UNKNOWN FAMANFQ-.. 27.017 26.907 0.080 8,800.055 9,533.951  524.797 3

Well Summary: In Plate: 384 St Up: 384 Ansiyzed: 384 Flagged: Omitted by Anahysis: () Omitted Manualy: Samples Used: 2 Targets Used: 1
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Section 5.1 Review Results 5
Identify well problems using the Well Table

To group by flag

From the Group By drop-down menu, select Flag. The software groups the flagged
and unflagged wells. In the example experiment, there are no flagged wells.

> Plate Layour

in Table ¥ Group By ¥ Expand All B Collapse all
Target Name
# [wal [ omt | tity Mean | Quarttity SD | Sample Name | Targst Name Tasc | T Mean asp | co
T Sample Mame D o . L Y L T T 1 O B
9 a9 r Task 4,094,994 322.4525K RMAse P UNKNOWHN 28582 0.063
10 A10 r D 4,094,994 322.4525K RMAse P UNKNOWHN 28582 0.063
11 al1 r 4,004,904 222.4525K RMAse P UNKHOWN 28582 0,063
12 Al2 - bre 4,994,934 222.4525K RMAse P UNKNGWN 28562 0063
13 AL3 r 4,994,994 222.4525€ RMNAsE P UNKNOWIN 28562 0063
14 Al4 r 4,094,994 322.4525K RMAsE P UNKMOWHN 28582 0083
15 A15 r P 4,094,994 322.4525K RMAse P UNKNOWHN 28582 0.063
16 Al6 r 9,414.608 572.47210K RMAse P UNKHOWN 27678 009
wiell Pasition (Row)
17 A17 r 9,414.608 572.47210K RMAse P UNKHOWN 27678 009
18 A18 r Wel Position (Column) 3,414.698 572,472 10K RiAse P UNKMNOWH 27,678 0.09
19 A19 r None 9,414,608 S72,47210€ RiAse P UNKNOWHN 27678 0.09
20 A20 r B,758.828 9,414.608 572,472 10K RMAse P UNKNOWHN 27678 009
21 szl r 6,884,047 9,414.608 572.472 10K RMase P UNKNOWHN 27,678 009
2 a2 - 8,744.812 9,414.608 572.47210K RMAse P UNKHOWN 27678 009
23 AZ3 r 9,051,504 9,414,608 572,472 10K RMNAse P UNKNOWN 27678 009
24 A24 r 9,559.844 9,414.608 572,472 10K RMAsE P UNKNOWN 27678 009
s B1 r RMAse P NTC
% B2 r 1,250 1,250 RMAse P STANDARD 20,568 0.087
7 B3 r 2,500 2,500 RMAse P STANDARD 20515 0.075
28 B4 - 5,000 5,000 RMAse P STANDARD 28611 0.054
29 B r 10,000 10,000 RMNAsE P STANDARD 27648 0057
a0 Bs r 20,000 20,000 RMAsE P STANDARD 26,553 0.043
31 B7 r 5,160.045 4,094,994 322.4525K RMAse P UNKNOWHN 28582 0.063
et - 5,114.345 4,094.994 222.4525K RMAse P UNKHOWHN 2852 0063
3 B r 4,843.689 4,004,904 222.4525K RMAse P UNKHOWN 28582 0,063
4 BI0 r 4,609.773 4,994,994 222.4525K RMAsE P UNKNOWN 28562 0063
3 Bl r 4,678,537 4,994,994 222.4525€ RMNAsE P UNKNOWIN 28562 0063
36 B12 r 4,990.247 4,994,994 322.4525K RMAse P UNKNOWHN 28582 0.063
7 B3 r 4,778,531 4,094,994 322.4525K RMAse P UNKNOWHN 28582 0.063
3 B4 - 4,736.198 4,004.904 222.4525K RMAse P UNKHOWN 28582 0.083
39 BiS r 5,170,109 4,994,934 222.4525K RMNAse P UNKNOWIN 28562 0083
40 Bls r 9,485.763 9,414.608 572,472 10K RMAsE P UNKNOWN 27678 009
41 B17 r 10,087.83 9,414,608 572,472 10K RMAse P UNKNOWHN 27,678 009
42 B18 r 9,420,996 9,414.608 572,472 10K RMAse P UNKNOWN  FAMANFG: ., 27,674 27678 009
43 B9 : - 9,164.330 9,414.608 572.47210K RMAse P UNKNOWN  FAMAFG-.., 27.713 27678 | 009 _,_|
4
well Summary: In Plate: 384 Set Up: 384 Analyzed: 384 Flagged: 0 Omitted by Analysis: 0 Omitted Manually: 0 Samples Used: 2 Targets Used: 1

To group by Cy value

From the Group By drop-down menu, select Ct. The software groups the wells by Ct
value: low, medium, high, and undetermined. In the example experiment, the Ct
values are within the expected range (>8 and <35).

Plate Layout

+in Table ¥ Group By ¥ 0 Expand Al

Target Name
# I el I Omit I itity Mean | Quantity SD_| Sample hame | Target Mame Task I Dyes I 1 C1 Mean C1 5D o
- - Sample Hame I e TR T ST — PR 270 . 2
93 D21 r Task 9,414,638 572,472 10K RHAse P UNKHOWH  FAMAFQ-... 27.554 27.578 0.09
94 D22 r N 9,414,698 572,472 10K RNAss P UNKNOWN  FAM-HFQ-... 27,757 27.578 0.09
95 Dz3 r 9,414,698 572,472 10K RiAsE P UNKNOWN  FAMAFQ-... 27.828 27.678 0.09
25 D24 r Dre 0,414,608 572.47210K RiAs2 P UNKNOWN  FAMANFQ-.. 27.95 27.678 0.09
o1 B3 (] Flag 2,500 RHAse P STANDARD FAM-HFQ-... 23,429 20,515 0078
100 E4 - o N ] 5,000 RiAss P STANDARD  FAM-HFQ-.. 28,649 28,611 0054
101 E5 r rm— 10,000 RiAsE P STANDARD  FAM-NFQ-... 27.662 27.646 0057
102 E8 - 20,000 RiAse P STANDARD FAM-NFO-.. 26533 26,553 0049
103 E7 m] el Postion (Fow) 4,994.994 222.4525¢ ANAse P UNKROWR  FAM-NFQ-.. 28.584 28,582 0.063
104 EB r Wiell Position {Column) 4,094,994 222,4525K RMNAss P UMKNOWN  FAM-NFQ-.., 28,543 28,582 0.063
105 E9 r Hone: 4,994,954 222,4525K RiAsE P UNKNOWN  FAMAFQ-... 28,524 28,582 0083
106 E10 - 4560265 4,004,004 222,4525K RiAse P UNKNOWH  FAMANFO-.. 26619 28.552 0063
107 E11 - 4,745,286 4,004,004 222,4525Kk RHAse P UNKHOWN  FAMAHFQ-.. 28,653 28,582 0063
108 E12 - 4,860,692 4,004,094 222,4525K RiAss P UNKNOWN  FAM-HFQ-... 28,616 28.582 0063
109 E13 r 4,783.282 4,994.934 222,4525K RiAsE P UNKNOWN  FAMAFQ-... 28,642 28,582 0083
110 E14 - 5,008.202 4,004,004 222,4525K RiAse P UNKNOWH  FAMANFO-.. 26551 28.552 0063
111 E15 - 5,181,023 4,004,004 222.4525K RHAse P UNKHOWN  FAM-FQ-.. 28,528 28,582 0063
112 E16 r 10,065.235 9,414,698 572,472 10K RNAss P UNKNOWN  FAMAHFQ-.., 27.58 27.678 0.09
113 E17 r 9,138,209 9,414,698 572,472 10K RiAsE P UNKNOWN  FAMAFQ-... 27,718 27.678 0.09
114 E18 r 0,508,181 0,414,608 572.47210K RiAs2 P UNKNOWH  FAMANFQ-.. 27,617 27,678 0.09
115 E19 r 9,142.56 9,414,638 572,472 10K RHAse P UNKHOWN  FAMAFQ-... 27.717 27.578 0.09
116 E20 r 9,424.23 9,414,698 572,472 10K RNAss P UNKNOWN  FAM-HFQ-... 27,673 27.578 0.09
117 E21 r 8,763.623 9,414,698 572,472 10K RiAsE P UNKNOWN  FAMAFQ-... 27,777 27.678 0.09
118 E22 r 09,553.755 0,414,608 572.47210K RiAs2 P UNKNOWH  FAMANFQ-.. 27,654 27.678 0.09
119 E23 (] 8161914 9,414,638 572,472 10K RHAse P UNKHOWH  FAM-FQ-... 27.879 27.578 0.09
120 E24 - 7,265,062 9,414,698 572,472 10K RiAss P UNKNOWN  FAM-HFQ-.. 28,045 27.678 0.09
123 F3 r 2,500 2,500 RiAsE P STANDARD FAM-FQ-.. 23,465 29,515 0075
124 F4 - 5,000 5,000 RiAse P STANDARD FAM-NFO-.. 26625 28511 0,054
125 F5 - 10,000 10,000 RHAse P STANDARD FAMAHFQ-.. 27.612 27.546 0057
126 F§ - 20,000 20,000 RiAss P STANDARD  FAM-HFQ-... 26,543 26,553 0049
127 F7 r 46723658 4,994.934 222,4525K RiAsE P UNKNOWN  FAMAFQ-.. 28,676 28,582 0083
128 F8 - 5,241,754 4,004,004 222,4525K RiAse P UNKNOWH  FAMANFO-.. 26511 28.552 0063
129 Fg - 4,766,071 4,004,004 222,4525Kk RHAse P UNKHOWN  FAM-HFQ-.. 28,647 28,582 0063
130 F10 - 4,808,276 4,004,094 222,4525K RiAss P UNKNOWN  FAM-HFQ-.. 28,635 28.582 0063
131 F11 : r 5,342.352 4,994.934 222,4525K RiAsE P UNKNOWN  FAMAFQ-... 28,464 28,582 I 0083 J_I
4
well Summary: InPlate; 384 Set Up: 384 Analyzed: 384 Flagged: 0 Omitted by Analysis: 0 Omitted Manually: 0 Samples Used: 2 Targets Used: 1
QuantStudio™ ¢ and 7 Flex Real-Time PCR System Software Getting Started Guide for Standard Curve 41
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5 Chapter 5 Review Results and Adjust Experiment Parameters
Confirm accurate dye signal using the Multicomponent Plot

Tips for analyzing .
your own
experiments

Replicate — The software groups the wells by replicate: negative controls,
standards, and samples. Look in the Quantity columns to make sure the quantity
values for each replicate group are similar indicating tight Ct precision.

Flag — The software groups the flagged and unflagged wells. A flag indicates that
the software has found a potential error in the flagged well. For a description of
the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software flags, see “Flag
Settings” on page 50.

Cr — The threshold cycle (Cy) is the PCR cycle number at which the fluorescence
level meets the threshold. A Ct value >8 and <35 is desirable. A Cy value <8
indicates that there is too much template in the reaction. A Ct value >35 indicates
alow amount of target in the reaction; for Cy values >35, expect a higher standard
deviation.

Confirm accurate dye signal using the Multicomponent Plot

The Multicomponent Plot screen displays the complete spectral contribution of each
dye in a selected well over the duration of the PCR run.

Purpose In the standard curve example experiment, you review the Multicomponent Plot
screen for:

ROX™ dye (passive reference)
FAM™ dye (reporter)
Spikes, dips, and/or sudden changes

Amplification in the negative control wells

View the 1. From the Experiment Menu pane, select Analysis » Multicomponent Plot.
Multicomponent Note: If no data are displayed, click Analyze.
Plot
2. Display the unknown and standard wells one at a time in the Multicomponent
Plot screen:
a. Click the Plate Layout tab.
b. Select one well in the plate layout; the well is shown in the Multicomponent
Plot screen.
Note: If you select multiple wells, the Multicomponent Plot screen displays
the data for all selected wells simultaneously.

3. From the Plot Color drop-down menu, select Dye.

4, Click E Show a legend for the plot (default).

Note: This is a toggle button. When the legend is displayed, the button changes to
Hide the plot legend.

5. Check the ROX dye signal. In the example experiment, the ROX dye signal
remains constant throughout the PCR process; a constant ROX dye signal
indicates typical data.

42 QuantStudio™ & and 7 Flex Real-Time PCR System Software Getting Started Guide for Standard Curve
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Section 5.1 Review Results 5
Confirm accurate dye signal using the Multicomponent Plot

6. Check the FAM dye signal. In the example experiment, the FAM dye signal
increases throughout the PCR process; increase in FAM dye signal indicates
normal amplification.

Well Table

Multicomponent Plot

Plot Settings

Flot Color IDye VI

I™ Save current settings as the default L2345 [e[7|s[9[w 11 12 13[14[15 |16 [17 [18 |19 20 |21 |22 [23 24|

. ) il L LT
A P aly i -
= | e [ | [ [ il I [ [ A
Multicomponent Plot {0 < 5 < P P 0 P 7 [

500,000 | | < < < < [ | P P P P P o o
450,000 |7 = = < | [
00.000 = |5 Y|P | Y [P [ A
350,000 Gﬂ11777nnnrllrlnnlnrlrlnnnnrlrlnn

a H

3 H

£ 300,000 F | < = Y i

@ .

2 250,000 1| e < =P [ Pl [

5

E} .

i 200,000 | < = < P P P [ e
150,000 (| e = = = 0 | |
100,000 | e = = = 0 | |
50,000 | < 5 <0 |

0 1| | < < < P PP PP PP
0o 2 4 @& & 10 12 14 18 1A 0 2 24 ¥ W/ N I 34 ¥ W 40 £ [ |
Cycle | | = <P 0 | |
Legend [ | < < 0 | |
M Far ElROX F
wls: [ 288 580 [ 16 0 Empty
well Summary: In Plate: 384 Sat Up: 384 Analyzed: 334 Flagged: 0 Omitted by Analysis: [ Orvitted Manwally: 0 Samples Used: 2 Targets Used: 1

7. Select the negative control wells one at time and check for amplification. In the
example experiment, there is no amplification in the negative control wells.

Multicomponent Plot

Plot Settings
Flat Color |Dye - :m:
I save current settings as the default 1 2 | 3 | 4 | 5 ‘ 6 ‘ 7 | 8 | 3 | 0 | 11 ‘ 12 |
2 P 5 i G = | C8|E S 5 S e I e o o o
Multicomponent Plot AW (s s lsi s ]S T T i I e
500,000
0000 A= sTsClsEs s T T Y
400,000
S wTsCs st s Is T T Y
%300.000 i
A wCsLs IsLs Is ol vl
= 000 A wCsLs Ists I T T O
ey — |
re—————————————————————— | N s s s s s | 10 O B o B o B
50,000
. | " sEs sEs Is T T O
a 2 4 L] & 10 12 14 16 1 M 2 M M M N 2 M ¥ ¥\ 40 2
Gycle
- N SIS Os s s, [0 [ I e
M Fan Il ROX _l;l
1] | 3
wells: [[ 288 [5] 80 [ 16 0 Empty
well Summary: In Plate: 334 Sat Up; 334 analyzed: 394 Flanged: 0 Smitked by Analysis: 0 Omitted Manualhy: O Samples Usad: 3 Targets Used: 1
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Determine signal accuracy using the Raw Data Plot

Tips for confirming  When you analyze your own standard curve experiment, look for:

dye accuracy in .
your own
experiment .

Passive reference — The passive reference dye fluorescence level should remain
relatively constant throughout the PCR process.

Reporter dye — The reporter dye fluorescence level should display a flat region
corresponding to the baseline, followed by a rapid rise in fluorescence as the
amplification proceeds.

Irregularities in the signal — There should not be any spikes, dips, and/or sudden
changes in the fluorescent signal.

Negative control wells — There should not be any amplification in the negative
control wells.

Determine signal accuracy using the Raw Data Plot

The Raw Data Plot screen displays the raw fluorescence signal (not normalized) for
each optical filter for the selected wells during each cycle of the real-time PCR.

Purpose In the standard curve example experiment, you review the Raw Data Plot screen for a
stable increase in signal (no abrupt changes or dips) from the appropriate filter.

View the Raw Data 1.

Plot

From the Experiment Menu pane, select Analysis » Raw Data Plot.

Note: If no data are displayed, click Analyze.

Display all 384 wells in the Raw Data Plot screen by clicking the upper left corner
of the plate layout in the Plate Layout tab.

Click E Show a legend for the plot (default). The legend displays the color
code for each row of the reaction plate (see the legend in the Raw Data Plot shown
below).
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Section 5.1 Review Results 5
Determine signal accuracy using the Raw Data Plot

4. Click and drag the Show Cycle pointer from cycle 1 to cycle 40. In the example
experiment, there is a stable increase in signal from filter 1, which corresponds to
the FAM™ dye filter.

Raw Data Plot <

£ L amE G

Raw Data Plot

550,000
500,000
450,000
400,000
350,000
300,000

=
=
? 250,000

200,000
150,000
100,000
50,000
0
x1-mi XZ"H? x3m3 x4 -"4 x5-m5
Filter
Legerd
|iA-ECDE.FIGH ;l|
=
Options
Show Cycle 40 H
T S S T S TS T S ST S S S
1 5) 10 15 20 23 30 33 40
well Summary: In Plate: 384 Set Up: 334 Anahyzed: 384 Flagged: 0 Onited by Analysis: 0 Omitted Manually: 0 Samples Used: 2 Targets Used: 1

The filters used for the example experiment are:

PCR Filter ca])

Emission Filter
ml(520+15) m2(558+11) m3(586+10) ma(623+14) mS(682+14) me(711+12)

x1(470£15)

x2(520£10)

x3(550+11)

Excitation Filter

%4(580+10)

¥5(640:£10)

x6(662+10)

Melt Curve Filter caT)

Emission Filter
ml(520£15) m2(558+11) m3(586=10) ma(623+14) mS(682+14) me(711+12)

*1(47015)

x2(520:£10)

¥3(550+11)

X4(5B0:£10)

Excitation Filter

*5(640+10)

X6(662:10)
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Tips for

determining signal
accuracy in your .
own experiments

Chapter 5 Review Results and Adjust Experiment Parameters
Review the flags in the QC Summary

Characteristic signal growth

* No abrupt changes or dips

Review the flags in the QC Summary

QC Summary

riay ounmnary |

When you analyze your own standard curve experiment, look for the following in
each filter:

The QC Summary screen displays a list of the QuantStudio™ 6 and 7 Flex Real-Time
PCR System Software flags, including the flag frequency and location for the open

experiment.

View the QC Summary

1. From the Experiment Menu pane, select Analysis » QC Summary.

Note: If no data are displayed, click Analyze.

2. Review the Flags Summary.

Note: A 0 displayed in the Frequency column indicates that the flag does not
appear in the experiment. If the frequency is >0, the flag appears somewhere in

the experiment; the well position is listed in the Wells column.

In the example experiment, there are no flagged wells.

3. In the Flag Details table, click each flag with a frequency >0 to display detailed
information about the flag. In the example experiment, the Frequency column
displays O for all flags.

4. (Optional) For those flags with frequency >0, click the troubleshooting link to view
information on correcting the flag.

Total wels:

384 | Processed Wells:

384 Manually Omitted wells:

0 | Targets Used:

Wells Set Up: 384 | Flagged wells: 0 Analysis Omitted Wells: 0 | Samples Used:
Flag Details
Flag: MNarne Frequency wells
AMPNC Amplfication in negative control

BADROK

Bad passive reference signal

(OFFSCALE

Fluorescence is offscale

HIGHSD

High standard deviation in replicate group

MOAMP

Mo amplification

MOISE

Maise higher than others in plate

IMaise spikes

Mo signal in well

Outlier in replicate group

SPIKE
MOSIGMNAL
QUTLIERRG
EXPRAIL

[Exponential algorithm faled

BLFATL

[Bazeline algorithm failed

THOLDFAIL

[Threshalding algarithrn faled

HEEEEEEEE

CTRAIL

ICT algorithm failed

Flag:
Flag Detail:

Flag Criteria:
Flagged Wells:

AMPNC—Amplification in negative contral

A sequence amplified in a negative control
reaction.

CT =350
Nore
Wit AMPHNC Troubleshooting Information

Summary:

46

Wells in Plate: 384

wells Set Up: 384 walls Analyzed: 384

wels Flagged: 0

Wels Omitted by Analysis: 0

wells Omitted Manually: 0

Samples Used: 2

Targets Used: 1
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Section 5.1 Review Results 5
For more information

Possible flags The flags listed below may be triggered by the experiment data.
Note: To change the flag settings, refer to “Flag Settings” on page 50.

Flag Description

Pre-processing flag
OFFSCALE Fluorescence is offscale

Primary analysis flags

BADROX Bad passive reference signal
NOAMP No amplification
NOISE Noise higher than others in plate
SPIKE Noise spikes
NOSIGNAL No signal in well
EXPFAIL Exponential algorithm failed
BLFAIL Baseline algorithm failed
THOLDFAIL Thresholding algorithm failed
CTFAIL Cy algorithm failed

Secondary analysis flags
OUTLIERRG Outlier in replicate group
AMPNC | Amplification in negative control
HIGHSD High standard deviation in replicate group

For more information

For more information on... Refer to... Publication
number
Publishing data Chapter 2 in Booklet 1, Getting Started with QuantStudio™ 6 and 7 4489822
Flex Real-Time PCR System Software Experiments
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For more information
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Section 5.2 Adjust parameters for re-analysis of your own experiments 5
Adjust analysis settings

Section 5.2 Adjust parameters for re-analysis of your
own experiments

Adjust analysis settings

The Analysis Settings dialog box displays the analysis settings for the threshold cycle
(Cy), flags, and advanced options.

If the default analysis settings in the QuantStudio'" 6 and 7 Flex Real-Time PCR
System Software are not suitable for your own experiment, you can change the settings
in the Analysis Settings dialog box, then reanalyze your experiment.

View the analysis 1. From the Experiment Menu pane, select Analysis.

settings 2. Click Analysis » Analysis Settings to open the Analysis Settings dialog box.

In the example experiment, the default analysis settings are used for each tab:
o (g Settings
¢ Flag Settings
* Advanced Settings
¢ Standard Curve Settings

The following is an image of the Analysis Settings dialog box for a Standard
Curve experiment:

12 Analysis Settings for QS6_QuantStudio_384-Well_Standard_Curve_Example

Flag Settings Advanced Settings Standard Curve Settings

* R the default settings for f targets in this experiment. To use different settings for a target, select the target from the table, deselect Use Default
Settings, then change the se

~— Data Step Selection Algorithm Settings
Select the step and stage to use for Ct analysis. Only stage/step combinations for which data suitable for Cr
analysis have been collected are displayed. Baseling Threshold «

Stage 2, Step 2 v

~— Default Ct Settings
Default CT settings are used to calculate the CT for targets without custom settings. To edit the default settings, dick Edit Default Settings.

Threshold: AUTO Baseline Start Cycle: AUTO Baseline End Cycle: AUTO

~— Select a Target ~— CT Settings for RNAse P
Target Threshold Baseline Start Baseline End CT Settings to Use: Default Settings
RMAse P AUTO AUTO AUTO A
v

Save to Library Load from Library Revert to Default Analysis Settings Apply Analysis Settings
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5 Chapter 5 Review Results and Adjust Experiment Parameters
Adjust analysis settings

3. View and, if necessary, change the analysis settings (see “Adjust analysis settings”
below).

Note: You can save the changes to the analysis settings to the Analysis Settings
Library for later use. For more information, see About the Analysis Settings
Library in Booklet 1, Getting Started with QuantStudio'" 6 and 7 Flex Real-Time PCR
System Software Experiments.

4. Click Apply Analysis Settings to apply the current analysis settings.

Note: You can go back to the default analysis settings, by clicking Revert to
Default Analysis Settings.

Adjust analysis Ct Settings
settings * Data Step Selection

Use this feature to select one stage/step combination for Ct analysis when there is
more than one data collection point in the run method.

* Algorithm Settings
Use the Baseline Threshold algorithm to determine the Ct values.

The Baseline Threshold algorithm is an expression estimation algorithm that
subtracts a baseline component and sets a fluorescent threshold in the exponential
region for gene quantification.

e Default Cy Settings

Use the default Cr settings feature to calculate Cr for the targets that do not have
custom settings. To edit the default settings, click Edit Default Settings.

® Cp Settings for Target
When you manually set the threshold and baseline, Life Technologies

recommends:
Setting Recommendation

Threshold Enter a value for the threshold so that the threshold is:
e Above the background.
¢ Below the plateau and linear regions of the amplification curve.
e Within the exponential phase of the amplification curve.

Baseline Select the Start Cycle and End Cycle values so that the baseline ends
before significant fluorescent signal is detected.

Note: This setting is applicable only to the Baseline Threshold algorithm.

Note: Selecting Automatic Threshold implies selection of automatic setting of the
baseline. However, if Automatic Threshold is deselected, then you can choose
between setting the baseline either automatically or manually.

Flag Settings
Use the Flag Settings tab to:

* Adjust the sensitivity so that more wells or fewer wells are flagged.

* Change the flags that are applied by the QuantStudio"" 6 and 7 Flex Real-Time
PCR System Software.

To adjust the flag settings

50 QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Getting Started Guide for Standard Curve
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Section 5.2 Adjust parameters for re-analysis of your own experiments
Adjust analysis settings

In the Use column, select the check boxes for flags to apply during analysis.

(Optional) If an attribute, condition, and value are listed for a flag, specify the
setting for applying the flag.

Note: If you choose to adjust the setting for applying a flag, make minor
adjustments as you evaluate the appropriate setting.

In the Reject Well column, select the check boxes if you want the software to reject
wells with the flag.

Note: After you have rejected the flagged wells, analysis results depend on
factors such as the experiment type and flag type. For example, rejecting wells
flagged by HIGHSD in experiments using the Standard Deviation calculations
may change the result of Ct SD. For some flags, analysis results calculated before
the well is rejected are maintained.

Click Apply Analysis Settings in the Analysis Settings dialog box. If the run
status is complete, the data are reanalyzed.

The following is an image of the Flag Settings tab:

Flag Settings Advanced Settings Standard Curve Settings

* Configure the flags and filtering. In this panel you can enable, disable, and configure flags, and indicate if a well is to be rejected when a flag is raised.

Flag Description | Use Attribute Condition Value Reject Well
AMPNC Amplification in negat... cr = + |35.000 O
BADROX Bad passive referenc... Bad passive referenc... |= + (0.600 O
OFFSCALE Fluorescence is offscale O
HIGHSD High standard deviati... Cr standard deviation |= + |0.500 O
NOAMP No amplification Amplification algorith... |< + |0.100 O
NOISE Moise higher than ot... Relative noise = + [4.000 O
SPIKE Moise spikes Spike algorithm result |= + [1.000 O
NOSIGMAL Mo signal in well [}
OUTLIERRG Qutlier in replicate ar... [}
EXPFAIL Exponential algorithm... [}
BLFAIL Baseline algorithm failed O
THOLDFAIL Thresholding algorith... [}
CTFAIL Cr algorithm failed [}

Revert to Default Analysis Settings Apply Analysis Settings W

Advanced Settings

Use the Advanced Settings tab to change baseline settings well-by-well.

To use custom baseline settings for a well-target combination:

1. Select one or more well-target combinations in the table.
2. Deselect the Use Ct Settings Defined for Target check box.
QuantStudio™ ¢ and 7 Flex Real-Time PCR System Software Getting Started Guide for Standard Curve 51
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5 Chapter 5 Review Results and Adjust Experiment Parameters
Improve Cr precision by omitting wells

3. Define the custom baseline settings:

¢ For automatic baseline calculations, select the Automatic Baseline check
box.

¢ To define the baseline, deselect the Automatic Baseline check box, then enter
the baseline start cycle and baseline end cycle.

Standard Curve Settings

Use this tab to review the settings of the current standard curve experiment or to
import the standard curve from an external experiment (with the same samples and
targets) and apply it to the current experiment.

Note: The run method must be the same. Life Technologies recommends using the
standard curve from the current experiment.

For the example experiment, the settings from the current experiment have been used.

12 Analysis Settings for QS6_QuantStudio_384-Well_Standard_Curve_Example

Cr Settings Flag Settings Advanced Settings

* Review the standard curve plots for each target. To use a standard curve from another experiment, dick Import.

~— Override Standard Curve

(®) Use the standard curve from this experiment
(O Use a3 standard curve imported from another experiment
~— Standard Curve View
[
205 T
2a.0 HH"-—-.%
28.5 Ry
28.0 ‘“‘-x-x_-
275 —
27.0 “'H\.lx
26.5 T
28.0 -""“-a-
100 [ A 0000 | O0e0e]
Reporter Target Slope Y-Intercept R(superscript 2) Efficiency(%)
FAM ‘RNAse P ‘—3.2?? 39.043 0.997 101.927 ‘A
v

Save to Library Load from Library

Apply Analysis Settings

Revert to Default Analysis Settings

Improve Ct precision by omitting wells

52

Experimental error may cause some wells to be amplified insufficiently or not at all.
These wells typically produce C values that differ significantly from the average for
the associated replicate wells. If included in the calculations, these outliers can result in
erroneous measurements; to ensure Ct precision, omit the outliers from the analysis.

1. From the Experiment Menu pane, select Analysis » Amplification Plot.

Note: If no data are displayed, click Analyze.

QuantStudio™ & and 7 Flex Real-Time PCR System Software Getting Started Guide for Standard Curve
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»| Plate Layout Well Table

menu.

a.
b.

Section 5.2 Adjust parameters for re-analysis of your own experiments

Select the Well Table tab.

In the Well Table, view outliers:

For more information

From the Group By drop-down menu, select Replicate.

In the Amplification Plot screen, select Ct vs Well from the Plot Type drop-down

Look for any outliers in the replicate group (make sure they are flagged).

Select the Omit check box next to outlying well(s), as shown in the following
image.

Group By ¥ Expand All
# | wiell | ornit. | Flag |Sample Na...lTarget Nau.l Task | Dyes T | CT Mean 7 SD | Quantity | Quiantity ... |Quamtlty SD | Comments
1 a1 r Rhase P NTC FAM-MFD-... Undetermi... B
2 A2 r RMHase P STANDARD  FAM-MFQ-.. 20.845 29.801 0.084 1,250
3 A3 r RMaze P STANDARD  FAM-MFQ-.. 28.855 28762 0.071 2,500
4 A4 r RMN&ze P STANDARD  FAM-MFQ-.. 27.837 27.858 0.055 5,000
5 A5 r RN#se P STANDARD  FAM-NFQ-.. 26,825 26,891 0,053 10,000
6 A6 r RHAsze P STANDARD  FAM-MFOQ-.. 25.831 25,804 0.047 20,000
7 AT r S RMHase P UNKNOWMN - FAM-MFQ-... 27.88 27828 0065 4,802.257  4,089.372 220,799
2 A r S RMHAze P UMKMNOWMN - FAM-MFO-... 27.806 27828 0065 5059029 4,089.372 220,799
9  AQ r 5K RMHaze P UMKMNOWN - FAM-MFQ-... 27.909 27828 0065 4,708,362 4,080.372 220,739
10 Al0 r = RMHase P UMKMNOWN - FAM-MFQ-... 27.875 27.828 0065 4,823,056 4,589.372 229.799
11 A1l r = RMaze P UNKMNOWN - FAM-MFQ-... 27.931 27.828 0065 4,634.604 4,089.372 229.799
12 Al2 r = RMN&ze P UMKMNOWMN  FAM-MNFQ-... 27.705 27.828 0065 5433725 4,080.372 229.799
13 Al13 r SK RN#se P UNKNOWM - FAM-NFQ-,.. 27.823 27.828 0065 4999525 4,989,372 229,799
14 Al4 r S RHAsze P UNKMOWN  FAM-MFQ-... 27.809 27828 0065 4,709,555 4,989.372 229,799
15 AlS r S RMHase P UNKMNOWMN - FAM-MFO-,.. 27.894 27828 0065 4,757,322 4,089.372 220,799
16 Al6 r 10K RMHAze P UNKMNOWMN - FAM-MFO-... 26,902 26,907 002 9550178 9,533.051 524.797
17 AL7 r 10K RMHaze P UMKMNOWMN - FAM-MFQ-... 26.907 26,907 002 9523245 9,533.051 524.797
15 Al8 r 10K RMHase P UMKMNOWN - FAM-MFQ-... 26,955 26,907 003 9,206,665 9,533.051 524.797
19 Al9 r 10K RMaze P UNKMNOWN - FAM-MFQ-... 26.849 26,907 003 9912618 9,533.951 524.797
20 A20 r 100K RMN&ze P UNKMNOWN - FAM-MNFQ-... 26,982 26,907 008 9028357 9,533.051 524.797
21 A21 r 10K RN#se P UNKNOWM - FAM-NFQ-,., 26,991 26,907 o0s 8977218 9,533,951 524,797
22 AZ2 r 10K RHAsze P UNKNOWN  FAM-MFO-... 26,974 26,907 0.0z 9,080.47 9,533.851 524.797
22 AZ3 r 10K RMHase P UMKMNOWMN - FAM-MFO-... 26,975 26,907 002 9,074,082 9,532.051 524.797
24 A24 r 10K RMHAze P UMKMNOWMN - FAM-MFO-... 26,915 26,907 002 9464632 0,532.0501 524.797
25 Bl r Rhase P NTC FAM-MFD-... Undetermi...
26 B2 r RMHase P STANDARD FAM-MFQ-.. 20.654 29.801 0.084 1,250
27 B3 r RMaze P STANDARD  FAM-MFQ-... 28.685 28762 0.071 2,500
28 B4 r RMN&ze P STANDARD FAM-MFQ-.. 27.820 27.858 0.055 5,000
29 BS r RN#se P STANDARD  FAM-NFQ-.. 26.85 26,891 0,053 10,000
30 Bo r RHAsze P STANDARD  FAM-MFOQ-.. 25.731 25,804 0.047 20,000
21 B7 r S RMHase P UNMKMNOWMN - FAM-MFO-.. 27,774 27828 0065 5175612 4,089.372 220,799
22 Be r S RMHAze P UNKMNOWMN - FAM-MFO-... 27.796 27828 0.065 5,097.28 4,080.372 220,799
32 B9 r 5K RMHaze P UMKMNOWMN - FAM-MFQ-... 27.871 27828 0065 4,834,492  4,080.372 220,739
34 Bl10 r = RMHase P UNKNOWMN - FAM-MFQ-... 27.94 27.828 0065 4,606,265 4,589.372 229.799
35 Bll r = RMaze P UNKMNOWN - FAM-MFQ-... 27.935 27.828 0065 4623702 4,080.372 229.799
36 Bl12 r = RMN&ze P UMKMNOWN - FAM-MNFQ-... 27.859 27.828 0065 4,676,215 4,080.372 229.799 ;I
P — — P e P e
well Summary: In Plate: 384 Set Up: 384 Analyzed: 384 Flagged: 0 Omitted by Anabysis: Ormitted Manualky: O Samples Used: 2 Targets Used: 1

5. Click Analyze to reanalyze the experiment data with the outlying well(s)
removed from the analysis.

Note: You can also omit undesirable wells in an experiment from the Plate Layout
screen. To omit a well from the Plate Layout screen, right-click the well and select
Omit.

For more information

For more information on Refer to Publication
number
Amplification efficiency Amplification Efficiency of TagMan® Gene Expression Assays 127AP05-03
Application Note.
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For more information
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Export Experiment Results

1. Open the Standard Curve example experiment file that you analyzed in
Chapter 5.

2. In the Experiment Menu, click E ;—'_— Export.

Note: To export data automatically after analysis, select the Auto Export check
box during experiment setup or before running the experiment. Auto export is
unchecked for the example experiment.

3. Select QuantStudio™ 6 and 7 format.

4. Complete the Export dialog box as shown below:

Field or Selection Entry

Select Data to Results

export/ Select

Content

Export Data To One File

Export File Name QS6_QuantStudio_384-Well_Standard_Curve_Example_data

File Type * txt

Export File Location | C:\Applied Biosystems\QuantStudio 6 and 7 Flex
Software\User Files\Export
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Chapter 6 Export Experiment Results

Your Export screen should look like this:

[ Auto Expart Format : |QuantStudiD ™6 and 7 v| Export Data To: (2 One File () Separate Files Open file(s) when export is complete

Export File Location: |C:\App|\ed Biosyste ms\QuantStudio 6 and 7 Flex Softwar| Export File Mame: QS6_QuantStudio_384-Well_Standa rd_Curve| File Type: ||"’E] (=) w

[ Raw Data Amplification [ Multicomponent Results

Select Content

elect Lonten Well Well Position Sample Name Sample Color Biogroup Name | Biogroup Color | Target Name il
All Fields & 1A1 RNAse P RG A
2A2 RiAse P RG

Vel 3A3 RiAse P RG

el Position 4 A4 RMAse P RG

545 RNAse P RG

sample Name 6 A6 RMAse P RG

747 5K RGB(132,193,241) RNAse P RG

sample Color 8 A8 5K RGB(132,193,241) RMAse P RG

8 " 949 5K RGB(132,193,241) RNAse P RG

logroup Name 10 A10 5K RGB(132,193,241) RiAse P RG

Biogroup Color 11A11 5K RGB(132,193,241) RNAse P RG

12 A12 5K RGB(132,193,241) RNAse P RG

Target Name 13A13 5K RGB(132,193,241) RNAse P RG

14 Al4 5K RGRB(132,193,241) RNAse P RG

Target Color 1 15415 5K RGB(132,193,241) RNAsa P RG

16 A16 10K RGB(168,255,222) RNAse P RG

Task 17 A17 10K RGB(168,255,222) RiAse P RG
Reporter 18 A18 10K RGB(168,255,222) RNAse P RG v

Ml (& | ¥

[m Save Export Set As Load Export Set Delete Export Set

Your exported file when opened in Notepad should look like this:

B Q56_OQuantStudio_384-Well_Standar
File Edit Format View Help

[ Block Type = 384-well Block A
calibration Background is expired = yes

Calibration Background performed on = 01-29-2010
Calibration HRM MELTDOCTOR 15 expired = ves

Calibration HRM MELTDOCTOR performed on = 01-14-2010
Calibration Normalization FAM-ROX is expired = ves
Calibration Normalization FAM-ROX performed on 01 29-2010
calibration Normalization vIC-ROX 15 expired =

calibration Normalization vIC-rROX performed on 01 29-2010
Calibration Pure Dye FAM is expired = Yes

Calibration Pure Dye FAM performed on = 01- 29 20].0
Calibration Pure Dye MELTDOCTOR is exp1red

calibration Pure Dye MELTDOCTOR performed on 0]. 14-2010
calibration Pure Dye NED is expired =
Calibration Pure Dye NED performed on =
Calibration Pure Dye ROX s expired = ve
Calibration Pure Dye ROX performed on =
calibration Pure Dye SYBR is expired = ve
Calibration Pure Dye SYBR performed on = ].2 28-2009
Calibration Pure Dye TAMRA 15 expired = Yes
Calibration Pure Dye TAMRA performed om = 12-28-2009
Calibration Pure Dye VIC is expired =

_Curve_Example_data.txt - Not

*

].2 28-2009
01 29-2010

calibration Pure Dye VIC perfurmed on 01 29-2010
calibration rROI 15 expired = yes

Calibration ROI performed on = 01-29-2010
calibration uniformity is exp'lr'ed = Yes

calibration uniformity performed on = 01-29-2010

Chemistry = TAQMAN

Date Created = 2013-07-05 12:04:07 PM SGT

Experiment Barcode = NA

Experiment Comment = NA

Experiment File Name = C:\Program Files‘\Applied Biosystems\QuantStudio & and 7 Flex
Smftware\examp?es\qSEFTex\qsﬁ 384-well_standard_curve_Example. eds

* Experiment Name = Qs6_ quantstudm 384-well_standard_curve_gxample
= EXperiment Run End Time 2010-02-01 15:02:10 PM sSGT

Experiment Type = standard curve

Instrument Name = NA

Instrument Serial Number = 278880018

Instrument Type = quantstudio(TM) 6 Flex system

Passive Reference = ROX

quantification cyc'\e Method =

signal smoothing on = true

stage/ Cycle where Ana1ysﬁ5 is performed = 5tage 2, step 2

User Name = NA

EoROE R L RO K O X E R KN EEE KK EEHEEEEE T K

F

%

EEEEEEE]

[Sample Setup]

wWell wWell Position  Sample Name Sample Color Biogroup Name Biogroup Color Target Name Target Color Task
Reporter quencher Quantity Comments
1 Al RNAse P "RGB(139,189,249)" NTC FAM NFQ-MGB
2 A2 RNASe P "RGB(139,189,249)" STANDARD FAM NFQ-MGB "1, 250.000"
3 A3 RNAse P "RGB(139,189,249)" STANDARD FAM NFQ-MGB "2, 500.000"
4 Al RNASe P "RGE(139,189,249)" STANDARD FAM NFQ-MGE "5, 000, 000"
5 A5 RNASe P "RGE(139,189,249)" STANDARD FAM NFQ-MGE ""10, 000, 000"
6 AB RNAse P "RGE(139,189,249)" STANDARD FAM NFQ-MGB "'20, 000. 000"
7 AT 5K "RGB(132,193,241)" RNASE P "RGB(139,189,249)" UNKNOWN FAM NFQ-MGB
8 A8 SK "RGB(132,193,241)" RNAse P "RGB(139,189,249)" UNKNOWN FAM NFQ-MGB
v
.M . . .
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adjusting analysis settings 49
adjusting parameters, re-analyzing own
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amplification plot
amplification efficiency 15, 33, 53
assessing amplification results 33
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reviewing outliers 36
reviewing threshold values 35
tips for analyzing own experiments 36
viewing 24, 34
AMPNC flag 47
analysis results, exporting 55
Analysis Settings
Advanced Settings 49
Cr Settings 49
Flag Settings 49
Standard Curve Settings 49
Analyze
Amplification Plot 33
Multicomponent Plot 42
QC Summary 46
Raw Data Plot 44
Standard Curve Plot 31
Well Table 39
Auto Export 55
Automatic Threshold 50

BADROX flag 47
baseline values, correcting 38
BLFAIL flag 47

C

cocktail mix 19
components
reaction mix 17
reaction plate 20
correlation coefficient 33

Index

Cr settings
algorithm settings 50
data step, selecting 50
default 50
target 50
Cr Settings tab 50
CTFAIL flag 47

D
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PART 1
Running Relative Standard Curve Experiments






About Relative Standard Curve
Experiments

This chapter covers:
B About Relative Standard Curve experiments. ...................... ... ..., 11

B About the example experiment .............. ... ... o i 13

IMPORTANT! First-time users of the QuantStudio'" 6 and 7 Flex Real-Time PCR System
Software, please read Booklet 1, Getting Started with QuantStudio™ 6 and 7 Flex Real-
Time PCR System Software Experiments and Booklet 7, QuantStudio™ 6 and 7 Flex Real-
Time PCR System Software Experiments - Appendixes of this binder thoroughly. The
booklets provide information and general instructions that are applicable to all the
experiments described in this binder.

Note: For more information about any of the topics discussed in this guide, access the
Help from within QuantStudio™" 6 and 7 Flex Real-Time PCR System Software by
pressing F1, clicking € in the toolbar, or selecting Help » QuantStudio™ 6 and 7 Flex
Real-Time PCR System Software Help.

About Relative Standard Curve experiments

The Relative Standard Curve method is used to determine relative target quantity in
samples. The QuantStudio ™ 6 and 7 Flex Real-Time PCR System Software measures
amplification of the target and of the endogenous control in samples, in a reference
sample, and in a standard dilution series. Measurements are normalized using the
endogenous control. Data from the standard dilution series are used to generate the
standard curve. Using the standard curve, the software interpolates target quantity
and endogenous control quantity in the samples and the reference sample. For each
sample and reference sample, the target quantity is normalized by endogenous control
quantity (quantity of target/quantity of endogenous control). The normalized quotient
from samples is divided by the quotient from the reference sample to get relative
quantification (fold change). The software determines the relative quantity of target in
each sample by comparing target quantity in each sample to target quantity in the
reference sample.

Relative Standard Curve experiments are commonly used to:
¢ Compare expression levels of a gene in different tissues.
* Compare expression levels of a gene in a treated sample and an untreated sample.
¢ Compare expression levels of wild-type alleles and mutated alleles.

¢ Analyze the gene expression changes over time under specific treatment
conditions.
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1 Chapter 1 About Relative Standard Curve Experiments
About Relative Standard Curve experiments

The Comparative CT (AACT) method is used to determine the relative target quantity
in samples. With the comparative Ct method, the QuantStudio™ 6 and 7 Flex Real-
Time PCR System Software measures amplification of the target and of the
endogenous control in samples and in a reference sample. For more information on
Comparative CT (AACr) experiments, refer to Part II, Running Comparative CT (AACr)
Experiments of this booklet.

Assemble required .
components .

Sample — The tissue group that you are testing for a target gene.

Reference sample (also called a calibrator) — The sample used as the basis for
relative quantification results. For example, in a study of drug effects on gene
expression, an untreated control is an appropriate reference sample.

Standard — A sample that contains known quantities of the target; used in
quantification experiments to generate standard curves.

Standard dilution series — A set of standards containing a range of known
quantities. The standard dilution series is prepared by serially diluting standards.

Endogenous control — A gene that is used to normalize template input
differences, and sample-to-sample or run-to-run variation.

Replicates — The total number of identical reactions containing identical
components and identical volumes.

Negative controls — Wells that contain water or buffer instead of sample template.
No amplification of the target should occur in negative control wells.

PCR options When performing real-time PCR, choose between:

Singleplex and multiplex PCR (below)
and
1-step and 2-step RT-PCR (page 13)

Singleplex and Multiplex PCR

You can perform a PCR reaction using either:

Singleplex PCR - In singleplex PCR a single primer and probe set is present in
the reaction tube or well. Only one target or endogenous control can be amplified
per reaction.

Or

Multiplex PCR — In multiplex PCR, two or more primer and probe sets are
present in the reaction tube or well. Each set amplifies a specific target or
endogenous control. Typically, a probe labeled with FAM™" dye detects the target
and a probe labeled with VIC® dye detects the endogenous control.

IMPORTANT! SYBR® Green reagents cannot be used for multiplex PCR.

- O L [ Target Primer Set
O
N 3 ©0 (O Endogenous Control
7 Primer Set
. ~~ cDNA
Singleplex PCR Multiplex PCR
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Chapter 1 About Relative Standard Curve Experiments 1
About the example experiment

1- and 2-Step RT-PCR

You can perform reverse transcription (RT) and PCR in a single reaction (1-step) or in
separate reactions (2-step). The reagent configuration you use depends on whether
you are performing 1- or 2-step RT-PCR:

¢ 1-step PCR-In 1-step RT-PCR, RT and PCR take place in one buffer system.
Using one buffer system provides the convenience of a single-tube preparation
for RT and PCR amplification. However, you cannot use Fast PCR Master Mix or
the carryover prevention enzyme, AmpErase® UNG (uracil-N-glycosylase), to
perform 1-step RT-PCR.

e 2-step PCR- 2-step RT-PCR is performed in two separate reactions: First, total
RNA is reverse-transcribed into cDNA, then the cDNA is amplified by PCR. This
method is useful for detecting multiple transcripts from a single cDNA template
or for storing cDNA aliquots for later use. The AmpErase® UNG enzyme can be
used to prevent carryover contamination.

About the example experiment

To illustrate how to perform a Relative Standard Curve, this guide leads you through
the process of designing and performing an example experiment. The example
experiment represents a typical setup that you can use to quickly familiarize yourself
with the QuantStudio™" 6 and 7 Flex Real-Time PCR System Software.

The objective of the Relative Standard Curve example experiment is to compare the
expression of the FAS transcriptional factor (an oncoprotein that activates the
transcription of growth-associated genes) in Human cDNA tissues.

In the Relative Standard Curve example experiment:
® The samples are kidney, liver, brain, and heart.
¢ The target is FAS.

* The endogenous control is HPRT.
* The reference sample is brain.

* One standard curve is set up for FAS. The standard used for the standard dilution
series is a Human cDNA sample of known total concentration.

* One standard curve is set up for HPRT (endogenous control). The standard used
for the standard dilution series is a Human Male Raji cDNA sample of known
total concentration.

* Reactions are set up for 2-step RT-PCR. The Invitrogen VILO Kit is used for
reverse transcription; the TagMan® Gene Expression Master Mix (2X) is used for
PCR.

* Select primer and probe sets from the Life Technologies TagMan® Gene
Expression Assays product line:

— For the target assay (FAS), select assay ID Hs00907759_m1.
— For the endogenous control assay (HPRT), select assay ID Hs99999909_m1.
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and Comparative Cy Experiments



1 Chapter 1 About Relative Standard Curve Experiments
About the example experiment
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Design the Experiment

This chapter explains how to design the example experiment from the Experiment
Setup menu.

This chapter covers:

B Define the experiment properties. . ............. ... ...t 15

Define targets, samples, and biological replicates. ......................... 16
B Assign targets, samples, and biological groups............. ... ... oo 17
B Setuptherunmethod....... ... ... ... 19
B Tips for designing your own experiment............... ... ..., 20
B Formoreinformation. .......... ... .. 21

Note: To automatically export the analyzed data to a specified location, select the Auto
Export task from the Export screen, before running the experiment. For more
information on Auto Export, refer to Chapter 2 in Booklet 1, Getting Started with
QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments.

Define the experiment properties

Click Experiment Setup » Experiment Properties to create a new experiment in the
QuantStudio™ 6 and 7 Flex Software. Enter:

Field or Selection Entry
Experiment Name QSé_QuantStudio_384-Well_Relative_Standard_Curve_Example
Barcode Leave field empty
User Name Example User
Comments Relative Standard Curve example
Instrument type QuantStudio™ 6 Flex System
Block 384-Well Block
Experiment Type Relative Standard Curve
Reagents TagMan® Reagents
Ramp speed Standard
Reagent information NA

Save the experiment.

QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Getting Started Guide for Relative Standard Curve 15
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Chapter 2 Design the Experiment

Define targets, samples, and biological replicates

Your Experiment Properties screen should look like this:

How do you want to identify this experiment?

* Experiment Name: | QS6_QuantStudio_384-well_Relative_Standard_Curve_Example Comments: |Relative Standard Curve Experiment 25
Barcode:
User Mame: |Example User -

Which instrument type are you using to run the experiment?

s QuantStudio™ 6 Flex System | [ QuantStudio™ 7 Flex System }

| 384-well | [ 96-well (0.2mL} } [ Fast 96-Well (0.1mL) ]

[ standard Curve ] [ Relative Standard Curve | [ Comparative CT (AACT) ] [ Melt Curve ]

[ L ] [ TR ]

Which reagents do you want to use to detect the target sequence?

| TagMan® Reagents | [ SYBR® Green Reagents } [ other ]
What properties do you want for the instrument run?
( standard ] [# Fast |

What is the reagent information?

Iewe

Type Name Part Number Lot Number Expiration Date

Define targets, samples, and biological replicates

Click Define to access the Define screen. Enter:

1. Targets
Target name Reporter Quencher Color
FAS FAM NFQ-MGB [
HPRT VvIC NFQ-MGB
2. Samples
Sample name Color
Brain
Heart [ ]
Kidney [}
Liver |

3. Dye to be used as a Passive Reference

ROX
4. Custom Task Name
Not applicable
16 QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Getting Started Guide for Relative Standard Curve
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Chapter 2 Design the Experiment 2
Assign targets, samples, and biological groups

5. Analysis Settings

Field Select
Reference Sample Brain
Endogenous Control HPRT

Your Define screen should look like this:

SavetoLibrary  Import from Library

B import from Fie
Target Name Reporter Quencher Color
Sample Name Color
FAS FAM ~ |NFQ-MGB v|. v
Brain v
HPRT VIC w [NFQ-MGB V| v
Heart |. -
Kidney |. v
Liver |. v

Biological Replicate Groups

Analysis Settings

Biological Group Name Color Comments
Reference Sample: |Brain ~
Endogenous Controk |HPRT w
Passive Reference Custom Task Name
ROX v Celete

Name Color

Icon Char

Note: This example experiment does not define biological replicate groups. Leave
Biological Replicate Groups blank.

Assign targets, samples, and biological groups

Click Assign to access the Assign screen.

Note: To automatically set up and assign standards, click s sfnesndseipStndarde | ¢, oryen
the Define and Set Up Standards dialog box.
To assign the targets and samples:
1. Set up the standards.
2. For the first standard for the FAS target:
a. Click-drag to select wells A9-A16.
b. Check check box next to FAS in the Targets list.
c. Select S in the Task drop-down menu.
d. Enter 625 in the Quantity column.
QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Getting Started Guide for Relative Standard Curve 17
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Chapter 2 Design the Experiment
Assign targets, samples, and biological groups

e. Repeat steps a through c for each of the standards for the FAS target,
selecting the wells listed in the table below, and entering the corresponding

quantity.

epeat step 2 for each standard for the HPRT target.
UEDLIS Well number Task Quantity Sl
name name
FAS A1 - A8 Negative None None
E1-E12 Unknown | Determined by Kidney
run
E13 - E24 Unknown | Determined by Heart
run
M-112 Unknown Determined by Liver
run
113 - 124 Unknown Determined by Brain
run
A9 - A16 Standard 625 None
A17 - A24 Standard 2,500 None
C1-C8 Standard 312.50 None
C9 - C16 Standard 1,250 None
C17 - C24 Standard 5,000 None
HPRT P1- P8 Negative None None
H1 - H12 Unknown | Determined by Kidney
run
H13 - H 24 Unknown | Determined by Heart
run
L1-L12 Unknown Determined by Liver
run
L13 - L24 Unknown Determined by Brain
run
N1 - N8 Standard 165.25 None
N9 - N16 Standard 625 None
N17 - N24 Standard 2,500 None
P9 - P16 Standard 312.50 None
P17 - P24 Standard 1,250 None

QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Getting Started Guide for Relative Standard Curve
and Comparative Cy Experiments



., Define and Set Up Standards

Targets

oo Tt o
FAS ivl vI

Chapter 2 Design the Experiment
Set up the run method

Your Assign screen should look like this:

Well Table

Plate Layout

6 |8 [ [t [z [ 13[4 [15 16 [17 (18[9 [20 [21 [22 [z [ 24 |

fdd 000 odoDEe B B B EE BB EEEE B @3

] e 2 |
Samples —0o (")
O Brain
O Heart
O Kidney
O Liver

Biological Groups =

ZH!‘Wﬁﬁﬂﬁﬁﬁﬁﬂﬁﬂﬁ“ﬁ"ﬁ“ﬁ"ﬁ“ﬁ“ﬁ“ﬁ“ﬁ"#ﬁ?#

HE B BB BB E BB E B EEEEEEEEE 3B

o e e b e e e e e e e o it bl

AOBBBABIBIBD T TRy

FHRFFFFFFFFFS S A6 A S 66 @0

[ Il I I s R Y I = = s < = = s s = = < = = = = I s

wels: [[] 96 5] 80 [ 16

192 Empty

Set up the run method

QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Getting Started Guide for Relative Standard Curve

Click Run Method to access the Run Method screen. Set the thermal profile under the

Graphical View tab. Enter:
¢ Reaction Volume Per Well: 10 uL

e Thermal Profile

Stage Step Ramp rate = Temperature Time
Hold Stage Step 1 1.6°C/s 50°C 2 minutes
' Step 2 1.6°C/s 95°C 10 minutes
PCR Stage . Step 1 1.6°C/s 95°C 15 seconds
Number of Cycles: 40 Step 2 1.6°C/s 60°C 1 minute

Enable AutoDelta:
Unchecked (default)

Starting Cycle: Disabled
when Enable AutoDelta is
unchecked

and Comparative Cy Experiments
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Chapter 2 Design the Experiment
Tips for designing your own experiment

Your Run Method screen should look like this:

Run Method

Reaction volume per well: | 10 pL

Hold Stage

PCR Stage

Mumber of Cycles: |4D :’
7 Enable AutoDelta

Starting Cyde: Il 3:

100

75 °C |

50 °C—|

25 °C |

95.0 °C 95.0 °C
10000 L6°Cis pois \
. 1E-2C/s
1.6 °Cfs 600 °C
50.0 °C 01:00
0z:00
16 °Cfs RO
Step Stepz Step Step2

4

’— Legend

Data Collection On =

Data Collection Off A AutoDelta Cn A AutoDelta Off

Tips for designing your own experiment
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Life Technologies recommends that you:

Set up a standard curve for each target assay in the reaction plate.

Identify each target assay with a unique name and color. You can enter up to 100
characters in the Target Name field.

Identify each sample using a unique name and color. You can enter up to 100
characters in the Sample Name field.

Select an endogenous control for each sample. The endogenous control is a target
that is present in all samples under investigation. It should be expressed equally
in all sample types, regardless of treatment or tissue origin (examples of
endogenous controls are B-actin, GAPDH, and 18S ribosomal RNA [185 rRNA]).
The endogenous control is used to normalize the PCR results; the endogenous
control corrects for variable sample mass, nucleic acid extraction efficiency,
reverse transcription efficiency, and pipette calibration errors.

Note: Each sample type (for example, each tissue in a study comparing multiple
tissues) requires an endogenous control.

Enter at least five dilution points for each standard curve in the reaction plate.

Enter at least three replicates (identical reactions) for each point in the standard
curve and for each sample reaction.

Enter at least three negative control reactions for each target assay.
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Chapter 2 Design the Experiment

For more information

¢ Carefully consider the appropriate range of standard quantities for your assay
because the range of standard quantities affects the amplification efficiency
calculations:

— For more accurate measurements of amplification efficiency, use a broad
range of standard quantities, spanning between 5 and 6 logs. If you do so,
use a PCR product or a highly concentrated template, such as a cDNA clone.

— If you have a limited amount of cDNA template and/or if the target is a low-
copy number transcript, or known to fall within a given range, a narrow
range of standard quantities may be necessary.

e Minimally run a five-point curve of 1:10 dilutions to minimize the effects of small
pipetting errors.

¢ Select a reference sample from your previously defined samples. Amplification
results from the samples and from the reference sample are compared to
determine relative expression.

* Select an endogenous control from your previously defined target assays.
Amplification results from the endogenous control are used to normalize the
amplification results from the target for differences in the amount of template
added to each reaction.

For more information

For more information on... Refer to... Publication
number

Consumables Chapter 1 in Booklet 1, Getting Started with QuantStudio™ 6 and 7 Flex 4489822
Real-Time PCR System Software Experiments
Appendix A in Booklet 7, QuantStudio™ 6 and 7 Flex Real-Time PCR
System Software Experiments - Appendixes

Using other quantification Booklet 2, Running Standard Curve Experiments and Part 2 of Booklet 4489822

methods 3, Running Relative Standard Curve and Comparative Cy Experiments.

Amplification efficiency Amplification Efficiency of TagMan® Gene Expression Assays Application 127AP05-03
Note

Using Alternative Setup Chapter 3 in Booklet 1, Getting Started with QuantStudio™ é and 7 Flex 4489822
Real-Time PCR System Software Experiments
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For more information
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Prepare the Reactions

This chapter explains how to prepare the PCR reactions for the Relative Standard
Curve example experiment.

This chapter covers:

B Assemble required materials ............. ... . o oL 23

Preparethetemplate ........ ... ... .. . 23
B Prepare thesampledilutions ............... ... ... i il 24
B Prepare the standard dilution series for FAS and HPRT assays.............. 24
B Prepare the reaction mix (“cocktail mix”)........... ... .. . it 25
B Preparethereactionplate........... ... o i i 26
m Tips for preparing reactions for your own experiments. .................... 28
B Formoreinformation............ ... ... . i 29

Assemble required materials

¢ Jtems listed in Booklet 1, Getting Started with QuantStudio™ 6 and 7 Flex Real-Time
PCR System Software Experiments

* Samples - Total RNA isolated from kidney, heart, liver, and brain tissues.
¢ Example experiment reaction mix components:

— TaqMan® Gene Expression Master Mix (2X)

— FAS Assay Mix (20X)

— HPRT Assay Mix (20X)

Note: Fast Universal Master Mix is not recommended to be used with the 96-well
(0.2 mL) reaction plates or reaction tubes and tube strips sealed with caps.

Prepare the template

Prepare the template for the PCR reactions (both samples and standards) using one of
the Invitrogen VILO kits, SuperScript® VILO™ cDNA Synthesis Kit (Part no. 4453650).

Example For the Relative Standard Curve example experiment, the template for the PCR
experiment reactions is cDNA reverse-transcribed from total RNA samples using the Invitrogen
settings VILO Kkits.

To prepare the Use the Invitrogen VILO kits to reverse-transcribe cDNA from the total RNA samples.
template Follow the procedures in the Invitrogen VILO Kits Protocol (Pub. no. 100002284) to:
QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Getting Started Guide for Relative Standard Curve 23
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Chapter 3 Prepare the Reactions

Prepare the sample dilutions

1. Isolate total RNA from cells using an Ambion® sample preparation kit
appropriate to the tissue or cell type.

2. Quantify and perform quality control on the RNA.

3. Convert the RNA to cDNA via reverse transcription.

Prepare the sample dilutions

For the Relative Standard Curve example experiment, no more than 10% of your
reaction should consist of the undiluted cDNA.
1. Label a separate microcentrifuge tube for each diluted sample:
¢ Kidney
¢ Heart
e Liver

¢ Brain

2. Add the required volume of water (diluent) to each empty tube:

Tube Sample name Diluent volume (pL)
1 Kidney 76
2 Heart 76
3 Liver 76
4 Brain 76

3. Add the required volume of sample stock (100 ng/uL) to each empty tube:

Tube Sample name Diluent volume (pL)
1 Kidney 4
2 Heart 4
3 Liver 4
4 Brain 4

4. Vortex each diluted sample for 3 to 5 seconds, then centrifuge the tubes briefly.

5. Place the diluted samples on ice until you prepare the reaction plate.

Prepare the standard dilution series for FAS and HPRT assays

The same standard materials are used to prepare the exact same dilutions for both the
target genes. The prepared standards are then used to generate the two standard
curves.

* The stock concentration for cDNA is 100 ng/uL.
* The volumes calculated for both the FAS and HPRT assays are:
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Chapter 3 Prepare the Reactions

Prepare the reaction mix (“cocktail mix”)

Standard Standard
name Dilution Source Diluent Total volume .
. Source concentration
(Labeled point volume (pL) = volume (pL) (pL)
(ng/pL)
tube)
Std. 1 1 Stock 20 20 40 100
Std. 2 2 Dilution 1 20 20 40 50
Std. 3 3 Dilution 20 20 40 25
Std. 4 4 Dilution 3 20 20 40 12.5
Std. 5 5 Dilution 4 20 20 40 6.25

1. Label ten separate microcentrifuge tubes for each diluted standard:
e FAS (FASStd. 1 - FAS Std. 5)
e HPRT (HPRT Std. 1 - HPRT Std. 5)

2. Prepare five standard dilutions each for FAS and HPRT:

Note: For dilution 1, first vortex the stock for 3 to 5 seconds, then centrifuge both
the Std. 1 tubes briefly before pipetting 10 pL stock into each Std. 1 tube.

3. For each subsequent dilution, add source to the standard:

a. Use a new pipette tip to add 10 pL of source to the FAS and HPRT tubes
containing the standard.

b. Vortex the tubes for 3 to 5 seconds, then centrifuge the tubes briefly.

4. Place the standards on ice until you prepare the reaction plate.

Prepare the reaction mix (“cocktail mix”)

1. Label an appropriately sized tube for each reaction mix:
¢ FAS Reaction Mix
¢ HPRT Reaction Mix

2. For the FAS assay, add the required volumes of each component to the FAS
Reaction Mix tube:

Volume (pL) for 1 Volume_ [uL) for 96
Component . reactions (plus
reaction
10% excess)

TagMan® Gene Expression 5 530
Master Mix (2X)

FAS Assay Mix (20X) 05 53
Water 3.5 371
Total Reaction Mix Volume 9 954

3. For the HPRT assay, add the required volumes of each component to the HPRT
Reaction Mix tube:
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3 Chapter 3 Prepare the Reactions
Prepare the reaction plate

Volume (pL) for 1 Volume: 1) o 0%
Component . reactions (plus
reaction
10% excess)

TagMan® Gene Expression 5 530
Master Mix (2X.)

HPRT Assay Mix (20X 0.5 53
Water 3.5 371
Total Reaction Mix Volume 9 954

Mix the reaction in each tube by gently pipetting up and down, then cap each
tube.

Centrifuge the tubes briefly to remove air bubbles.

Place the reaction mixes on ice until you prepare the reaction plate.

Note: Do not add the sample or standard at this time.

Prepare the reaction plate

Example
experiment
reaction plate
components

26

The reaction plate for the Relative Standard Curve example experiment contains:

A MicroAmp® Optical 384-Well Reaction Plate
Reaction volume: 10 pL/well

96 Unknown wells [T

80 Standard wells [

16 Negative control wells [1]

192 Empty wells

The following is an image of the plate layout for the example experiment:

1 z 3 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24

4 S 13 7 8 9
B |8 |8 |8 |8 |8 |5 |5 |s |s |5 |s |s |s s |s |s |s |8 |5 |5 _|s |

n‘o‘z‘z‘f‘x‘u‘— I‘m‘ﬂ‘m‘o‘m‘m

welis: [ 96 [ 80 [ 16 192 Empty
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Chapter 3 Prepare the Reactions

Prepare the reaction plate

To prepare the 1. For each target, prepare the negative control reactions:
reaction plate a. To an appropriate volume tube, add the volumes of reaction mix and water
components listed below.
. . Reaction mix Water volume
Tube Reaction mix
volume (pL) (pL)
1 FAS Reaction Mix 79.2 8.8
2 HPRT Reaction Mix 79.2 8.8

b. Mix the reaction by gently pipetting up and down, then cap the tube.
c. Centrifuge the tube briefly to remove air bubbles.

d. Add 10 pL of the negative control reaction to the appropriate wells in the
reaction plate.

2. For each replicate group, prepare the standard reactions:

a. To appropriately sized tubes, add the volumes of reaction mix and standard
listed below.

Standard Reaction Standard
Tube . Reaction mix | mixvolume Standard volume
reaction
(uL) (uL)
1 FAS Std. 1 FAS Reaction 79.2 FAS Std. 1 8.8
Mix
2 FAS Std. 2 FAS Reaction 79.2 FAS Std. 2 8.8
Mix
3 FAS Std. 3 FAS Reaction 79.2 FAS Std. 3 8.8
Mix
4 FAS Std. 4 FAS Reaction 79.2 FAS Std. 4 8.8
Mix
5 FAS Std. b FAS Reaction 79.2 FAS Std. 5 8.8
Mix
6 HPRT Std. 1 | HPRT 79.2 HPRT Std. 1 8.8
Reaction Mix
7 HPRT Std. 2 | HPRT 79.2 HPRT Std. 2 8.8
Reaction Mix
8 HPRT Std. 3 | HPRT 79.2 HPRT Std. 3 8.8
Reaction Mix
9 HPRT Std. 4 | HPRT 79.2 HPRT Std. 4 8.8
Reaction Mix
10 HPRT Std. 5 | HPRT 79.2 HPRT Std. 5 8.8
Reaction Mix

b. Mix the reactions by gently pipetting up and down, then cap the tubes.
c. Centrifuge the tubes briefly to remove air bubbles.

d. Add 10 pL of the standard reaction to the appropriate wells in the reaction
plate.
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Tips for preparing reactions for your own experiments

3. For each replicate group, prepare the reactions for the unknowns:

a. To appropriately sized tubes, add the volumes of reaction mix and sample
listed below:

Unknown Reaction Sample
Tube . Reaction mix | mixvolume | Sample volume
reaction
(L) (L)
1 FAS Kidney FAS Reaction 118.8 Kidney 13.2
Mix
2 FAS Heart FAS Reaction 118.8 Heart 13.2
Mix
3 FAS Liver FAS Reaction 118.8 Liver 13.2
Mix
4 FAS Brain FAS Reaction 118.8 Brain 13.2
Mix
5 HPRT HPRT 118.8 Kidney 13.2
Kidney Reaction Mix
6 HPRT Heart | HPRT 118.8 Heart 13.2
Reaction Mix
7 HPRT Liver HPRT 118.8 Liver 13.2
Reaction Mix
8 HPRT Brain | HPRT 118.8 Brain 13.2

Reaction Mix

b. Mix the reactions by gently pipetting up and down, then cap the tubes.

c. Centrifuge the tubes briefly to remove air bubbles.

d. Add 10 pL of the unknown (sample) reaction to the appropriate wells in the
reaction plate.

4. Seal the reaction plate with optical adhesive film.

5. Centrifuge the reaction plate briefly to remove air bubbles.

6. Confirm that the liquid is at the bottom of each well of the reaction plate. If not,
centrifuge the reaction plate again at a higher speed and for a longer period of

time.

7. Until you are ready to perform the run, place the reaction plate at 4°C, in the dark.

Tips for preparing reactions for your own experiments

Tips for preparing
templates

When you prepare your own Relative Standard Curve experiment, Life Technologies
recommends the following templates:

e Complementary DNA (cDNA) — cDNA reverse-transcribed from total RNA

samples.

* Genomic DNA (gDNA) - Purified gDNA already extracted from tissue or
sample
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Tips for preparing
sample dilutions

Tips for preparing
the reaction mix

Tips for preparing
the reaction plate

Chapter 3 Prepare the Reactions

For more information

When you prepare your own Relative Standard Curve experiment, for optimal
performance of TagMan® Gene Expression Assays or Custom TagMan® Gene
Expression Assays, use 10 to 100 ng of cDNA template per 10uL reaction.

If your experiment includes more than one target assay, prepare the reaction mix for

each target assay separately.

When you prepare your own Relative Standard Curve experiment, make sure the
arrangement of the PCR reactions matches the plate layout displayed in the

QuantStudio™ 6 and 7 Flex Software.

For more information

For more information on... Refer to... Publication
number
Assigning the reaction plate Chapter 2 in Booklet 1, Getting Started with QuantStudio™ é and 4489822
components 7 Flex Real-Time PCR System Software Experiments
Sealing the reaction plate Chapter 2 in Booklet 1, Getting Started with QuantStudio™ é and 4489822
7 Flex Real-Time PCR System Software Experiments
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For more information
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Run the Experiment

This chapter explains how to run the example experiment on the QuantStudio™ 6 or 7
Instrument.

This chapter covers:
B Starttherun......... .. 31

B Monitor the TUN. . . ..o 31

IMPORTANT! Run the experiment at the same ambient temperature at which you
calibrated the instrument. Extreme variations in ambient temperature can affect the
heating and cooling of the instrument and influence experimental results.

IMPORTANT! Do not attempt to open the access door during the run. The door is
locked while the QuantStudio " 6 or 7 Instrument is in operation.

Start the run

1. Open the Relative Standard Curve example file that you created using
instructions in Chapter 2.

2. Load the reaction plate into the instrument.

3. Start the run.

Monitor the run

Monitor the example experiment run:
* From the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software using the
Run screen, while the experiment is in progress.

¢ From the Instrument Console of the QuantStudio™ 6 and 7 Flex Real-Time PCR
System Software (to monitor an experiment started from another computer or
from the QuantStudio™ 6 or 7 Instrument touchscreen).

¢ From the QuantStudio™ 6 or 7 Instrument touchscreen.
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Chapter 4 Run the Experiment
Monitor the run

From the 1. In the Instrument Console screen, select the instrument icon.

Instrument 2. Click Manage Instrument or double-click on the instrument icon.

Console of the

QuantStudio™ 6 3. In the Manage Instrument screen, click Monitor Running Experiment to access
and 7 Flex Real- the Run screen.

Time PCR System

Software

View the Amplification Plot

You can view the progress of the run in real time. During the run, periodically view all
the three plots available from the QuantStudio™ 6 and 7 Flex Real-Time PCR System
Software for potential problems.

To view data in the Amplification Plot screen, click Amplification Plot from the Run
Experiment Menu, and select the Plate Layout tab, then select the wells that you want
to view.

The following is an image of the Amplification Plot screen as it appears at the end of
the example experiment.

01

ARN

Amplification Plot

0.0001 )
oooot ||| |

0.000001
2

Flate Layout

A2 p a T

X 2

xxl:!:l Showe in Wells W Select Wells =

Ampliﬁcation Plot 1t 2 3 4 5 & 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24

R

e e e e T ————— e e T e e e e —

T O Z E —~ = o = I @ M om g

32

QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Getting Started Guide for Relative Standard Curve
and Comparative Cy Experiments



Chapter 4 Run the Experiment
Monitor the run

View the Temperature Plot

To view data in the Temperature Plot screen, click Temperature Plot from the Run
Experiment Menu.

The following is an image of the Temperature Plot screen as it appears during the
example experiment.

Run Status

Run Status:

Estimated Time Remaining: 00:00:00
Run Started at: 12,/10,/09 6:58 PM Run Complete at:8:29 PM

Instrument Name: None

Temperature Plot current Temperatures

2 P B ILE] g ‘i.ﬂ, ¥ [ Cover 104.8°C
v Ml sample 25.1°C
Temperature Plot -+ Block 24.9°C
10
100
ao 7 f N
=)
m 70 J
Eso. »-—JI -—J-J.!-r—J.-r ;___J.,.___J. L i L ] L
§ 50
g
40
ao 1’1
20
10
a Temperature Plot
00:33:20 00:45:50 00:50:00 00:54:10 00:58:20 01:02:30 01:08:40 01:10:50 01:15:00 o1:1@:10 01:23:20 01:27:30 01:31
Time Wiew 1 Hour hd
Fixed Wigw [T
A »
Note: The Sample temperature displayed in the Current Temperatures group is an
estimated value.
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Monitor the run

View the Run Method

To view data in the Run Method screen, click Run Method from the Run Experiment
Menu.

The following is an image of the Run Method screen as it appears in the example

experiment.
Run Method Edit Run Method
Adjust # of Cycles;
Hold Stage PCR Stage
Murmber of Cycles: I4E| j [T 2dd Melt Curve Stage to End
[T Enable &utoDelta = add Holding Stage to End
starting Cycee: |1 = I add Infinite Hold to End
10:00 16°C/s 015 \6
: : 1.5-8Cfs
L6 °Cfs B0.0 °C
S0.0 T 01:00
02:00
igecis [T
Stept Step2 Step1 Step2
A »

Legend
Data Collection On = Data Colection Off A AutoDelta On A AutoDelta Off

View run data
To view the run data, click View Run Data from the Run Experiment Menu.

The following is an image of the View Run Data screen as it appears in the example
experiment:

Run Data Report
Experiment Name: QS56_QuantStudio_384-Wel Reltive_Standard_Curve_Pxample

Start Time: 12-10-2009 19:00:01 5GT
Stop Time: 12-10-2009 20:31:44 5GT
Run Duration: 91 minutes 42 seconds

User Name: DEFAULT

Instrument Name:

Firmware Version:

Software Version: NfA

Instrument Serial Number: 278880013
Sample Volume: 10.0
Cover Temperature: 105.0

Instrument Type:

Block Type: 384-Wel Block

Errors Encountered:
< b .
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Monitor the run

From the You can also view the progress of the run from the QuantStudio" 6 or 7 Instrument
QuantStudio™ é or  touchscreen.

7 Instrument The following are images of the Run Method screen on the QuantStudio™ 6 or 7
touchscreen Instrument touchscreen:

Experiment view

@ Time View Ht]  Experiment View
Run Started: July 06 2013 - 05:48PM Sample: 0.0 °C
Reaction Volume: 20 pL Heated Cover [Set Point): 105.0 °C (105.0 °C)
Time Remaining: 01:15:39
Stage 1 Stage 2
X1 3 of 40
95.0 °C 95.0 °C

- 10:00 0:15 N\ po.0%c
—— 1:00
2:00 a

July:06 2013 - 05:48PM o

Heated cover reached target temperature.

Time view
®© Time View tH|  Experiment View
Run Started: July 06 2013 - 05:48PM Sample: 95.0 °C

Reaction Yolume: 20 pL Heated Cover [Set Point): 105.0 °C (105.0 °C)

Stage /Step /Cycle: 1/2/1
@ Remaining Time . Elapsed Time
July 06 2013 - 05:48PM o
Heated cover reached target temperature.
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Monitor the run
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Review Results and Adjust
Experiment Parameters

In Section 5.1 of this chapter you review the analyzed data using several of the analysis
screens and publish the data. Section 5.2 of this chapter walks you through the process
of modifying experiment parameters to troubleshoot problems with experiment
results before rerunning an experiment.

This chapter covers:

B Section 5.1 Review Results .........cciiiiiiiiiiiiiiiiiiiiiiiiiiiine, 39
Analyze the example experiment. . ............. ... ... ... ool 39

B View the Standard Curve Plot ........ ... ... ... .. o i il 39
B Assess amplification results using the Amplification Plot................... 42
B Assess the gene expression profile using the Gene Expression Plot. .......... 49
B Identify well problems using the Well Table .............................. 51
B Confirm accurate dye signal using the Multicomponent Plot................ 53
B Determine signal accuracy using the Raw DataPlot ....................... 55
B View the endogenous control profile using the QCPlot .................... 57
B Review the QC flags in the QC Summary .............. ... .. ..., 58
B Formoreinformation. .......... ... 60
B Section 5.2 Adjust parameters for re-analysis of your own experiments .... 61
B Adjustanalysissettings......... ... .. 61
B Improve CT precision by omittingwells. . ............... ... ... .o o 65
B Formoreinformation. ............... i 66
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Section 5.1 Review Results

Analyze the example experiment

1.

Section 5.1 Review Results
Analyze the example experiment

Open the example experiment file that you ran in Chapter 4.

2. Click Analyze. The software analyzes the data using the default analysis settings.

You can also access the experiment to analyze from the Home screen.

View the Standard Curve Plot

Example
experiment
standard curve
values

To view and assess
the Standard Curve
plot

The Standard Curve Plot screen displays the standard curve for samples designated as
standards. The QuantStudio'" 6 and 7 Flex Real-Time PCR System Software calculates
the quantity of an unknown target from the standard curve.

In the standard curve example experiment, you review the Standard Curve Plot screen

for the following regression coefficient values:

Slope/amplification efficiency
R? value (correlation coefficient)

Cy values

. From the Experiment Menu pane, select Analysis » Standard Curve.

Note: If no data are displayed, click Analyze.

Display all 384 wells in the Standard Curve Plot screen by clicking the upper left
corner of the plate layout in the Plate Layout tab.

Enter the Plot Settings:
Menu Selection
Target All
Plot Color Default

(This is a toggle button. When the legend

is displayed, the button changes to Hide
the plot legend.)

Check (default)

4. View the values displayed below the standard curve. In the example experiment,
the values for each target fall within the acceptable ranges:

Amplification
2
Target Slope R4 Value efficiency (Eff%)
FAS -3.38 0.998 97.612
HPRT —-3.652 0.983 87.858
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View the Standard Curve Plot

5. Check that all samples are within the standard curve. In the example experiment,
all samples (blue dots) are within the standard curve (red dots).

Standard Curve <

Plot Settings

Target IAII A Plot Color IDefauIt hd

[ Save current settings as the default

32

Ell

30

Cr

29
28

27

Standard Curve

Legerd

1000 10000
Giuantity

Target: FAS Slope: -3.38 ¥-Inter: 39.356 Rz; 0.998 Eff%o: 97.612 Errer: 0.022

Tarqet: HPRT Slope: -3.652 Y-Inter: 40.028 R_Z,: 0.983 Effth: 87.858 Error: 0.077

. Standard . Unknown Unknowen (Flagged)

well Summary:

40

Set Up: 192 Analyzed: 192 Flagged: 0 Ornitted by Anabysis: 0 Qmnitted Manually: 0 Samnples Used: 4 Targets Used: 2

6. Check the Cy values:
7. Click the Well Table tab.

8. From the Group By drop-down menu, select Replicate.
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Section 5.1 Review Results 5
View the Standard Curve Plot

9. Look at the values in the Ct column. In the example experiment, the Ct values fall
within the expected range (>8 and <35).

»| Plate Layout Well Table

Show in Table ¥ Selectiiells ¥  Group By ¥ Expand all B Collapse Al
# | wel I omit | Flag ISamp.‘.I Target Name Task I Dyes ‘1| T T Mean CT 5D I Cuantity I Mormalize. .. | Mormalize... | Efficiency
209 117 r 1,000 RMase P LINKMNOWH FAM-NFO-MGE | 28,935 29,035 0.071 1,093.478 1.037 97,39~
210 118 r 1,000 RMase P UMKNOW FAM-MFQ-MGE | 29.038 209.035 0.071 1,019.329 1.037 97.39
211 119 r 1,000 RMase P LIMKMNOW M FAM-MFQ-MGE | 29,009 29.035 0.071 1,032,701 1.037 97.39
212 120 I 1,000 RMase P LINKMNOWH FAM-NFO-MGE | 20,048 29.035 0.071 1012421 1.037 97,39
213 121 r 1,000 RMHase P LINKMNOW N FAM-NFO-MGE | 29,073 29,033 0.071 995,587 1.037 97,39
214 122 r 1,000 RMase P UMKNOW FAM-MFQ-MGE | 29.055 209.035 0.071 1,007.571 1.037 97.39
215 123 r 1,000 RMase P LIMKMNOWI FAM-MFQ-MGE | 29,151 29.035 0.071 943,913 1.037 o739
215 124 I 1,000 RMase P LINKMNOWH FAM-NFO-MGE | 29,064 29,035 0.071 1,001.774 1.037 97,39
229 113 r 1,000 RMase P UMKNOW FAM-MFQ-MGE | 28.973 29.035 0.071 1,065.29 1.037 97.39
230 114 r 1,000 RMase P UIMKMNOW FaM-MFQ-MGE | 28.832 209.035 0.071 1,172.701 1.037 97.39
231 115 r 1,000 RMase P LIMKMNOWI FAM-MFQ-MGE | 28,935 29.035 0.071 1,078.69 1.037 o739
232 J16 r 1,000 RMase P LINKMNOWH FAM-NFO-MGE | 28,932 29,035 0.071 1,051.813 1.037 97,39
233 117 r 1,000 RMase P UMKNOW FAM-MFQ-MGE | 29.029 209.035 0.071 1,025.679 1.037 97.39
234 118 r 1,000 RMase P UIMKMNOW FAM-MFQ-MGE | 29.002 209.035 0.071 1,044.77 1.037 97.39
235 119 r 1,000 RMase P LIMKMNOWI FAM-MFQ-MGE | 29.044 29.035 0.071 1,015.042 1.037 o739
235 J20 r 1,000 RMase P LINKMNOWH FAM-NFO-MGE | 29.04 29,035 0.071 1,018.366 1.037 97,39
237 121 r 1,000 RMase P UMKNOW FaM-MFQ-MGE | 29.009 209.035 0.071 1,039.876 1.037 97.39
238 122 r 1,000 RMase P LIMKMNOW M FAM-MFQ-MGE | 29,085 29.035 0.071 987.252 1.037 o739
239 123 I 1,000 RMase P LINKMNOWH FAM-NFO-MGE | 29,21 29.035 0.071 906,946 1.037 97,39
240 124 r 1,000 RMHase P LINKMNOW N FAM-NFO-MGE | 29,071 29,033 0.071 995,517 1.037 97,39
233 K13 r 1,000 RMase P UMKNOW FAM-MFQ-MGE | 28.959 209.035 0.071 1,068.005 1.037 97.39
254 K14 r 1,000 RMase P LIMKMNOWI FAM-MFQ-MGE | 29,092 29.035 0.071 981,744 1.037 o739
255 K15 I 1,000 RMase P LINKMNOWH FAM-NFO-MGE | 29.018 29,035 0.071 1,033.374 1.037 97,39
256 K16 r 1,000 RMase P UMKNOW FAM-MFQ-MGE | 28.984 29.035 0.071 1,057.409 1.037 97.39
IET K17 1 I ‘ml 1 nnn Rhlaca O [N NI N FAMLRIET- SR 20 NdR 20 NS nn7 I 1N1d 225 1m27 O'FELI

well Summary: In Plate: 384 Set Up: 283 Analyzed: 283 Flagged: 0 Omitted by Analysis: 0 Omitted Manually: 0 Samples Used: 4 Targets Used: 2

Tips for analyzing When you analyze your own Relative Standard Curve experiment, look for:

your own * Slope/amplification efficiency values — The amplification efficiency is calculated
experiments using the slope of the regression line in the standard curve. A slope close to —3.3
indicates optimal, 100% PCR amplification efficiency. Factors that affect
amplification efficiency:
— Range of standard quantities — For more accurate and precise efficiency

measurements, use a broad range of standard quantities, 5 to 6 logs
(10 to 100 fold).

— Number of standard replicates — For more accurate efficiency measurements,
include replicates to decrease the effects of pipetting inaccuracies.

— PCR inhibitors — PCR inhibitors in the reaction can alter amplification
efficiency.

¢ R2values (correlation coefficient) — The R? value is a measure of the closeness of
fit between the regression line and the individual Cy data points of the standard
reactions. A value of 1.00 indicates a perfect fit between the regression line and
the data points. An R? value >0.99 is desirable.

® Cpvalues — The threshold cycle (Cy) is the PCR cycle number at which the
fluorescence level meets the threshold.

— A Cpvalue >8 and <35 is desirable.
— A Cpvalue <8 indicates that there is too much template in the reaction.

— A Cyvalue >35 indicates a low amount of target in the reaction; for Ct values
>35, expect a higher standard deviation.
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Assess amplification results using the Amplification Plot

If your experiment does not meet the guidelines above, troubleshoot as follows:

*  Omit wells (see “Improve CT precision by omitting wells” on page 65).

Or

* Rerun the experiment.

Assess amplification results using the Amplification Plot

Amplification plots
available for
viewing

Purpose

View the
Amplification Plot

The Amplification Plot screen displays amplification of all samples in the selected
wells. There are three plots available:

ARn vs Cycle — ARn is the magnitude of normalized fluorescence signal generated
by the reporter at each cycle during the PCR amplification. This plot displays ARn
as a function of cycle number. Use this plot to identify and examine irregular
amplification and to view threshold and baseline values for the run.

Rn vs Cycle — Rn is the fluorescence signal from the reporter dye normalized to
the fluorescence signal from the passive reference. This plot displays Rn as a
function of cycle number. Use this plot to identify and examine irregular
amplification.

Cr vs Well — Cr is the PCR cycle number at which the fluorescence meets the
threshold in the amplification plot. This plot displays Cr as a function of well
position. Use this plot to locate outlying amplification (outliers).

Each plot can be viewed as a linear or log10 graph type.

The purpose of viewing the amplification plot for the example experiment is to
identify:

Correct baseline and threshold values

Qutliers

. From the Experiment Menu pane, select Analysis » Amplification Plot.

Note: If no data are displayed, click Analyze.

Display the FAS wells in the Amplification Plot screen:
a. Click the Plate Layout tab.
b. From the Select Wells drop-down menu, select Target, then FAS.
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Assess amplification results using the Amplification Plot

The following is an image of the Plate Layout screen:

Well Table

Plate Layout

g g g g g Fryge g g g Y Frg g O TS S g i i i g g i e

wels: [ 96 [ 8o [ 16 192 Empty
well Summary: In Plate: 254 Set Up: 192 Anahyzed: 192 Flagged: 0 Oritted by Analysis: 0 Oritted Manualy: 0 Samples Used: 4 Targets Used: 2
3. In the Amplification Plot screen, enter:
Menu Selection
Plot Type ARn vs Cycle (default)
Plot Color Well (default)
|ﬁ Check (default]
(This is a toggle button. When the legend
is displayed, the button changes to Hide
the plot legend.)
4. View the baseline values:
a. From the Graph Type drop-down menu, select Linear.
b. Select the Baseline check box to show the start cycle and end cycle.
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Assess amplification results using the Amplification Plot

c. Verify that the baseline is set correctly: The end cycle should be set a few
cycles before the cycle number where significant fluorescent signal is
detected. In the example experiment, the baseline is set correctly.

Amplification Plot
Plot Settings

Plot Type: [ARN vs Cycle v[ Graph Type:|unear v[ Flot calar:lw'ell vl

[ Save current settings as the default

Amplification Plot

ARR

2 4 & 8 0 2 4 18 L3 20 22 24 M4 38 3 a0
Cycle
Options
Target: [FAS = | Threshold: W &uto 0,13 ¥ &uto Baseline
Show: [~ Threshold — W Baseline Start: Well B0 Target 4. Baseline End: Well (B Target £
well Summary: In Plate: 384 Set Up: 192 Analyzed: 102 Flagged: 0 Omitted by Analysis: 0 Omitted Manually: O Samples Used: 4 Targets Used: 2
5. View the threshold values:
Menu Select

Graph Type Log
Target FAS

a. Select the Threshold check box to show the threshold.

QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Getting Started Guide for Relative Standard Curve
and Comparative Cy Experiments

44



Section 5.1 Review Results 5
Assess amplification results using the Amplification Plot

b. Verify that the threshold is set correctly. In the example experiment, the
threshold is in the exponential phase.

Amplification Plot
Plot Settings

Flot Type: |ARn vs Cycle »| Graph Type: |Log v[ Plot Calor: [well vl

[ Save current settings as the default

®
ho)
e
&
R
&
if

Amplification Plot
1ED1

1EQD

0.1
0.m
=
73
0.001

0.0001

0.00001

0.000001

Options
Target: IFAS vIThreshald: ¥ Auto |0.139954

I futo Baseline

Showe: ¥ Threshold — [ Baseline Start: well 0 Target < Baseline End: Wel [l Target 4

well Summary: In Plate: 284 Set Up: 102 Analyzed: 102 Flagged: 0 Oritted by &nahysis: 0 Omitted Manually: O Samples Used: 4 Targets Usad: 2

6. Locate outliers:
a. From the Plot Type drop-down menu, select Ct vs Well.

b. Look for outliers from the amplification plot. In the example experiment,
there are no outliers for FAS.

Amplification Plot
Plot Settings

Plot Type: [CT vs Well vl Graph Type: IL\near -l Plot Color: |We|\ 'l

™ Sawe current settings as the default

Amplification Plot

40.0 Jumm
375
350
325
300 { b v
275 )

250
25
200
175
150
125
100
75
50
25
00

Cr

5 10 15 20 25 30 35 40 45 50 55 60 65 70 75 80 85 50 55100105 101 15120025 300 35140045 501 559606 651701750 501 551 SR SDHD0ER 1 (21 EXNEHD UG IDALD 7 (B 1532 | BTBED
Well Mumber

Well Summary: In Plate: 304 Set Up: 192 Analyzed: 102 Flagged: Omitted by Analysis: 0 Ornitted Marwally: 0 Sarnples Used: 4 Targets Used: 2

7. Repeat steps 2 through 6 for the HPRT wells.

QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Getting Started Guide for Relative Standard Curve 45
and Comparative Cy Experiments



5 Chapter 5 Review Results and Adjust Experiment Parameters
Assess amplification results using the Amplification Plot

Tips for analyzing When you analyze your own Relative Standard Curve experiment, look for:

your own e Qutliers

experiments * A typical amplification plot — The QuantStudio'" 6 and 7 Flex Real-Time PCR
System Software automatically calculates baseline and threshold values based on
the assumption that the data exhibit a typical amplification plot. A typical
amplification plot has four distinct sections:

— Plateau phase
— Linear phase
— Exponential (geometric phase)

— Baseline

A following is an image of a typical amplification plot:

Ampilification Plot
Plot Settings

Plot Type:lL\Rn vs Cycle =| Graph Type:i|Log =] Plot Color: {wel hd

[~ Save current settings as the default

PPl R E

B

Amplification Plot

1E01

1E00

01

00

LRn

0001 i 3
o.oom |/

oooom {0/

0.000001

Options
Target: IAII vl Threshald: [~ Auto T suto Baseline

Show: W Threshold — ¥ Baseline Start: Wel B0 Target . Baseline End: Well (B Target .

well Summary: In Plate: 384 Set Up: 288 Analyzed: 288 Flagged: 0 Cimitted by Analysic: 0 Ormitted Manually: 0 Samples Used: 4 Targats Used: 2

IMPORTANT! Experimental error (such as contamination or pipetting errors) can
produce atypical amplification curves that can result in incorrect baseline and
threshold value calculations by the QuantStudio'" 6 and 7 Flex Real-Time PCR
System Software. Therefore, Life Technologies recommends that you examine the
Amplification Plot screen and review the assigned baseline and threshold values
for each well after analysis completes.
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Assess amplification results using the Amplification Plot

e Correct threshold values.

Threshold Set Correctly 1e01

The threshold is set in the
exponential phase of the
amplification curve.

1E00

Threshold settings above
or below the optimum
increase the standard
deviation of the replicate
groups.

Threshold Set Too Low i

The threshold is set below 04
the exponential phase of
the amplification curve. - .
The standard deviation is a oo
significantly higher than 0.0001
that for a plot where the
threshold is set correctly.
Drag the threshold bar up
into the exponential phase
of the curve.

Threshold Set Too High ,

The threshold is set above o
the exponential phase of
the amplification curve. -

The standard deviation is 5 oo
significantly higher than oot {1
that for a plot where the
threshold is set correctly. EARE
Drag the threshold bar R R I I T R N e R X,
down into the exponential oree

phase of the curve.

ARN

0.001

0.00001

0.000001 *—

0ot

|
0.00001

¢ Correct baseline values

Baseline Set Correctly D s e s

The amplification curve
begins after the maximum 01
baseline. 0ot

0.001 4
0.0001

0.00001 1|/

0.000001
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Assess amplification results using the Amplification Plot

Baseline Set Too Low

The amplification curve
begins too far to the right
of the maximum baseline.
Increase the End Cycle
value.

ARN

0.0007 1"

0.00001

0.000001
2

0,001 43

Baseline Set Too High

The amplification curve
begins before the
maximum baseline.
Decrease the End Cycle
value.

AR

0.001

0.0001

0.00001

0.000001
2

8 10 12 14 B 1@ A0 2 H¥ X B/ N R M ¥ W £
Cycle

If your experiment does not meet the guidelines above, troubleshoot as follows:

Omit wells (see “Improve CT precision by omitting wells” on page 65).

Or

Manually adjust the baseline and/or threshold (see “Adjust analysis settings” on

page 61).
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Section 5.1 Review Results 5
Assess the gene expression profile using the Gene Expression Plot

Assess the gene expression profile using the Gene Expression Plot

The Gene Expression Plot screen displays the results of relative quantification
calculations in the gene expression profile. There are two plots available:

* RQ vs Target — Groups the relative quantification (RQ) values by target. Each
sample is plotted for each target. You can view the plot as the linear, log10, Ln,
and log2 graph types. The Gene Expression plot when viewed as a linear graph
type looks like this:

Gene Expression
Plot Settings

Plot Type: RQ wvs Target + Graph Type:|Linear |+ | Orientation: Vertical Bars “

[] save current settings as the default

RO
w

JCRU-RN-N N
RQ vs Target

51140

1.603

0.813

o

Target

Lege
Brain . Heart . Kidney . Liver

Well Summary:

QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Getting Started Guide for Relative Standard Curve

In Plate: 384

Set Up: 192 Analyzed: 192 Fiagged: 0 Omitted by Analysis: 0 Omitted Manusly: 0 Samples Used: 4 Targets Used: 2
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Assess the gene expression profile using the Gene Expression Plot

RQ vs Sample — Groups the relative quantification (RQ) values by sample. Each
target is plotted for each sample. You can view the plot as the linear, log10, Ln,
and log?2 graph types. The Gene Expression plot when viewed as a linear graph
type looks like this:

Gene Expression
Plot Settings

[] Save current settings as the default

Plot Type: RQ ws Sample «  Graph Type:|Linear |+ | Orientation: Vertical Bars »

RO
w
a

£ P B WK
RQ vs Sample

1.603

0.813

& \\w? Ea
Sample
e
MWras
Well Summary: In Piste: 384 SetUp: 192 Anahyzed: 192 Flegged: 0 Omitted by Anafysis: 0 Omitted Manually: () Samples Used: 4 Targsts Used: 2
Example Review each target in the Gene Expression Plot screen for the expression level (or fold

experiment values

View the Gene
Expression Plot

change) of the target sample relative to the reference sample.

1.

From the Experiment Menu pane, select Analysis » Gene Expression.

Note: If no data are displayed, click Analyze.

In the Gene Expression Plot screen:
a. From the Plot Type drop-down menu, select RQ vs Sample.
b. From the Graph Type drop-down menu, select Log10.

c. From the Orientation drop-down menu, select Vertical Bars.

Click E Show a legend for the plot (default).

Note: This is a toggle button. When the legend is displayed, the button changes to
Hide the plot legend.

50 QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Getting Started Guide for Relative Standard Curve

and Comparative Cy Experiments



Section 5.1 Review Results 5
Identify well problems using the Well Table

In the example experiment, the expression level of FAS in heart, kidney, and liver is
displayed relative to its expression level in the reference sample (brain). Since the
reference sample is compared to itself, the relative expression level is 1. When the
result is displayed in the Log10 graph type, the expression level of the reference
sample appears as 0 in the graph (log10 of 1 =0).

Gene Expression

Plot Settings

Plot Type: |RQ v= Sample w | Graph Type:|Logl0 v | Orientation: Vertical Bars ~

[[] Save current settings as the default

PP Al E =
RQ vs Sample

0.80
0.75
0.70
0.65
0.60
0.55
0.50
0.45

0708

(=}
& 0.40
© 035
g’ 0.30
0.28
0.20%5
0.20 —
015
010
0.05
o
0.00
-0.10 _0.00
o g A o
o & & &
Sample
e
Il -5
Well Summary: In Plate: 384 Set Up: 192 Anzhyzed: 192 Flagged: 0 Omitted by Anahysis: ) Omitted Manualy: 0 Samples Ussd: 4 Targets Used: 2

Assessing the gene  When you analyze your own Relative Standard Curve experiment, look for differences
expression plot in in gene expression (as a fold change) relative to the reference sample.

your own
experiments

Identify well problems using the Well Table

The Well Table displays data for each well in the reaction plate, including:
* The sample name, target name, task, and dyes

* The calculated threshold cycle (Ct), normalized fluorescence (Rn), and quantity

values
¢ Flags
Exampl_e Review the Well Table to evaluate the Ct precision of the replicate groups.
experiment values
and flags
View the well table 1. From the Experiment Menu pane, select Analysis » Amplification Plot, then click
the Well Table tab.
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Identify well problems using the Well Table

2. From the Group By drop-down menu, select Replicate.

3. Look at the C1 SD column to evaluate the Ct precision of the replicate groups. In
the example experiment, the Cp SD have the expected value of <0.5.

Expand &l

.| Target Name Quantity | Normaliz...
205 113 r Fas UNEMOWN FaM-MNFO-MGE 1,058.359
206 114 r Erain Fas UMNEMOWIN FAM-MNFQ-MGE 29,199 29.182 0,052 | 1,010.662
207 115 I Brair FAS UNKMNCHWAN FAM-NFQ-MGE 29,139 29,182 0.059 | 1,052.721
208 116 r Erain Fas UNKMOWN FaM-MNFO-MGE 29,156 20.182 0.059 | 1,040.639
209 117 r Erain Fas UNEMOWN FAM-MNFQ-MGE  20.066 20.182 0.059 | 1,106.298
210 118 r Erain Fas UMNEMOWIN FAM-MNFQ-MGE 29,186 29,182 0,052 | 1,019.635
211 119 r Brair FAS UNKMNCHWAN FAM-NFQ-MGE 29,16 29,182 0.059 | 1,037.892
212 120 r Erain Fas UNEMOWN FaM-MNFOQ-MGE 20,2 20.182 0.059 | 1,008.953
213 121 r Erain F&s UMEMOWIN FAM-MNFQ-MGE 20,222 209,182 0.052 095,076
214 122 I BErairn FAS UNEMCHWAR FAM-MFQ-MGE 29,204 29,182 0.059 | 1,007.341
213 123 r Brain FAS UNKMNCHWAN FAM-NFQ-MGE 29,305 29,182 0.059 940,462
216 124 u Erain F&s UNEMOWN FaM-MNFOQ-MGE 20,217 20.182 0.059 003,492
Erain - HPRT
277 L13 I Brair HFRT UNKMNCHWAN WIC-NFQ-MGE 30,252 30.438 0.205 475,135
278 L14 r Erain HFRT UNKMOWN YIC-NFQ-MGE 30,681 30.438 0.205 362.578
273 L15 r Erain HFRT UNEMOWN VIC-NFQ-MGE 30,201 30.438 0.205 490.889
280 L16 r Erain HFRT UMNEMOWIN VIC-MNFQ-MGE 30,265 30,438 0.205 471,341
281 L17 r Brair HFRT UNKMNCHWAN WIC-NFQ-MGE 30,352 30.438 0.205 445,114
282 L18 r Erain HFRT UNEMOWN YIC-NFQ-MGE 30,232 30.438 0.205 481.19
283 L19 r Erain HFRT UMEMOWIN VIC-NFQ-MGE 30,746 30,438 0.205 348.027
284 L20 u BErairn HFRT UNEMCHWAR WIC-NFQ-MGE 30,212 30,438 0.205 457,733
285 L21 r Brair HFRT UNKMNCHWAN WIC-NFQ-MGE 3068 30.438 0.205 362.614
286 L22 r Erain HFRT UNEMOWN YIC-NFQ-MGE 300422 30.438 0.205 426.906
AT 22 <| ml Rrain HCORT (I g T WV T RIFM SR 2N 420 0 428 n2ns ATI)'-T na
well Summary: In Plate: 384 St Up: 102 Analyzed: 102 Flagged: Oritted by Analysiz: 0 Ornitted Manually: 0

Assessing the well
table in your own

experiments

52

Normaliz...

1.04
1.04
1.04
104
104
1.04
1.04
104
1.04
1.04
1.04

Samples Used: 4

Efficiency

97612
97,612
97.612
97.612
o7.612
97,612
97.612
97612
o7.612
97,612
97.612

87,858
87.6858
87.6858
g97.858
87,858
87.658
87.6858
87,858
87,858
87.658

a7 aee _ILI
»

Targets Used: 2

Note: To show or hide columns in the Well Table, select or deselect respectively the
column name from the Show in Table drop-down menu.

When you analyze your own Relative Standard Curve experiment, look for standard
deviation in the replicate groups (C SD values). If needed, omit outliers (“Improve CT
precision by omitting wells” on page 65).
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Confirm accurate dye signal using the Multicomponent Plot

Confirm accurate dye signal using the Multicomponent Plot

The Multicomponent Plot screen displays the complete spectral contribution of each
dye in a selected well over the duration of the PCR run.

Pu rpose In the Relative Standard Curve example experiment, you review the Multicomponent
Plot screen for:

View the 1.
Multicomponent
Plot

ROX™ dye (passive reference)
FAM™ dye (reporter for RNase P)
VIC® dye (reporter for HPRT)
Spikes, dips, and/or sudden changes

Amplification in the negative control wells

From the Experiment Menu pane, select Analysis » Multicomponent Plot.

Note: If no data are displayed, click Analyze.

Display the unknown and standard wells one at a time in the Multicomponent
Plot screen:

a. Click the Plate Layout tab.

b. Select one well in the plate layout; the well is shown in the Multicomponent
Plot screen.

Note: If you select multiple wells, the Multicomponent Plot screen displays
the data for all selected wells simultaneously.

From the Plot Color drop-down menu, select Dye.

Click |7— Show a legend for the plot (default).

Note: This is a toggle button. When the legend is displayed, the button changes to
Hide the plot legend.
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Confirm accurate dye signal using the Multicomponent Plot

5. Check the FAM and VIC dye signals. In the example experiment, the FAM and
VIC dyes signal increase throughout the PCR process, indicating normal
amplification.

Multicomponent Plot
Plot Settings

Plot Color |Dye vl 3 e —
™ Save current settings as the default 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24

Multicomponent Plot

= e e te be 1o te ba fe = e = e i= e ie e fe e fe e fe = js |
550,000

500,000

450,000

400.000

m|-n m U‘ﬁ|m|h

350,000

300.000 { = =

;Tmmm

250,000

Fluorescence

200,000

150,000 —

100,000 —

50,000

o Pl I |3 I | | | o | o | | || | | | P o P | o | P

a2 4 & & W 12 14 18 @ N 2 M B W W B M B M 40 2

Cycle
Legerd [P [P o o o o o o P P P P P P P P P P P P P P P P
M For ROy IO
wels: [ 96 [ 80 [ 16 192 Ermpty
well Summary: In Plate: 384 Set Up: 192 Analyzed: 192 Flagged: 0 Omitted by Analysis: 0 Omitted Manually: 0 Samples Used: 4 Targets Used: 2

6. Check the ROX dye signal. In the example experiment, the ROX dye signal
remains constant throughout the PCR process indicating typical data.

7. Select the negative control wells one at time and check for amplification. In the
example experiment, there is no amplification in any of the negative control wells.

Multicomponent Plot
Plot Settings

Plot Color (Dye - I

[ Save current settings as the default 1 2 3 4 5 &
£ p B & Wy =
Multicomponent Plot

iewe Legend =

708 |9 (10|11 |12 |13 |14 |15 |16 |17 (18|19 |20 |21 |22 |23 |24
= = = = = = = 0= 0= f= i= s i= s =

FEFE PR PR FE AR R P FE P FEEEFE AR PR
550,000

o FIITTTTTE TP O ORI O
400,000

350,000

300,000

250,000

Fluorescence

200,000

150,000

100,000

50,000

o Fill Fil P3N i PO o | O | O P P I P P | | | o | O | P P

0 2z &4 & & W 12 14 16 18 W T ¢ B MW M T M B/ ;W M 2

- O|Z|3|I—|X‘|_4|'—' :|:|c\‘-n|m|o|n|m :bI

Cycle
Leg=nd rlﬂﬂﬂﬂﬂﬂﬂ'r:mmmmmmmmmmmmmmm
WFa ROy I YIC
wells: [[ 96 [5]80 [ 16 192 Ermpty
well Summary: In Plate: 384 Set Up: 192 Analyzed: 192 Flagged: 0 Ornitted by Analysis: 0 Omitted Manually: 0 Samples Used: ¢ Targets Used: 2
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Determine signal accuracy using the Raw Data Plot

Tips for confirming  When you analyze your own Relative Standard Curve experiment, look for:

dye accuracy in .
your own
experiment .

Passive reference — The passive reference dye fluorescence level should remain
relatively constant throughout the PCR process.

Reporter dye — The reporter dye fluorescence level should display a flat region
corresponding to the baseline, followed by a rapid rise in fluorescence as the
amplification proceeds.

Irregularities in the signal — There should not be any spikes, dips, and/or sudden
changes in the fluorescent signal.

Negative control wells — There should not be any amplification in the negative
control wells.

Determine signal accuracy using the Raw Data Plot

The Raw Data Plot screen displays the raw fluorescence signal (not normalized) for
each optical filter for the selected wells during each cycle of the real-time PCR.

About the example In the Relative Standard Curve example experiment, you review the Raw Data Plot
experiment screen for a stable increase in signal (no abrupt changes or dips) from the appropriate
filter.

View the Raw Data 1.
Plot

From the Experiment Menu pane, select Analysis » Raw Data Plot.

Note: If no data are displayed, click Analyze.

2. Display all 384 wells in the Raw Data Plot screen by clicking the upper left corner
of the plate layout in the Plate Layout tab.

3. Click E Show a legend for the plot (default). The legend displays the color code
for each row of the reaction plate (see the legend in the Raw Data Plot shown
below).
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Determine signal accuracy using the Raw Data Plot

4. Click and drag the Show Cycle pointer from cycle 1 to cycle 40. In the example
experiment, there is a stable increase in signal from filter 1, which corresponds to
the FAM™ dye filter.

Raw Data Plot

0 = M-
A p B & i
Raw Data Plot
1 2 3 4 5 & 7 10 11 12 13 14 15 16 17 16 19 20 21 22 23 24
800,000 -
750,000 A
700.000 B
ZZEEZE < | P 5 S S 5 S 5 5 S S S S
550,000 { 4 B
500,000
5 40000 e [AF O G  G
-‘_3 400,000 F
=
£ 3s0,000
300,000 Ak
250,000 1 IS
200.000
150,000 1 I i [ [ [ [ [ [ 0 0 O A A A
100,000 ]
50,000
5 K
e e | o [0 00 R O O o v
Filker M
Lagerd
S R R R oo o o o o o o o o o e ol
A B C u} E F G H =l M
e = . =
Options ®
o | R N T, S o o et P
Show Cycle 40 H
P e
1 S 10 15 20 235 30 35 40
wells: [[96 a0 [ 16 192 Empty
Well Summary: In Plate: 304 Set Up: 192 Lnalyzed: 192 Flagged: 0 Smitted by Analysis: 0 Orritted Manualby: 0 Sarmnples Used: 4 Targets Used: 2

The filters used for the example experiment are:

PCR Filter (=)

Emission Filter

ml(520+15) m2(558+11) m3(586+10) ma(623+14) m5(682+14) me(711+12)

x1(470£15)

®2(520+10)

x3(550+11)

Excitation Filter

x4(580£10)

¥5(640+10)

x6(662+10)

Melt Curve Filter =

Emission Filter

ml{520x15) m2(558+11) m3({586+10) ma(623x14) m5(682x+14) m6&(711+12)
x1(470+15)
B ¥2(52010)
s x3(550+11)
g X4(580410)
¥5(640210) L
x6(662210) v
Tips for When you analyze your own Relative Standard Curve experiment, look for the
accuracy in your ¢ Characteristic signal growth
own experiment * No abrupt changes or dips
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Section 5.1 Review Results 5
View the endogenous control profile using the QC Plot

View the endogenous control profile using the QC Plot

In the Relative Standard Curve experiment, the QC Plot screen displays the
Endogenous Control Profile plot for all the targets in the experiment. The QC Plot
serves as a tool to help users choose the best endogenous control for that experiment.
The endogenous control profile plot is a visual display of the Cr level of the
endogenous control across the sample. You can view up to four endogenous controls
at a time. The sample is plotted on the X-axis, and the Cr is plotted on the Y-axis. The
expression is viewed as a color and shape combination in the plot. Endogenous
controls are also known as reference genes.

To view the QC Plot:

1. From the Experiment Menu pane, select Analysis » QC Plot.
Note: If no data are displayed, click Analyze.

2. In the QC Plot screen, click Target Table to select a target to profile:

a. In the Candidate Control column, select the check box of the target of the
endogenous control profile to plot. In the example experiment, the
endogenous control is HPRT.

b. Select a color from the Color drop-down menu.
c. Select a shape from the Shape drop-down menu.
3. Click the View Replicate Results Table.
4. Select the check box of the samples you want to plot.

5. Click E Show a legend for the plot (default).

Note: This is a toggle button. When the legend is displayed, the button changes to
Hide the plot legend.
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Chapter 5 Review Results and Adjust Experiment Parameters
Review the QC flags in the QC Summary

The QC Plot in the Relative Standard Curve example experiment looks like this. Note
that the endogenous control, HPRT is expressed at the same level in all the four

samples:

cr

Brain

AL ap I =

Endogenous Control Profile

—

Heart Kidney Liver

Sample

& FAS @ HFRT

Target Table

well Summary:

In Plate: 354 Set Up: 192 Analyzed: 192

Flagged: 0

%| candidate Control | Target | Color Shape
| FAS B
v HERT | H[ - |
\iew Replicate Results Table View Biclogical Groups ]
Selected? I Sample | Target | CT Mean ACT Mean |
Vv Kidney FAS 26,817 12,384 «
cd Heart FAS 20.525 1.966
i Liver FAS 28.49 3878 |
] e e e e YR
Ornitted by Analysis: Oritted Marwally: 0 Samples Used: 4 Targets Used: 2

This example experiment does not define Biological Groups.

Review the QC flags in the QC Summary

The QC Summary screen displays a list of the QuantStudio™ 6 and 7 Flex Real-Time
PCR System Software flags, including the flag frequency and location for the open

Note: If no data are displayed, click Analyze.

From the Experiment Menu pane, select Analysis » QC Summary.

Note: A 0 displayed in the Frequency column indicates that the flag does not
appear in the experiment. If the frequency is >0, the flag appears somewhere in
the experiment; the well position is listed in the Wells column.

In the example experiment, there are no flagged wells.

3. In the Flag Details table, click each flag with a frequency > 0 to display detailed
information about the flag. In the example experiment, the Frequency column

4. (Optional) For those flags with frequency > 0, click the troubleshooting link to
view information on correcting the flag.

experiment.
View the QC 1.
Summary
2. Review the Flags Summary.
displays O for all flags.
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Section 5.1 Review Results
Review the QC flags in the QC Summary

The following is an image of the QC Summary screen for the example experiment:

QC summary .

Flag Details
Flag: Description Freguency Wells

AMPINC Amplification in negative contral 0 -
BADRCH Bad passive reference signal 0

OFFSCALE Fluorescence is offscale 0

HIGHSD High standard deviation in replicate group o

MNOAMP Mo arnplification o

MNOISE Moise higher than others in plate o

SPIKE Moise spikes o

MOSIGNAL Mo signal in well o

OUTLIERRG Cutlier in replicate group 0 |
EXFFAIL Exponential algarithm failed 0

BLFAIL Easeline algorithr failed 0 -
Total wells: 384 | Processed Wels: 192 Manually Oritted wWells: 0 | Targets Used: 2
wiells Set Up: 192 | Flagged wells: 0 Analysis Omitted wills: 0 | Samples Used: 4

well Summary: In Plate; 304

Possible flags

Set Up: 102 Analyzed: 192

Flagged: 0 Ormitted by Analysis: 0 Craitted Marwally: 0 Samples Used: 4

The flags listed below may be triggered by the experiment data.

Targets Used: 2

Flag

Description

Pre-processing flag

OFFSCALE Fluorescence is offscale
Primary analysis flags

BADROX Bad passive reference signal
NOAMP No amplification
NOISE . Noise higher than others in plate
SPIKE Noise spikes
NOSIGNAL No signal in well
EXPFAIL Exponential algorithm failed
BLFAIL Baseline algorithm failed
THOLDFAIL Thresholding algorithm failed
CTFAIL Cy algorithm failed

Secondary analysis flags
OUTLIERRG Outlier in replicate group
AMPNC Amplification in negative control
HIGHSD High standard deviation in replicate group

QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Getting Started Guide for Relative Standard Curve
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Chapter 5 Review Results and Adjust Experiment Parameters
For more information

For more information

For more information on... Refer to... It
number
Publishing data Chapter 2 in Booklet 1, Getting Started with QuantStudio™ 6 and 7 | 4489822
Flex Real-Time PCR System Software Experiments.
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Section 5.2 Adjust parameters for re-analysis of your own experiments 5
Adjust analysis settings

Section 5.2 Adjust parameters for re-analysis of your
own experiments

Adjust analysis settings

The Analysis Settings dialog box displays the analysis settings for the threshold cycle
(Cy), flags, and advanced options.

If the default analysis settings in the QuantStudio™" 6 and 7 Flex Real-Time PCR
System Software are not suitable for your own experiment, you can change the settings
in the Analysis Settings dialog box, then reanalyze your experiment.

View the analysis 1. From the Experiment Menu pane, select Analysis.

settings 2. Click Analysis » Analysis Settings to open the Analysis Settings dialog box.

In the example experiment, the default analysis settings are used for each tab:
® (g Settings
¢ Flag Settings
* Relative Quantification Settings
* Advanced Settings

¢ Standard Curve Settings

The following is an image of the Analysis Settings dialog box for a Relative
Standard Curve experiment:

13 Analysis Settings for 056_QuantStudio_384-Well_Relative_Standard_Curve_Example

~— Data Step Selection Algorithm Settings
Select the step and stage to use for C1 analysis, Only stage/step combinations for which data suitable for CT
analysis have been collected are displayed. Baseline Threshold

Stage 2, Step 2 v

~— Default Cr Settings
Default CT settings are used to calculate the Ct for targets without custom settings. To edit the default settings, dick Edit Default Settings.

Threshold: AUTO Baseline Start Cycle: AUTO Baseline End Cycle: AUTO

~— Select a Target ~— CT Settings for FAS
Target Threshold Baseline Start Baseline End Cr Settings to Use: Default Settings
FAS AUTO AUTO AUTO a
HFRT 0.04 AUTO AUTO

Save to Library Load from Library Revert to Default Analysis Settings Apply Analysis Settings W

QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Getting Started Guide for Relative Standard Curve 61
and Comparative Cy Experiments



Chapter 5 Review Results and Adjust Experiment Parameters

Adjust analysis settings

Adjust analysis
settings

62

3. View and, if necessary, change the analysis settings (see “Adjust analysis settings”

below).

Note: You can save the changes to the analysis settings to the Analysis Settings
Library for later use. For more information, see About the Analysis Settings
Library in Booklet 1, Getting Started with QuantStudio'™ 6 and 7 Flex Real-Time PCR
System Software Experiments.

. Click Apply Analysis Settings to apply the current analysis settings.

Note: You can go back to the default analysis settings, by clicking Revert to
Default Analysis Settings.

Cr Settings
e Data Step Selection

Use this feature to select one stage/step combination for Ct analysis when there is
more than one data collection point in the run method.

Algorithm Settings
Use the Baseline Threshold algorithm to determine the Ct values.

The Baseline Threshold algorithm is an expression estimation algorithm that
subtracts a baseline component and sets a fluorescent threshold in the exponential
region for gene quantification.

Default Ct Settings

Use the default Cr settings feature to calculate Cr for the targets that do not have
custom settings. To edit the default settings, click Edit Default Settings.

Cr Settings for Target

When you manually set the threshold and baseline, Life Technologies
recommends:

Setting Recommendation

Threshold Enter a value for the threshold so that the threshold is:

e Above the background.

¢ Below the plateau and linear regions of the amplification curve.
e Within the exponential phase of the amplification curve.

Baseline Select the Start Cycle and End Cycle values so that the baseline ends
before significant fluorescent signal is detected.

Note: This setting is applicable only to the Baseline Threshold algorithm.

Note: Selecting Automatic Threshold implies selection of automatic setting of the
baseline. However, if Automatic Threshold is deselected, then you can choose
between setting the baseline either automatically or manually.

Flag Settings
Use the Flag Settings tab to:

¢ Adjust the sensitivity so that more wells or fewer wells are flagged.
* Change the flags that are applied by the QuantStudio" 6 and 7 Flex Real-Time

PCR System Software.
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Section 5.2 Adjust parameters for re-analysis of your own experiments
Adjust analysis settings

To adjust the flag settings

1.
2.

In the Use column, select the check boxes for flags to apply during analysis.

(Optional) If an attribute, condition, and value are listed for a flag, specify the
setting for applying the flag.

Note: If you choose to adjust the setting for applying a flag, make minor
adjustments as you evaluate the appropriate setting.

In the Reject Well column, select the check boxes if you want the software to reject
wells with the flag.

Note: After you have rejected the flagged wells, analysis results depend on
factors such as the experiment type and flag type. For example, rejecting wells
flagged by HIGHSD in experiments using the Standard Deviation calculations
may change the result of C1 SD. For some flags, analysis results calculated before
the well is rejected are maintained.

Click Apply Analysis Settings in the Analysis Settings dialog box. If the run
status is complete, the data are reanalyzed.

The following is an image of the Flag Settings tab:

Flag Settings Relative Quantification Settings Advanced Settings Standard Curve Settings

* Configure the flags and filtering. In this panel you can enable, disable, and configure flags, and indicate if a well is to be rejected when a flag is raised.

Flag Description Use Attribute Condition Value Reject Well
AMPNC Amplification in negat... cr = + [35.000 O
BADROX Bad passive referenc... Bad passive referenc... > + (0.600 O
OFFSCALE Fluorescence is offscale O
HIGHSD High standard deviati... Cr standard deviation |> + |0.500 O
NOAMP No amplification Amplification algorith... |< + |0.100 O
NOISE Noise higher than ot... Relative noise = + [4.000 O
SPIKE Noise spikes Spike algorithm result  |= + [1.000 O
NOSIGMAL No signal in well [}
OUTLIERRG Qutlier in replicate gr... [}
EXPFAIL Exponential algorithm... [}
BLFAIL Baseline algorithm failed O
THOLDFAIL Thresholding algorith... O
CTFAIL Cr algorithm failed O

Revert to Default Analysis Settings Apply Analysis Settings

QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Getting Started Guide for Relative Standard Curve

Relative Quantification Settings

Use the Relative Quantification Settings tab to:

and Comparative Cy Experiments

Change the type of analysis, singleplex or multiplex.

Change the reference sample and/or endogenous control.
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Adjust analysis settings

* Reject Outliers with ACy values less than or equal to the entered value.
Note: The Outlier Rejection settings apply only to multiplex reactions.

¢ Select the algorithm to use to determine the relative quantification minimum and
maximum values (error bars):

— Confidence Level - Select to calculate the RQ minimum and maximum
values based on the selected confidence level. Select the confidence level to
use.

— Standard Deviations - Select to calculate the RQ minimum and maximum
values based on the selected number of standard deviations. Select the
number of standard deviations to use.

Advanced Settings
Use the Advanced Settings tab to change baseline settings well-by-well.
To use custom baseline settings for a well-target combination:

1. Select one or more well-target combinations in the table.

2. Deselect the Use Ct Settings Defined for Target check box.

3. Define the custom baseline settings:

e TFor automatic baseline calculations, select the Automatic Baseline check
box.

¢ To define the baseline, deselect the Automatic Baseline check box, then enter
the baseline start cycle and baseline end cycle.

Standard Curve Settings

Use this tab to review the settings of the current standard curve experiment or to
import the standard curve from an external experiment (with the same samples and
targets) and apply it to this current experiment.

Note: The run method must be the same. Life Technologies recommends using the
standard curve from the current experiment.
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Section 5.2 Adjust parameters for re-analysis of your own experiments 5
Improve Cr precision by omitting wells

For the example experiment, the settings from the current experiment have been used.

42 Analysis Settings for Q$6_QuantStudio_384-Well_Relative_Standard_Curve_Example

CT1 Setkings

Flag Settings Relative Quantification Settings Advanced Settings

e standard curve plots for each target. To use a standard curve from another experiment, dick Import.

~— Override Standard Curve
(®) Use the standard curve from this experiment
() Use a standard curve imported from another experiment
~—Standard Curve View
32 [
Eal S
30 - -..___._. N
20 RS =
28 - Tm—
—
27 - - —m
Reporter Target Slope Y-Intercept Ri{superscript 2) Efficiency(%)
FAM FAS -3.381 39.356 0.998 07.612 &
VIC HFRT -3.652 40.028 0.983 87.858
2

Save to Library Load from Library Revert to Default Analysis Settings Apply Analysis Settings W

Improve Ct precision by omitting wells

QuantStudio™

Experimental error may cause some wells to be amplified insufficiently or not at all.
These wells typically produce Cy values that differ significantly from the average for
the associated replicate wells. If included in the calculations, these outliers can result in
erroneous measurements; to ensure Ct precision, omit the outliers from the analysis.

Note: In the Relative Standard Curve example experiment, there are no outliers. No
wells need to be removed from analysis.

1. From the Experiment Menu pane, select Analysis » Amplification Plot.

Note: If no data are displayed, click Analyze.

2. In the Amplification Plot screen, select Ct vs. Well from the Plot Type drop-down
menu.

3. Select the Well Table tab, select replicates to omit:

4. In the Well Table:
a. From the Group By drop-down menu, select Replicate.

b. Look for outliers in the replicate group (make sure they are flagged).
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well Summary:

Chapter 5 Review Results and Adjust Experiment Parameters
For more information

123

c. Select the Omit check box next to outlying well(s), as shown in the following
image.

Plate Layout

Expand All

Sample Na.. | Target Name| _Task | _Dyes | _Cr | CrMean| c75SD_| quantity

AT

I UNKMNOWN FAM-NFQ-MGE 1,058,359

r Erain FAS UNEROWN FAM-MFO-MGE 25,199 29.182 0058  1,010.662 1.04 97.612
r Erain FAS UMW FAM-MFOQMGE 28,139 29,182 0058 1052721 1.04 97.612
r Erain FAS UMKNOW!N FAM-MNFO-MGE 29,156 20,182 0058 1,040.639 1.04 07612
r Brain FAS UNKMNOWN FAM-NFQ-MGE 29,066 29,182 0038 1,106,298 1.04 97,612
r Erain FAS UNEROWN FAM-MFO-MGE 29,186 29.182 0.058  1,019.635 1.04 97.612
r Erain FAS UMENOWN FAM-MNFQ-MGE 20,16 20,182 0058 1,037.892 104 97,612
I BErain FAs UNKMOWMN FAM-MFO-MGE 29,2 20,182 0038  1,009.952 1.04 07,612
r Brain FAS UNKMNOWN FAM-NFQ-MGE 28,222 29,182 0.038 993,076 1.04 97,612
r Erain FAS UNEROWN FAM-MFQ-MGE 208,204 20,182 0058 1,007.341 1.04 97.612
r Erain FAS UMENOWN FAM-MNFOQMGE 28,305 29,182 0.058 940,462 1.04 97612
I Erain FAS UNKMNOWN FAM-NFO-MGE 28,217 29,182 0.058 993,492 1.04 97,612
r Erain HPRT UMW WIC-NFQ-MGE 30,252 30.438 0.205 475.135 87.858
r Erain HPRT UMKNOW!N VICNFQ-MGE 30,881 30,438 0.205 362.578 g7.858
r Brain HPRT UNKMNOWN WIC-NFQ-MGE 30,201 30,438 0,205 490,889 87,858
r Erain HPRT UNEROWN WIC-NFQ-MGE 30,265 30.438 0.205 471.341 87.858
r Erain HPRT UMENOWN WIC-MNFQ-MGE 30,352 30,438 0.205 445,114 87.858
I BErain HPRT UNKMOWMN WIC-NFQ-MGE 30,232 30,438 0,205 481,19 87,858
r Brain HPRT UNKMNOWN WIC-NFQ-MGE 30,746 30,4358 0.203 348.027 87,858
r Erain HPRT UNEROWN WIC-NFQ-MGE 30,312 30.438 0.205 457,733 87.858
r Erain HPRT UMENOWN VIC-MNFQ-MGE  20.62 30,438 0.205 362.814 g27.858
I Brain HPRT UNKMNOWN WIC-NFQ-MGE 30,422 30,438 0,205 426,506 87,858

- — Erzin LoRT 1 IR AR UTCMECUMGE 30 470 an 470 n2ns 4’])-: na o7 o5e _DILI
In Plate; 384 Set Up: 1092 Analyzed: 192 Flagged: 0 Omitted by Analysis: 0 Cmitted Marwally: 0 Samples Used: 4 Targets Used: 2

5. Click Analyze to reanalyze the experiment data with the outlying well(s)
removed from the analysis.

Note: You can also omit undesirable wells in an experiment from the Plate Layout
screen. To omit a well from the Plate Layout screen, right-click the well and select
Omit.

For more information

For more information on Refer to Publication number

Amplification efficiency Amplification Efficiency of TagMan® Gene Expression Assays 127AP05-03

Application Note
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Export Analysis Results

1. Open the Relative Standard Curve example experiment file that you analyzed in
Chapter 5.

2. In the Experiment Menu, click E Export.

Note: To export data automatically after analysis, select the Auto Export check
box during experiment setup or before running the experiment. Auto export is
unchecked for the example experiment.

3. Select QuantStudio™ 6 and 7 format.
Note: Select 7900 Format if you want to export the Clipped Data.

4. Complete the Export dialog box as shown below:

Field or

Selection e

Select Data to Results
export/ Select
Content

Export Data To One File

Export File Name | QS6_QuantStudio_384-
Well_Relative_Standard_Curve_Example_data

File Type *.txt
Export File C:\Applied Biosystems\QuantStudio 6 and 7 Flex Software\User
Location Files\Export

Your Export screen should look like this:

[ Auto Export Format : |QuantStudio™ 6 and 7 v Export Dats To: @ One Fie O Separste Fies Open file(s) when export s complete

Export File Location: |C:\Applied Biosyste ms\QuantStudio 6 and 7 Flex Softwar Export File Name: |QS6_QuantStudio_384-Well_Relative_Standz| File Type: |[E] (xtxt) %

Sample Setup [ Raw Data Amplfication [ Multicomponent [J7ech. Rep. Results [ Bio. Rep. Resits Results

Skip Empty Wells Skip Omitted Wells

Select Content Well Well Position Sample Name Target Name Task Reporter Quencher R
All Fields e 1A1 FAS NTC FAM NFQ-MGB ~
2A2 FAS NTC FAM NFQ-MGB
Wel 3A3 FAS NTC FAM NFQ-MGE
well Position 4 A4 FAS NTC FAM NFQ-MGB
5A5 FAS NTC FAM NFQ-MGB
Sample Name 646 FAS NTC FAM HFQ-MGB
7A7 FAS NTC FAM NFQ-MGB
Target Name 8A8 FAS NTC FAM NFQ-MGB
9AQ FAS STANDARD FAM NFQ-MGB
Task 10 AL0 FAS STANDARD FAM HFQ-MGB
Reporter 11A11 FAS STANDARD FAM NFQ-MGB
12 A12 FAS STANDARD FAM NFQ-MGB
Quencher 13413 FAS STANDARD FAM NFQ-MGE
14 A14 FAS STANDARD FAM NFQ-MGB
RQ 15415 FAS STANDARD FAM NFQ-MGB
16 Al6 FAS STANDARD FAM NFQ-MGB
RQ Min 17 A17 FAS STANDARD FAM NFQ-MGB
RQ Mex 18A18 FAS STANDARD FAM NFQ-MGE ¥
¥ = >
W Save Export Set As || Load Export Set || Delete Export Set
.M . . . .
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H Chapter 6 Export Analysis Results

Your exported file when opened in Notepad should look like this:

[ Q56_QuantStudio_384-Well_Relative_Standard_Cui

File Edit Format Wiew Help

* Block Type = 384-well Block A
* Calibration Background is expired = ves =
* calibration Background performed on = 11-24- 2009

* calibration Normalization FAM-ROX is Expwred =

* calibration Normalization FAM-ROX performed on = 11 24-2009

* calibration Normalization VIC-ROX is expired =

* Calibration Normalization VIC-ROX performed on 11 24-2009

# calibration Pure Dye FAM 15 expired = ves

*® calibration Pure Dye FAM performed on = 11-24- 2009

* calibration Pure Dye MELTDOCTOR is expired =

* calibration Pure Dye MELTDOCTOR perfurrmad on = 12 07-2009

* Calibration Pure Dye NED is expired =

* calibration Pure Dye NED performed on = 11 24-2009

# calibration Pure Dye ROX 15 expired = ye

* calibration pure Dye ROX performed on = 11 24-2009

* calibration Pure Dye SYBR is expired = ve

* calibration Pure Dye SYBR performed on = 11 24-2009

* Calibration pure Dye TAMRA 15 expired =

* Calibration pure Dye TAMRA performed on = 11 24-2009

* calibration Pure Dye VIC 15 expired =

* calibration Pure Dye VIC performed on = 11—24—2003

* calibration ROI is expired = ves

* calibration ROI performed on = 11-24-2009

* Calibration uniformity is Exp'lred = Yes

# calibration uniformity performed on = 11-24-2009

* chemistry = TagQMan

* Date Created = 2013-07-05 16:23:54 PM SGT

* Experiment Barcode =

i Expsr‘\ment Comment = NA

* Experiment File Name = C:\Program Files\applied Biosystems‘Quantstudio 6 and 7 Flex
software\examples\Qs6Flex\Qs6_384-well_Relative_standard curve Example.eds

* Experiment Name = Q56_QuantStudio_384-well_Relative_Standard_Curve_Example

* Experiment Run End Time = 2009-12-10 20:29:36 PM 5GT

* Experiment Type = Relative standard Curve

* INSTtrument Name = NA

# Instrument Serial Number = 278880013

* INstrument Type = Quantstudio(TM) 6 Flex System

* Passive Reference = ROX

* quantification Cycle MEthud

* s5ignal smoothing on = tr

* stage/ Cycle where Ana'\ysws is performed = stage 2, step 2

* User Name = NA

[Samp'\e setup]

well Position  Sample Name sample color Biogroup Name Biogroup Color Target Name Target Color Task

REpurtEr quencher qQuantity Comments

1 FAS "RGB(255,0,0)" NTC FAM NFQ-MGB

2 A2 FAS “"RGE(255,0,0)" NTC FAM NFQ-MGB

2 A3 FAS 'RGB(255,0,00" NTC FAM NFQ-MGE

4 Ad FAS "RGB(255,0,0)" NTC FAM NFQ-MGB

5 A5 FAS "RGB(255,0,0)" NTC FAM NFQ-MGB

6 AB FAS "RGB(255,0,0)" NTC FAM NFQ-MGB

7 AT FAS "RGB(255,0,0)" NTC FAM NFQ-MGB

8 A8 FAS "RGB(255,0,0)" NTC FAM NFQ-MGB

9 A9 FAS "RGB(255,0, u)" STANDARD FAM NFQ-MGE 625.000

10 AL0 FAS "RGB(255,0,0)" STANDARD FAM NFQ-MGE 625.000

v
. ™ . . . .
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About Comparative C; Experiments

This chapter covers:
B About Comparative CT experiments. . ........... .. ..., 71

B About the example experiment .............. ... ... o i 73

IMPORTANT! First-time users of the QuantStudio™ 6 and 7 Flex Real-Time PCR
System Software, please read Booklet 1, Getting Started with QuantStudio™ 6 and 7 Flex
Real-Time PCR System Software Experiments and Booklet 7, QuantStudio™ 6 and 7 Flex
Real-Time PCR System Software Experiments - Appendixes of this binder thoroughly. The
booklets provide information and general instructions that are applicable to all the
experiments described in this binder.

Note: For more information about any of the topics discussed in this guide, access the
Help from within QuantStudio™" 6 and 7 Flex Software by pressing F1, clicking € in
the toolbar, or selecting Help » QuantStudio' " 6 and 7 Flex Software Help.

About Comparative Ct experiments

Assemble required

The Comparative CT (AACt) method is used to determine the relative target quantity
in samples. With the comparative Cy method, the QuantStudio™ 6 and 7 Flex Software
measures amplification of the target and of the endogenous control in samples and in a
reference sample. Measurements are normalized using the endogenous control. The
software determines the relative quantity of target in each sample by comparing
normalized Cy (ACy) in each sample to normalized Ct (ACry) in the reference sample.

Comparative Ct experiments are commonly used to:
¢ Compare expression levels of a gene in different tissues.
* Compare expression levels of a gene in a treated sample and an untreated sample.
¢ Compare expression levels of wild-type alleles and mutated alleles.
¢ Analyze the gene expression changes over time under specific treatment

conditions.

The Relative Standard Curve method determines the relative target quantity in
samples. The QuanStudio™ 6 and 7 Flex Software measures amplification of the target
and of the endogenous control in samples, in a reference sample, and in a standard
dilution series. For more information on Relative Standard Curve experiments, refer to
Part I, Running Relative Standard Curve Experiments of this booklet.

e Sample - The tissue group that you are testing for a target gene.

components * Reference sample (also called a calibrator)- The sample used as the basis for
relative quantification results. For example, in a study of drug effects on gene
expression, an untreated control is an appropriate reference sample.
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Chapter 7 About Comparative Cy Experiments

About Comparative Cr experiments

* Endogenous control — A gene that is used to normalize template input
differences, and sample-to-sample or run-to-run variation.

* Replicates — The total number of identical reactions containing identical
components and identical volumes.

* Negative controls — Wells that contain water or buffer instead of sample template.
No amplification of the target should occur in negative control wells.

PCR options When performing real-time PCR, choose between:
¢ Singleplex and multiplex PCR (below)
and
¢ 1l-step and 2-step RT-PCR (page 72)

Singleplex and Multiplex PCR

You can perform a PCR reaction using either:

¢ Singleplex PCR - In singleplex PCR a single primer and probe set is present in
the reaction tube or well. Only one target or endogenous control can be amplified
per reaction.

Or

* Multiplex PCR - In multiplex PCR, two or more primer and probe sets are
present in the reaction tube or well. Each set amplifies a specific target or
endogenous control. Typically, a probe labeled with FAM™ dye detects the target
and a probe labeled with VIC® dye detects the endogenous control.

IMPORTANT! SYBR® Green reagents cannot be used for multiplex PCR.

. O o= [ Target Primer Set
=
s 3 o (O Endogenous Control
7 Primer Set
, ~—~ cDNA
Singleplex PCR Multiplex PCR

1- and 2-Step RT-PCR

You can perform reverse transcription (RT) and PCR in a single reaction (1-step) or in
separate reactions (2-step). The reagent configuration you use depends on whether
you are performing 1- or 2-step RT-PCR:

¢ 1-step RT-PCR- In 1-step RT-PCR, RT and PCR take place in one buffer system.
Using one buffer system provides the convenience of a single-tube preparation
for RT and PCR amplification. However, you cannot use Fast PCR Master Mix or
the carryover prevention enzyme, AmpErase® UNG (uracil-N-glycosylase), to
perform 1-step RT-PCR.

¢ 2-step RT-PCR- 2-step RT-PCR is performed in two separate reactions: First, total
RNA is reverse-transcribed into cDNA, then the cDNA is amplified by PCR. This
method is useful for detecting multiple transcripts from a single cDNA template
or for storing cDNA aliquots for later use. The AmpErase® UNG enzyme can be
used to prevent carryover contamination.
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About the example experiment

About the example experiment

To illustrate how to perform comparative Ct experiment, this guide leads you through
the process of designing and performing an example experiment. The example
experiment represents a typical setup that you can use to quickly familiarize yourself

™

with the QuantStudio " 6 and 7 Flex Software.

The objective of the comparative C example experiment is to compare the expression
of GH1, LPIN1, LIPC, GAPDH, and ACTB in liver, heart, brain, and lung tissues.

The samples are liver, heart, lung, and brain tissues.
The targets are GH1, LPIN1, LIPC, GAPDH, and ACTB.
The reference sample is brain.

The endogenous control is ACTB.

The experiment is designed for singleplex PCR, where the targets and
endogenous control assays are performed in separate wells.

Reactions are set up for 2-step RT-PCR. The Invitrogen VILO Kit is used for
reverse transcription; the TagMan® Fast Universal PCR Master Mix is used for
PCR.

Primer and probe sets are selected from the Life Technologies TagMan® Gene
Expression Assays product line:

— GH1 Assay Mix: Hs00236859_m1

— LPIN1 Assay Mix: Hs00299515_m1

— LIPC Assay Mix: Hs00165106_m1

— GAPDH Assay Mix: Hs99999905_m1
— ACTB Assay Mix: Hs99999903_m1
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About the example experiment
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Design the Experiment

This chapter explains how to design the example experiment from the Experiment
Setup menu.

This chapter covers:

B Define the experiment properties. . ............. ... ...t 75

Define targets, samples and biological replicates .......................... 76
B Assign targets, samples and biological groups ............. ... ... oo L 78
B Setuptherunmethod....... ... ... ... 79
B Tips for designing your own experiment............... ... ..., 80
B Formoreinformation. .......... ... .. 81

Note: To automatically export the analyzed data to a specified location, select the Auto
Export task from the Export screen, before running the experiment. For more
information on Auto Export, refer to Chapter 2 in Booklet 1, Getting Started with
QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments.

Define the experiment properties

Click Experiment Setup » Experiment Properties to create a new experiment in the
QuantStudio™ 6 and 7 Flex Software. Enter:

Field or Selection Entry
Experiment Name QS6_QuantStudio_384-Well_Comparative_Ct_Example
Barcode Leave field empty
User Name Example User
Comments Comparative Ct (AAC+) example
Instrument type QuantStudio™ 6 Flex System
Block 384-Well Block
Experiment Type Comparative Ct (AACy)

Reagents TagMan® Reagents
Ramp speed Fast
Reagent information NA

Save the experiment.
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Define targets, samples and biological replicates

Your Experiment Properties screen should look like this:

12 QuantStudio™ 6 and 7 Flex Real Time PCR System Software v1.0.
File Edit Instrument Analysis Tools Help
[E0] New Experiment - 5 Open... [l Save ~ £ Close g Import... - £ Create Side... £ Print Report...

Reagents: TagMan® Reagents

B} =<periment: QS6_QuantStudio_384-Wel... Type: Comparative Cr (AACT)

How do you want to identify this experiment?

» G—\ Setup * Experiment Name: | QS6_QuantStudie_384-Wel_Comparative_Ct_Example Comments: | Comparative CT (AACT) Experiment ~
Barcode:
Epenment
Properties User Name: [Example User ~
Define
Which instrument type are you using to run the experiment?
Assign
[~ ‘Quantstudio™ 6 Flex System ) Quantstudio™ 7 Flex System )

Run Mathod

~ 384-well | [ 96-well (0.2mL) ] [ Fast 96-Well (0.1mL) ]

T
W ( Standard Curve ) ( Relative Standard Curve ] & Comparative Cr (AACT) ) ( melt curve J
A
@ ( Genotyping J Presence/Absence
Which reagents do you want to use to detect the target sequence?
Other

TagMan® Reagents ) SYBR® Green Reagents

What properties do you want for the instrument run?

( Standard ] [~ Fast )

What is the reagent information?

Name Part Number Lot Number Expiration Date

Define targets, samples and biological replicates

Click Define to access the Define screen. Enter:

1. Targets

Target name Reporter Quencher Color
ACTB FAM NFQ-MGB ]
GAPDH FAM NFQ-MGB [ ]

GH1 FAM NFQ-MGB [

LPINT FAM NFQ-MGB

LIPC FAM NFQ-MGB [ ]

2. Samples

Sample Name Color

Brain [ |

Lung [ ]
Liver [

Heart
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Define targets, samples and biological replicates

3. Dye to be used as a Passive Reference

ROX

Custom Task Name

Not applicable
5. Analysis Settings

Field Select
Reference Sample Brain
Endogenous Control ACTB

Your Define screen should look like this:

Save to Library

Import fram Library

Target Name Reporter Quencher Color

ACTE FAM w [NFQ-MGB v ‘. w
GAPDH FAM + |NFQ-MGB v ‘. L
GH1 FAM v [NFQMGE v‘. v
LPINT FAM + |NFQ-MGB v‘ »
LIPC FAM + |NFQ-MGE ~ ‘. ~

Sample Name Color
Brain ‘. W
Lung ‘. v
Livar ‘. v
Heart ‘ A4

Biological Replicate Groups

Biological Group Name Color Comments

Analysis Settings

Reference Sample: |Brain -
Endogenous Control: ACTE ~

Passive Reference

ROX v

Custom Task Name

Color Icon Char

Note: This example experiment does not define biological replicate groups. Leave
Biological Replicate Groups blank.
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Assign targets, samples and biological groups

Assign targets, samples and biological groups

Click Assign to access the Assign screen. Enter the targets and samples:

Target name Well number Task S:;nr:;e
ACTB A1, A2, A3 Unknown Brain
C1, C2,C3 Unknown Heart
E1, E2, E3 Unknown Lung
G1, G2, G3 Unknown Liver
A24 Negative None
GAPDH A5, A6, A7 Unknown Brain
C5, C6, C7 Unknown Heart
ES, E6, E7 Unknown | Lung
G5, G6, G7 . Unknown Liver
C24 | Negative None
GH1 A9, A10, A11 Unknown Brain
C9, C10, C11 Unknown Heart
E9, E10, E11 Unknown Lung
G9, G10, G111 Unknown Liver
E24 Negative None
LPIN1 A13, A14, A15 Unknown Brain
C13, C14, C15 Unknown Heart
E13, E14, E15 Unknown Lung
G13, G14, G15 Unknown Liver
G24 | Negative None
LIPC | A17, A18, A19 ' Unknown | Brain
C17, C18, C19 Unknown | Heart
E17, E18, E19 Unknown Lung
G17, G18, G19 Unknown Liver
124 (Row |, Column 24) Negative None
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Set up the run method

Your Assign screen should look like this:

Targets

ACTB
gz’:;w : : t [z 3[4 [s5[e 769 [wl[ufrz]1a][15 16171819 [z 2 [z [2s[z4]
Ol | v v| | |F |EEr L L 5T | A | aa =F | =F =7 & & & m
e v ~| |

?fﬁ" L T | . L — TR T m
Samples —0———— (A i
hiﬂﬂﬂ & & & & & & = = = & & & m
Brain F
gt::? ?l*’l*’l*’ L L AL At =l | = | = o ™
Of  |Heart i

I | |

B
Biological Groups —————— (Ta] K_
NEEZET .

m

n |

o

B

wels: [ 60 [ 5 319 Empty

Set up the run method

Click Run Method to access the Run Method screen. Set the thermal profile under the
Graphical View tab. Enter:

* Reaction Volume Per Well: 10 uL

e Thermal Profile

Ramp .
Stage Step rate Temperature Time
Hold Stage Step 1 1.9°C/s 95°C 20 seconds
PCR Stage Step 1 1.9°C/s 95°C 1 second
Number of Cycles: 40 Step 2 1.6°C/s 60°C 20 seconds
Enable AutoDelta:
Unchecked (default)
Starting Cycle: Disabled
when Enable AutoDelta is
unchecked
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Tips for designing your own experiment

Your Run Method screen should look like this:

Run Method

Reaction Volume per well: 10 ML

Ciperr fun Methad Save Run Methad

Hold Stage PCR Stage
MNurnber of Cycles: |4D i’
[T Enable AutoDelta
Starting Cycle: I]. 3:
1H0E— 95.0 °C 25.0 °C
0020 18°C/s oot \
75 °C_| RO §C
LS
G0.0 =C
a0 | 8ecfs 0020
@
25 °C_|
oec_ |
Stept Stepl Stepz
4 »

Legend
Data Collection On © = Data Collection OffF A AutoDelta On A AutoDelta Off

Tips for designing your own experiment

Life Technologies recommends that you:

* Identify each target assay with a unique name and color. You can enter up to 100
characters in the Target Name field.

¢ Identify each sample using a unique name and color. You can enter up to 100
characters in the Sample Name field.

* Select an endogenous control for each sample. The endogenous control is a target
that is present in all samples under investigation. It should be expressed equally
in all sample types, regardless of treatment or tissue origin (examples of
endogenous controls are B-actin, GAPDH, and 18S ribosomal RNA [18S5 rRNA]).
The endogenous control is used to normalize the PCR results; the endogenous
control corrects for variable sample mass, nucleic acid extraction efficiency,
reverse transcription efficiency, and pipette calibration errors. Note that:

— Each sample type (for example, each tissue in a study comparing multiple
tissues) requires an endogenous control.

— If samples are spread across multiple plates, each plate must have an
endogenous control. Additionally, every plate must include an endogenous
control for every sample type on the plate.

* Select an endogenous control from your previously defined target assays.
Amplification results from the endogenous control are used to normalize the
amplification results from the target for differences in the amount of template
added to each reaction.

* Select a reference sample from your previously defined samples. Amplification
results from the samples and from the reference sample are compared to
determine relative expression.
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Chapter 8 Design the Experiment
For more information

For more information on Refer to Publication
number
Consumables Chapter 1 in Booklet 1, Getting Started with QuantStudio™ 6 4489822
and 7 Flex Real-Time PCR System Software Experiments
Appendix A in Booklet 7, QuantStudio™ 6 and 7 Flex Real-
Time PCR System Software Experiments - Appendixes
Using the Standard Curve Booklet 2, Running Standard Curve Experiments. 4489822
quantification methods
Using the relative standard curve Part 1 of this booklet 4489822
quantification method
Selecting an endogenous control Application Note Using TagMan® Endogenous Control Assays 127AP05-03
to Select an Endogenous Control for Experimental Studies
Reference samples (also known as User Bulletin #2: Relative quantification of Gene Expression 4303859
calibrators) and endogenous controls
Using alternative setup Chapter 3 in Booklet 1, Getting Started with QuantStudio™ 6 4489822

and 7 Flex Real-Time PCR System Software Experiments
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For more information
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Prepare the Reactions

This chapter explains how to prepare the PCR reactions for the Comparative Cy
(AACt) example experiment.

This chapter covers:

B Assemble required materials ............. ... . o oL 83

Preparethetemplate ........ ... ... .. . 83
B Prepare thesampledilutions ............... ... ... i il 84
B Prepare the reaction mix (“cocktail mix”)........... ... ... .. L. 84
B Preparethereactionplate.......... ... .. o i i 85
m Tips for preparing reactions for your own experiments. . ................... 86
B Formoreinformation. .......... ... .. i e 87

Assemble required materials

e Items listed in Booklet 1, Getting Started with QuantStudio™" 6 and 7 Flex Real-Time
PCR System Software Experiments.

* Samples - Total RNA isolated from liver, heart, brain, and lung tissues.
* Example experiment reaction mix components:

— TaqMan® Fast Universal PCR Master Mix (2X.)

— ACTB Assay Mix (20X)

— GAPDH Assay Mix (20X)

— GH1 Assay Mix (20X)

— LIPN1 Assay Mix (20X)

— LIPC Assay Mix (20X)

Note: Fast Universal Master Mix is not recommended to be used with the 96-well
(0.2 mL) reaction plates or reaction tubes and tube strips sealed with caps.

Prepare the template

Prepare the template for the PCR reactions using the High-Capacity cDNA Reverse
Transcription Kit or one of the Invitrogen VILO kits to carry out the reverse
transcription.

Exampl_e For the Comparative Cp example experiment, the template for the PCR reactions is
experiment cDNA reverse-transcribed from total RNA samples using one of the Invitrogen VILO
: kits, SuperScript® VILO™ cDNA Synthesis Kit (Part no. 4453650).
settings
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Prepare the sample dilutions

Prepare the Use the Invitrogen VILO kits to reverse-transcribe cDNA from the total RNA samples.
template Follow the procedures in the Invitrogen VILO Kits Protocol (Pub. no. 100002284) to:

1. Prepare the RT master mix.
2. Prepare the cDNA reactions.

3. Perform reverse transcription on a thermal cycler.

Prepare the sample dilutions

For the Comparative Cp example experiment, no more than 10% of your reaction
should consist of the undiluted RT product.
1. Label a separate microcentrifuge tube for each diluted sample:
e Liver
¢ Heart
¢ Brain

¢ Lung

2. Add the required volume of water (diluent) to each empty tube:

Tube Sample name Diluent volume (pL)
1 Liver 19
2 Heart 19
3 Brain 19
4 Lung 19

3. Add the required volume of cDNA sample stock (100 ng/uL) to each empty tube:

Tube Sample name Volume (pL)
1 Liver 1.0
2 Heart 1.0
3 Brain 1.0
4 Lung 1.0

4. Vortex each diluted sample for 3 to 5 seconds, then centrifuge the tubes briefly.

5. Place the diluted samples on ice until you prepare the reaction plate.

Prepare the reaction mix (“cocktail mix”)

1. Label an appropriately sized tube for each reaction mix:
* ACTB Reaction Mix
¢ GAPDH Reaction Mix
¢ GH1 Reaction Mix
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¢ [PIN1 Reaction Mix
e LIPC Reaction Mix

Chapter 9 Prepare the Reactions n

Prepare the reaction plate

2. For the ACTB assay, add the required volumes of each component to the ACTB

Reaction Mix tube:

Component

Volume (pL) for 1

Volume (pL) for 13
reactions (plus

reaction 10% excess)
TagMan® Fast Universal PCR 5.0 75.0
Master Mix (2X)
ACTB Assay Mix (20X) 0.5 7.5
Water 3.5 52.5
Total Reaction Mix Volume 9.0 135.0

3. Mix the reaction mix in each tube by gently pipetting up and down, then cap each

tube.

4. Centrifuge the tubes briefly to remove air bubbles.

5. Place the reaction mixes on ice until you prepare the reaction plate.

6. Repeat steps 2 through 5 for the GAPDH, GH1, LPIN1, and LIPC assays.
Note: Do not add the sample at this time.

Prepare the reaction plate

Example The reaction plate for the Comparative Ct example experiment contains:
experiment * A MicroAmp® Optical 384-Well Reaction Plate
reaction plate * Reaction volume: 10uL/well
components * The reaction plate contains:
— 60 Unknown wells [
- 5 Negative control wells [
— 319 Empty wells
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Tips for preparing reactions for your own experiments

The following is an image of the plate layout for the example experiment:

1)
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[u]
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]

[=]ol=]=]-]~T=

wels: [ 60 [ 5 319 Ermpty
To prepare the 1. Add 1 pL of each cDNA to the appropriate wells.
reaction plate 2. Pipet 1 pL of sterile water into the NTC wells.
components
3. Add 8 uL of the appropriate assay-specific cocktail to the wells.
4. Seal the reaction plate with optical adhesive film.
5. Centrifuge the reaction plate briefly to remove air bubbles.
6. Confirm that the liquid is at the bottom of each well of the reaction plate. If not,

centrifuge the reaction plate again at a higher speed and for a longer period of
time.

7. Until you are ready to perform the run, place the reaction plate at 4°C, in the dark.

Tips for preparing reactions for your own experiments

Tips for preparing When you prepare your own Comparative Ct experiment, Life Technologies

templates recommends the following templates:
¢ Complementary DNA (cDNA) — cDNA reverse-transcribed from total RNA
samples.
* Genomic DNA (gDNA) - Purified gDNA already extracted from tissue or
sample.
Tips for preparing If your experiment includes more than one target assay, prepare the reaction mix for
the reaction mix each target assay separately.
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For more information

Tips for preparing When you prepare your own Comparative Ct experiment, make sure the arrangement
the reaction plate of the PCR reactions matches the plate layout displayed in the QuantStudio™ 6 and 7
Flex Real-Time PCR System Software.

For more information

For more information on... Refer to... Publication
number
Assigning the reaction plate = Chapter 2 in Booklet 1, Getting Started with QuantStudio™ é and 7 Flex 4489822
components Real-Time PCR System Software Experiments
Sealing the reaction plate Chapter 2 in Booklet 1, Getting Started with QuantStudio™ é and 7 Flex 4489822
Real-Time PCR System Software Experiments
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Run the Experiment

This chapter explains how to run the example experiment on the QuantStudio™ 6 or 7
Instrument.

This chapter covers:
B o Startthe run. .. ... e 89
B Monitor the TUN. . . ..o 89

IMPORTANT! Run the experiment at the same ambient temperature at which you
calibrated the instrument. Extreme variations in ambient temperature can affect the
heating and cooling of the instrument and influence experimental results.

IMPORTANT! Do not attempt to open the access door during the run. The door is
locked while the QuantStudio " 6 or 7 Instrument is in operation.

Start the run

1. Open the Comparative Ct example file that you created using instructions in
Chapter 8.

2. Load the reaction plate into the instrument.

3. Start the run.

Monitor the run

Monitor the example experiment run:

* From the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software using the
Run screen, while the experiment is in progress.

¢ From the Instrument Console of the QuantStudio™ 6 and 7 Flex Real-Time PCR
System Software (to monitor an experiment started from another computer or
from the QuantStudio™ 6 or 7 Instrument touchscreen).

¢ From the QuantStudio™ 6 or 7 Instrument touchscreen.
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Monitor the run

From the
Instrument
Console of the
QuantStudio™ 6
and 7 Flex Real-
Time PCR System
Software

Amplification Plot <

ARN

0.1

1. In the Instrument Console screen, select the instrument icon.
2. Click Manage Instrument or double-click on the instrument icon.

3. In the Manage Instrument screen, click Monitor Running Experiment to access
the Run screen.

View the Amplification Plot

You can view the progress of the run in real time. During the run, periodically view all
the three plots available from the QuantStudio™ 6 and 7 Flex Software for potential
problems.

Click Amplification Plot from the Run Experiment Menu, select the Plate Layout tab,
then select the wells t to view.

The following is an image of the Amplification Plot screen as it appears at the end of
the example experiment.

Plate Layout
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View the Temperature Plot

Click Temperature Plot from the Run Experiment Menu.
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Monitor the run

The following is an image of the Temperature Plot screen as it appears during the
example experiment.

Temperature Plot
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Note: The Sample temperature displayed in the Current Temperatures group is an
estimated value.

View the Run Method
Click Run Method from the Run Experiment Menu.

The following is an image of the Run Method screen as it appears in the example

experiment.
Run Method Edit Run Method
Adjust # of Cycles: I
Hold Stage PCR Stage
Mumber of Cyrles: |4D :I I Add Melt Curve Stage to End
[T Enable AutoDelta = Add Holding Stage to End

Starting Cycler |1 3: 7 add Infinite Hald to End

00:20 Lo G5 oooy \6
: : 1E~2fs

60,0 °C
.95 [a]n =]
Stepi Stepi Step2
4 »
Legend
Data Collection On = Data Colection Off A AutoDelta On A AutoDelta Off
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Monitor the run

Run Data Report

Experiment Mame:
Start Time:

Stop Time:

Run Duration:

User Mame:
Instrument Name:
Firmware Version:
Software Version:
Instrument Serial Number:
Sample Volurme:
Cover Temperature:
Instrument Type:
Block Type:

Errors Encountered:

View Run Data
Click View Run Data from the Run Experiment Menu.

The following is an image of the View Run Data screen as it appears in the example
experiment:

Q56_QuantStudio_384-wel_Comparative_Ct_Example
10-02-2010 08:38:10 5GT
10-02-2010 09:20:04 SGT
41 minutes 53 seconds
DEFALLT

Yankees_Rule

1.0.3

QuantStudio Software v1.0
278880012

10.0

105.0

384-Wel Block

From the

™

You can also view the progress of the run from the QuantStudio ™ 6 or 7 Instrument

QuantStudio™ 6 or  touchscreen.

7 Instrument

The following are images of the Run Method screen on the QuantStudio'™ 6 or 7

touchscreen Instrument touchscreen:
Experiment view
® Time View Ht|  Experiment View
Run Started: July 06 2013 - 05:48PM Sample: 0.0 °C
Reaction Volume: 20 pL Heated Cover [Set Point): 105.0 °C (105.0 °C)
Time Remaining: 01:15:39
Stage 1 Stage 2
X1 3of40
95.0 °C 95.0 °C
10:00 0:15 \ 50.0 °C
1:00
o
July 056 2013 - 05:48PM 0
Heated cover reached target temperature.
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Monitor the run

Time View
®© Time View t] Experiment View
Run Started: July 06 2013 - 05:48PM Sample: 95.0 °C
Reaction Volume: 20 pL Heated Cover [Set Point): 105.0 °C (105.0 °C)

Stage /Step /Cycle: 1/2/1

01:31:52

@ Remaining Time Elapsed Time

July 06 2013 - 05:48PM 0

Heated cover reached target temperature.
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Monitor the run

94 QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Getting Started Guide for Relative Standard Curve
and Comparative Cy Experiments



Review Results and Adjust
Experiment Parameters

In Section 11.1 of this chapter you review the analyzed data using several of the
analysis screens and publish the data. Section 11.2 of this chapter walks you through
the process of modifying experiment parameters to troubleshoot problems with
experiment results before rerunning an experiment.

This chapter covers:

B Section 11.1 Review Results .........ccoiiiiiiiiiiiiiiiiiiiiiiiiiinne, 97
Analyze the example experiment. . ............. ... ... ... ool 97

B Assess the gene expression profile using the Gene Expression Plot. . ......... 97
B Identify well problems using the Well Table .............................. 99
B Assess amplification results using the Amplification Plot.................. 101
B Confirm accurate dye signal using the Multicomponent Plot............... 108
B Determine signal accuracy using the Raw DataPlot ...................... 110
B View the endogenous control profile using the QCPlot ................... 112
B Review the flagsin the QCSummary .............ccoiiiiio .. 113
B Formoreinformation. .......... ... . i 115
B Section 11.2 Adjust parameters for re-analysis of your own experiments .. 117
B Adjustanalysissettings................ .. ... i 117
B Improve CT precision by omitting wells. .. ........................... ... 120
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Section 11.1 Review Results

Analyze the example experiment

1. Open the example experiment file that you ran in Chapter 10.

2. Click Analyze. The software analyzes the data using the default analysis settings.

Note: You can also access the experiment to analyze from the Home screen.

Assess the gene expression profile using the Gene Expression Plot

The Gene Expression Plot screen displays the results of relative quantification
calculations in the gene expression profile. There are two plots available:

* RQ vs Target — Groups the relative quantification (RQ) values by target. Each
sample is plotted for each target. You can view the plot as the linear, log10, Ln,
and log2 graph types. The Gene Expression plot when viewed as a linear graph
type looks like this:

Gene Expression

Plot Settings

Plot Type:|RQ vs Target | Graph Type:|Linear w Orientation: |Vertical Bars v

[ 5ave current seftings as the defaull

AP B W S
RQ vs Target

550 530,871

§00 II

RQ

o 1 2.232 1.251 0.174 1 1.053 0181 0.612 1 0.501 0.501 1 0.458 0.583 0.3

Target

Legend
. Brain Heart . Liver . Lung

Well Summary: In Plate: 384 Set Up: 65 Anshyzed: 65 Flegged: 3 Omitted by Analysis: I Omitted Manualhy: 0 Samples Used: 4 Targats Used: 5
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Assess the gene expression profile using the Gene Expression Plot

* RQ vs Sample — Groups the relative quantification (RQ) values by sample. Each
target is plotted for each sample. You can view the plot as the following graph
types: linear, log10, Ln, log?2.

Gene Expression
Plot Settings
Plot Type:|RQ vs Sample »|Graph Type: Linear v |Orientation: |Vertical Bars -

[ save current settings as the default

A pablE
RQ vs Sample

550 530,871

RO

Sample

e
M ceroH i1 @urc P

Well Summary: In Plate: 384 Set Up: 65 Analyzed: 65 Flagged: 3 Omitted by Analysis: 0 Omitted Manually: 0 Samples Used: 4 Targets Used: 5

Example Review each target in the Gene Expression Plot screen for the expression level (or fold
experiment values change) of the target sample relative to the reference sample.

View the Gene 1. From the Experiment Menu pane, select Analysis » Gene Expression.
Expression Plot Note: If no data are displayed, click Analyze.

2. In the Gene Expression Plot screen, select:

Menu Selection
Plot Type RQ vs Sample (default)
Graph Type Log10
Orientation Vertical Bars

3. Click [~ Show a legend for the plot (default).

Note: This is a toggle button. When the legend is displayed, the button changes to
Hide the plot legend.
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Identify well problems using the Well Table

In the example experiment, as shown below, the expression level of each target gene in
liver, heart, and lung is displayed relative to its respective expression level in the
reference sample (brain). Since the reference sample is compared to itself, the relative
expression level is 1. When the result is displayed in the Log10 graph type, the
expression level of the reference sample appears as 0 in the graph (log10 of 1=0).

Gene Expression

Plot Settings

Plot Type:|RQ vs Sample | Graph Type:|Logl0 v | Orientation:|Vertical Bars -

[[]save current settings as the default

2oL a ey =
RQ vs Sample

3.00
278 2.725
2.50
2.28
2.00
1.76
1.50

o 126
o
= oo
2 ors
0.50 0.348
0.25 N
00 o o i a . 0.022 ==
[ | =
-0.25 = 0179 0213 -
03 | - -
080 0.332 0301
-0.523
-0.75 =
0.743 -0.78
-1.00
- & & 3
<% & o &
Sample
Leges
M caeon cHi @urc Pt
Well Summary: In Plate: 384 Set Up: 65 Anahyzed: 65 Flagged: 3 Omitted by Analysis: 0 Omitted Manually: 0 Samples Used: 4 Targsts Used: 5

Assessing the gene  When you analyze your own Comparative Cy experiment, look for differences in gene
expression plot expression (as a fold change) relative to the reference sample.

your own
experiments

Identify well problems using the Well Table

The Well Table displays data for each well in the reaction plate, including:
* The sample name, target name, task, and dyes

* The calculated threshold cycle (Ct), normalized fluorescence (Rn), and quantity

values
e Flags
Example Review the Well Table to evaluate the Cy precision of the replicate groups.
experiment values
and flags
View the well table 1. From the Experiment Menu pane, select Analysis » Amplification Plot, then click
the Well Table tab.
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Identify well problems using the Well Table

| Plate Layout able

2. From the Group By drop-down menu, select Replicate.

3. Look at the C1 SD column to evaluate the Ct precision of the replicate groups. In
the example experiment, there are three outliers. You will omit these wells in the
troubleshooting section (“Improve CT precision by omitting wells” on page 120).

Group by W
|
# Well | Omit Flag Sample ... Target.. Task Dyes ET CT Mean @ CT SD ACT ACT Me... | ACT SE AACT RQ RQ Min RQ M

= Flagged Wells A

153 G9 ] 1 Liver GH1 UNKNOWN  FAM-NFQ-... 36.234 35.576 0.642 16.385 0.374 2.467 0.181 0.088

154 G10 O 1 Liver GH1 UNKHNOWN ~ FAM-NFQ-... 34.951 35.576 0.642 16.385 0.374 2.467 0.181 0.088

155 G11 ] 1 Liver GH1 UMKNOWN ~ FAM-NFQ-... 35.542 35.576 0.642 16.385 0.374 2.467 0.181 0.088
= Unflagged Wells

Al ] Brain ACTB UNKNOWN ~ FAM-NFQ-... 17.339 17.281 0.050

2 A2 I | Brain ACTB UNKNOWN ~ FAM-NFQ-... 17.245 17.281 0.050

3 A3 O Brain ACTB UNKNOWN ~ FAM-NFQ-... 17.260 17.281 0.050

4 A4 (]

5 A5 O Brain GAPDH UNKNOWN ~ FAM-NFQ-... 17.627 17.631 0.010 0.349 0.030 0.000 1.000 0.945

6 AB ] Brain GAPDH UNKNOWN  FAM-NFQ-... 17.622 17.631 0.010 0.349 0.030 0.000 1.000 0.945

7 A7 1 Brain GAPDH UNKNOWN ~ FAM-NFQ-... 17.642 17.631 0.010 0.349 0.030 0.000 1.000 0.945

8 A8 O

9 A9 ] Brain GH1 UNKNOWN  FAM-NFQ-... 31.215 31.200 0.211 13.919 0.125 0.000 1.000 0.786

10 A10 O Brain GH1 UNKNOWN ~ FAM-NFQ-... 31.403 31.200 0.211 13.819 0.125 0.000 1.000 0.786

11 ALl ] Brain GH1 UNKNOWN ~ FAM-NFQ-... 30.982 31.200 0.211 13.919 0.125 0.000 1.000 0.786

12 A2 O

13 A13 O Brain LPIN1 UNKNOWN ~ FAM-NFQ-... 21.765 21.819 0.047 4.537 0.040 0.000 1.000 0.926

14 Al4 I Brain LPINT UNKNOWN  FAM-NFQ-... 21.839 21.819 0.047 4.537 0.040 0.000 1.000 0.926

15 AlS O Brain LPIN1 UNKNOWM  FAM-NFQ-... 21.853 21.819 0.047 4.537 0.040 0.000 1.000 0.926

16 Al6 (]

17 A7 O Brain LIPC UNKNOWN ~ FAM-NFQ-... 29.293 29.235 0.053 11.853 0.042 0.000 1.000 0.922

18 A18 ] Brain LIPC UNKNOWN ~ FAM-NFQ-... 29.224 20.235 0.053 11.953 0.042 0.000 1.000 0.922

19 A19 1 Brain LIPC UNKNOWN  FAM-NFQ-... 29.188 29.235 0.053 11.953 0.042 0.000 1.000 0.922

20 A20 O

21 A21 (]

22 A2 O

23 A23 (]

24 A24 O ACTB NTC FAM-NFQ-... Undetermi...

25 B1 ] ¥
< >

Well Summary: In Piste: 384 Set Up: 65 Analyzed: 65 Flagged: 3 Omitted by Analysis: Omittd Manualy: 0 Samples Ussd: 4 Targets Used: 5

Assessing the well
table in your own
experiments

100

Note: To show/hide columns in the Well Table, select/deselect the column name from
the Show in Table drop-down menu.

When you analyze your own Comparative C experiment, look for standard deviation
in the replicate groups (Ct SD values). If needed, omit outliers (see “Improve CT
precision by omitting wells” on page 120).
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Assess amplification results using the Amplification Plot

Assess amplification results using the Amplification Plot

Amplification plots = The Amplification Plot screen displays amplification of all samples in the selected
available for wells. There are three plots available:

viewing * ARnvs Cycle - ARn is the magnitude of normalized fluorescence signal generated
by the reporter at each cycle during the PCR amplification. This plot displays ARn
as a function of cycle number. You can use this plot to identify and examine
irregular amplification and to view threshold and baseline values for the run.

* Rnvs Cycle — Rn is the fluorescence signal from the reporter dye normalized to
the fluorescence signal from the passive reference. This plot displays Rn as a
function of cycle number. You can use this plot to identify and examine irregular
amplification.

* Cyvs Well - Cyis the PCR cycle number at which the fluorescence meets the
threshold in the amplification plot. This plot displays Cr as a function of well
position. You can use this plot to locate outlying amplification (outliers).

Each plot can be viewed as a linear or log10 graph type.

Purpose The purpose of viewing the amplification plot for the example experiment is to
identify:
¢ Correct baseline and threshold values
¢ Qutliers
View the 1. From the Experiment Menu pane, select Analysis » Amplification Plot.
Amplification Plot Note: If no data are displayed, click Analyze.

2. Display the LPIN1 wells in the Amplification Plot screen:
a. Click the Plate Layout tab.
b. From the Select Wells drop-down menus, select Target, then LPIN1.
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Assess amplification results using the Amplification Plot

The following is an image of the Plate Layout screen:

.
.
[
.
| N I T I T [T in Aw 2w e
H
- s
]
n]
o]
e |
wels: [ 60 [ 5 319 Empty
‘Well Summary: In Plste: 384 Set Up: 65 Anzhyzed: §5 Flagged: 3 Omitted by Anahysis: 0 Omitted Manualhy: Samples Used: 4 Targsts Used: 5
3. In the Amplification Plot screen, enter:
Menu Selection
Plot Type ARn vs Cycle (default)
Plot Color Well (default)
F Check (default)
(This is a toggle button. When the legend
is displayed, the button changes to Hide
the plot legend.)
4. View the baseline values:
a. From the Graph Type drop-down menu, select Linear.
b. Select the Baseline check box to show the start cycle and end cycle.
102 QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Getting Started Guide for Relative Standard Curve

and Comparative Cy Experiments



Section 11.1 Review Results 1 1
Assess amplification results using the Amplification Plot

c. Verify that the baseline is set correctly: The end cycle should be set a few
cycles before the cycle number where significant fluorescent signal is
detected. In the example experiment, the baseline is set correctly.

Amplification Plot
Plot Settings

Plot Type:|/ARn vs Cycle |»| Graph Type:|Linear | Plot Color:|Well w

[ Save current settings as the default

2L el

Amplification Plot
1.3
1.2
1.1
1.0
09

0.8

DC: 0.7 _7__7_fz—::—=—ﬁ
S —
0.8
0.5 = il
0.4 i
=
0.3 o
0.2
0.1
2 4 & & 10 12 14 16 18 20 22 24 26 28 30 52 a4 36 a8 40
Cycle
Options
Target: [LPIN1 |+ | Thrashold: [] Auto [0.061456
Show: [] Threshold — [/] Baseline Start: Well B Target < Baseline End: Well (M Target 4.
‘Well Summary: In Plste: 384 Set Up: 65 Anahyzed: 65 Flagged: 3 Omitted by Analysis: Omitted Manually: 0 Samples Used: 4 Targets Used: 5
5. View the threshold values:
Menu Select
Graph Type Log
Target LPTN1

a. Select the Threshold check box to show the threshold.
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Assess amplification results using the Amplification Plot

b. Verify that the threshold is set correctly. In the example experiment, the
threshold is in the exponential phase.

Amplification Plot
Plot Settings

Plot Type:|/ARn vs Cycle |v| Graph Type:|Log ~ | Plot Color:|Well v

[ save current settings as the default

Amplification Plot

1E01

1E00

0.1

ARn

0.061456

0.001

Cycle

Options

Target: [LPIN1 |+ Threshold: [] Auto |0.061456 [] Auto Baseline

Show: [¥] Thrashold — [] B3  Well M Target 4 Baseline End: Well (M Target 4.

Well Summary: In Plate: 384 Set Up: 65 Anahyzed: 65 Flagged: 3 Omitted by Anahysis: 0 Omitted Manualy: 0 Samples Used: 4 Targsts Used: 5

6. Locate any outliers:
a. From the Plot Type drop-down menu, select Ct vs Well.

b. Look for outliers from the amplification plot. In the example experiment,
there are no outliers for LP1N1.

Amplification Plot

Plot Settings

Plot Type:|CT wvs Well w | Graph Type: Plot Color: |Well ~

[] save current settings as the default

Amplification Plot

Cr

5 10 15 20 25 30 35 40 45 50 55 60 65 70 75 80 65 90 95100105 101 15 20125 301 351 401451501 551601 651 70751 @1 e 1@ 44 GTHED
WWell Mumber

Well Summary: In Plste: 384 Set Up: 65 Anshyzed: 65 Flzgged: 3 Omitted by Analysis: Omitted Manually: 0 Samples Used: 4 Targets Used: 5
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Assess amplification results using the Amplification Plot

7. Repeat steps 2 through 6 for the GH1, TGFB1, LIPC, GAPDH, 18S, and ACTB
wells. In the example experiment, there is one outlier for 18S. You will omit these
wells in the troubleshooting section (“Improve CT precision by omitting wells” on
page 120).

Tips for analyzing When you analyze your own Comparative Ct experiment, look for:

your own e Qutliers

experiments * A typical amplification plot — The QuantStudio™ 6 and 7 Flex Software

automatically calculates baseline and threshold values based on the assumption
that the data exhibit a typical amplification plot. A typical amplification plot has
four distinct sections:

— Plateau phase
— Linear phase
— Exponential (geometric phase)
— Baseline
A typical amplification plot should look like this:

Amplification Plot

Plot Settings
Plot Type: ARn ws Cycle || Graph Type:|Log + | Plot Color:|Well »

[] save current sattings as the default

Amplification Plot

1E01

1E00

ARn

0.1
0.061456

0.001

Options

Target: LPIN1 & | Threshold: [] Auto |0.061456 [[] Auto Baseline

Show: [¥] Threshold —

tiwel B Target 4+ Baseline End: Well (W Target 4

‘Well Summary: In Plate: 384 Set Up: 65 Analyzed: 65 Flagged: 3 Omitted by Analysis: 0 Omitted Manually: 0 Samples Used: 4 Targets Used: 5

IMPORTANT! Experimental error (such as contamination or pipetting errors)
can produce atypical amplification curves that can result in incorrect
baseline and threshold value calculations by the QuantStudio™ 6 and 7 Flex
Software. Therefore, Life Technologies recommends that you examine the
Amplification Plot screen and review the assigned baseline and threshold
values for each well after analysis completes.
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Correct threshold values

Chapter 11 Review Results and Adjust Experiment Parameters
Assess amplification results using the Amplification Plot

Threshold Set Correctly

The threshold is set in the
exponential phase of the
amplification curve.

Threshold settings above or
below the optimum increase
the standard deviation of the
replicate groups.

Threshold Set Too Low

The threshold is set below
the exponential phase of the
amplification curve. The
standard deviation is
significantly higher than that
for a plot where the threshold
is set correctly. Drag the
threshold bar up into the
exponential phase of the
curve.

Threshold Set Too High

The threshold is set above
the exponential phase of the
amplification curve. The
standard deviation is
significantly higher than that
for a plot where the threshold
is set correctly. Drag the
threshold bar down into the
exponential phase of the
curve.

ARN

ARN

ARN

101

1E00

0.1

0.01

1E01

1E00

o1

oo

1ED1

1E00

o1

0.061456

0.008248

0.608555
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Assess amplification results using the Amplification Plot

Correct baseline values

Baseline Set Correctly 1E01

The amplification curve
begins after the
maximum baseline.

1E00

o1

ARN

Baseline Set Too Low 1E01

The amplification curve
begins too far to the
right of the maximum
baseline. Increase the
End Cycle value.

1E00

AR
o

Baseline Set Too High 101

The amplification curve
begins before the
maximum baseline.
Decrease the End Cycle
value.

1E00

ARN

o1

If your experiment does not meet the guidelines above, troubleshoot as follows:

Omit wells (see “Improve CT precision by omitting wells” on page 120).
Or

Manually adjust the baseline and/or threshold (see “Adjust analysis settings”

page 117).
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Confirm accurate dye signal using the Multicomponent Plot

Confirm accurate dye signal using the Multicomponent Plot

The Multicomponent Plot screen displays the complete spectral contribution of each
dye in a selected well over the duration of the PCR run.

Purpose In the Comparative Cy example experiment, you review the Multicomponent Plot
screen for:

View the 1.

Multicomponent
Plot

ROX™ dye (passive reference)
FAM™ dye (reporter)
Spikes, dips, and/or sudden changes

Amplification in the negative control wells

From the Experiment Menu pane, select Analysis » Multicomponent Plot.

Note: If no data are displayed, click Analyze.

Display the unknown and standard wells one at a time in the Multicomponent
Plot screen:

a. Click the Plate Layout tab.

b. Select one well in the plate layout; the well is shown in the Multicomponent
Plot screen.

Note: If you select multiple wells, the Multicomponent Plot screen displays
the data for all selected wells simultaneously.

From the Plot Color drop-down menu, select Dye.

Click [== Show a legend for the plot (default).

Note: This is a toggle button. When the legend is displayed, the button changes to
Hide the plot legend.

108 QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Getting Started Guide for Relative Standard Curve

and Comparative Cy Experiments



Confirm accurate dye signal using the Multicomponent Plot

Section 11.1 Review Results

5. Check the FAM dye signals. In the example experiment, the FAM dye signal
increases throughout the PCR process, indicating normal amplification.

Multicomponent Plot
Plot Settings

porcomroye

[ 5ave current settings as the default

- o W e
AL el = !
Multicomponent Plot
160,000
180,000
170,000
o ; UBDEL B o
140,000 F
130,000 { - + - - [ r
120,000 a0 JLah, JL 0.og d
g .
é 110,000 N "
@ 100,000 ||
S eonoo I u
b s0.000 I
70.000 il
60,000 [
50,000 «
40,000 L
30,000 [ |
20,000 M
10,000 —
0 N
¢ 2 4 & & W © & ® @ = = 3 PEEEE] a e |||
Cycle o
Lege |
Il FAM Il ROX P
wels: [ 60 [ 5 319 Empty
Well Summary: In Plate: 384 Set Up: 65 Analyzed: 65 Flagged: 3 Omitted by Analysis: 0 Omitted Manually: 0 Samples Used: 4 Targets Used: 5

6. Select the negative control wells one at time and check for amplification. In the
example experiment, there is no amplification in the negative control wells.

Multicomponent Plot

Plot Settings
pce oo
[[] save current settings as the default | 12 ‘ 13 | 14 ‘ 15 | 16 ‘ 17 |15 | 19 |2|J ‘21 |22 ‘23 ZU
2P B 111 D m
Multicomponent Plot B
100000 - |1 n.0.m E|
180,000 [
170,000 i
oo 233 FO3 DFF 111 JOD B
150,000 E_ l l l
140,000 F
130,000 —
» 120000 & uuu uuu 111 0.oo uuu J.
£ oo i ?
2 100000 |
5 0000 1 v |
S 80000 L
70,000 1
60,000 1
50,000 L
40,000 .
30,000 -
20,000 M
10,000 -
a N
oz 4 & & 10 i2 14 8 @ 2 2 26 M/ AW W @ @ a2 -
Cycle o
Lages -
Il FaM Il ROX P
wels: [ 60 [ 5 319 Empty
Well Summary: In Plates 384 Set Up: 65 Analyzed: 65 Flagged: 3 Omitted by Analysis: 0 Omitted Manually: 0 Samples Used: 4 Targets Used: 5
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Determine signal accuracy using the Raw Data Plot

Tips for confirming ~ When you analyze your own Comparative Ct experiment, look for:

dye accuracy in * Passive reference — The passive reference dye fluorescence level should remain
your own relatively constant throughout the PCR process.
experiment * Reporter dye — The reporter dye fluorescence level should display a flat region

corresponding to the baseline, followed by a rapid rise in fluorescence as the
amplification proceeds.

* Irregularities in the signal — There should not be any spikes, dips, and/or sudden
changes in the fluorescent signal.

* Negative control wells — There should not be any amplification in the negative
control wells.

Determine signal accuracy using the Raw Data Plot

The Raw Data Plot screen displays the raw fluorescence signal (not normalized) for
each optical filter for the selected wells during each cycle of the real-time PCR.

About the example Inthe Comparative Ct example experiment, you review the Raw Data Plot screen for a
experiment stable increase in signal (no abrupt changes or dips) from the appropriate filter.

View the Raw Data 1. From the Experiment Menu pane, select Analysis » Raw Data Plot.
Plot Note: If no data are displayed, click Analyze.

2. Display all 384 wells in the Raw Data Plot screen by clicking the upper left corner
of the plate layout in the Plate Layout tab.

3. Click [E= Show a legend for the plot (default).

Note: This is a toggle button. When the legend is displayed, the button changes to
Hide the plot legend.

Note: The legend displays the color code for each row of the reaction plate (see
the legend in the Raw Data Plot shown below).
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Section 11.1 Review Results 1 1
Determine signal accuracy using the Raw Data Plot

4. Click and drag the Show Cycle pointer from cycle 1 to cycle 40. In the example
experiment, there is a stable increase in signal from filter 1, which corresponds to
the FAM™ dye filter.

Raw Data Plot £
R L Al
Raw Data Plot
750,000
700,000
850,000 1
600,000 \ R
550,000 3
500,000
N
450,000
& 400,000
E
‘& 250,000
=
300,000
250,000
200,000
150,000
100,000 |
50,000
o —
x1-m1 x3-m3 xdmd *5-mS
Filter
Leges
EA BB BNc WD MiE HF WG W ~
i1 ) H< N Hv Hy Ho WP v
Options
Show Cycle 40 J
1 5 10 15 20 25 30 35 40
Well Summary: In Plate: 384 Set Up: 65 Anshyzed: 65 Fiageed: 3 Onitted by Anslysis: 0 Oritted Manushy: Samples Ussdi 4 Targsts Ussd: 5
The filters used for the example experiment are:
PCR Filter [

Emission Fitter

ml(520=15) m2(558+11) m3(586+10) m4(623=x14) m5(682=14) me&(711+12)
*1(470+15)

%2(520+10)

¥3(550=11)

Excitation Filtter

*4(580+10)

¥5(640+10)

*¥6(662+10)

Melt Curve Filter [

Erission Filcer
ml1(520+15) m2(558+11) m3(586+10) m4(623+14) m5(682+14) m6(711 +12)
x1(470=15)
] x2(520+10)
= ¥3(550+11)
% *4(580=10)
*5(640+10)
x6(662+10) ~
Tips for When you analyze your own Comparative C experiment, look for the following in
determining signal  each filter:
accuracy in your ¢ Characteristic signal growth
own experiment e No abrupt changes or dips
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View the endogenous control profile using the QC Plot

View the endogenous control profile using the QC Plot

In the Comparative Cp experiment, the QC Plot screen displays the Endogenous
Control Profile plot for all the targets in the experiment. The QC Plot serves as a tool to
help you choose the best endogenous control for that experiment. The endogenous
control profile plot is a visual display of the Cr level of the endogenous control across
the sample. You can view up to four endogenous controls at a time. The sample is
plotted on the X-axis, and Cry is plotted on the Y-axis. The expression is viewed as a
color and shape combination in the plot. Endogenous controls are also known as
reference genes.

Example In the example experiment, you can view the endogenous control profile of ACTB,
experiment GAPDH, GH1, and LPIN1 the QC Plot screen.

settings

View the QC Plot 1. From the Experiment Menu pane, select Analysis » QC Plot.

Note: If no data are displayed, click Analyze.

2. In the QC Plot screen, click Target Table.

a. In the Candidate Control column, select the check box of the target of the
endogenous control profile to plot. In the example experiment, the
endogenous controls selected are ACTB, GAPDH, GH1, and LPIN1.

b. Select a color for each target, from the Color drop-down menu.
c. Select a shape for each target, from the Shape drop-down menu.

3. Click the View Replicate Results Table.

4. Select the check box of the samples to plot. In the example experiment, all the four
samples, Brain, Heart, Liver, and Lung are selected.

5. Click E Show a legend for the plot (default).

Note: This is a toggle button. When the legend is displayed, the button changes to
Hide the plot legend.
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Review the flags in the QC Summary

The following is an image of the QC Plot in the Comparative Cy example

experiment:

P L a il

Endogenous Control Profile

e
A
25 ——
-—
200
.
5]
175
150
125
100
75
50
25
oo -
Brain Heart Liver Lung
Sample
- ACTE @ GAPDH GH1 =& LPIN1
Well Summary: In Plate: 384 Set Up: 65 Analyzed: 65 Flagged: 3

—

Target Color Shape
ACTE I n] >
GAPDH I =] 2
GH1 L kel »
LPINL I S v
LIPC v ¥
Wiew Biological Groups W
Omit Sample Target CT Mean ACT Me... ACT SE AACT RQ RQN
Brain ACTB 21.498
Brain GAPDH 17.631 -2.867 0.01 o 1
Brain GH1 332 9.702 0.122 0 1
Brain LPIN1 21.819 0.321 0.028 0 1
Brain LIPC 20.235 7737 0.032 o 1
Heart ACTB 21.633
[ Heart GAPDH 17.28 -4.354 0.047 -0.486 1.401
O Heart GH1 31.933 10.3 0.152 0.597 0.661
O Heart LPIN1 23.729 2.095 0.041 1775 0.202
O Heart LIPC 31.038 9.405 0.066 1.668 0.315
Lung ACTB 217
O Lung GAPDH 21.084 -0.616 0.04 3.251 0.105
O Lung GH1 32.837 11.136 0.021 s 0.37
O Lung LPIN1 24.485 2.785 0.053 2.464 0.181
[ Lung LIPC 31.162 9.462 0.062 1.725 0.302
Liver ACTB 21.988
O Liver GAPDH 19.217 -2.772 0.06 1.096 0.468
O Liver GH1 35.576 13.588 0.372 3.885 0.068
O Liver LPIN1 24.322 2,333 0.078 2.012 0.248
O Liver LIPC 22.092 0.102 0.068 -7.632 198.563 1
£ bd
Omitted by Analysis: 0 Omitted Manualy: 0 Samples Used: 4 Targets Used: 5

Note: This example experiment does not define Biological Groups.

Review the flags in the QC Summary

The QC Summary screen displays a list of the QuantStudio™ 6 and 7 Flex Software
flags, including the flag frequency and location for the open experiment.

Review the QC Summary screen in the Comparative Ct example experiment for any
flags triggered by the experiment data. Wells G9, G10, and G11 have data that
triggered the HIGHSD flag.

View the QC 1. From the Experiment Menu pane, select Analysis » QC Summary.

Summary

Note: If no data are displayed, click Analyze.

2. Review the Flags Summary.

Note: A 0 displayed in the Frequency column indicates that the flag does not

appear in the experiment. If the frequency is >0, the flag appears somewhere in
the experiment; the well position is listed in the Wells column.

In the example experiment, there are seven flagged wells.
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Review the flags in the QC Summary

3. In the Flag Details table, click each flag with a frequency >0 to display detailed
information about the flag. In the example experiment. The HIGHSD flag appears
three times, in the wells G9, G10, and G11, indicating high standard deviation in
the replicate group.

Note: The HIGHSD flag appears because the Ct values exceed the expected range
due to low expression of the GH1 gene in the Liver sample.

4. (Optional) For those flags with frequency >0, click the troubleshooting link to view
information on correcting the flag.

The following is an image of the QC Summary for the example experiment:

e

lag Details
Flag: Description Freguency Wells
AMPHC Amplification in negative control i}
BADROX Bad passive reference signal [i]
OFFSCALE Fluorescence is offscale [i
HIGHSD High standard deviation in replicate group 3 GS, G10, G11
NOAMP Mo amplification [i]
MNOISE Moise higher than others in plate 0
SPIKE Moise spikes 0
MNOSIGHAL Mo signal in well [i]
OUTLIERRG Outlier in replicate group [i]
EXPFAIL Exponential algorithm failed 0
BLFAIL Baseline algorithm failed 0
THOLDFAIL Thresholding algorithm failed [i]
CTFAIL Ct algorithm failed [i]
Flag: HIGHSD—High standard deviation in replicate group
Flag Detail: The Ct standard deviation for the replicate group exceeds the flag
setting.
Flag Criteria: CT standard deviation = 0.5
Flagged Wells: G9, G10, G11
View HIGHSD Troubleshooting Information
Total Wells: 384 | Processed Wels: 65 Manually Omitted Wells: 0 | Targets Used: 5
Wells Set Up: 65 Flagged Wells: 3 Analysis Omitted Wells: 0 | Samples Used: 4
Well Summary: In Plate: 384 Set Up: 65 Anaiyzed: 65 Flagged: 3 Omitted by Analysis: 0 Omitted Manusly: 0 Samples Usd: 4 Targets Usad: 5

Possible flags

114

The flags listed below may be triggered by the experiment data.

Flag

Description

Pre-processing flag

OFFSCALE Fluorescence is offscale
Primary analysis flags

BADROX . Bad passive reference signal

NOAMP No amplification

NOISE Noise higher than others in plate

SPIKE Noise spikes

NOSIGNAL No signal in well

EXPFAIL Exponential algorithm failed

BLFAIL Baseline algorithm failed

THOLDFAIL Thresholding algorithm failed
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For more information

Flag Description
CTFAIL Cy algorithm failed
Secondary analysis flags
OUTLIERRG Outlier in replicate group
AMPNC Amplification in negative control
HIGHSD High standard deviation in replicate group
For more information
For more information on... Refer to... Publication
number
Publishing data Chapter 2 in Booklet 1, Getting Started with QuantStudio™ é and 4489822
7 Flex Real-Time PCR System Software Experiment
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For more information
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Adjust analysis settings

Section 11.2 Adjust parameters for re-analysis of
your own experiments

Adjust analysis settings

The Analysis Settings dialog box displays the analysis settings for the threshold cycle
(Cy), flags, and advanced options.

If the default analysis settings in the QuantStudio'" 6 and 7 Flex Software are not
suitable for your own experiment, you can change the settings in the Analysis Settings
dialog box, then reanalyze your experiment.

View the analysis 1. From the Experiment Menu pane, select Analysis.

settings 2. Click Analysis » Analysis Settings to open the Analysis Settings dialog box.

In the example experiment, the default analysis settings are used for each tab:
® (g Settings
¢ Flag Settings
* Relative Quantification Settings

* Advanced Settings

The following is an image of the Analysis Settings dialog box for a Comparative
Cr experiment:

13 Analysis Settings for QS6_QuantStudio_384-Well _Comparative_Ct_Example

C g Flag Settings Relative Quantification Settings Advanced Settings

rgets in this experiment. To use different settings for a target, select the target from the table, deselect Use Default

—Data Step Selection Algorithm Settings
Select the step and stage to use for C1 analysis. Only stage/step combinations for which data suitable for C1
analysis have been collected are displayed. Baseline Threshold «

Stage 2, Step 2

— Default Ct Settings
Default CT settings are used to calculate the CT for targets without custom settings. To edit the default settings, dick Edit Default Settings.

Threshold: AUTO Baseline Start Cycle: AUTO Baseline End Cycle: AUTO | Edit Default Settings

— Select a Target ~— Cr Settings for ACTB
Target Threshold Baseline Start Baseline End Cr Settings to Use: Default Settings
ACTB AUTO AUTO AUTO 2
GAPDH AUTO AUTO AUTO
GH1 AUTO AUTO AUTO
LIPC AUTO AUTO AUTO
LPIN1 AUTO AUTO AUTO
w

Save to Library Load from Library Revert to Default Analysis Settings Apply Analysis Settings
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Adjust analysis settings

Adjust analysis
settings

3.

View and, if necessary, change the analysis settings (see “Adjust analysis settings”
below).

Note: You can save the changes to the analysis settings to the Analysis Settings
Library for later use. For more information, see About the Analysis Settings
Library in Booklet 1, Getting Started with QuantStudio'™ 6 and 7 Flex Real-Time PCR
System Software Experiments.

Click Apply Analysis Settings to apply the current analysis settings.

Note: You can go back to the default analysis settings, by clicking Revert to
Default Analysis Settings.

Cr Settings

Data Step Selection

Use this feature to select one stage/step combination for Cy analysis when there is
more than one data collection point in the run method.

Algorithm Settings
Use the Baseline Threshold algorithm to determine the Ct values.

The Baseline Threshold algorithm is an expression estimation algorithm that
subtracts a baseline component and sets a fluorescent threshold in the exponential
region for gene quantification.

Default Ct Settings

Use the default Cr settings feature to calculate Cr for the targets that do not have
custom settings. To edit the default settings, click Edit Default Settings.

Cr Settings for Target

When you manually set the threshold and baseline, Life Technologies
recommends:

Setting Recommendation

Threshold Enter a value for the threshold so that the threshold is:

e Above the background.

¢ Below the plateau and linear regions of the amplification curve.
e Within the exponential phase of the amplification curve.

Baseline Select the Start Cycle and End Cycle values so that the baseline ends
before significant fluorescent signal is detected.

Note: This setting is applicable only to the Baseline Threshold algorithm.

Note: Selecting Automatic Threshold implies selection of automatic setting of the
baseline. However, if Automatic Threshold is deselected, then you can choose
between setting the baseline either automatically or manually.

Flag Settings
Use the Flag Settings tab to:

Adjust the sensitivity so that more wells or fewer wells are flagged.
Change the flags that are applied by the QuantStudio™™ 6 and 7 Flex Software.

To adjust the flag settings
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Adjust analysis settings

In the Use column, select the check boxes for flags to apply during analysis.

(Optional) If an attribute, condition, and value are listed for a flag, specify the
setting for applying the flag.

Note: If you choose to adjust the setting for applying a flag, make minor
adjustments as you evaluate the appropriate setting.

In the Reject Well column, select the check boxes if you want the software to reject
wells with the flag.

Note: After you have rejected the flagged wells, analysis results depend on
factors such as the experiment type and flag type. For example, rejecting wells
flagged by HIGHSD in experiments using the Standard Deviation calculations
may change the result of Ct SD. For some flags, analysis results calculated before
the well is rejected are maintained.

Click Apply Analysis Settings in the Analysis Settings dialog box. If the run
status is complete, the data are reanalyzed.

The following is an image of the Flag Settings tab:

Flag Description Use Attribute Condition Value Reject Well
AMPNC Amplification in negativ..., T < ~ [35.000 ]
BADROX Bad passive reference ... Bad passive reference ... |> w [0.600 B
OFFSCALE Fluorescence is offscale L}
HIGHSD High standard deviatio... CT standard deviation = ~ [0.500 B
NOAMP No amplification Amplification algerithm ...| < w [0.100 L]
NOISE Noise higher than oth... Relative noise > ~ [4.000 ]
SPIKE Noise spikes Spike algorithm result > w [1.000 L}
NOSIGNAL Ho signal in well (]
OUTLIERRG Outlier in replicate group B
EXPFAIL Exponential algorithm f...| [
BLFAIL Baseline algorithm failed B
THOLDFAIL Thresholding algorithm... .}
CTFAIL Cr algorithm failed O

Revert to Default Analysis Settings [m

Relative Quantification Settings

Use the Relative Quantification Settings tab to:

Change the type of analysis, singleplex or multiplex.

* Change the reference sample and/or endogenous control.
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Improve Cr precision by omitting wells

* Reject Outliers with ACyvalues less than or equal to the entered value.
Note: The Outlier Rejection settings apply only to multiplex reactions.

* Select the algorithm to use to determine the relative quantification minimum and
maximum values (error bars):

— Confidence Level - Select to calculate the RQ minimum and maximum
values based on the selected confidence level. Select the confidence level to
use.

— Standard Deviations - Select to calculate the RQ minimum and maximum
values based on the selected number of standard deviations. Select the
number of standard deviations to use.

Advanced Settings
Use the Advanced Settings tab to change baseline settings well-by-well.
To use custom baseline settings for a well-target combination:

1. Select one or more well-target combinations in the table.

2. Deselect the Use Ct Settings Defined for Target check box.

3. Define the custom baseline settings:

e TFor automatic baseline calculations, select the Automatic Baseline check
box.

¢ To define the baseline, deselect the Automatic Baseline check box, then enter
the baseline start cycle and baseline end cycle.

Improve C; precision by omitting wells

Experimental error may cause some wells to be amplified insufficiently or not at all.
These wells typically produce Cy values that differ significantly from the average for
the associated replicate wells. If included in the calculations, these outliers can result in
erroneous measurements; to ensure Ct precision, omit the outliers from the analysis.

In the Comparative Cy example experiment, there are seven outliers. To remove these
wells from analysis.

1. From the Experiment Menu pane, select Analysis » Amplification Plot.

Note: If no data are displayed, click Analyze.

2. Inthe Amplification Plot screen, select Ct vs. Well from the Plot Type drop-down
menu.

3. Select the Well Table tab.
4. In the Well Table, identify outliers:

a. From the Group By drop-down menu, select Replicate.
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i

Look for outliers in the replicate group (make sure they are flagged). In the
example experiment, wells G9, G10, and G11 have outliers.

»|  Plate Layout

¥ Groupby ¥ Expand &l
# Well | Omit Flag Sample ... Target... Task Dyes cT CT Mean | CT SD ACT ACT Me... ACT SE AACT RQ RQ Min RQ M
149 G5 O Liver GAPDH UMKNOWN ~ FAM-NFQ-... 19.113 19.217 0.092 0.026 0.071 -0.323 1.251 1.001 A
150 G6 O Liver GAPDH UMKNOWN  FAM-NFQ-... 19.250 19.217 0.092 0.026 0.071 -0.323 1.251 1.001
151 G7 ] Liver GAPDH UMKNOWN ~ FAM-NFQ-... 19.288 19.217 0.092 0.026 0.071 -0.323 1.251 1.001
= Liver - GH1
153 G9 ] 1 Liver GH1 UMKNOWN  FAM-NFQ-... 36.234 35.576 0.642 16.385 0.374 2.467 0.181 0.088
154 G10 ] 1 Liver GH1 UNKNOWN  FAM-NFQ-... 34.951 35.576 0.642 16.385 0.374 2.467 0.181 0.088
155 G11 [] 1 Liver GH1 UMKNOWN ~ FAM-NFQ-... 35.543 35.576 0.642 16.385 0.374 2.467 0.181 0.088 —
161 G17 ] Liver LIPC UMKNOWN  FAM-NFQ-... 21.973 22.002 0.107 2.901 0.078 -9.052 530.871 456.875 6.
162 G18 " Liver LIPC UMKNOWN  FAM-NFQ-... 22.181 22.092 0.107 2.901 0.078 -9.052 530.871 456.875 6
163 G19 ] Liver LIPC UMKNOWN  FAM-NFQ-... 22.122 22.082 0.107 2.901 0.078 -9.052 530.871 456.875 6.
157 G13 ] Liver LPINL UNKNOWN  FAM-NFQ-... 24.180 24.322 0.127 5.131 0.087 0.593 0.663 0.560
158 G14 ] Liver LPIN1 UMKNOWN  FAM-NFQ-... 24.361 24.322 0.127 5.131 0.087 0.593 0.663 0.5e0
159 G15 " Liver LPINT UNKNOWN ~ FAM-NFQ-... 24.424 24.322 0.127 5.131 0.087 0.593 0.663 0.560
B Lung - ACTB
97 E1 ] Lung ACTB UMKNOWN ~ FAM-NFQ-... 18.151 18.210 0.064
98 E2 ] Lung ACTB UNKNOWN  FAM-NFQ-... 18.202 18.210 0.054
99 E3 ] Lung ACTB UMKNOWN ~ FAM-NFQ-... 18.278 18.210 0.064
101 ES ] Lung GAPDH UMKNOWN  FAM-NFQ-... 21.082 21.084 0.065 2.874 0.053 2.525 0.174 0.157
102 E6 O Lung GAPDH UMKNOWN  FAM-NFQ-... 21.020 21.084 0.065 2.874 0.053 2.525 0.174 0.157
103 E7 ] Lung GAPDH UMKNOWN ~ FAM-NFQ-... 21.150 21.084 0.065 2.874 0.053 2.525 0.174 0.157
B Lung - GH1
105 E9 ] Lung GH1 UNKNOWN  FAM-NFQ-... 32.856 32.837 0.030 14.626 0.041 0.707 0.612 0.566
106 E10 ] Lung GH1 UMKNOWN  FAM-NFQ-... 32.802 32.837 0.030 14.626 0.041 0.707 0.612 0.566
107 E11 ] Lung GH1 UMKNOWN  FAM-NFQ-... 32.851 32.837 0.030 14.626 0.041 0.707 0.612 0.566
113 E17 O Lung LIPC UMKNOWN  FAM-NFQ-... 31.081 31.162 0.105 12.952 0.071 0.998 0.501 0.436
114 E18 "] Lung LIPC UMKNOWN  FAM-NFQ-... 31.281 31.162 0.105 12.952 0.071 0.998 0.501 0.436 v
< | b3
Well Summary: In Plzte: 384 Set Up: 65 Anahyzed: 65 Fiagged: 3 Omitted by Anahysis: 0 Omitted Manualy: Samples Used: 4 Targets Used: 5

c. Select the Omit check box next to outlying well(s).

»| Plate Layout

Group by ¥ Expand Al
# Well | Omit Flag Sample ...| Target... Task Dyes cT CT Mean | CT SD ACT ACT Me... | ACT SE ANCT RQ RQ Min RQ M
149 G5 ] Liver GAPDH UMKNOWN  FAM-NFQ-... 19.113 19.217 0.092 0.026 0.071 -0.323 1.251 1.001 5
150 G6 O Liver GAPDH UMKNOWN ~ FAM-NFQ-... 19.250 19.217 0.092 0.026 0.071 -0.323 1.251 1.001
151 G7 ] Liver GAPDH UMKNOWN ~ FAM-NFQ-... 10.288 19.217 0.092 0.026 0.071 -0.323 1.251 1.001
153 Go UNKNOWN ~ FAM-NFQ-...
154 G10 1 Liver GH1 UMKNOWN  FAM-NFQ-... 34.951 35.576 0.642 16.385 0.374 2.467 0.181 0.088
155 G11 1 Liver GH1 UNKNOWN  FAM-NFQ-... -
= Liver - LIPC
161 G17 O Liver LIPC UMKNOWN  FAM-NFQ-... 21.973 22.092 0.107 2.901 0.078 -9.052 530.871 456.875 6
162 G18 ] Liver LIPC UMKNOWN  FAM-NFQ-... 22.181 22,082 0.107 2.901 0.078 -8.052 530.871 456.875 |
163 G19 [] Liver LIPC UMKNOWN  FAM-NFQ-... 22.122 22.092 0.107 2.901 0.078 -9.052 530.871 456.875 6
157 G13 ] Liver LPIN1 UMKNOWN  FAM-NFQ-... 24.180 24.322 0.127 5.131 0.087 0.593 0.663 0.5e0
158 G14 O Liver LPINT UMKNOWN  FAM-NFQ-... 24.361 24.322 0.127 5.131 0.087 0.593 0.663 0.560
159 G15 ] Liver LPIN1 UMKNOWN ~ FAM-NFQ-... 24.424 24.322 0.127 5.131 0.087 0.593 0.663 0.560
87 E1 ] Lung ACTB UMKNOWN  FAM-NFQ-... 18.151 18.210 0.064
98 E2 ] Lung ACTB UMKNOWN  FAM-NFQ-... 18.202 18.210 0.064
9% E3 ] Lung ACTB UNKNOWN  FAM-NFQ-... 18.278 18.210 0.064
101 E5 O Lung GAPDH UMKNOWN ~ FAM-NFQ-... 21.082 21.084 0.065 2.874 0.053 2.525 0.174 0.157
102 E6 O Lung GAPDH UMKNOWN  FAM-NFQ-... 21.020 21.084 0.065 2.874 0.053 2.525 0.174 0.157
103 E7 ] Lung GAPDH UMKNOWN ~ FAM-NFQ-... 21.150 21.084 0.065 2.874 0.053 2.525 0.174 0.157
105 E9 ] Lung GH1 UMKNOWN  FAM-NFQ-... 32.856 32.837 0.030 14.626 0.041 0.707 0.612 0.566
106 E10 ] Lung GH1 UNKNOWN ~ FAM-NFQ-... 32.802 32.837 0.030 14.626 0.041 0.707 0.612 0.566
107 E11 [] Lung GH1 UMKNOWN ~ FAM-NFQ-... 32.851 32.837 0.030 14.626 0.041 0.707 0.612 0.566
113 E17 ] Lung LIPC UMKNOWN  FAM-NFQ-... 31.081 31.162 0.105 12.952 0.071 0.998 0.501 0.436
114 E18 ] Lung LIPC UMKNOWN  FAM-NFQ-... 31.281 31.162 0.105 12.952 0.071 0.998 0.501 0.436 v
£ | >
Well Summary: In Plate: 384 Set Up: 65 Anzhyzed: 65 Flagged: 3 Omitted by Anahysis: 1 Omitted Manually: 0 Samples Used: 4 Targets Used: 5
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Improve Cr precision by omitting wells

5. Click Analyze to reanalyze the experiment data with the outlying well(s)
removed from the analysis.

Note: You can also omit undesirable wells in an experiment from the Plate Layout

screen. To omit a well from the Plate Layout screen, right-click the well and select
Omit.
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Export Analysis Results

. Open the Comparative Ct example experiment file that you analyzed in

In the Experiment Menu, click E Export.

Note: To export data automatically after analysis, select the Auto Export check
box during experiment setup or before running the experiment. Auto export is
unchecked for the example experiment.

Select QuantStudio™" 6 and 7 format.

Note: Select 7900 Format if you want to export the Clipped Data.

Complete the Export dialog box as shown below:

Field or Selection

Entry

Select Data to
export/ Select
Content

Results

Export Data To
Export File Name
File Type

Export File Location

One File
QS6_QuantStudio_384-Well_Comparative_Ct_Example_data
* txt

C:\Applied Biosystems\QuantStudio 6 and 7 Flex
Software\User Files\Export
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Your Export screen should look like this:

[ Auto Export Format = |Quant’5tud|n ™6 and 7 v| Export Data To: () One File () Separate Files Open file(s) when export 5 complete

Export File Location: |m5\Qua ntStudio & and 7 Flex Software\User File 5\Expurt| Export File Name: |iiu_384—WeII_C0 mpa rative_ct_EmmpIe_data| File Type: ‘E] (=) |

Sample Setup [] Raw Data Amplification [ Multicomponent [] tech. Rep. Results [ Bio. Rep. Results

Skip Empty Wells Skip Omitted Wells

Select Content Well Well Position Sample Name Delta Ct SD Target Name Task Reporter qQ
Al Fields » 141 Brain ACTB UNKNOWN FAM NF ~
242 Brain ACTB UNKNOWN FAM NF
el 3A3 Brain ACTB UNKNOWN FAM NF
wel Pasition 5A5 Brain 0.051 GAPDH UNKNOWN FAM NF
6 A6 Brain 0.051 GAPDH UNKNOWN FAM NF
Sample Name 7 A7 Brain 0.051 GAPDH UNKNOWN FAM NF—
9A9 Brain 0.217 GH1 UNKNOWN FAM NF
Target Name 10 A10 Brain 0.217 GH1 UNKNOWN FAM NF
Task 1 11 A11 Brain 0.217 GH1 UNKNOWN FAM NF
13 A13 Brain 0.068 LPINT UNKNOWN FAM NF
Reparter 14 A14 Brain 0.068 LPINT UNKNOWN FAM NF
15 A15 Brain 0.068 LPINT UNKNOWN FAM NF
Quencher 17 A17 Brain 0.073 LIPC UNKNOWN FAM NF
18 A18 Brain 0.073 LIPC UNKNOWN FAM NF
RQ 19410 Brain 0.073 LIPC UNKNOWN FAM NF
) 24 p24 ACTE NTC FAM NF
RQ Min 4901 Heart ACTB UNKNOWN FAM NF
RQ Max 50 C2 Heart ACTE UNKNOWN FAM NF
o = | S

W Save Export Set As Load Export Set Delete Export Set

Your exported file when opened in Notepad should look like this:

JuantStudio_384-Well_Comparative
File Edit Format View Help

[* Block Type = 384-well Block A
Calibration Background is expired = =
calibration Background performed on = 09 24-2010

calibration HRM MELTDOCTOR is expired = yes

calibration HRM MELTDOCTOR performed on = 10-02-2010

calibration Normalization FAM-ROX is expired = yes

calibration Normalization FAM-ROX performed on = 09-22-2010

calibration Normalization VIC-ROX is expired = yes

Calibration Normalization VIC-ROX performed on = 09-22-2010

calibration Pure Dye ABY is expired = Y

calibration Pure Dye ABY performed on = 03-31-2010

Calibration Pure Dye ABYQ 1s expired = ves

calibration pure Dye ABYQ performed on = 03-27-2010

calibration Pure Dye ATTO 700 is expired = ves

calibration Pure Dye ATTO 700 perfarmed Un = 04-06-2010

calibration Pure Dye DYE3} is expired =

calibration Pure Dye DYE3 performed on = Of—22—2010

Calibration Pure Dye DYE4 is expired =

Calibration pure Dye DYE4 performed on = 0 -22-2010

calibration Pure Dye FAM i5 expired = ve

Calibration Pure Dye FAM performed on = 09 22-2010

calibration Pure Dye FAMQ 1s expired = ves

calibration pure Dye FAMQ performed mn = 03 27-2010

Calibration pure Dye JUN 15 expired =

calibration pure Dye JuN performed on 03 31-2010

calibration pure Dye JuNQ 15 expired =

Calibration Pure Dye JUNQ performed on = 03 2f 2010

calibration Pure Dye MELTDOCTOR is expired =

cCalibration Pure Dye MELTDOCTOR performed on = 10—02—2010

Calibration pure Dye MP is expired = ves

calibration pure Dye MP performed on = 07-22-2010

Calibration Pure Dye MUSTANGP is expired = Yves

calibration Pure Dye MUSTANGP perﬁ]rmed un = 06-16-2010

calibration Pure Dye NED is expired =

calibration Pure Dye NED performed on GE 12-2010

Calibration pure Dye NPR 15 expired =

calibration Pure Dye NPR performed on 02—13—2010

calibration pure Dye Q705 is expired = “ves

calibration Pure Dye Q705 performed on = 07-14-2010

calibration Pure Dye QUASAR 705 is expired = Yes

Calibration Pure Dye QuUAsAR 705 performed on 02—15—2010

calibration Pure Dye QUASAR7OS5 is expired = Y

calibration pure Dye QUASAR7OS performed on = 04 06-2010

calibration Pure Dye ROX is expired =

calibration Pure Dye ROX performed on 09 22-2010

calibration Pure Dye SYBR is expired =

calibration pure Dye sYBR performed on = 0 -22-2010

calibration Pure Dye TAMRA is expired = ve

calibration pure Dye TAMRA performed on =
calibration Pure Dye VIC is expired = ves
calibration Pure Dye VIC performed on = 09 22-2010
calibration Pure Dye VICQ 15 expired = v
Calibration pure Dye VICQ per’for’med an 03—27’—20].0
calibration ROI is expired

calibration ROI performed on 09 22-2010
calibration uniformity is ex;nred = Yes

G

o

02 13-2010

Kok R R RE R E R R R KRR R R R REE KRR AR DR R KRR KRR R A KA R R AR E R R AR R
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Design and Analyze a Gene
Expression Study

The QuantStudio™ 6 and 7 Flex Real-Time PCR Development Software can combine
the analysis of experiments that use the Relative Standard Curve or the Comparative
Cr (AACt) quantification methods into a Gene Expression study. A study provides a
wider range for analyzing and comparing target behavior across multiple
experiments.

Note: You can import different types of quantification experiments into a single Gene
Expression study, but make sure the run method and experiment type are identical for
all the experiments in that study. Also make sure that the experiments have been run
on the same type of qPCR instrument.

Note: You can design an example study using the example experiments provided with
the QuantStudio™ 6 and 7 Flex Real-Time PCR Development Software. This chapter
explains how to design and analyze multiple Comparative Ct experiments as a study.
When you design a Gene Expression study, make sure that each experiment in that
Gene Expression study has a unique name. Absence of a unique name, leads to failure
of the run.

This chapter covers:

B About Gene Expressionstudies............... ... . o i 126
About the example study .......... ... i 126

B Designastudy......... ... 127
B Analyze theexamplestudy............ ... . i 132
B View the analysissettings........... ... ... i i 134
B Assess amplification results using the Amplification Plot.................. 138
B Assess the gene expression profile using the Gene Expression Plot. . ..... ... 140
B Confirm accurate dye signal using the Multicomponent Plot............... 148
B View the QC Plots. . . oottt e 149
B Viewthe QCSummary ...........ouuiiiiiiiiiiiiiiiiiiiiiiii.. 158
B Compare analysis settings. . ......... ... 160
B Exportthestudy.......... ... .. 165
B Formoreinformation........... ... ... .. i 168
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About Gene Expression studies

About Gene Expression studies

In a Gene Expression study, you can... You cannot...
* Specify the endogenous control(s) and ¢ Create, add, or modify samples.
reference sample for the study. e Create, add, or modify targets.
¢ Set individual efficiency values for each e Change assay tasks.

target. ) _
You can perform these operations in

Select the control type when applicable. individual experiments.

Set baseline and threshold values and

confidence levels, or set the number of
standard deviations for Comparative ¢7
Min./Max.

Omit wells individually or together
through their association with replicate
groups (technical or biologicall.

About the example study

In the Comparative Cy example study:

Two reaction plates (experiments) are used.

Experiments that you add to the study are two Comparative Ct experiments that
have already been analyzed.

The cDNA was prepared from total RNA that was isolated from the following
4 samples:

— Heart

— Liver

— Brain

— Lung
Five targets (assays) are used:

— LIPC: Hs00165106_m1

— GAPDH: Hs99999905_m1

— ACTB: Hs99999903_m1

— LPINI: Hs00299515_m1

— GH1: Hs00236859_m1
The reference sample is Brain.
The endogenous control is ACTB.

Each experiment in the study was designed for singleplex PCR, where the target
and endogenous control assays are run in separate wells.

For each experiment in the study, reactions were set up for 2-step RT-PCR:

— The cDNA was reverse-transcribed from total RNA samples using
Invitrogen VILO Kit.

— The reactions were prepared using TagqMan® Fast Universal PCR Master Mix
(2X).
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Design a study

Design a study

Create a new study To create a new study in the QuantStudio™ 6 and 7 Flex Real-Time PCR Development
Software, from the Home screen, click g New Gene Expression Study.

Set up the study in 1. In the Study Menu pane, select Setup » Study Properties

the Stuc_jy 2. In the Study Properties pane, click the Study Name field, then enter QS6_384-
Properties screen Well_Comparative_Ct_with_Bioreplicates_Study_Example.

3. Click the Comments field, then enter Example Comparative Ct Study for the
Comparative Ct Experiments.

4. In the Setup Experiments pane, click Add Experiment(s).

5. In the Open dialog box, browse to the QS6_384-
Well_Comparative_Ct_Example_1.eds and QS6_384-
Well_Comparative_Ct_Example_2.eds files at:

C:\Program Files\ Applied Biosystems\ QuantStudio 6 and 7 Flex
Software\ examples\ QS6Flex

The QuantStudio™ 6 and 7 Flex Real-Time PCR Development Software displays
the details of the experiment in the Properties pane.

Your Study Properties screen should look like this:

Study: QS6_384-Well Comparative Ct with_Bioreplicates_Study Fxample Export 3
Study Properties

* Study Mame: QS6_384-Well_Comparative_Ct_with_Bioreplicates_Study Example Comments (Optional): |Comparative Ct Study Example ~
User Name (Optional): Example user

Last Modified:

Number of Experiments: 2 b

Set Up Experiments (2)
Add Experiment(s) Remove Selected Experiment(s) Edit Experiment(s) w

Enter a fiter query, then click "Apply Fiter."

IF Experiment Name v ||= v :]
Experiment Name Instrument Type | Number of Tar... | Number of Samples | Operator Run Date Properties: Q56_QuantStudio Comparativ
:QSELQuantStudio Comparativ... QuantStudio(TM) ... 5 4 10/02/201... —
[ s6_quantstudio Comparativ... QuantStudio(TM) ... 5 4 10/05/201... Samples VI
e i
@ Hegative Control Wel
@ stendard Wel
@ Unknown wel
@ Empty Well
Filter the To narrow your search for an experiment, define and apply a filter:
experiments in the 1. In the left-most drop-down menu, select an experiment attribute to query.
study
2. In the center drop-down menu, select an operator for the query.
3. In the right-most field, enter the condition to look for, then click Apply Filter.
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After you apply a filter, click Hide Filter/Show Filter to hide or show the filter tool, or
click Remove Filter to remove the filter.

Define Replicates In the Define Replicates screen, create biological replicate groups and use them to
associate samples for the analysis. Biological replicates allow you to assess the
representative nature of your results as they relate to the population being studied.
Including biological replicates can give insight into any natural variation that is in the

population.
Example study The Gene Expression example study contains four biological replicate groups. These
settings are lung, heart, brain, and liver. Each biological groups consists eight replicates.
To define replicates 1. In the Study Menu pane, select Setup » Define Replicates.

2. Click Add Biological Group to open the Add Biological Replicate Group dialog
box.

3. Define the biological replicate group:
a. Click the Biological Group Name field, then enter Heart.
b. In the Color field, select the color.

c. Click the Comments field, then enter Example Biological Replicate Group
for the Example Comparative Ct Study.

4. Add technical replicates:

a. From the Select Plate drop-down menu, select QuantStudio Comparative Ct
Example 1.eds.

b. In the plate layout, select wells A1, A3, A5, A7, A9, All, A13, A15, A17, and
A19, then click (e to add the technical replicate wells that are associated
with the selected well to the biological group.

c. Click OK.

d. Perform steps a through c to add the remaining technical replicate wells
associated with the selected well to the biological group.
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5. On the Set Up Biological Replicates screen, select the Heart biological group that

you just added to the study. The QuantStudio™ 6 and 7 Flex Real-Time PCR

Development Software displays the details of the biological group in the
Properties pane.

@y Instructions: Enter 3 name for the biological replicate group, then add technical replicate groups to the new biological replicate group as needed.

Define Biological Replicate Group

Biological Group Name:  [Heart | [ i3 02 9]
Comments (Optional): | @mPle Biological Replicate Group for the Exemple Comparative Ct Study ‘
Add technical replicates to the new biological replicate group:
For each experiment in the study, select the plate, then select the welk of the plate that contain samples associated with the new biological replicate group.
As you select technical replicates, the software automatically adds the associated replicate wels to the biological replicate group.
Select Plate: [Q56_QuantStudio Comparative Ct Example 1 v Technical Replicate Groups Added to Biological Replicate Group:
= # of Replicates in Group: 5
Sample Target
Brain ACTB
Brain LIPC
alr Brain GAPDH
ry Brain GH1
s g e D e RS e el e Brain LPINT
P C ol C m
o]
£ | W ) ) 'y W m
E
G || L % AN 48 = W |5 L L =
H
[1] ]
E
K
T
m Used on Plate(s):2
[ - 0S6_Quantstudio Comparative Ct Example 1
M - Qs86_Quantstudio Comparative Ct Example 2
o
(¢ |
wels: [M 60 Ho s 319 Empty

Save and Add Another Group

Set Up Biological Replicate Groups

‘Add Biological Group [ Edit Biological Group_ || Delete Biological Group
Biolagical Group Name Color # of Replicates | Comments

Heart I s .000

Liver 5.000 Biological Group Name: Heart
Brain 5.000 color: [

Lung 5.000

Comments:

# of Replicates: 5

Sample Target
Heart LIPC
Heart (GAPDH
Heart LPIN1
Heart ACTB
Heart GH1

Used on Plate(s): 2

- Q95_Quantstudio Comparative Ct Example 1
= 086_QuantStudio Comparative Ct Example 2

6. Click Analyze, then close the study:
a. Select File » Close.
b. At the prompt, click Yes to save the changes.
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Design a study

Edit a Biological
Replicate Group

Remove Biological
Replicate Groups

N -

N -

c. Inthe Save Study as dialog box, click Save to accept the default file name and
location. The example study is saved and closed, and you are returned to the
Home screen. You can also save the study you create at C:\Program
Files\ Applied Biosystems\ QuantStudio 6 and 7 Flex
Software \ examples\ QS6Flex.

. Open the study of interest.

In the Study Menu pane, select Setup » Define Replicates.

Click Edit Biological Group to open the Edit Biological Replicate Group dialog
box.

Edit the group information:
a. From the Biological Group Name drop-down menu, select the group to edit.
b. To change the group name, click Edit, enter a new name, then click OK.
c. To change the color, select a color from the drop-down menu.

d. (Optional) Enter comments.
From the Select Plate drop-down menu, select the experiment of interest.

Add samples to the biological group:

a. In the Plate Layout, select the well(s) of the plate that contain samples to add
to the biological group.

b. Click [MESEN to add the samples that are associated with the selected wells to
the biological group.

Remove samples from the biological group:

a. Inthe Technical Replicate Groups Added to Biological Replicate Group pane,
select a sample. You can select only one sample at a time.

b. Click

to remove the sample from the biological group.

Repeat steps 5 through 7 for the other experiments in the study.

Click OK to save the changes and return to the study; click Cancel to exit the
dialog box without saving the changes.

Open the study of interest.

In the Study Menu pane, select Setup » Define Replicates.

In the Define Replicates screen, select the group to remove, then click Delete
Biological Group.

Click Yes to remove the group from the study; click No to keep the group in the
study.
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Tips for designing * Enter a study name that is descriptive and easy to remember. You can enter up to
your own study 100 characters in the Study Name field. The study name is used as the default file
name.

You can only use the alpha-numeric, period (.), hyphen (-), underscore ( _), and
spaces ( ) characters in the Experiment Name field.

¢ (Optional) Enter comments to describe the study. You can enter up to
1000 characters in the Comments field.

¢ Use the default user name, or enter a new user name, to identify the owner of the
study. You can enter up to 100 characters in the User Name field.

Note: If security is enabled, the User Name field is automatically populated with
the name you selected at log in.

* You can add an unlimited number of experiments (reaction plates) to the study.
Click Add Experiment (s) or Remove Selected Experiment(s) to add or remove
experiments to or from a study. Note the following;:

— Each experiment in the study must:

— Have one or more common endogenous control(s). The endogenous
control(s) must be present on each reaction plate within the study.

Note: The endogenous control gene for a given sample must be run on
the same plate as the target gene for a given sample in order for a study
to be created.

— Have identical thermal cycling parameters (the same number of steps
and cycles). The 6 and 7 Flex Real-Time PCR Development
Software cannot combine in the same study experiments that use Fast
and Standard thermal cycling conditions.

— Have the same passive reference.
— Have the same experiment type.
— Have been run on the same instrument type.

— As the default, the QuantStudio™" 6 and 7 Flex Real-Time PCR Development
Software assigns the endogenous control and reference sample for a study
based on the analysis settings of the first experiment that you added to the
study.

— If experiments that contain biological replicate groups are added to a study,
™

the QuantStudio = 6 and 7 Flex Real-Time PCR Development Software
automatically merges the matching biological groups.

- The QuantStudio™" 6 and 7 Flex Real-Time PCR Development Software
automatically analyzes a study after you add more than one experiment to it.
Consequently, to ensure that the software uses the correct settings, Life
Technologies recommends that you review the analysis settings of your
study after adding multiple experiments.

¢ When adding experiments to the study, Ctrl-click multiple experiments in the
Open dialog box to add them to the study.

* Select an experiment that has been added to the study to view its properties in the
Properties pane.

 Filter the experiments added to the study to simplify the list for easier review. See
“Filter the experiments in the study” on page 127.
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Analyze the example study

* Enter a biological replicate group name that is descriptive and easy to remember.
You can enter up to 100 characters in the Biological Group Name field. You can
only use the alpha-numeric, full-stop (.), hyphen (-), underscore ( _), and space ()
characters in the Experiment Name field.

¢ (Optional) Enter comments to describe the biological replicate group. You can
enter up to 1000 characters in the Comments field.

* You can add an unlimited number of technical replicates to a biological group.

IMPORTANT! A sample cannot belong to more than one biological group.

— Click-drag over the desired wells, or Ctrl-click or Shift-click in the plate
layout to select multiple wells.

— Click the upper-left corner of the plate layout to select all wells.

* You can change the name of a biological replicate group, change its color
identification and description, and add or remove technical replicates. See “Edit a
Biological Replicate Group” on page 130.

* You can remove an existing biological replicate group. See “Remove Biological
Replicate Groups” on page 130.

IMPORTANT! After you remove a biological replicate group from a study, you
cannot restore it.

Analyze the example study

Access the
example study

View the
experiment data
and well results

™

This section explains how to use the QuantStudio ™ 6 and 7 Flex Real-Time PCR
Development Software to analyze the Gene Expression example study. It also describes
Life Technologies recommended best practices as you perform the analysis.

Note: The Comparative Cy Study Example.edm file illustrated in this chapter
demonstrates the use of biological replicate groups. You can also create a study
without the use of biological replicate groups.

Access the example study that you created on your computer.

C:\Program Files\ Applied Biosystems\ QuantStudio 6 and 7 Flex
Software \ examples\ QS6_384 Well Comparative Ct with Bioreplicates Study
Example.edm

The Experiment Data and Well Results Data panes appear in the Amplification Plot,
Multicomponent Plot, and Multiple Plots View screens.

The Gene Expression screen displays the Replicate Results Data and the Well Results
Data panes.
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Analyze the example study

Only the Well Results Data pane appears in the QC Plots View screen.

e To display or hide columns in the Experiment Data pane- from the Show In Table
drop-down menu, select or deselect one or more options: Experiments,
# of Targets, # of Samples, Run Date.

Experiment Data

Show In Table ¥

l

RS Experment |- # of Tar...| # ofSa... | Run Date
|| #ofTargets It Ex... 5 4 0ct 1, 2010
v #ofsamples It Bx... 5 4 0ct 4, 2010
z Run Date

* To display a subset of the study data in the plots— Select one or more rows in the
Experiment Data pane or the Well Results Data pane, then select the Hide
unselected data from plot check box appearing in the plot pane to display data
only from the selected rows.

The Experiments Data pane lists each reaction plate (experiment) that is added to a
study. The data that are displayed in the Well Results Data pane depend on which tab
you select in the Experiment Data pane:

Tab Description Illustration

Well Table When you select one or more eXperimentS in the
tab Experiment Data pane, the well table displays the —
wells that make up the selected experiment(s). [Show In Table v |

# | Experiment # of Tar...| # of Sa... | Run Date
1 Q56_QuantStudio Comp... 5 4 May 5, 2013
2 QS6_QuantStudio Comp... 5 4 May 5, 2013

Well Results Data

VERENE Plate Layout

Show In Table ¥ | Group Results By ¥

# Sample Target Experim...| Omit Flag RQ ||
ACTB 086 Quants [ 1 ~
Bran  ACTB 056 Quants  [J
Brain ACTB )56 Quants |
Brain  ACTB 056 ouents [
GAPDH 056 Quants [ 1
Brain GAPDH )56 _Quants O 0.4552979.
Brain GAPDH Q56 Quants: O 0.4552979;
Brain GAPDH )56 Quants ] 0.4552979.
. Brain GH1 086 OnantS I 0.99340’5"’
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View the analysis settings

Tab

Description Illustration

Plate When you select one experiment in the

Layout tab | Experiment Data pane, the plate layout displays

Layout tab.

the plate layout for the selected experiment. _

. . # | Experiment # of Tar...| # of Sa... | Run Date
If you select more than one experiment in the 1Q56_Quantstudio Comp... 5 4 1ay5, 2013
Experiment Data pane, only the plate layout for 2086_Quantstudio Com... 3 4 May 5, 2013

the first experiment is displayed in the Plate

Well Results Data

e
Well Table Plate Layout

[ T | T B B T = I -3

View the analysis settings

The Analysis Settings dialog box displays the analysis settings for the threshold cycle
(Cy), flags, and relative quantification. If the default analysis settings in the
QuantStudio™ 6 and 7 Flex Real-Time PCR Development Software are not suitable for
your study, you can change the settings in the Analysis Settings dialog box, then
reanalyze your study.

Note: In the Comparative Ctexample study, the default analysis settings are used
without changes.

To adjust the analysis settings

1. From the Study Menu pane, select Analysis.

2. Click Analysis Settings to open the Analysis Settings dialog box.

3. Select the Relative Quantification Settings tab, then view the default reference
sample and endogenous control. In the example study, the default reference
sample is brain and the default endogenous control is 18S.

4. Select the Ct Settings tab, then the Flag Settings tab. In the example study, the
default analysis settings are used in each tab.

134 QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Getting Started Guide for Relative Standard Curve

and Comparative Cy Experiments



Chapter 13 Design and Analyze a Gene Expression Study

View the analysis settings

5. View and, if necessary, change the analysis settings. For more information on the
changes to analysis settings, refer to “Tips for analyzing your own study” on
page 135.

Note: You can save the changes to the analysis settings to the Analysis Settings
Library for later use. For more information, see About the Analysis Settings
Library in Booklet 1, Getting Started with QuantStudio™™ 6 and 7 Flex Real-Time PCR
System Software Experiments.

6. Click Apply Analysis Settings to apply the current analysis settings.

Note: You can go back to the default analysis settings by clicking Revert to
Default Analysis Settings.

7. Click Analyze.

The following is an image of the Analysis Settings dialog box for a Comparative
Cr Study:

-2 Analysis Settings for Q56_384-Well_Comparative_Ct_with_Bioreplicates_Study_Fxample

Flag Settings Relative Quantification Settings

targets in this experiment. To use different settings for a target, select the target from the table, deselect Use Default

~— Data Step Selection
Select the step and stage to use for CT analysis. Only stage/step combinations for which data suitable for CT analysis have been collected are displayed.

Algorithm Settings —,

Baseline Threshold |+
Stage 2, Step 2 v

— Default Cr Settings
Default CT settings are used to calculate the CT for targets without custom settings, To edit the default settings, dick Edit Default Settings.

Threshold: AUTO Baseline Start Cycle: AUTO Baseline End Cycle: AUTO Edit Default Settings

— Select a Target

~— CT Settings for ACTB

Target Threshold Baseline Start Baseline End Cr Settings to Use: [#] Default Settings
ACTB AUTO AUTO AUTO
GAPDH AUTO AUTO AUTO
GH1 AUTO AUTO AUTO
LIPC AUTO AUTO AUTO
LPINT AUTO AUTO AUTO

Save to Library Load from Library Revert to Default Analysis Settings [m [m

Tips for analyzing
your own study

Unless you have already determined the optimal settings for your study, use the
default analysis settings in the QuantStudio™ 6 and 7 Flex Real-Time PCR
Development Software. If the default settings are not suitable for your study, change
the settings as described below.

Ct Settings
e Data Step Selection
Use this feature to select multiple locations of analysis, in case several are chosen.
* Algorithm Settings
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View the analysis settings

Use the Baseline Threshold algorithm to determine the Ct values.

The Baseline Threshold algorithm is an expression estimation algorithm that
subtracts a baseline component and sets a fluorescent threshold in the exponential
region for gene quantification.

Default Ct Settings

Use the default Cr settings feature to calculate Cr for the targets that do not have
custom settings. To edit the default settings, click Edit Default Settings.

Cr Settings for Target

When you manually set the threshold and baseline, Life Technologies
recommends:

Setting Recommendation

Threshold Enter a value for the threshold so that the threshold is:

e Above the background.

¢ Below the plateau and linear regions of the amplification curve.
e Within the exponential phase of the amplification curve.

Baseline Select the Start Cycle and End Cycle values so that the baseline ends
before significant fluorescent signal is detected.

Note: This setting is applicable only to the Baseline-Threshold algorithm.

Note: Selecting Automatic Threshold implies selection of automatic setting of the
baseline. However, if Automatic Threshold is deselected, then you can choose
between setting the baseline either automatically or manually.

Flag Settings

Use the Flag settings tab to:

* Adjust the sensitivity so that more wells or fewer wells are flagged.

™

¢ Change the flags that are applied by the QuantStudio = 6 and 7 Flex Real-Time

PCR Development Software.

To adjust the flag settings

1.
2.

In the Use column, select the check boxes for flags to apply during analysis.

(Optional) If an attribute, condition, and value are listed for a flag, specify the
setting for applying the flag.

Note: If you choose to adjust the setting for applying a flag, make minor
adjustments as you evaluate the appropriate setting.

In the Reject Well column, select the check boxes if you want the software to reject
wells with the flag.

Note: After you have rejected the flagged wells, analysis results depend on
factors such as the experiment type and flag type. For example, rejecting wells
flagged by HIGHSD in experiments using the Standard Deviation calculations
may change the result of Ct SD. For some flags, analysis results calculated before
the well is rejected are maintained.

Click Apply Analysis Settings in the Analysis Settings dialog box. If the run
status is complete, the data are reanalyzed.
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The following is an image of the Flag Settings tab:

-2 Analysis Settings for Q56_384-Well_Comparative_Ct_with_Bioreplicates_Study_Fxample

Flag Description Use Attribute Condition Value Reject Well

SPIKE Noise spikes Spike algorithm resulk  |> w (1.000 L}

BADROX Bad passive reference... Bad passive reference...|= « |0.600

NOAMP No amplification Amplification algorith... |< ~ |0.100

CTFAIL Cr algorithm failed O

BLFAIL Baseline algorithm failed O

EXPFAIL Exponential algorithm... O

THOLDFAIL Thresholding algorith... O

HIGHSD High standard deviati... Ct standard deviation |> - |D.SDD ‘

OUTLIERRG Qutlier in replicate gr... O

NOSIGNAL No signal in well O

NOISE Noise higher than oth... Relative noise > w |4.DDD ‘ L}

OFFSCALE Fluorescence is offscale O

AMPHC Amplification in negati... [ng s w |35.DDD ‘ O

[roee JlConer ]
Relative Quantification Settings
Use the Relative Quantification Settings tab to:
* Change the reference sample and/or endogenous control. As the default, the

QuantStudio™ 6 and 7 Flex Real-Time PCR Development Software assigns the
endogenous control and reference sample for a study based on the analysis
settings of the first experiment added to it. You can add multiple endogenous
controls to a study.
Correct the amplification efficiency. You can enter a percentage value between 1%
and 150% for each target. When you set an assay to have a value that differs from
100% efficiency, the software uses the relative standard curve algorithm.
(For multiplex reactions) Specify the ACt value at which to reject replicates
(outlier rejection).
Select the algorithm to use to determine the relative quantification minimum and
maximum values (error bars):

— Confidence Level - Select to calculate the RQ minimum and maximum
values based on the selected confidence level. Select the confidence level to
use.

— Standard Deviations - Select to calculate the RQ minimum and maximum
values based on the selected number of standard deviations. Select the
number of standard deviations to use.
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Assess amplification results using the Amplification Plot

In the comparative Ct example study, you review each target in the Amplification Plot
screen for correct baseline and threshold values.

1. From the Study Menu pane, select Analysis » Amplification Plot.
Note: If no data are displayed, click Analyze.

2. Inthe Experiment Data pane, select all of the experiments (click and drag to select
all rows in the table).

3. In the Amplification Plot pane, set the parameters for the plot:
a. From the Plot Type drop-down menu, select ARn vs Cycle.
b. From the Plot Color drop-down menu, select Well.
c. Click E Show a legend for the plot.

Note: This is a toggle button. When the legend is displayed, the button
changes to Hide the plot legend.

d. From the Target drop-down menu, select ACTB to highlight all ACTB wells
in the study.

4. View the baseline values:
a. From the Graph Type drop-down menu, select Linear.
b. Select the Show Baseline check box to show the start cycle and end cycle.

c. Verify that the baseline is set correctly: The end cycle should be set a few
cycles before the cycle number where significant fluorescence is detected. In
the example study, the baseline is set correctly.

Note: The data shown in the screenshot below is of the example experiment.
Results vary depending on the experiment setup.

Amplification
Plot Settings

Plot Type:|ARn vs Cycle |+ | Graph Type:|Linear |+ | Plot Color:|Well v

[] Save current settings as the default

£ P Ay s

Amplification

Cycle

Lo
s BE5 BNcC WD ME F G H i,
I ) Hx H. Hv Hy Ho Hr

Target: ACTE ~ | Threshold: [¥] Auto

show: [] Threshold — [] Baseline Start! Wel M Target 4 Baseline End: Well (M Target 4

65 Wells Selected Hide unselected data from plot

5. View the threshold values:
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a. From the Graph Type drop-down menu, select Log.

b. Deselect the Show Baseline check box, then select the Show Threshold
check box to show the threshold.

c. Verify that the threshold is set correctly. In the example study, the threshold
is in the exponential phase.

Amplification £
Plot Settings

Plot Type:|ARn vs Cycle % | Graph Type:|Log + | Plot Color:|Well ~

[] save current settings as the default

£ L oa kR g =
Amplification
1E01

1E00

0.1 {L0SRS]

0.01
& o001 QS
5 \

0.0001

0.00001

0.000001

0.0000001
a

Cycle

-
. s c D E HF G H ~
1 ) L. Hv Hn Ho Hr

Target:| ACTE + | Threshold: Auto

show: [7] Threshold — [ Baseline Start: Wel B Target 4 Baselne End: Wel (M Target 4.

65 Wels Selected Hide unselected data from plot

6. Repeat steps 3 through 5 for the remaining targets.

Tips for assessing Ensure that your study meets the following requirements:

amplification in * A typical amplification plot — See the amplification plot examples in the
your own study Chapter 5 and Chapter 11.

¢ Correct baseline and threshold values — See the threshold examples and the
baseline examples in Chapter 5 and Chapter 11.

If your study does not meet these requirements, you can:

* Manually adjust the baseline and/or threshold. See “View the analysis settings”

on page 134.
¢ Omit individual wells from the analysis. See “Omit wells from the analysis” on
page 164.
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Assess the gene expression profile using the Gene Expression Plot

The Gene Expression Plot screen displays the results of the relative quantification
calculations in the gene expression profile. Three plots are available:

* RQ vs Target — Groups the relative quantification (RQ) values by target. Each
sample is plotted for each target. You can view the plot as the following graph
types: linear, log10, Ln, log2.

* RQ vs Sample — (displayed only when the Technical Replicates tab is selected in
the Replicate Results Data pane) — Groups the relative quantification (RQ) values
by sample. Each target is plotted for each sample. You can view the plot as the
following graph types: linear, log10, Ln, log?2.

* RQ vs BioGroup — (displayed only when the Biological Replicates tab is selected
in the Replicate Results Data pane) — Groups the relative quantification (RQ)
values by biological replicate group. Each target is plotted for each sample. You
can view the plot as the following graph types: linear, log10, Ln, log2.

About the exampl_e In the Comparative Cp example study, you review each target in the Gene Expression
study Plot screen for the expression level (or fold change) of the target sample relative to the
reference biological replicate group.

View the Gene 1. From the Study Menu pane, select Analysis » Gene Expression.

Expression Plot 2. In the Gene Expression Plot pane, set the parameters for the plot:

a. In the Plot Type drop-down menu, select RQ vs BioGroup.
b. In the Graph Type drop-down menu, select Log10.

c. In the Orientation drop-down menu, select Vertical Bars.
d. Click |7— Show a legend for the plot.

Note: This is a toggle button. When the legend is displayed, the button
changes to Hide the plot legend.
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In the example study, the expression levels of multiple targets in the biological
replicate group are displayed relative to the expression levels of the same targets
in the reference biological replicate group (universal). Because the reference
sample is compared to itself, the relative expression level is 1. When the result is
displayed in the Log10 graph type, the expression level of the reference sample
appears as 0 in the graph (log10 of 1 =0).

Save current settings as the default

2.75
2.50
2.25
2.00
1.78
1.50
1.25
1.00

logl0RQ

0.75
0.50
0.25
0.00
-0.25
-0.50
-0.75

Plot Type:|RQ vs BioGroup | Graph Type:|Log1l0 | Orientation: Vertical Bars v

RQ vs BioGroup

0.342

. 0.003

-0.338 -0

2.871

PP alk s

v

S |
-0174 ]
-0322

-0.511

&

P

Biological Group

-
M -ce Mcerod lcHt [lurc B et

0 Replicates Selected

[ Hide unselected data from plot
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b. From the Endo Controls drop-down menu, select GAPDH, GH1, and LIPC,
then deselect ACTB.

Note: You can also select the endogenous controls in the Analysis Settings
dialog box. See “View the analysis settings” on page 134.

l{ Replicate Results Data
TR
| Show In Table ¥ | Add BioGroup  Endo Controls “ Ref Sample ¥

Sample Target ACT Me... | ACT SE iy

1 Brain ACTB A~
2 Brain ACTB
3 O Brain GAPDH
4 O Brain GAPDH 0.3144583 0.03370482
5 O Brain GH1
6 O Brain GH1 E 13.828029 0.1315035 0.0
7 O Brain LIPC 28.92020 11.664282 0.0410995... -1
8 O Brain LIPC
9 O Brain LPIN1 21.73203 4.467014 0.0398248... -1
10 O Brain LPINT
11 Heart ACTB 18.136377
12 Heart: ACTB
13 Heart GAPDH
14 Heart: GAPDH 17.315718 -0.8206588 0.0384727... v

< >

b Replicate Results Data

# | Omit Sample Target Ct Mean ACT Me... ACT SE AACT RQ RQ Min RQ Max [
1 Brain ACTB 17.265015 ~
2 O Brain GAPDH 17.579475 0.31446025 0.0337048... 1.1351172 0.45529792 0.43082792 0.48115778
3 O Brain GH1 31.093044 13.828031 0.13150350.0095444... 0.9934061 0.80079186 1.2323498
4 O Brain LIPC 28.929298 11.664284 0.0410995... -1.1238338 2.179253 2.0372863 2.3311126
5 O Brain LPIN1 21.732025 4.4670115 0.03982485 -1.1272669 2.1844451 2.0464113 2.3317897
6 Heart ACTB 18.136375
7 Heart GAPDH 17.315718 -0.82065696 0.0384727... 0.0 1.0 0.93888897 1.0650887
8 Heart GH1 31.95486 13.818485 0.0868147 0.0 1.0 0.86736786 1.1529133
<] Heart LIPC 30.924492 12.788117 0.05548723 0.0 1.0 0.9130676 1.0952091
10 Heart LPIN1 23.730654 5.5942783 0.0346004... 0.0 1.0 0.9448669 1.0583501
11 Liver ACTB 19.201887
12 O Liver GAPDH 19.181273 -0.02061506 0.05293959 0.800041% 0.5743325 0.5265987 0.62639314
13 O Liver GH1 35.452633 16.254082 0.23876446  2.435596 0.18484707 0.12329348 0.27713096
14 [ Liver LIPC 21.993778 2.7918909 0.0500186... -89.006226 1021.32485 940.93475 1108.5834 b

AV

Well Results Data

Show In Table ¥ || Group Results By ¥ :]:]

# Sample Target Experim...| Omit Flag RQ RQ Min RQ Max Flags cT ACT ACT Me... | ACT SE AACT

Brain  ACTB 0S6 Quants [ 17.265797 NaN -~
Brain ACTB 56 Quants ] 17.17082 MaN

Bran  ACTB 056 Quants [ 17.186125 NaN

Brain ACTB S6_Quants ] 17.404072 NaM

Brain ACTB 56 QuantS O 17.216124 NaM

Brain  ACTB 086 Quants [ 17.347149 NaN

Brain  GAPDH 0s6 Quants [ 0.45529792 0.43082792 0.48115778 17.508968 0.31446025 0.0337048...1,1351172...

Bran  GAPDH 0s6 Quants [ 0.45529792 0.43082792 0.48115778 17.50408 0.31446025 0.0337048...1.1351172...

Brain  GAPDH 0s6 Quants [ 0.45529792 0.43082792 0.48115778 17.523808 0.31446025 0.0237048...1.1351172... -
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Assess the gene expression profile using the Gene Expression Plot

4. Click Analyze. In the example study shown below, all samples for the
endogenous controls GAPDH, ACTB, and LIPC have no values (with the
exception of the Ct Mean value), and the RQ values for the remaining samples
change. For example, in the example study, the RQ value for the brain sample
changes from 1.0 (with 18S as the endogenous control) to none with the new
endogenous controls.

b Replicate Results

Ted
| Show In Table ¥ | Add BioGroup | Endo Controls ¥ | Ref Sample ¥

# | Omit Sample Target CT Mean | ACT Me... | ACT SE AACT RQ RGQ Min RQ Max [
i ¥ Brain 17.265017 -8.602256 0.0818908% -0.006942... 1.0048238 0.8922643 1.1315829 A
2 Brain i 17.579475
= Brain 31.093044
4 Brain 28.029208
| ] Brain 21.73203 4.1352425 0.07943937 -1.1342009 2.1949832 1.9560475 2.4631054
6 Heart ACTB 18.136377 -8.595313 0.06349747 0.0 1.0 0.9119953 1.0064960
7 Heart GAPDH 17.315718
8 Heart GH1 31.95486
9 Heart LIPC 30.924492

10 Heart LPIN1 23.730658 -3.0010324 0.06456639 0.0 1.0 0.91058207 1.0981987

il [l Liver ACTB 19.201889 -5.7585125 0.13895898 2.8368008 0.13997093 0.11432851 0.1713646

12 Liver GAPDH 19.181273

1 Liver GH1 35.452633

1 Liver LIPC 21.993778

15 ] Liver LPIN1 24.238232 -0.7191273 0.14233042 2.2819052 0.20562604 0.16713315 0.25298434

16 O Lung ACTB 18.253523 -0.9706745 0.03890908 -1.375361 2.5943282 2.45193093 2.7440856

17 Lung GAPDH 21.026237

18 Lung GH1 32.66008 b

‘Well Results Data

Show In Table ¥ || Group By ¥

B Sample Target Experim... Omit Flag RQ RQ Min RQ Max Flags cT aCT ACT Me...  ACT SE AACT

Brain ACTB 256 QuantS F 17.265797 HaN e
Bran ACTE S6_QuantS O 17.17082 NzN

Brain ACTB S6_QuantS 0 17.186125 NaN

Bran ACTE QS6_Quants O 17.404072 Nal

Brain ACTB 56 Quants O 17.216124 NaN

Bran  ACTE 056 Quants [ 17.347149 Nal

Brain GAPDH 056 Quants (| 0.45529792 0.43082792 0.48115778 17.508968 0.31446025 0.0337048... 1.1351172...

Bran GAPDH 56 _QuantS 0O 0.45529792 0.43082792 0.48115778 17.50408 0.31446025 0.0337048...1.1351172...

Bran GAPDH 056 _Quants F 0.45529792 0.43082792 0.48115778 17.523808 0.31446025 0.0337048... 1.1351172... v

Tips for assessing  Look for:

the gene profile in * Differences in gene expression (as a fold change) relative to the reference sample.

your own study ¢ Standard deviation in the replicate groups (Cp SD values).

If needed, you can omit outliers. See “Omit replicates from the analysis” on page 147.

Note: To display a subset of the study data in the Gene Expression Plot pane, select
one or more rows in the Technical Replicates tab or the Biological Replicates tab, then
select Hide unselected data from plot to display data only from the selected rows.
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View the replicate results data and the well results data

Chapter 13 Design and Analyze a Gene Expression Study

View the replicate results data and the well results data

The Replicate Results Data pane lists each reaction plate (experiment) that is added to
a study. The results of the study are arranged by technical or biological replicate

association.

The data that are displayed in the Well Results Data pane depend on which tab you
select in the Replicate Results Data pane:

Technical Replicates Tab

Biological Replicates Tab

This tab arranges the results of the relative quantification
analysis by technical replicate group. The ViiA™ 7 Software
displays the results for each sample/target combination as
a row in the table.

You can view the members of a technical replicate group by
selecting the appropriate row in the table. When a row is
selected, the Well Results Data pane displays the wells that

This tab arranges the results of the relative quantification
analysis by biological replicate group. The QuantStudio™ 6
and 7 Flex Software displays the results for each biological
group as a row in the table (each row displays a biological
sample with its target).

You can view the members of a biological replicate group by
selecting the appropriate row from the table. When a row

make up the selected technical replicate group. is selected:

¢ The Biological Replicate Details table displays the
technical replicate groups that make up the selected
biological replicate group.

l Replicate Results Data

Tex SN  Biclogical Repicates

Show In Table ¥ | Add BioGroup | Endo Controls ¥ | Ref Sample ¥

Gmi | G | et @rlfen MUk | M0 6 | 0 e The Well Results Data pane displays the individual
1 Brain ACTB 17.265017 8 . .
2 O Ban GAPDH 1757475 03144583 00370482 members of the technical replicate groups that make up
3 0O o GHL 31093044 13828029 0.13150350.0 . . .
4 O Bamn LIPC 28.929208  11.6642820.0410095... -1 the selected blologlcal repllcate group.
5 [ Ben LPINL 2173203 4.4670140.0308248... -1
§ Heart ACTE 18.136377
7 Heart GAPDH 17315718 -0.82065880.0384727... Replicate Results Data
8 Heart GHL 3195486 13.818484 0.08681472
9 Heart LPC 30.924492 127881155 0.0554872... &
10 Heart LPINL 23730658 5.5042810.0346003...
1 Liver ACTB 19.201889 Show In Table ¥ | Add BioGroup | Endo Controls ¥ | Ref BioGroup ¥
2 [0 e GAPDH 10.181273 -0.020617... 005293955 0
13 O Lwer GHL 35452633 16.25408 023876446 2¥ # | Omit Biologic...| Target | #Repli.. | Cr Mean  Acr M
< 14 1 Brain ACTB 1 17.265017 860~
o 2 Bran GAPDH 1 17579475
Well Results Data 3 Brain 6H1 1 31093044 v
I ] ‘ :
Biological Replicate Details Edit BioGroup J{ Delete BioGroup
# Sample | Target Experim... | Omit Flag RQ
Ban  ACTE 0% ounts [ A # | Omit Sample | Target CT Mean | ACT Me... ACT SE
Ban  ACTB 056 Quants [ 1 O Be@n ACTB 17.265017 8.602256 0.081890¢
Brain  ACTB 086 Quants [ 2 Brain GAPDH 17.579475
Brain ACTB 56 Quants [
Ban  ACTB 0% Quants [ 4 ?
Bran  ACTB Q86 Quants [ AV
Bain  GAPDH Q36 Quants  [J 0.45526792 Well Results Data
Brain GAPDH 56 Quants: O 0.45529792
. » ] )
# Sample  Target Experim...  Omit Flag RQ
Ban  ACTB 0s6 ownts [0 A
Ban  ACTB 0s6 uants [
Ban  ACTB 0s6 Quants [
Brain ACTB S6_Quants O
Ban  ACTB 0s6 Quants [
Ban  ACTB 0s6 Quants [
Ban  GAPDH 056 Quants [ 045520792
Ban  GAPDH Q56 Quants [ 045529792y
< 3
Column The table below provides definitions for the column headings that appear in the tables
descriptions in the Technical Replicates and Biological Replicates tabs.

Note: To show or hide columns in a table, select or deselect the column name from the
Show In Table drop-down menu.
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Chapter 13 Design and Analyze a Gene Expression Study
View the replicate results data and the well results data

Column

Description

AC;

The calculated ACy value for the replicate group associated with the test
sample.

Note: The ACy value is calculated only for multiplex experiments and is
calculated at the well level (that is, the individual technical replicate level] by
subtracting the target Cy value from the endogenous control 1 value.

ACt Mean

The arithmetic average of the technical replicate Cy values for the sample
replicate group.

Note: The ACt Mean value is calculated at the reaction plate level and
represents the mean difference between the target 1 values and the
endogenous control Cy values for all the technical replicates for that sample
that are present on the plate.

ACy SE

The Standard Error of the mean associated with the reported Mean ACy
value.

Note: The ACt SE value is calculated differently for multiplex and singleplex
experiments. For multiplex experiments, the calculation is at the well level.
For singleplex experiments, the calculation combines the plate-level ¢7 value
variation between the target and the endogenous control.

Note: If you select the Standard Deviation option in the RQ Min/Max
calculations on the Relative Quantification Settings in the Analysis Settings
dialog box, ACy SD, that is the Standard Deviation values are calculated by
the QuantStudio™ 6 and 7 Flex Software.

AACt

# Replicates

The calculated AAgt value for the replicate group associated with the
reference sample.

The number of biological replicate groups in the study.

Biological The name of the biological replicate group.
Group
Cr Threshold cycle; the PCR cycle number at which the fluorescence meets the
threshold in the amplification plot.
Ct Mean The arithmetic average of the technical replicate ¢7 values.
Experiment | The name of the experiment file (for example, heart.eds).
Flag The number of QC flags that the well generated as listed in the £ symbol.
Omit Indicates the omission status of the members of the associated technical or
(Replicate biological replicate groupl(s):
ResultsData | & A check mark [v) indicates that all replicates have been removed from the
pane) analysis.
¢ A hyphen (-] indicates that one or more replicates have been removed
from the analysis.
Omit (Well Indicates the omission status of the well. A check mark (v] indicates that the
Results Data | well has been removed from the analysis.
pane)
RQ The calculated relative level of gene expression for the replicate group that

is associated with the test sample.
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View the replicate results data and the well results data

Column

Description

RQ Max

The maximum relative level of gene expression in the test samples
calculated using the confidence level set in the Analysis Settings dialog box.

Note: The maximum includes the variability associated with the endogenous
control and targets in only the test samples.

RQ Min

Sample

The minimum relative level of gene expression in the test samples calculated
using the confidence level set in the Analysis Settings dialog box.

Note: The minimum includes the variability associated with the endogenous
control and targets in only the test samples.

The sample associated with the data displayed in the row.

Target

The target assay associated with the data displayed in the row.

Well

The location of the well in the reaction plate.

About the exampl_e In the Comparative Ct example study, you review the Replicate Results Data pane and
study the Well Results Data pane to evaluate the Ct precision of the replicate groups and
view related RQ information.

View the results 1. From the Study Menu pane, select Analysis » Gene Expression.

data

2. Click 4 at the top left of the Replicate Results Data pane.

3. View the technical replicates:

a. Click the Technical Replicates tab. The table displays the results by technical
replicate group.

b. In the Technical Replicates table, select the following groups:

Brain/GAPDH (row?2)
Brain/LIPC (row 4)
¢ Brain/LPIN1 (row 5)

The Well Results Data pane displays all wells that make up the selected
groups.

4. View the values in the Well Results Data pane:

a. From the Group Results By drop-down menu, select Target.
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View the replicate results data and the well results data

b. View the Cr, ACt Mean, and ACt SE values to evaluate the Cp precision of
the replicate groups. In the example study, the low ACy SE values indicate
these replicates have good Cr precision.

bd Replicate Results Data

Technical Repli
| Show In Table ¥ | Add BioGroup | Endo Controls ¥ | Ref Sample ¥
# | Omit Sample Target CT Mean ACT Me... ACT SE AACT RQ RQ Min RQ Max [
1 Brain ACTB 17.265017 ~
2 [] Brain GAPDH 17.570475 0.3144583 0.03370482  1.135117 0.45529795 0.43082792 0.48115784
3 ] Brain GH1 31.093044 13.828029 0.13150350.0095443... 0.9934062 0.8007919 1.2323499
4 ] Brain LIPC 28.929298 11.664282 0.0410995... -1.1238337 2.1792529 2.0372863 2.3311124
5 [] Brain LPIN1 21.73202  4.4670140.0398248... -1.1272674 2.1844450 2.0464118 2.3317004
6 Heart ACTB 18.136377
7 Heart GAPDH 17.315718 -0.8206588 0.0384727... 0.0 1.0 0.9388889 1.0650887
8 Heart GHL 31.95486 13.818484 0.08681472 0.0 1.0 0.8673678 1.1520135
9 Heart LIPC 30.924492 12.7881155 0.0554872... 0.0 1.0 0.9130675 1.0952092
10 Heart LPIM1 23.730658 5.594281 0.0346003... 0.0 1.0 0.94486696 1.0583501
17 Liver ACTB 19.201889
12 O Liver GAPDH 19.181273 -0.020617... 0.05293955 0.8000416 0.5743326 0.5265989 0.62639326
13 ] Liver GH1 35.452633 16.25408 0.23876446 2.4355955 0.18484712 0.12329351 0.277131
14 ] Liver LIPC 21.093778 2.7018890.0500186... -0.006226 1021.32495 040.9340  1108.5833 b
-

Well Results Data

Show In Table ¥ || Group Results By ¥

# Sample Target Experim...| Omit Flag RQ RQ Min RQ Max Flags cT ACT ACT Me... | ACT SE AACT

Brain ACTB )S6_QuantS O 17.265797 MNal -~

Brain ACTB 156 Quants O 17.17082 Mal

Brain ACTB )56 Quants O 17.186125 Nall

Brain ACTB 356 Quants O 17.404072 NaN

Brain ACTB 156 Quants (ol 17.216124 Nal

Brain ACTB 056 Quants O 17.247149 NaN

Brain GAPDH 156 Quants |:| 0.45529792 0.43082792 0.48115778 17.508968 0.31446025 0.0337048...1.1351172...

Brain GAPDH 156 Quants O 0.45529792 0.43082792 0.48115778 17.50408 0.31446025 0.0337048...1.1351172...

Brain GAPDH )S6 _Quants [F] 0.45529792 0.43082792 0.48115778 17.523808 0.31446025 0.0337048...1.1351172... »
T|ps for viewing * Select the Technical Replicates tab or the Biological Replicates tab to organize
replicate results in and view the sample data according to the associated technical replicate group or

your own study biological replicate group.
* View all wells for a technical or biological replicate group by selecting the
appropriate row in the table. When a row is selected, the Well Results Data pane

displays the wells that make up the group. Ctrl-click to select multiple rows.

¢ Change the endogenous control by clicking Endo Control, then selecting a new
target.

* Change the reference sample by clicking Ref Sample, then selecting a new
sample.

¢ Add biological replicate groups by clicking Add BioGroup.

* Omit biological or technical replicates from the analysis. See “Omit replicates
from the analysis” on page 147.

Note: The QuantStudio 384 Well Comparative Ct with Bioreplicates Study
Example.edm file demonstrates the use of biological replicate groups. You can
also create example study that does not use biological replicate groups.

Omit replicates To omit a technical or biological replicate from the analysis:

from the analysis 1. From the Study Menu pane, select Analysis » Gene Expression.

2. Select the Technical Replicates or Biological Replicates tab according to the type
of replicate that you want to omit.

3. In the replicate table, scroll to the biological or technical replicate of interest, then
select the corresponding check box in the Omit column.
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Confirm accurate dye signal using the Multicomponent Plot

4,

Click Analyze when you finish omitting wells.

IMPORTANT! You cannot omit all technical replicates that belong to a reference
sample or a reference biological group, or that serve as the endogenous control for
a study.

Note: You can also omit the biological replicates in the Biological Replicate
Details table at the bottom of the Biological Replicates tab.

Confirm accurate dye signal using the Multicomponent Plot

The Multicomponent Plot screen displays the complete spectral contribution of each
dye over the duration of the PCR run in a selected well of any experiment that is added
to the study.

About the example In the comparative Ct example study, you review the Multicomponent Plot screen for:

study .

View the 1.

Multicomponent 2
Plot

ROX™ dye (passive reference)
FAM™ dye (reporter)
Spikes, dips, and/or sudden changes

Amplification in the negative control wells

From the Study Menu pane, select Analysis » Multicomponent Plot.

. In the Experiment Data pane, select the QuantStudio Comparative Ct Example

1.eds experiment.

Display the unknown wells one at a time in the Multicomponent Plot pane:
a. Click the Plate Layout tab.

b. Select one well in the plate layout; the well is shown in the Multicomponent
Plot pane.

Note: If you select multiple wells, the Multicomponent Plot pane displays the
data for all selected wells simultaneously.

In the Multicomponent Plot pane, set the parameters for the plot:
a. From the Plot Color drop-down menu, select Dye.
b. Click |7— Show a legend for the plot.

Note: This is a toggle button. When the legend is displayed, the button
changes to Hide the plot legend.

Check the FAM dye signal. In the example study, the FAM dye signal increases
throughout the PCR process, which indicates normal amplification.

Check the ROX dye signal. In the example study, the ROX dye signal remains
constant throughout the PCR process, which indicates typical data.
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Chapter 13 Design and Analyze a Gene Expression Study
View the QC Plots

Repeat steps 2 through 6 for the remaining experiments in the study.

Multicomponent M Experiment Data
Plot Settings

Plot Color [Dye v

Save current settings as the default

> Show In Table ¥

# | Experiment # of Tar...| # of Sa... | Run Date
1QS6_QuantStudio Comp... 5 4 0ct 2, 2010

175,000

150,000

Multicomponent

— 2Q56_QuantStudio Comp... 5 40ct 5, 2010

125,000

100,000

Fluorescence

75,000

50,000

25,000

o

Well Results Data

v
Well Table Plate Layout
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12 Wells Selected Hide unselected data from plot
Tips for confirming ¢ Passive reference — The passive reference dye fluorescence level should remain
dye-signal relatively constant throughout the PCR process.
accuracy in your * Reporter dye — The reporter dye fluorescence level should display a flat region
own studies corresponding to the baseline, followed by a rapid rise in fluorescence as the

amplification proceeds.

Irregularities in the fluorescence — There should not be any spikes, dips, and/or
sudden changes in the fluorescence.

Negative control wells — There should not be any amplification in the negative
control wells.

If your study does not meet the guidelines above, you can omit individual wells from
the analysis. See “Omit wells from the analysis” on page 164.

View the QC Plots

The QC Plots screen displays the endogenous control and replicate analysis results for
each reaction plate (experiment) added to the study. The following plots are derived
from the experiments added to a study:

Endogenous Control Profile
Box Plot
Technical Replicates Correlation

Biological Replicates Correlation
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View the QC Plots

View the The QC Plots screen displays the Endogenous Control Profile plot for the endogenous
Endogenous controls used in the experiments added to a gene expression study. The endogenous
; control profile plot displays how much of the endogenous control is expressed in a
Control Profile plot sample. The sample is plotted on the X-axis, and the Cy is plotted on the Y-axis. The
expression is viewed as a color and shape combination in the plot.

In the example study, you view four potential endogenous controls expressed in four
samples. The potential endogenous controls are:

ACTB

* GHI1

LIPC

LPIN1

The samples are brain, heart, lung, and liver.
1. From the Study Menu pane, select Analysis » QC Plots.
2. In the QC Plots pane, click Endogenous Control Profile.

w

In the Candidate Endogenous Controls pane, select the check boxes of those
Targets whose profile you want to view in the plot pane. In the example study, the
Target ACTB is chosen to be the endogenous control because it is expressed at
similar levels in three out of four of the given samples.

L

In the Replicate Results Data pane, view results by replicate group.

a. Click the Technical Replicates tab. The table displays the results by technical
replicate group.

b. Click the Biological Replicates tab. The table displays the results by
biological replicate group.

Endogenous Contral Profile Box Plot T Technical Replicates Correlation T Biclogical Graup Carrelation W

3 B o [, Candidate Endogenous Controls
£ oL oallhE g = og

>| candidate Con... Target Color Shape

) v ACTB I o
Endogenous Control Profile GH1 —: o :
LIPC v [=] v
LPINL I v =
O GAPDH hd .

AV

- R -
225 B e — o -
——
# | Omit Biologic... | Target # Repli... | CT Mean | ACT I\.
- w0 : 1 Brain ACTB 1 17.265017 ~
© s I\.,/‘l/- 2 Brain GAPDH 1 17.579475 0314
3 Brain GH1 1 31.093044 13.82
150 4 Brain LIPC 1 28.920298 11.6G
5 Brain LPINT al 21.73203 446
125 6 Heart: ACTB 1 18.136377
7 O Heart GAPDH 1 17.315718 -0.820»
100 ¢ S
75 Biological Replicate Details Edit BioGroup Delete BioGroup
50 # | Omit Sample Target Ct Mean | ACT Me...| ACT SE
1 Brain ACTB
25 2 Brain ACTB
oo
Heart Brain Lung Liver
Sample
LIPC =& GH1 4 ACTE ¥ LFIN1
< bd

View the box plots The Box Plot displays the Cp distribution of a particular Target in samples. You can see
the individual Ct values/ raw data with this plot.
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View the QC Plots

In the example study, you view the box plots of five targets in four different samples:

e LPIN1

e GAPDH
e LIPC

e GHI1

e ACTB

The samples are Heart, Liver, Lung, and Brain.
1. In the QC Plots pane, click Box Plots to access the Replicate Results Data pane.

2. In the Replicate Results Data pane, click the Technical Replicates tab. The table
displays the results by technical replicate group.

3. Click the Biological Replicates tab. The table displays the results by biological
replicate group.

4. Click the Experiments tab to select the experiment whose Box plot to view.

5. View the values in the Well Results Data pane. View the Cp, ACt Mean, and ACy
SE values to evaluate the C precision of the replicate groups. In the example
study, the low ACy SE values indicate these replicates have good Cy precision.

Endogenous Contral Profile w Technical Replicates Correlation T Biclogical Group Correlation }

/@ r(:) ﬂ J_"H g i:‘i_i, 1= <W Biological Replicates T Experiments ]
» & | omit Sample | Target | C7 Mean | act Me..| actsE | alJY
1 Brain ACTB 17.265017 ~
25 2 0O Brain GAPDH 17.579475 0.3144583 0.03370482
3 O Brain GH1 31.093044 13.828029 0.13150350.C
200 4 O Brain LIPC 28.020298 11.664282 0.0410095... -1
—— 5 0O Brain LPINL 21.73203  4.467014 0.0398248... -1
275 6 Heart ACTB 18.136377
7 Heart GAPDH 17.315718 -0.8206588 0.0384727...
250 8 Heart GH1 31.95486  13.818484 0.08681472
9 Heart LIPC 30.024492 12.7881155 0.0554872...
25 10 Heart LPINL 23.730658  5.504281 0.0346003...
—_— 1 Livar ACTB 19.201889
200 12 O Liver GAPDH 19.181273 -0.020617... 0.05293955
= 13 O Liver GH1 35452633  16.25408 0.23876446 :
S s . 14 O Liver LIPC 21.993778  2.791889 0.0500186... -+
2 < >
3“3: 150 bl
o Well Results Data
125
I
100
£ Sample Target Experim... Omit Flag RQ
75 Brain ACTE O -~
Brain ACTE O
50 Bran  ACTB O
s Brain ACTE O
Brain ACTB O
00 Brain ACTB ]
Biain Bran  GAPDH O 0.45526792
Sample Brain  GAPDH O 0.45529792
[ LPC W LPINT = GAPDH [ oM < >

View the Technical  The Technical Replicates Correlation plot displays the correlation between the target

Replicates genes in one or more samples.

Correlation plot The Technical Correlation Group plot is made of two components, the scatter plot and
the heat map.
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Scatter Plot

The scatter plot shows the p P .
: 8 g & iy
distribution of ACt of =
targets for different Scatter Plot
Study: Q56 _384-Well_Comparative_Ct_with_Bioreplicates_Study_Example,
samples. Brain cDNA vs Brain cDNA, R* = 1.0
If a correlation 200 A~

(represented by R? or the
coefficient of
determination) exists
among the targets in the
samples, the targets
appear on or along the
line of reference. If the
correlation is weak or not
present, the targets appear
scattered in the plot, away 25
from the line of reference.

17.5

125 /

10.0

delta Ct: Brain cDMNA

7.8

5.0

. . DIDU‘?U 25 50 7.5 10.0 125 15.0 17.5 200
The line of reference is delta Ct Brain cDNA

. . « T™
fixed in the QuantStudio 185 = ACTB m GCKAR ® GAPDH = GH1 = LIPC = LPINT = TGFB1
6 and 7 Flex Real-Time
PCR Development

Software.

If:

e R2=/z1, then the Scatter Plot

Correlation is Study: @QS6_384-Well_Comparative_Ct_with_Bioreplicates_Study_Example, Heart vs Liver, RO = 0.03
17

strong 1 -

e RZ<1, then the "
correlation is weak 1

e R2=0, then there is
no correlation 1

£ L oa i

delta Ct: Liver

Heat maps

The heat map shows the
variation of coefficient
determination for
different scatter plots.
Each cell of the heat A8 1 2 3 4 & & 7 & & w 1 1 1 1
map represents a ot o e

different scatter plot, igm ALtl::TNE|1 ACTB I GAPDH " GAPDH I GAPDH % GH1 ® GH1 ® GH1 = LIPC = LIPC = LIPC = LPIN1
and therefore a different
value for R2. The cells inclined to red represent a lower R? value; the cells inclined to
green represent a higher R2 value.

\
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In the example study,
you view the scatter

plots and heat maps of

five targets in four
different samples:

The samples are Brain,

LPIN1
GAPDH
LIPC
GH1
ACTB

Heart, Kidney and
Lung.

1.

In the QC Plots
pane, click
Technical
Replicates
Correlation to

access the Heat Map.

Chapter 13 Design and Analyze a Gene Expression Study
View the QC Plots

Erain

Heart

Liver

Lung

In the Heat Map, click the cell with a correlation value, R2=/=1. The
corresponding scatter plot pane displays the scatter plot of the targets in that

technical replicate group along the line of reference.

£ L By & iy

Scatter Plot
Study: @S6_384-Well_C ive_Ct_with_Biorepli

delta Ct: Brain
~

_Study_E: le, Brain vs Brain, RO =1

delta Ct: Brain

LPIMN1 = LPINT

WACTB WACTB WACTB © GAPDH ' GAPDH © GAPDH = GH1 ® GH1 ® GH1 ®wLIPC = LIPC W LIPC = LPIN1

A

Brain

Heart

Liver

Lung
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3. Click the cell with a correlation value, R? =/= 0. The corresponding scatter plot

pane displays the scatter plot of the targets in that technical replicate group away
from the line of reference.

A

SR N [

Scatter Plot
Study: @S6_384-Well_Comparative_Ct_with_Bioreplicates_Study_Example, Liver vs Heart, R0 = 0.03
17

Brain

Heart

delta Ct: Heart

Liver

] 1 2 3 4 g 5] 7 8 a 10 11 12 13 14 15 18 17
della Ct Liver Lung

WACTB wACTB wACTB ©GAPDH " GAPDH © GAPDH = GH1 ™ GH1 = GH1 W LIPC = LIPC W LIPC = LPIN1
LPINT = LPINT

View the Biological  The Biological Group Correlation plot displays the correlation between the target

Group Correlation genes in one or more biological group samples. Biological groups provide a broader
plot set of samples, with the same targets.

Note: If the experiments in your study do not use biological replicate groups, see
“Define Replicates” on page 128 to create a new biological group.

The Biological Group Correlation plot is also made of two components, the scatter plot
and the heat map.
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Scatter Plot

The scatter plot shows the
distribution of ACt of
targets for different
biological groups. If a
correlation (represented by
R? or the coefficient of
determination) exists
among the targets in the
biological groups, the
targets appear on or along
the line of reference. A
weak correlation or no
correlation is represented
by the targets being
scattered in the plot and
away from the line of
reference.

Note: The line of reference
is fixed in the

Chapter 13 Design and Analyze a Gene Expression Study

View the QC Plots

Y
Scatter Plot
Study: @S56_384-Well_Comparative_Ct_with_Bioreplicates_Study_Fxample, Heart vs Heart, RO =1

delta Ct: Heart

N

-1 ] 1 2 3 4 -] ] 7 8 a 10 11 12 12 14
delta Ct. Heart

[=ACTB = GAPDH = GH1 = LIPG = LPINT]

QuantStudio™ 6 and 7 Flex Real-Time PCR Development Software.

If:
e R2=/=1, then the
correlation is strong
e R2<1, then the
correlation is weak

e R2=0, then there is
no correlation
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Scatter Plot
S}gd}r Q@56_384-Well_Comparative_Ct_with_Bioreplicates_Study_Example, Lung vs Liver, RO = 0.574
16 =
15
14
13
12
1
10
9
8
7
[
5
4
3 L
2
1
o ]
0 1 2 3 4 5 [ 7 3 [ 10 1 12 13 14 15
delta Ct: Lung

= ACTE = GAPDH = GH1 = LIPC = LPIN1
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View the QC Plots

Heat maps

The heat map shows the
variation of coefficient
determination for different
scatter plots. Each cell of
the heat map represents a
different scatter plot, and
therefore a different value
for R2. The dull green cells
represent a lower R? value;
the bright green cells

represent a higher R2 value.

In the example study, you
view the scatter plots and
heat maps of eight targets
across four biological
groups:

e LPIN1

e GAPDH

e LIPC

e GHI1

e ACTB

Heart

Lung

Brain

Liver

Technical replicate samples of Brain cDNA belong to the biological group Brain, those
of Lung cDNA belong to biological group Lung, technical replicate samples of Liver
cDNA belong to the biological group Liver, and those of Heart cDNA belong to the

biological group Heart.

To view the Biological Group Correlation plot:

1. In the QC Plots pane, click Biological Group Correlation to access the heat map.
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View the QC Plots

2. In the Heat Map, click the cell with a correlation value, R2=/=1. The
corresponding scatter plot pane displays the scatter plot of the targets in that

biological replicate group along the line of reference.

2P e ol
Scatter Plot

Study: @56_384-Well_C:

delta Ct: Heart

ive_Ct_with_Biorepli _Study_E: le, Heart vs Heart, RO=1

Heart:

Lung

Erain

-1 i} 1 2 3

Liver
4 5 a 7 Bl El 10 11 1z 13 14

delta Ct Heart

= ACTE = GAPDH = GH1 = LIPC LPH'\I1|

3. Click the cell with a correlation value, R? =/= 0. The corresponding scatter plot
pane displays the scatter plot of the targets in that biological replicate group away

from the line of reference.

A L Bl E

A

Scatter Plot

Study: QS6_384-Well_C
7

delta Ct. Liver

ive_Ct_with_Bioreplicates_Study_| , Heart vs Liver, RO = 0.549

Heart

Lung

Brain

Liver

delta Ct Heart

[mac

TB = GAPDH = GH1 = LIPC = LPINY ‘

Tips for viewing
your own scatter
plots and heat
maps

When you analyze your study, look for scatter plots and heat maps that display a
correlation value that is =/= 1 for samples that come from the same source or tissue
(technical or biological replicates). If the replicates do not correlate well, that could be a

sign that there is a problem with a sample.

If your study does not meet the guidelines above, you can omit individual wells from

the analysis. See “Omit wells from the analysis” on page 164.
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View the QC Summary

About the example
study

View the QC
Summary

Flag
= Experiment Flags - 2 of 11 Found
SPIKE
BADROX
NOAMP
CTFAIL
BLFAIL
EXPFAIL
HIGHSD
MOSIGHAL
MNOISE
QFFSCALE
AMPNC
= Replicate Flags - 0 of 2 Found
THOLDFAIL
OUTLIERRG

The QC Summary screen displays a list of the QuantStudio™" 6 and 7 Flex Real-Time
PCR Development Software flags, and it includes the flag frequency and location for
any experiment that is added to a study.

In the Comparative Cy example study, you review the QC Summary screen for any
flags generated by the study data. In the example study, several wells produced data
that generated flags.

1. From the Study Menu pane, select Analysis » QC Summary.

Note: If no data are displayed, click Analyze.

In the Flags Summary table, look in the Frequency column to determine which
flags appear in the study. In the example study. The EXPFAIL flag appears 10
times and the NOAMP flag appears once.

Note: A 0 displayed in the Frequency column indicates that the flag does not
appear in the study.

For each flag that appears in the study, click the flag row to display details about
the flag in the Flag Details table. In the example study, the NOAMP flag indicates
no amplification and the EXPFAIL flag indicates that the exponential algorithm
failed.

Consider removing the NOAMP well from the analysis. See “Omit wells from the
analysis” on page 164.

>

Name Frequency

MNoise spikes

Bad passive reference signal

No amplification

C1 algorithm failed

Baseline algorithm failed
Exponential algorithm failed

High standard deviation in replicate group
No signal in well

Noise higher than others in plte
Fluorescence is offscale
Amplification in negative control

CcoococorooROoO
1=}

Thresholding algorithm failed
Outlier in replicate group 1}

=)

Flag Details

»
‘

Flag:
Flag Detail:
Flag Criteria:

NOAMP—No amplification

The sample did not amplify
Amplification algorithm result <= 0.1
View NOAMP Troubleshooting

Information

Show In Table ¥ || Group Results By ¥

# Sample Target

iGH1

Experim...

i Lwer 056 Quants

ACT Me... | ACT SE AACT well
16.25408 0.238764462.4355956... G11

Flag ACT omit

O

RQ RQ Min
0.18484712 0.12329351

RQ Max
0.277131

Flags cT
NOAMP Undetermi...

Possible flags

158

For Comparative Cy studies, the flags listed below may be generated by the study
data.
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If a flag does not appear in the study, its frequency is 0. If the frequency is >0, the flag
appears somewhere in the study, and the associated well position is listed in the
Wells column.

Flag Description

Pre-processing flag

OFFSCALE Fluorescence is offscale

Primary analysis flags

BADROX Bad passive reference signal

NOAMP No amplification

NOISE Noise higher than others in plate

SPIKE Noise spikes

NOSIGNAL No signal in well

EXPFAIL | Exponential algorithm failed

BLFAIL . Baseline algorithm failed

THOLDFAIL | Thresholding algorithm failed

CTFAIL Ct algorithm failed

Secondary analysis flags

OUTLIERRG Outlier in replicate group

AMPNC Amplification in negative control

HIGHSD High standard deviation in replicate group
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Compare analysis settings

Tips for using flags .
to evaluate your
study

In the Flag Summary table, click each flag that has a frequency >0 to display
details about the flag in the Flag Details table. If needed, click the troubleshooting
link in the Flag Details table to view information on correcting the flag.

Note: In the Flag Details table, the numbers on each flag symbol indicate the
number of flags generated for that well. For example, 2 indicates that two flags
have been generated for that well.

You can change the flag settings. For more information, see “Flag Settings” on
page 136:
— Adjust the sensitivity so that more wells or fewer wells are flagged.

— Change the flags that are applied by the QuantStudio" 6 and 7 Flex Real-
Time PCR Development Software.

You can omit individual wells from the analysis. See “Omit wells from the
analysis” on page 164.

Compare analysis settings

Use the Compare Settings screen to perform a side-by-side comparison of analysis
settings for a comparative 1 study. You can change one or more of the analysis
settings, then compare the new results with the previous results. For example, you can
compare the effects of:

Using multiple endogenous controls versus a single endogenous control.

Changing the amplification efficiency of a specific target versus keeping it at
100%.

About the example  In the comparative Ct example study, you change the endogenous control to LPINT1,
study then compare results.

Modify comparison 1.

criteria

From the Study Menu pane, select Analysis » Compare Settings. When the
Compare Settings screen is initially displayed (before you make any changes):

¢ In the Settings Comparison pane, the green column is titled “Current
Analysis Settings,” the white column is titled “Comparison Analysis
Settings,” and the Use Comparison Analysis Settings button is under the
green column.

* In the Results Comparison pane, values in the white columns and values in
the green columns are the same.

* The Gene Expression Comparison plot is the same plot that is displayed in
the Gene Expression screen (Analysis » Gene Expression).
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Compare analysis settings

2. In the Settings Comparison pane, click Edit in the green column to open the
Comparison Analysis Settings dialog box.

Gene Expression Comparison *| settings Current Analysis Settings | |21 Comparison Analysis Settings | Edit...
1,200 = Target Settings (Threshold, Baseline Start, Baseline End) A
1180 GH1 AUTO, AUTO, AUTO AUTO, AUTO, AUTO
' GAPDH AUTO, AUTO, AUTO AUTO, AUTO, AUTO
1100 LPINL AUTO, AUTO, AUTD AUTO, AUTO, AUTD
1080 ACTB AUTO, AUTO, AUTO AUTO, AUTO, AUTO
1 000 LIPC AUTO, AUTO, AUTO AUTO, AUTO, AUTO
; = Flag Settings
os0 SPIKE USED Spike algorithm resuft=1.0 USED Spike algorithm resuft=1.0
ao0 BADROX USED Bad passive referance algorithm ... USED Bad passive reference algorithm ...
NOAMP USED Amplfication algorithm result<0.... USED Amplification algorithm result<0....
Ba0 CTFALL USED USED
800 BLFAIL USED USED
750 EXPFAIL USED USED )
700 Use Comparison Analysis Settings
B50 AW
=) : =
x 600 H Results Comparison
550
Enter a filter query, then click "Apply Filter.”
500
400
350
200 # Sample Target CT Mea... | CT Mea... | ACT Me... || ACT Me... | ACTSE1 | ACTSEZ2 | AACT 1 AACT 2
20 1 Brain ACTB 17.265 17.265 ~
2 Brain GAPDH 17.578 17.579 0.314 0.314 0.034 0.034 1.135 ik]
200 3 Brain GH1 31.093 31.003 13.828 13.828 0.132 0.132 0.01 (
150 4 Brain LIPC 28.528 28.528 11.664 11.664 0.041 0.041 -1.124 1.
100 5] Brain LPINL 21.732 21,732 4.467 4.467 0.04 0.04 -1.127 -1.
6 Heart ACTB 18.136 18.136
s0 7 Heart GAPDH 17.316 17.316 -0.821 -0.821 0.038 0.038 0
ol N N i Heart GH1 31.855 31.955 13.818 13.818 0.087 0.087 0
& & o5 & 9 Heart LIPC 30.924 30.924 12.788 12.788 0.055 0.055 0
A ¥ > 10 Heart LPINL 23.731 23.731 5.584 5.554 0.035 0.035 0 &
Sample o . - < —_— —— 3
3. In the Comparison Analysis Settings dialog box, change the endogenous control:
. o g . .
a. Select the Relative Quantification Settings tab.
b. In the Endogenous Control(s) pane, select LIPN1 from the Endogenous
Control drop-down menu.
L™ . . . .
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Compare analysis settings

c. Click Analyze to analyze the data and close the dialog box.

Relati

€T Settings Flag Settings

@ Comparative Cr Analysis Settings

Analysis Type
( Select the type of analysis to perform.

@ Singleplex

ce

Biological Replicate Group Reference Sample:

Select reference samples for the biological and/or technical replicate groups of this study.

]

Technical Replicate Group Reference Sample:  |Heart v]

— Endogenous Control(s)

Endogenous Control: |ACTE v

Select the target to use as the endogenous control for this experiment.

— Efficiency

Enter percentage values between 1 and 150%

Target
ACTB
GAPDH
GH1
LIPC

LnThie

Efficien... | Efficien... | Override Std/Rsc ...

100.0 0.0 ~
100.0 0.0 £
100.0 0.0
100.0 0.0

1nnn nn

— Outlier Rejection

[] Reject Replicates with specified ACT

(—

Select to reject replicates with ACT values less than or equal to the value entered below. These analysis settings apply only to multiplex reactions,

~ RQ Min/Max Calculations

(® Confidence Lavel: \9—5‘0 ¥ %

(O Standard Deviations:

Select an algerithm to determine RE Min and Max values (emer bars).

Save to Library Load from Library Revert to Default Analysis Settings [m W

4. In the Settings Comparison pane, click Use Comparison Analysis Settings under
the green column, then compare the results:

In the Settings Comparison pane, the white column is titled “Comparison
Analysis Settings,” the green column is titled “Current Analysis Settings,”
and the Use Comparison Analysis Settings button is under the white
column.

In the Results Comparison pane, values in the white columns are based on
the default analysis settings, and values in the green columns are based on
the modified analysis settings. In the example experiment, changing the
endogenous control to 18S affects the RQ values. To view the RQ values,
scroll to the left. If desired, you can click and drag the RQ column headings
so that they appear first in the table.

The Gene Expression Comparison plot displays the default analysis settings
(the values from the white columns).

Note: The Gene Expression Comparison plot has limited functions. For
example, you cannot change to log scale and you cannot view by target.
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Note: The default analysis settings are the settings automatically made by
the software when the study is initially analyzed.

825

500

Gene Expression Comparison > Settings Current Analysis Settings - Comparison Analysis Settings

(=l Target Settings (Threshold, Baseline Start, Baselne End) ~
GH1 AUTO, AUTOQ, AUTO AUTO, AUTO, AUTO
GAPDH AUTO, AUTO, AUTO AUTO, AUTO, AUTO
LPIN1 AUTO, AUTO, AUTO AUTO, AUTO, AUTO
ACTB AUTO, AUTOQ, AUTO AUTO, AUTO, AUTO
LpC AUTO, AUTO, AUTO AUTO, AUTO, AUTO

= Flag Settings
SPIKE USED Spike algorithm result=1.0 USED Spike algorithm result=1.0
BADROX USED Bad passive reference algorithm ... USED Bad passive reference algorithm ...
NOAMP USED Amplification algorithm resuft<0.... USED Amplification algorithm result<0....
CTFAIL USED USED
BLFAIL USED USED
EXPFAIL USED

Use Comparison Analysis Settings

_~
3
Z;g Enter 2 fitter guery, then dick "Apply Fiter."
325 Fs | ~ = v
2mple [ noct e JEEERE
o
253 # Sample Target CT Mea... | CT Mea... | ACT Me... | ACT Me... | ACT SE1 | ACT SE 2 | AACT 1 MACT 2
176 1 Brain ACTB 17.265 17.265 4467 0.04 1127 ~
180 2 Brain GAPDH 17.579 17.579 -4.153 0.314 0.027 0.034 2.262 il
125 3 Brain GH1 31.093 31.003 9.361 13.828 0.13 0.132 1.137 (
100 4 Brain LIPC 28.929 28.929 7.197 11.664 0.036 0.041 0.003 -1.
75 5 Brain LPINT 21.732 21.732 4.467 0.04 =il
s0 6 Heart ACTB 18.136 18.136 -5.594 0.035 [t}
26 7 Heart GAPDH 17.316 17.316 -6.415 -0.821 0.04 0.038 0
ol — S | ———, 8 Heart GH1 31.955 31.955 8.224 13.818 0.088 0.087 0
& ‘,,*‘ oy <2 El Heart LIPC 30.924 30.924 7.194 12.788 0.057 0.055 [t}
< ¥ N h 10 Heart LPINL 23.731 23.731 5.594 0.035 3
Sample I < — — —_— B - >
5. From the Study Menu pane, select Analysis » Gene Expression to view the gene
expression plot using the modified analysis settings.
Note: In the Gene Expression screen you can view the modified data in log scale,
by target, and so on. See “Assess the gene expression profile using the Gene
Expression Plot” on page 140.
6. (Optional) View the data in the other analysis screens. All other analysis screens
for the study display the data using the modified analysis settings.
7. Close the study.
* Save your changes before closing the study.
Or
* C(Close the study without saving your changes. If you do not save your
changes, the software reverts to the default analysis settings the next time
you open the study.
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Compare analysis settings

Tips for managing ¢ Edit the comparison analysis settings as desired. For information on editing the
your own settings, see “View the analysis settings” on page 134.
comparison * After making your first round of changes to the analysis settings, you can

continue making changes using one of the following methods:

— (Recommended) Revert to the saved analysis settings, then make new
changes. To do this: In the Settings Comparison pane, click Use Comparative
Analysis Settings (now under the white column) to revert to the saved
analysis settings, then repeat steps 2 through 6 above. This method ensures
that you do not lose the saved analysis settings.

Note: If you have made changes, but have not saved them, the software
reverts to the default analysis settings when you click Use Comparative
Analysis Settings. The default analysis settings are the settings
automatically made by the software when the study is initially analyzed.

— Continually compare new settings with previous settings. To do this: In the
Settings Comparison pane, alternate clicking Edit in the white and green
columns, then repeat steps 3 through 6 above. This method does not allow
you to return to your saved settings; subsequent comparisons are made with
the previous analysis settings, building upon any changes that you have
already made.

Revert to the IMPORTANT! The default analysis settings are defined by the software. If you make
default analysis changes to the analysis settings and save the study, the saved changes are lost when
settings you revert to the default analysis settings.
1. In the Settings Comparison pane, click Edit next to the settings you want to revert
to the default: Current Analysis Settings or Comparison Analysis Settings.
2. In the Analysis Settings dialog box, revert to defaults and reanalyze the data:
a. Click Revert to Default Analysis Settings.
b. At the prompt, click Yes.
warning x|
g ‘ou have selected to revert to DefFault Analysis Settings. Are you sure you wank to continue?
Ma
c. Click Analyze to analyze the data and close the dialog box.
3. In the Settings Comparison pane, click Use Comparison Analysis Settings. In the
Results Comparison pane, values for the settings you selected to edit in step 1
(“Current Analysis Settings” or “Comparison Analysis Settings”) are generated
according to the default analysis settings.
Omit wells from You can use the Well Table to omit individual wells from the analysis. To omit a well:
the analysis 1. From the Study Menu pane, select one of the following analysis screens:
* Analysis » Amplification Plot
* Analysis » Multicomponent Plot
* Analysis » Multiple Plots View
2. In the Experiment Data pane, select the experiment that contains the well to omit.
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3. In the Well Results Data pane, click the Well Table tab, then select the check box
in the Omit column for the well to omit.

Note: You cannot omit all technical replicates that belong to a reference sample or
a reference biological group, or that serve as the endogenous control.

Export the study

Note: If you are using RealTime StatMiner® Software to analyze the exported data,
make sure you have assigned a sample to all the wells containing data in the
individual experiments. If a sample is not assigned, the RealTime StatMiner® Software
reports an error during import.

You can export the data within a study from the Analysis screen. To export a study:
1. On the Analysis screen, click Export to access the Export Properties tab.

2. Define export properties.
a. Select the data to export. Options are:
* Amplification Data
¢ Results
* Technical Analysis Result
¢ BioGroup Analysis Result
¢ QC Summary

b. Select One File or Separate Files from the drop-down menu to export all
data to one file or in separate files for each data type respectively.

c. Enter the export file properties and file name.

d. Select the file type from the File Type drop-down menu. You can choose
from *.txt, *.xls, and *.xIsx.

e. Enter the Export File Location. The default location is C:\ Applied
Biosystems\ QuantStudio 6 and 7 Flex Software\ User Files\ Export.

f.  Select the Open file(s) when export is complete check box to automatically
open the file when export is complete.

For the example study, enter:

Field or Entr
Selection y
Select Data Amplification Data
to export
Select one One File
file or
separate files
Export File QS6_384-
Name Well_Comparative_Ct_with_Bioreplicates_Study_ Example_data
File Type *.txt
Export File C:\Applied Biosystems\QuantStudio 6 and 7 Flex Software\User
Location Files\Export
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Field or

Selection R

Open file(s) Unchecked
when export
is complete

Save current | Unchecked
settings as
the default

7900 Format . Unchecked

The following is an image of the Export Data screen:

-1 Export Data E|
Select the type of data to export, select whether to export one file or separate files, then enter expart file properties, (Optional) Click "Customize Export” to change the export format and to select fields to -
export. Click "Start Export™ to export your data. &)

Amplification Data [ Results
[] Technical Analysis Result [] BioGroup Analysis Result

1. Select data to export:
[ QC Summary

2. Select one file or separate files: Select to export all data to one file or it separate fies for each data type.

3. Enter export file properties:

Export File Mame: |QSE_384—WEH_CU mparative_Ct_with_Bioreplicates_Study Example_data File Type: !E‘] (*.txt) v|
Export File Location: |C:\App|ied Biosystems\QuantStudio 6 and 7 Flex Software\User Files\Export ‘

[10pen Tile(s) when export 5 complete

[ save current settings as the default [] 7900 Format Start Export -

3. To change the export format, complete the tasks on the Customize Export tab.

Note: To complete the tasks on the Customize Export tab you must have at least
one type of data to export.

a. Select the data from the Export Properties tab. The type of data that you
selected in the Export Properties tab appears in the Customize field in the
Customize Export tab.

b. Select the data type content.

c. Select the Tabs or Commas radio button to select the Field Separator
(Delimiter).

d. Select the Open file(s) when export is complete check box to automatically
open the file when export is complete.

For the example study, enter:
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Export the study

Field or

Selection e

Customize Amplification Data

Field Commas
Separator
(Delimited)

Open file(s) Unchecked
when export
is complete

Save current | Unchecked
settings as
the default

7900 Format . Unchecked

The following is an image of the Export Data screen for customized export of
Amplification Data:

-1 Export Data E|

Select the type of data to export, select whether to export one file or separate files, then enter export file properties, (Optional) Click "Customize Export” to change the export format and to select fields to
export, Click "Start Export™ to export your data.

Customize: }Ampliﬁc ation Data : File Mame: QS6_384-Wel| Comparative_Ct_with_Bioreplicates_Study_BExample_data  File Type: [5]
Select Amplification Dat - Amplification Data Export
All Amplification * Experim...| Well Cycle Sample Target Rn ARN Omitted Sample ...

: Q56_Quan... Al 1 Brain ACTB 0.002 7] 10 ~
Faperiment:fame 056_Quan... Al 28rin ACTR 0.001 0 10 =
] wel QS6_Quan... Al 3 Brain ACTB 0.001 O 10

0Q56_Quan... Al 4 Brain ACTB 0.002 [ 10
Cycle Q56_Quan... Al 5 Brain ACTB 9.776026E-4 [F] 10

0Q56_Quan... Al & Brain ACTB -6.325745... || 10
Sample Q56_Quan... Al 7 Brain ACTB -0.002 il 10

0Q56_Quan... Al 8 Brain ACTB -0.001 || 10
Target 0S6_Quan... AL 9Brzin ACTB 0.001 O 10
RN 0Q56_Quan... Al 10 Brain ACTB -0.001 || 10

0Q56_Quan... Al 11 Brain ACTB -0.001 ] 10
1 ARR ¥ 0Q56_Quan... Al 12 Brain ACTB -4.064515... || 10
< > Q56_Quan... Al 13 Brain ACTB 7.3627447... F1 10
Field Separator (Delimite 0Q56_Quan... Al 14 Brain ACTB 0.003 || 10

0Q56_Quan... Al 15 Brain ACTB 0.010 ] 10
O Tabs @ Commas | |Q56_Quan... Al 16 Brain ACTB 0.023 O 10

056 Ouan... Al 17 Brain ACTR n.043 1 10 b

[] Open file(s) when export is complete

[1 save current settings as the default [] 7900 Format Start Export -

4. Select the Save current settings as the default check box to save the export
settings that you have modified. Alternatively, select the 7900 Format check box to
save the export settings in the 7900 format.

5. Click Start Export.
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For more information

For more information

For more information on Refer to Publication
number
Calculating Relative User Bulletin #2: Relative Quantitation of Gene Expression. 4303859
Quantification Values
Consumables Chapter 1 in Booklet 1, Getting Started with QuantStudio™ 6 and 7 Flex 4489822
Real-Time PCR System Software Experiments
Appendix A in Booklet 7, QuantStudio™ 6 and 7 Flex Real-Time PCR
System Software Experiments - Appendixes
Publishing data Chapter 2 in Booklet 1, Getting Started with QuantStudio™ é and 7 Flex 4489822
Real-Time PCR System Software Experiments.
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About Genotyping Experiments

This chapter covers:

B Aboutdatacollection. .......... .. i 5

5 NUCIEASE @SSAY . . . . 6
B Minimizing non-specific fluorescence.................. ... ... ..o 7
B Reading and analyzing theplates ............. ... ... .. oL 7
B About the example experiment ........... ... ..o i i 8

IMPORTANT! First-time users of the QuantStudio™" 6 and 7 Flex Real-Time PCR System
Software please read Booklet 1, Getting Started with QuantStudio'" 6 and 7 Flex Real-Time
PCR System Software Experiments and Booklet 7, QuantStudio'" 6 and 7 Flex Real-Time
PCR System Software Experiments - Appendixes of this binder thoroughly. The booklet
provides information and general instructions that are applicable to all the
experiments described in this binder

Note: For more information about any of the topics discussed in this guide, access the
Help from within QuantStudio™ 6 and 7 Flex Real-Time PCR System Software by
pressing F1, clicking €3 in the toolbar, or selecting Help » QuantStudio™ 6 and 7 Flex
Real-Time PCR System Software Help.

About data collection

Genotyping experiments are performed to detect single nucleotide polymorphism
(SNP) variants of a target nucleic acid sequence in samples. The PCR reactions contain
primers designed to amplify the sequence containing the SNP and reagents to detect
two different alleles.

You can collect the results of a genotyping experiment in two different ways: At the
end of the experiment, or continuously during the experiment. Data collection at the
end of the experiment is called end-point data collection. Data collection during the
experiment run is considered real-time PCR. The real-time data helps further data

analysis.

In end-point data collection, the normalized intensity of the reporter dye, or Rn, is the
data collected. Some end-point experiments also include pre-PCR (data collected
before the amplification process) data collection. The software calculates the delta Rn
(ARn) value per the following formula:

ARn = Rn (post-PCR read) — Rn (pre-PCR read), where Rn = normalized readings.

QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Getting Started Guide for Genotyping Experiments 5
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57 nuclease assay

About TagMan®
SNP Genotyping
assays

About TagMan®
MGB probes

A Genotyping assay detects variants of a single nucleic acid sequence, without
quantifying the target. The presence of two probes in each reaction allows Genotyping
of the two possible variants at the single nucleotide polymorphism (SNP) site in a
target sequence.

Each TagMan® SNP Genotyping Assay consists of a single, ready-to-use tube
containing:

* Two sequence-specific primers for amplifying the polymorphism of interest

* Two allele-specific TagMan® MGB probes for detecting the alleles for the specific
polymorphism of interest

Each allele-specific TagMan® MGB probe has:

* Areporter dye at its 5" end:
— VIC® dye is linked to the 5" end of the Allele 1 probe.
— FAM™ dye is linked to the 5" end of the Allele 2 probe.

The Allele 1 VIC® dye-labeled probe corresponds to the first nucleotide inside the
square brackets of the context sequence in the assay information file (AIF)
shipped with each order. The Allele 2 FAM™ dye-labeled probe corresponds to
the second nucleotide inside the square brackets of the context sequence in the
AIF. For the context sequence ATCGATT[G/T]ATCC, the VIC® dye-labeled probe
binds to the G allele, and the FAM"" dye-labeled probe to the T allele.

* A minor groove binder (MGB), which increases the melting temperature (T,,,) for
a given probe length and allows the design of shorter probes. The use of shorter
probes results in greater differences in T ,, values between matched and
mismatched probes, and more robust genotyping.

* A non-fluorescent quencher (NFQ) at its 3" end, which allows for detection of the
reporter dye fluorescence with greater sensitivity than with a fluorescent
quencher.

5" nuclease assay

The figure below is a schematic depiction of the 5 nuclease assay. During PCR:

e Each TagMan® MGB probe anneals specifically to its complementary sequence
between the forward and reverse primer sites.

*  When the oligonucleotide probe is intact, the proximity of the quencher dye to the
reporter dye quenches the reporter signal.

* AmpliTaq Gold® DNA polymerase extends the primers bound to the genomic
DNA template.
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Minimizing non-specific fluorescence

* AmpliTaq Gold® DNA polymerase (with its 5" nuclease activity) cleaves probes
that are hybridized to the target sequence.

* C(Cleavage of the probes hybridized to the target sequence separates the quencher
dye from the reporter dye, resulting in increased fluorescence by the reporter. The
fluorescence signal generated by PCR amplification indicates which alleles are
present in the sample.

1. Assay Components and DNATemplate
N GB GB
T Probe MO Probe A
Forward primer Ve Reverse primer
G A S
° DNA templ [G/A] ¥
\ template /
3 em 5
2. Denatured Template and Annealing Assay Components 5 3 LEGEND
N V VIC® dye
b )@EB ﬂf’e Reverse primer
robe Probe
. E) FAM™dye
G A \—f
Forward primer \ /
\ @ Quencher
f o \ .
: ° MGB Minor Groove
\, Binder
3. Polymerization and Signal Generation S 23 AmpliTaq Gold®
Y g DNA Polymerase
' Nopo N
Reverse primer =
‘&EG
Probe = Probe
A .
i V\ ===  Primer
Forward primer G /@B
0 =  Template
c Extended Primer
Match

Minimizing non-specific fluorescence

In TagMan® assays, fluorescence from nonspecifically bound probes is reduced,
because nucleotide mismatches between a probe and a sequence reduce the chances
that the probe will be cleaved. The probe’s short length means that a one-base-pair
mismatch will a have a larger negative effect on the binding. The mismatched probe
will not bind tightly to the allele; the AmpliTaq Gold® DNA polymerase will likely
displace the probe without cleaving the dye.

Reading and analyzing the plates

The QuantStudio™ 6 and 7 Flex Real-Time PCR System Software genotypes the DNA
samples from the reaction plate simultaneously. First, the software normalizes the
fluorescence of the reporter dyes to the fluorescence of the passive reference dye in
each well. Next, the software plots the normalized intensities (Rn) of the reporter dyes
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About the example experiment

in each sample well on an Allelic Discrimination Plot, which contrasts the reporter dye
intensities of the allele-specific probes. Finally, the QuantStudio™" 6 and 7 Flex Real-
Time PCR System Software algorithmically clusters the sample data, and assigns a
genotype call to the samples of each cluster according to its position on the plot.

™

Note: The QuantStudio ™ 6 and 7 Flex Real-Time PCR System Software clustering
algorithm does not call genotypes when only one genotype is present in an

experiment.
»
*
*
45 »
4.0
o~
o
z
z
3.5
3.0
) L]

24 24 34 24
Allele 1

The clustering of datapoints can vary along the horizontal axis (Allele 1), vertical axis
(Allele 2), or diagonal (Allele 1/Allele 2). This variation results from differences in the
extent of reporter dye fluorescent intensity after PCR amplification. The table below
shows the correlation between fluorescence signals and sequences in a sample.

A substantial increase in... Indicates...

VIC® dye-labeled probe fluorescence only | Homozygosity for Allele 1
FAM™ dye-labeled probe fluorescence only | Homozygosity for Allele 2

Both VIC® and FAM™ dye-labeled probes | Allele 1-Allele 2 heterozygosity
fluorescence

About the example experiment

To illustrate how to perform Genotyping experiments, this guide leads you through
the process of designing and performing an example experiment. The example
experiment represents a typical setup that you can use to quickly familiarize yourself
with a QuantStudio™ 6 and 7 Flex Real-Time PCR System Software.

The objective of the example Genotyping experiment is to investigate SNP rs8039,
where possible genotypes are AA, AC, and CC. In the example, two unknown
genomic DNA (gDNA) samples were genotyped using TagMan® Drug Metabolism
Genotyping Assay ID C__11711420_30. The reactions were set up so that the PCR
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About the example experiment

primers and probes that target both alleles of SNP rs8039 were present in the same
well. The PCR was performed using the TagMan® Genotyping Master Mix and run
according to the protocol that is described in the Performing a TagMan® Drug

Metabolism Genotyping Assay.
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About the example experiment
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Design the Experiment

This chapter explains how to design the example experiment from the Experiment
Setup menu.

This chapter covers:

B Define the experiment properties. . .......... ... ..o, 11
B Define SNPs and samples . ... 12
B Assign markers, samples, and controls................ ... o oo 14
B Setuptherunmethod....... ... ... .. i 16
B For moreinformation. .......... ... ... i 17

Note: To automatically export the analyzed data to a specified location, select the Auto
Export task from the Export screen, before running the experiment. For more
information on Auto Export, refer to Chapter 2 in Booklet 1, Getting Started with
QuantStudio'™ 6 and 7 Flex Real-Time PCR System Software Experiments.

Define the experiment properties

Click Experiment Setup » Experiment Properties to create a new experiment in the
QuantStudio™ 6 and 7 Flex Real-Time PCR System Software. Enter:

Field Entry
Experiment Name QuantStudio_384-Well_SNP_Genotyping_Example
Barcode Leave field empty
User Name Example User
Comments Genotyping example
Instrument type QuantStudio™ 6 Flex System
Block 384-Well Block
Experiment Type Genotyping
Reagents TagMan® Reagents
Ramp speed Standard
Reagent information NA

Select all three data-collection check boxes: Pre-PCR, Amplification, and Post-PCR
collection methods:

Pre-PCR Read Checked

Amplification Checked
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Post-PCR Read Checked

Save the experiment.

Your Experiment Properties screen should look like this:

Experiment: QuantStudio_384-Well_SN... Type: Genotyping Reagents: TagMan® Reagents
-~
* Experiment Name: QuantStudio_384-Well_SNP_Genotyping_Example Comments: | Genotyping Example -~
Barcode:
User Mame: [Example User ~

Which instrument type are you using to run the experiment?

| Quantstudio™ 6 Flex System | [ QuantStudio™ 7 Flex System ]

Which block are you using to run the experiment?

[ 384-well | [ a6-well (0.2mL) ] [ Fast 96-Well (0.1mL) ]

[ Standard Curve ] [ Relative Standard Curve ] [ Comparative Cr (AACT) ] [ Melt Curve ]

[~ Genotyping | [ Presence/Absence ]

Which reagents do you want to use to detect the target sequence?

| TagMan® Reagents | [ Other ]
What properties do you want for the instrument run?
[w Standard ] { Fast ]

Include: Pre-PCR Read Amplification

What is the reagent information?

Type Name Part Number Lot Number Expiration Date

Define SNPs and samples

Click Define to access the Define screen. Enter:

1. SNP Assays

SNP
assay e EELCSS GG Reporter | Quencher el Reporter | Quencher @ Color
reference = sequence 1 2

name

SNP Allele1 | VIC NFQ-MGB | Allele2 | FAM NFQ-MGB
Assay 1

SNP Allele1 | VIC NFQ-MGB | Allele2 | FAM NFQ-MGB
Assay 2

Note: The NCBI SNP reference and Context sequence fields are optional fields
and are used for reference. They are not required to run an experiment.

2. Samples
S Color SELTO Color S Color
name name name
Sample 1 . Sample 11 Sample 21
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S Color SELITO Color S Color
name name name

Sample 2 N Sample 12 Sample 22 .
Sample 3 . Sample 13 . . Sample 23 . .
Sample 4 . Sample 14 . Sample 24 .
Sample 5 N Sample 15 . Sample 25 .
Sample 6 Sample 16 . . Sample 26 .

Sample 7 . Sample 17 . Sample 27

Sample 8 . Sample 18 . Sample 28 .
Sample 9 . Sample 19 . . Sample 29 . .
Sample 10 B Sample 20 . Sample 30 .

3. Dye to be used as a Passive Reference

ROX

4. Custom Task Name
Not applicable

Your Define screen should look like this:

SNP Assay Name MNCEI SNP Reference | Context Sequence Allele 1 Reporter Quencher Allele 2 Reporter Quencher Color
SNP Assay 1 Allele 1 VIC NFQ-MGB Allele 2 FAM NFQ-MGB
SNP Assay 2 Allele 1 VIC NFQ-MGB Allele 2 FAM NFQ-MGB

Sample Name Color

H

Sample 1

Sample 2

<

Sample 3

Sample 4

<

LRI
<

Sample 5

<

Passive Reference

Custom Task Name

Color

Icon Char

Note: This example experiment does not define biological replicate groups. Leave
Biological Replicate Groups blank.
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Assign markers, samples, and controls

Assign markers, samples, and controls

Click Assign to access the Assign screen. Enter the SNP assays and samples:
e SNP Assay 1

Vel Well number Task Sample

name

SNP A3, A7, A11 Unknown | Sample 3

Assay 1 C1, C5, C9 Unknown | Sample 4
C3, C7, CN Unknown | Sample 5
E1, E5, E9 Unknown | Sample 6
E3, E7, E11 Unknown | Sample 7
G1, G5, G9 Unknown | Sample 8
G3, G7, G11 Unknown | Sample 9
11,15, 19 Unknown | Sample 10
13, 17, 111 Unknown | Sample 11
K1, Kb, K9 Unknown | Sample 12
K3, K7, K11 Unknown | Sample 13
M1, M5, M9 /1 Sample 14
M3, M7, M11 Unknown | Sample 15
01, 05, 09 1/2 Sample 16
03, 07, 011 2/2 Sample 17

SNP A1, A5, A9 Negative | NTC

Assay 1
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Chapter 2 Design the Experiment

Assign markers, samples, and controls

* SNP Assay 2

IZ::t Well number Task Sample
SNP A15, A19, A23 Unknown Sample 1
ASSay 2113 17, c21 Unknown | Sample 2
C15, C19, C23 Unknown Sample 18
E13, E17, E21 Unknown Sample 19
E15, E19, E23 Unknown Sample 20
G13, G17, G21 Unknown . Sample 21
G15, G19, G23 Unknown . Sample 22
113, 117, 121 Unknown . Sample 23
115, 119, 123 Unknown Sample 24
K13, K17, K21 2/2 Sample 25
K15, K19, K23 Unknown Sample 26
M13, M17, M21 1/2 Sample 27
M15, M19, M23 Unknown Sample 28
013, 017, 021 11 Sample 29
015, 019, 023 Unknown Sample 30
SNP A13, A17, A21 Negative NTC
Assay 2
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Chapter 2 Design the Experiment
Set up the run method

Your Assign screen should look like this:

B —— W R Flatc Layout
BETENETET
Shp Assay 1 [[lv | v
Dlise pssv2 | ) “l t [z ] s ] 6 | ¢ | s | s [ o [ w0 [ 1z | 13 | 14 [ 15 |
-
Sample & 9 Sample 8 9 Sample & ] Sample 21 2
: o o o G L]
H
10 Sample 11 10 Sample 11 10 Sample 11 Sample 23 24
an: | v o v L] v o
hl
Sample 12 Sample 13 Sample 12 Sample 13 Sample 12 Sample 13 5 Sample 26
Samples ————— &) (¥ S‘EE

14 15 14 15 14 15 Sample 27 Sample 28
" 7|

-
< >

wels: [ 72 [ 6 [leFAe e 288 Empty

Set up the run method

Click Run Method to access the Run Method screen. Set the thermal profile under the
Graphical View tab. Enter:

* Reaction Volume Per Well: 10 uL

e Thermal Profile

Ramp .
Stage Step rate Temperature Time

Pre-Read Stage Step 1 1.6°C/s 60 °C 30 seconds
Hold Stage Step 1 1.6°C/s 95°C 10 minutes
PCR Stage Step 1 1.6°C/s 95°C 15 seconds
* Number of Cycles: 40 Step2 | 1.6°C/s 60°C 1 minute

(default)
e Enable AutoDelta: Unchecked

(default)
¢ Starting Cycle: Disabled

when Enable AutoDelta is

unchecked
Post-Read Stage Step 1 1.6°C/s 60°C 30 seconds
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Chapter 2 Design the Experiment

For more information

Your Run Method screen should look like this:

Run Method
Reaction Volume per Well: uL
Gral W
Include:
Pre-Read Stage Hold Stage PCR Stage Post-Read Stage
Number of Cycles:
Starting Cycle:
100 *C_|
75 |
- E—
50 °C_| _ -
25 °C_|
0|
Stept Stept Stept Step2 Stepl
£ b
Legend
[ Data Collection On |~ = Data Collection Off A AutoDela On A AutoDelta OFF

For more information

For more information on... Refer to... Publication
number
Consumables Chapter 1 in Booklet 1, Getting Started with QuantStudio™ 6 and 7 Flex 4489822
Real-Time PCR System Software Experiments
Appendix A in Booklet 7, QuantStudio™ 6 and 7 Flex Real-Time PCR
System Software Experiments - Appendixes
Data collection Chapter 2 in Booklet 1, Getting Started with QuantStudio™ 6 and 7 Flex 4489822
Real-Time PCR System Software Experiments
Amplification efficiency Amplification Efficiency of TagMan® Gene Expression Assays Application 127AP05-03
Note
Using Alternative Setup Chapter 3 in Booklet 1, Getting Started with QuantStudio™ é and 7 Flex 4489822

Real-Time PCR System Software Experiments

QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Getting Started Guide for Genotyping Experiments
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Chapter 2 Design the Experiment

For more information
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Prepare the Reactions

This chapter explains how to prepare the PCR reactions for the Genotyping example
experiment.

This chapter covers:

Assemble required materials ........ ... 19
Prepare the sample dilutions ............... ... ... . o il 19
Prepare the reaction mix (“cocktail mix”)............... ... oo 20
Prepare the reaction plate . . ........ ... ... i 20
Example experiment reaction plate components. .......................... 20
To prepare the reaction plate: dried gDNA .............. ... ... ... .. ... 21
To prepare the reaction plate: wet gDNA . . ... ... ... ..., 22
Tips for preparing reactions for your own experiments. . ................... 22
Tips for preparing samples. ....... ... ... i 22
Tips for preparing the reaction mix............ ... ... .. 22
Tips for preparing the reactionplate..................................... 22
For more information.......... ... . i 22

Assemble required materials

Items listed in Booklet 1, Getting Started with QuantStudio™ 6 and 7 Flex Real-Time
PCR System Software Experiments

Samples - Sample 1 - Sample 30

Example experiment reaction mix components:
- TaqMan® Genotyping Master Mix (2X)
— SNP 1 Assay Mix (20X)
— SNP 2 Assay Mix (20X)

Note: Fast Universal Master Mix is not recommended to be used with the 96-well
(0.2 mL) reaction plates or reaction tubes and tube strips sealed with caps.

Prepare the sample dilutions

For the example experiment, two targets are assigned to 36 wells each. Each well
contains 20 ng of Coriell DNA diluted from 100 ng/uL of stock.

To prepare the sample dilutions:

1.

Label a separate microcentrifuge tube for each sample to be diluted.
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Chapter 3 Prepare the Reactions

Prepare the reaction mix (“cocktail mix”]

2. Add 5pL of sample stock to each empty tube.

3. Add 45pL of sterile water (diluent) to each tube, such that each working stock
tube has a final concentration of 10 ng/uL

4. Vortex each diluted sample for 3 to 5 seconds, then centrifuge the tubes briefly.

5. Place the diluted samples on ice until you prepare the reaction plate.

Prepare the reaction mix (“cocktail mix”)

1. Label an appropriately sized tube for each reaction mix:
¢ SNP 1 Reaction Mix
* SNP 2 Reaction Mix

2. For SNP Assay 1, prepare a cocktail by adding the required volumes of each
component to the SNP 1 reaction tube, as detailed below.

Reaction volume
i 0,
Reaction component Per well (pL) A LGRS < T
excess (pL)

Dry Wet Dry Wet

TagMan® Genotyping Master Mix (2X) 10.0 10.0 400.0 400.0
SNP Assay Mix (20X) 1.0 1.0 40.0 40.0
H,0, DNase-free 9.0 7.0 360.0 280.0
Total Reaction Mix Volume 20.00 18 800.0 720.0

. Gently pipet the reaction mix up and down, then cap the tube.

3

4. Centrifuge the tube briefly.

5. Place the reaction mixes on ice until you prepare the reaction plate.
6

. Repeat step 2 through 5 for the SNP 2 assay.
Note: Do not add the sample at this time.

Prepare the reaction plate

Example The reaction plate for the Genotyping example experiment contains:
experiment e A MicroAmp® Optical 384-Well Reaction Plate

reaction plate e Reaction volume: 10 plL/well

components ¢ 72 Unknown wells U]
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Chapter 3 Prepare the Reactions

Prepare the reaction plate

The following is an image of the plate layout:
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i
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i

Sample 10 Sample 11
| I
J

Sample 12 Sample 13

<

Sample 6

Sample 10

Sample 12

Sample 7 Sample & Sample 7 20 m
. .

Bl Sample & El Sample 21 Sample 22 Samg
v ] . i .
Sample 11 Sample 10 Sample 11 Sample 23 24 S=mp
| . w | v |
Sample 13 Sample 12 Sample 13 Sample 25 Sample 26 Samg ¥

>

wels: [ 72 6 [CleEs[Hs

288 Empty

To prepare the
reaction plate:
dried gDNA

N o o &

Pipet 2.0 pL of the appropriate sample (20 ng of purified genomic DNA) into each
well of the reaction plate.

All wells belonging to the same Genotyping assay must contain approximately
the same quantity of sample or control.

Note: While preparing the reaction plate for your own Genotyping experiment,
add between 1 and 20 ng of purified DNA per reaction.

Dry down the samples by evaporation at room temperature in a dark, amplicon-
free location. (Cover the reaction plate with a lint-free tissue while drying.)

Transfer 20 uL of reaction mix to each well.

IMPORTANT! Make sure that no cross-contamination occurs from well to well.

Seal the reaction plate with adhesive film.
Vortex the reaction plate for 3 to 5 sec.
Briefly centrifuge the reaction plate.

Confirm that the liquid is at the bottom of each well of the reaction plate. If not,
centrifuge the plate again at a higher speed and for a longer period of time.
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Chapter 3 Prepare the Reactions

Tips for preparing reactions for your own experiments

To prepare the 1.

reaction plate: wet
gDNA

S L B o

Add 2 uL of DNA to the appropriate wells.

Add 2 pL of water to wells containing the NTCs.

Transfer 18 uL of reaction mix to the appropriate wells.

Seal the reaction plate with optical adhesive film.

Vortex the reaction plate for 3 to 5 seconds, then briefly centrifuge it.
Centrifuge the reaction plate briefly.

Until you are ready to perform the run, place the reaction plate at 4°C, in the dark.

Tips for preparing reactions for your own experiments

Tips for preparing When you prepare the samples for your own experiment:

samples » Use DNAse-free water to dilute the samples.

¢ Use the same quantity of DNA per well for each experiment.
TipS for prepa ring When you prepare the reaction mix for your own experiment, make sure you prepare
the reaction mix the reactions for each SNP separately.

Prior to use:

Mix the master mix thoroughly by swirling the bottle.
Resuspend the assay mix by vortexing, then centrifuge the tube briefly.

Thaw frozen samples by placing them on ice. When thawed, resuspend the
samples by vortexing, then centrifuge the tubes briefly.

Tips for preparing When you prepare the reaction plate for your own experiment:

the reaction plate .

Make sure the reaction locations match the plate layout in the QuantStudio™ 6
and 7 Flex Real-Time PCR System Software.

Load 1 to 20 ng of purified genomic DNA per reaction

All wells belonging to the same Genotyping assay must contain approximately
the same quantity of sample or control.

Multiple assays may be run on one reaction plate, but must be analyzed
separately.

For more information

For more information on... Refer to... Publication
number
Assigning the reaction plate Chapter 2 in Booklet 1, Getting Started with QuantStudio™ 6 and 4489822
components 7 Flex Real-Time PCR System Software Experiments
Sealing the reaction plate Chapter 2 in Booklet 1, Getting Started with QuantStudio™ 6 and 4489822
7 Flex Real-Time PCR System Software Experiments
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Run the Experiment

This chapter explains how to run the example experiment on the QuantStudio™ 6 or 7
Instrument.

This chapter covers:
B o Startthe run. . ... e 23
B Monitor the run. . ... .. 23

IMPORTANT! Run the experiment at the same ambient temperature at which you
calibrated the instrument. Extreme variations in ambient temperature can affect the
heating and cooling of the instrument and influence experimental results.

IMPORTANT! Do not attempt to open the access door during the run. The door is
locked while the QuantStudio " 6 or 7 Instrument is in operation.

Start the run

1. Open the Genotyping example file that you created using instructions in
Chapter 2.

2. Load the reaction plate into the instrument.

3. Start the run.

Note: To collect real-time data during a run, click the button on the Run
Method screen in the Experiment Setup menu.

Monitor the run

Monitor the example experiment run:

* From the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software using the
Run screen, while the experiment is in progress.

e From the Instrument Console of the QuantStudio'" 6 and 7 Flex Real-Time PCR
System Software (to monitor an experiment started from another computer or

from the QuantStudio™" 6 or 7 Instrument touchscreen).

e From the QuantStudio™ 6 or 7 Instrument touchscreen.
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Chapter 4 Run the Experiment
Monitor the run

From the 1. In the Instrument Console screen, select the instrument icon.
Instrument 2. Click Manage Instrument or double-click on the instrument icon.
Console of the
QuantStudio™ 6 3. On the Manage Instrument screen, click Monitor Running Instrument to access
and 7 Flex Real- the Run screen.
Time PCR System ] o
Software View the Amplification Plot
You can view the progress of the run in real time. During the run, periodically view all
the three plots available from the QuantStudio™ 6 and 7 Flex Real-Time PCR System
Software for potential problems.
Click Amplification Plot from the Run Experiment Menu, select the Plate Layout tab,
then select the wells to view.
The following is an image of the Amplification Plot screen as it appears at the end of
the example experiment.
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Chapter 4 Run the Experiment
Monitor the run

View the Temperature Plot
Click Temperature Plot from the Run Experiment Menu.

The following is an image of the Temperature Plot screen as it appears during the
example experiment.

Temperature Plot Current Temperatures

~ U n [ [ cover
£ P a kK |Y

o [+ [l sample
Temperature Plot - Black

105 ——————

]
00:33:20 00:37:30 00:41:40 00:45:50 00:50:00 00:5410 00:58:20 01:02:30 01:08: 40 01:10:50 0M:15:00 [URER D) 01:23:20 01:27.30 01:31:40
Time

Temperature
o
9

Temperature Plot

Fixed View []

Note: The sample temperature displayed in the Current Temperatures group is a
calculated value.

View the Run Method
Click Run Method from the Run Experiment Menu.

The following is an image of the Run Method screen as it appears in the example

experiment.
Run Method Edit Run Method
Pre-Read Stage Hold Stage PCR Stage Post-Read Stage
Number of Cycles:
Starting Cycle:
Stept Stept Step Step? Stept
< bd
Legend
Data Collection On * =/ Data Collection Off A AutoDeka On A AutoDefta Off
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Monitor the run

Run Data Report

Experiment Name:
Start Time:

Stop Time:

Run Duration:

User Name:
Instrument Name:
Firmware Version:
Software Version:
Instrument. Serial Mumber:
Sample Volume:
Cover Temperature:

Block Type:

Errors Encountered:

Chapter 4 Run the Experiment

View run data

Click View Run Data from the Run Experiment Menu.

The following is an image of the View Run Data screen as it appears in the example

experiment.

QuantStudio_384-Wel SNP_Genotyping_Example
09-17-2010 06:57:35 5GT
09-17-2010 08:30:35 5GT
93 minutes 0 seconds
DEFAULT

‘Yankees_Rule

1.0.3

QuantStudio Software v1.0
278880012

10.0

105.0

384-Well Block

From the

QuantStudio™ 6 or

7 Instrument

You can also view the progress of the run from the QuantStudio" 6 or 7 Instrument

touchscreen.

The following are images of the Run Method screen on the QuantStudio™" 6 or 7

touchscreen Instrument touchscreen:
Experiment View
@ Time View ]  Experiment View
Run Started: July 06 2013 - 05:48PM Sample: 60.0 °C
Reaction Volume: 20 L Heated Cover (Set Point): 105.0 °C (105.0 °C)
Time Remaining: 01:15:39
Stage 1 Stage 2
X1 3of4d
95.0 °C 95.0 °C
10:00 0:15
N\_60.0°C
1:00
(]
July 06 2013 - D5:48PM 0
Heated cover reached target temperature.
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Chapter 4 Run the Experiment
Monitor the run

Time View
®© Time View |  Experiment Yiew
Run Started: July 06 2013 - 05:48PM Sample: 95.0 °C
Reaction Volume: 20 L Heated Cover (Set Point): 105.0 °C [105.0 °C)

Stage / Step / Cycle: 1/2/1

01:31:52

@ Remaining Time . Elapsed Time

July 06 2013 - 05:48PM 0

Heated cover reached target temperature.
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Chapter 4 Run the Experiment
Monitor the run
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Review Results and Adjust
Experiment Parameters

In Section 5.1 of this chapter you review the analyzed data using several of the analysis
screens and publish the data. Section 5.2 of this chapter walks you through the process
of modifying experiment parameters to troubleshoot problems with experiment
results before rerunning an experiment.

This chapter covers:

Section 5.1 Review Results ........ ..ot 31
B Analyze the example experiment. . .......... ... ..o i 31
View clusters in the Allelic Discrimination Plot ........................... 31

B Confirm setup accuracy using Plate Layout............................... 34
B Assess amplification results using the Amplification Plot................... 36
B Identify well problems using the Well Table .............................. 39
B Confirm accurate dye signal using the Multicomponent Plot................ 42
B Determine signal accuracy using the Raw DataPlot ....................... 44
B Review the flagsinthe QCSummary ..., 46
B Formoreinformation............ ... ... . i 47
Section 5.2 Adjust parameters for re-analysis of your own experiments. ........ 49
B Adjustanalysissettings........... ... i i 49
B Formoreinformation............ ... ... . i 53
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Chapter 5 Review Results and Adjust Experiment Parameters
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Section 5.1 Review Results

Analyze the example experiment

1. Open the example experiment file that you ran in Chapter 4.

2. Click Analyze. The software analyzes the data using the default analysis settings.

Note: You can also access the experiment to analyze from the Home screen.

View clusters in the Allelic Discrimination Plot

The Allelic Discrimination Plot contrasts the normalized reporter dye fluorescence
(Rn) for the allele-specific probes of the SNP assay.

View the allelic discrimination plot to identify:
* C(Clusters for the three possible genotypes (Allele 1 homozygous, Allele 2
homozygous, and Allele 1/2 heterozygous).
* A cluster for the negative controls.

Note: Including controls helps to improve the clustering algorithm, particularly in
situations where a limited number of samples are run.

To view and assess 1. From the Experiment menu pane, select Analysis » Allelic Discrimination Plot.
the allelic

Lo 2. Click the Plate Layout tab, then click any empty well to select it.
discrimination plot

Note: In the Allelic Discrimination Plot, the software highlights all wells that are
selected in the Plate Layout tab. If the plot displays a single color for all wells,
then all wells in the plate layout are selected.

3. In the allelic discrimination plot, select SNP Assay 1 from the SNP Assay menu,
then enable Autocaller.

The Allelic Discrimination Plot displays allele symbols for each sample evaluated
for the selected SNP. The samples are grouped on the plot as follows:

Genotype Symbol Location
Homozygous for Allele 1 of the ® (red) X-axis of the plot
selected SNP assay.
Homozygous for Allele 2 of the @ (blue) | Y-axis of the plot
selected SNP assay.
Heterozygous for both alleles of the (green) | Midway between the
selected SNP assay (Allele 1 and homozygote clusters
Allele 2).
A negative control. B (black] | Bottom-left corner of the

plot

Undetermined. %* (black) | Anywhere on plot
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5 Chapter 5 Review Results and Adjust Experiment Parameters
View clusters in the Allelic Discrimination Plot

Note: If the Autocaller is not enabled, the Allelic Discrimination Plot displays a
crossmark (X — Undetermined) for each sample.

4. Review each cluster in the plot:

a. Click and drag a box around the cluster to select the associated wells in the
plate layout and well table.

b. Confirm that the expected wells are selected in the well table.

For example, if you select the cluster at the bottom-left corner of the plot,
only the negative controls should be selected. The presence of an unknown
among the negative controls may indicate that the sample failed to amplify.

c. Repeat steps a and b for all other clusters in the plot.

d. The table below describes the elements of the Allelic Discrimination Plot.

Element Description

SNP Assay drop- Determines the SNP assay data that the QuantStudio™

down menu 6 and 7 Flex Software displays in the plot.

Plot Type drop- Determines the type of plot (Cartesian or Polar) that the

down menu QuantStudio™ 6 and 7 Flex Software uses to display the
data.

Apply Call drop- When a datapoint is selected, this menu allows you to

down menu assign an allele call to the datapoint within the
scatterplot.

Toolbar Contains tools for manipulating the scatterplot:

- Selection tool.
. ’v_ - Selection tool.
% - Repositioning tool.

. - Zooms in.
o - Zooms out.
Legend Explains the symbols in the scatterplot.
Options The Reveal Traces option allows you to trace the

clusters throughout the PCR process.

This option is not activated for the example experiment.
To activate the feature, see “Adjust analysis settings” on
page 50.
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Section 5.1 Review Results 5
View clusters in the Allelic Discrimination Plot

The following is an image of the Allelic Discrimination plot for the example
experiment:

Allefic Discrimination Plot
Plot Settings

Plate Layout
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Troubleshoot Do all controls have the correct genotype?
lustering on th . . . . .
clus _e go € In the example experiment and in your own experiments, confirm that data points
Allelic cluster as expected.

Discrimination Plot

Clustering in positive controls

1. From the well table, select the wells containing a positive control to highlight the
corresponding data points (symbols) in the Allelic Discrimination Plot.

2. Check that the data points for the positive controls cluster along the expected axis
of the plot. For example, if you select the Positive Control Allele 1/Allele 1, then
the controls should cluster along the X-axis.

3. Repeat steps 1 and 2 for the wells containing the other positive controls.

Failed amplification in the unknown samples

1. Select the data points of the cluster in the lower left corner of the Allelic
Discrimination Plot to select the corresponding wells in the well table.

2. Check that the selected wells in the well table are negative controls, and not

unknown samples.

Samples clustered with negative control
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5 Chapter 5 Review Results and Adjust Experiment Parameters
Confirm setup accuracy using Plate Layout

Samples that clustered with the negative controls may:
¢ Contain no DNA
¢ Contain PCR inhibitors

* Be homozygous for a sequence deletion

Confirm the results of these samples by retesting them.

Are outliers present?

If the Allelic Discrimination Plot contains clusters other than the three representative
genotype clusters (heterozygous, homozygous allele 1, and homozygous allele 2), then
those can be classified as outliers.

Confirm the results of the associated samples by retesting them.

Note: The results displays are synchronized. For example, selecting a well in the plate
layout selects the corresponding data in the well table and Allelic Discrimination Plot.

Confirm setup accuracy using Plate Layout

Example
experiment plate
layout values

View the layout

Review the experiment results in the Plate Layout. The plate layout displays the assay-
specific setup and analysis properties for the experiment in a well format
corresponding to the type of reaction plate used for the run.

For the example experiment, confirm that the QuantStudio™ 6 and 7 Flex Software
called:

* 54 samples as Allele 1 homozygous ( ® )
* 12 samples as Allele 2 homozygous ( @)
* 24 samples as heterozygous ( @)

¢ 0samples as undetermined (X)

Confirm that no wells of the reaction plate triggered QC flags (. ). The example
experiment does not display any flags.

1. Click the € icon beside the Allelic Discrimination Plot to maximize the plate
layout.

2. Click Show in Wells, then select or deselect a parameter that you want the
wells to display. Repeat this step until the plate layout contains all of the desired

parameters.
Parameter Description
Sample Name The name of the sample applied to the well.
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Section 5.1 Review Results 5
Confirm setup accuracy using Plate Layout

Parameter Description

Task The task assigned to the well:
@ - Unknown

[Z] - Negative Control

[1] - Positive Control - Allele 1
[ - Positive Control - Allele 2
[ - Positive Control - Allele 1/2

SNP Assay The name of the SNP evaluated by the well.

Name

Assay ID The Assay ID number of the SNP evaluated by the well.

Allele 1/ Allele 2 | The name of the associated allele for the SNP evaluated by the
well

Allele 1 Dyes / The name of the reporter and quencher dyes of the associated

Allele 2 Dyes allele for the SNP evaluated by the well

SNP Assay Color | The color of the SNP evaluated by the well.

Sample Color / The color of the sample or task applied to the well.
Task Color

Genotype Call The allele call assigned to the sample:
¢ ® Homozygous 1/1

e @ Homozygous 2/2

e ® Heterozygous 1/2

e B Negative Control

X Undetermined

Flag The number of QC flags the well triggered as listed in the
symbol.
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5 Chapter 5 Review Results and Adjust Experiment Parameters
Assess amplification results using the Amplification Plot

The following is an image of the plate layout of the example Genotyping experiment.
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Well Summary: In Plate: 384 Set Up: 96 Anahyzed: 96 Flagged: 0 Omitted by Anahysis: 0 Omitted Manually: 0 Samples Usad: 30 SNP Assays Used: 2
Tips for You can adjust your view of the plate layout:
troubleshooting * Note the location of any samples that trigger QC flags ( + ). Understanding the
y p 88 8 )
plate setup in your position of errors can aid in diagnosing any failures that may occur.
own experiment * You can select the entire reaction plate, areas of the reaction plate, or specific
wells:

— Click the upper left corner of the reaction plate to select all 384 wells.
— Left-click the mouse and drag across the area to select it.

— Select Sample, SNP Assay, or Task from the Select Wells menu in the Plate
Layout tab to select wells of a specific type using the well-selection criteria.

e Use the (Zoom In), (Zoom Out), and (Fit Plate) buttons to magnify or

compress the view of the wells shown.

e Use the < arrow tabs to expand the plate layout to cover the entire screen.

Assess amplification results using the Amplification Plot

IMPORTANT! Amplification plots are not used to make SNP calls. Examine the plots to
help with troubleshooting and quality control.

If you collected real-time data for your experiment, review the amplification data to
further understand the flags triggered by the experiment data.
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plots

View the ARn vs.
Cycle plot

Ampiification Plot

Section 5.1 Review Results 5
Assess amplification results using the Amplification Plot

The Amplification Plot screen displays amplification of all samples in the selected
wells. Use the amplification plots to confirm the results of the experiment:

* ARnvs. Cycle - ARn is the difference in normalized fluorescence signal generated

by the reporter between the pre-PCR read and the post-PCR read. This plot
displays Ag, as a function of cycle number. You can use this plot to identify and
examine irregular amplification and to view threshold and baseline values for the
run.

Note: Viewing the ARn vs. Cycle plot is discussed in this booklet as an example of
how to view the plot.

Rn vs. Cycle — Rn is the fluorescence signal from the reporter dye normalized to
the fluorescence signal from the passive reference. This plot displays Rn as a
function of cycle number. You can use this plot to identify and examine irregular
amplification.

Cr vs. Well — Cy is the PCR cycle number at which the fluorescence meets the
threshold in the amplification plot. This plot displays Cy as a function of well
position. You can use this plot to locate outlying amplification (outliers).

Each plot can be viewed as a linear or log10 graph type.

From the Experiment Menu pane, select Analysis » Amplification Plot.

Note: If no data are displayed, click Analyze.

2. Select the plot type and format:

Menu Selection
Plot Type ARn vs. Cycle
Plot Color Target
E Check (default]

(This is a toggle button. When the legend
is displayed, the button changes to Hide
the plot legend.)

Plot Settings

Plot Type:[ARn vs Cycle (| Graph Type:[Log

['save current settings as the default

] Plot Color:[Target v

1E01

1E00

0.001

Amplification Plot

Options
Target: [All || Threshold:
Shows: [ Threshokd — [] Baselne Start: Wel I Target - Baseline End: Wel (M Target =

Well Summary: n ot 384

Setup:06

Analyzed: 06 Fisgged: Omitted by Analysis: ) Omited Manualy: 0 Samples Used: 30 SNP Assays Used: 2
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Assess amplification results using the Amplification Plot

3. View the baseline values:

a. From the Graph Type drop-down menu, select Linear.

b. Select Baseline to show the start cycle and end cycle.

Amplification Plot
Plot Settings

Plot Type:|ARn vs Cycle +| Graph Typa:\Lmear V| Plot Color:\Target ~

[[] Save current settings as the default

Amplification Plot

®
o
=
=
R
[=’::-'.-
i

Show: [] Threshold — [ f3seiina SEarts Well M1 Target 4. Baseline End: Well (W Target 4

&£ 125
ES|
1.00
0.75
0.50
0.25
0.00 - - g =
2 i & 8 1o iz 14 16 15 20 22 24 26 B 30 3z 34 36 38 40
Cycle
Options
Taget e

Well Summary: In Plats: 384 Set Up: 96 Anzhyzed: 96 Flzgged: [ Omitted by Anshysis: Omitted Manually: () Samples Us=d: 30

4. View the threshold values:
a. From the Graph Type drop-down menu, select Log.
b. From the Target drop-down menu, select SNP Assay 1-Allele 2.

SNP Assays Used: 2
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Identify well problems using the Well Table

c. Select the Threshold check box to show the threshold.

Amplification Plot
Plot Settings

Plot Type:|ARN vs Cycle | Graph Type: Plot Color:[Target v

[ save current settings as the default

Amplification Plot

1E01

1E00

01

ARn

om

0.001 8=

Options

Target: |SNP Assay 1-Allele 2 % Threshold: [¥] Auto l:l

Show: [¥] Threshold — [[] Baseline Start: Well B Target & Baseline End: Well (M Target -

Well Summary: In Plste: 384 Set Up: 96 Anahyzed: 96 Fisgged: 0 Omitted by Anahysis: 0 Omitted Manualhy: 0 Samples Used: 30 SNP Assays Used: 2

Identify well problems using the Well Table

Review the details of the experiment results in the Well Table and identify any flagged
wells. The Well Table displays the assay-specific setup and analysis properties for the
experiment in a tabular format.

Example For the example experiment, look for wells that triggered QC flags (. ). The example
experlment Values experiment has no ﬂags.
and flags

View the well table 1. Select the Well Table tab.

2. Click the Flag column header to sort the data so that the wells that triggered flags
appear at the top of the table.

3. Confirm the integrity of the controls:

a. From the Group By menu, select Task to organize the table rows by their
function on the reaction plate.

b. Confirm that each of the controls do not display flags ( 1.).

c. Click the B jcon to collapse the negative and positive controls.
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Chapter 5 Review Results and Adjust Experiment Parameters

The following is an image of the well table of the example Genotyping

experiment.

Amplification Plot

Well Table

Plate Layout

Plot Settings
Plot Tvue: Graph Tvpe:|LUg v| Plot Culur:‘Target v| iells W Expand Al
[ save cument settings a5 the defaul: # Well | Omit Flag Sample ...| SNP As... AssaylD | Task Allele 1
) =) A = (- B Negative Control -~
p /O & R =4 !\ﬂ' = 1 Al " SHP Assay 1 Negative C... Allele 1
5 A5 " SHP Assay 1 Negative C... Allele 1
Amplification Plot 9  Ag O SHP Assay 1 Negative C... Allele 1
1E01 13 A13 " SHP Assay 2 Negative C... Allele 1
17 A17 O SHP Assay 2 Negative C... Allele 1
21 A21 1 SHP Assay 2 Negative C... Allele 1
B Unknown
1£00 3 A3 " Sample 3 SHP Assay 1 Unknown  Allele 1
7 OA7 " Sample 3 SHP Assay 1 Unknown Allele 1
11 A1l O Sample 3 SHP Assay 1 Unknown  Allele 1
15 AlS " Sample 1 SHP Assay 2 Unknown  Allele 1
19 A19 O Sample 1 SHP Assay 2 Unknown  Allele 1
% 0.1 23 A23 " Sample 1 SHP Aszay 2 Unknown  Allele 1
49 C1 O Sarmple 4 SMP Assay 1 Unknown  Allele 1
51 C3 " Sample 5 SHP Assay 1 Unknown  Allele 1
53 €5 " Sample 4 SHP Assay 1 Unknown  Allele 1
oot 55 7 ] Sample 5 SHP Assay 1 Unknown  Allele 1
57 €9 " Sample 4 SHP Assay 1 Unknown  Allele 1
58 C11 O Sample 5 SHP Assay 1 Unknown  Allele 1
6l C13 " Sample 2 SHP Assay 2 Unknown  Allele 1
63 C15 O Sample 18 SHP Assay 2 Unknown  Allele 1
0.001 65 C17 O Sample 2 SHP Assay 2 Unknown  Allele 1
67 C19 " Sample 18  SHP Assay 2 Unknown Allele 1
_ 69 C21 O Sample 2 SHP Assay 2 Unknown  Allele 1
Options 71 23 | Sample 18 SNP Assay 2 Unknown  Allele 1
Target: Threshold: [#] Auto Auto Baseline 97 E1 O Sample 6  SHP Assay 1 Unknown  Allele 1
09 E2 " Sample 7 SHP Aszay 1 Unknown  Allele 1
Show: [¥] Threshold — [¥] Baseline Start: Wel M Target 4 Baseline End: Well (M Target 4 ig; : S 2232 ; z:z E; i 3:&2:: Q::ZE i 3
< >
Well Summary: In Plate: 384 Set Up: Q6 Anzhyzed: 96 Flagged: Omitted by Analysis: { Omitted Manually: 0 Samples Used: 30 SNP Asszys Usad: 2
The following table gives the names and description of the columns in the well
table:
Column Description
Well The position of the well on the reaction plate.
Omit A check mark indicates that the well has been removed from the
analysis.
Flag A 1 indicates that the well triggered the number of flags listed
inside the symbol.
Sample Name The name of the sample.
SNP Assay The name of the SNP assay evaluated by the well.
Name
Assay ID The Assay ID number of the SNP evaluated by the well.
Task The task assigned to the well (Unknown, Negative Control, or
Positive Control).
Allele 1/ 2 The name of the associated allele for the SNP evaluated by the
well.
Allele 1/2Dyes | The name of the reporter and quencher dyes of the associated
allele for the SNP evaluated by the well.
Allele 1/2 g, Normalized signal (g,) of the reporter dye of the associated allele
for the SNP evaluated by the well.
Pass Ref The signal of the passive reference dye for the well.
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Identify well problems using the Well Table

Column

Description

Call

The allele call assigned to the sample, where possible calls are:
¢ @ Homozygous 1/1 - Homozygous for allele 1

* @ Homozygous 2/2 - Homozygous for allele 2

e ©® Heterozygous 1/2 - Heterozygous

o H Negative Control

X Undetermined

Quality(%)

The quality value calculated for the genotype call.

Method

The method used to assign the call to the sample (Auto if
assigned by the QuantStudio™ 6 and 7 Flex Real-Time PCR
System Software, or Manual if applied by a user).

Comments

Comments entered for the associated sample well.

Allele 1/2 Cy

Threshold cycle (Cy) of the sample for the associated allele for
the SNP evaluated by the well.

The Well Table displays columns for QC flags that are triggered by the experimental
data. If the experiment data does not trigger a QC flag, then the QuantStudio™" 6 and 7

Flex Real-Time PCR System Software does not display a corresponding column for the
flag.

A () in one of the following columns indicates that the associated well triggered the
flag.

Flag

Description

BADROX

The well produced a passive reference signal greater than the
limit defined in the analysis settings.

OFFSCALE

The well produced a level of fluorescence greater than the
QuantStudio™ 6 or 7 Instrument can measure.

NOSIGNAL

The well did not produce a detectable level of fluorescence.

CLUSTER#

For the SNP evaluated by the well, the number of clusters
generated from the experiment data is greater than the limit
defined in the analysis settings.

PCFAIL

The positive control did not produce an g, for the associated
allele greater than the limit defined in the analysis settings
indicating that the control may have failed to amplify.

SMCLUSTER

The number of data points in the associated cluster is less than
the limit defined in the analysis settings.

AMPNC

The negative control has produced a g, greater than the limit
defined in the analysis settings indicating possible amplification.

NOAMP

The well did not produce an g, for either allele that is greater
than the limit defined in the analysis settings indicating that the
well may have failed to amplify.

NOISE

The background fluorescence (noise) produced by the well is
greater than the other wells on the reaction plate by a factor
greater than the limit defined in the analysis settings.
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Confirm accurate dye signal using the Multicomponent Plot

Tips for analyzing
your own
experiments

Flag Description

SPIKE The amplification plot for the well contains one or more data
points inconsistent with the other points in the plot.

EXPFAIL The software cannot identify the exponential region of the
amplification plot for the well.

BLFAIL The software cannot calculate the best fit baseline for the data
for the well.

THOLDFAIL The software cannot calculate a threshold for the associated
well.
CTFAIL The software cannot calculate a threshold cycle (Cy) for the

associated well.

Confirm the integrity of positive controls

When you analyze the example experiment or your own experiment, if you are using
positive controls, confirm the integrity of the positive controls:

1.

From the Group By menu, select Task to organize the table rows by their function
on the reaction plate

Confirm that the positive controls do not display flags ( + ) and that their
normalized reporter dye fluorescence (R,) is appropriate for the genotype

(for example, if evaluating the Positive Control Allele 1/Allele 1, you would
expect to see significant increase in R, for the Allele 1 probe and very little for the
Allele 2 probe).

Adjust the Well Table

¢ Review the data for the Unknown samples. For each row that displays () in the

Flag column, note the data and the flag(s) triggered by the associated well.
Select areas of the table or wells of a specified type by:

— Left-clicking the mouse and dragging across the area you want to select an
area of the table.

— Selecting Sample, SNP Assay, or Task from the Select Wells menu in the
Well Table tab to select wells of a specific type using the well-selection tool.

Group the rows of the plate layout by selecting an option from the Group By
menu. You can then collapse or expand the lists either by clicking the +/- icon next
to individual lists, or by clicking Collapse All or Expand AlL

Omit a well from the analysis by selecting the Omit check box for that well. To
include the well in the analysis, deselect the Omit check box.

Note: You must reanalyze the experiment each time you omit or include a well.

Confirm accurate dye signal using the Multicomponent Plot

The Multicomponent Plot screen displays the complete spectral contribution of each
dye in a selected well over the duration of the PCR run.
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Confirm accurate dye signal using the Multicomponent Plot

Purpose In the example experiment, you review the Multicomponent Plot screen for:

View the 1.

Multicomponent
Plot

ROX™ dye (passive reference)
FAM™ dye (reporter)

VIC® dye (reporter)

Spikes, dips, and/or sudden changes

Amplification in the negative control wells

From the Experiment Menu pane, select Analysis » Multicomponent Plot.

Note: If no data are displayed, click Analyze.

Display the unknown wells in the plate layout to display the corresponding data
in the Multicomponent Plot screen:

a. Click the Plate Layout tab.

b. Select one well in the plate layout; the well is shown in the Multicomponent
Plot screen.

Note: If you select multiple wells, the Multicomponent Plot screen displays
the data for all selected wells simultaneously.

From the Plot Color drop-down menu, select Dye.

Click [ | Show a legend for the plot (default).

Note: This is a toggle button. When the legend is displayed, the button changes to
Hide the plot legend.

Check the ROX dye signal. In the example experiment, the ROX dye signal
remains constant throughout the PCR process; a constant ROX dye signal
indicates typical data.
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6. Check the FAM dye signal. In the example experiment, the FAM dye signal
increases throughout the PCR process; increase in FAM dye signal indicates
normal amplification.

Multicomponent Plot

Plot Settings
Plot Color |Dye v
[] save current settings as the default
- - s [ "
A P By
Multicomponent Plot
475,000
450,000
425,000
400,000
375,000
350,000
325,000
300,000
-
S 275000
o
2 250,000
o
£ 225000
E}
& 200,000
175,000
150,000
125,000 ——
100,000
75,000
50,000 I S SN SUN I
25,000
0
2 4 -] & 10 1z 14 16 16 20 22 24 26 28 30 3z 34 36 38 40 42 44
Cycle
L
I Fav Il ROX M VIC
Well Summary: In Plate: 384 Set Up: 96 Anahyzed: 96 Flagged: 0 Omitted by Anahysis: 0 Omitted Manuzlly: 0 Samples Used: 30 SNP Assays Used: 2

7. Select the negative control wells one at time and check for amplification. Wells
with the negative control should not show amplification. The example
experiment does not have negative controls.

Tips for confirming ~ When you analyze your own Genotyping experiment, look for:

dye accuracy in  Passive Reference — The passive reference dye fluorescence level should remain
your own relatively constant throughout the PCR process.
experiment * Reporter Dye — The reporter dye fluorescence level should display a flat region

corresponding to the baseline, followed by a rapid rise in fluorescence as the
amplification proceeds.

* Irregularities in the signal — There should not be any spikes, dips, and/or sudden
changes in the fluorescent signal.

* Negative Control wells — There should not be any amplification in the negative
control wells.

Determine signal accuracy using the Raw Data Plot

The Raw Data Plot screen displays the raw fluorescence signal (not normalized) for
each optical filter for the selected wells during each cycle of the real-time PCR.

Purpose In the Genotyping example experiment, you review the Raw Data Plot screen for a
stable increase in signal (no abrupt changes or dips) from the appropriate filter.
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View the Raw Data

Plot

Section 5.1 Review Results

Determine signal accuracy using the Raw Data Plot

From the Experiment Menu pane, select Analysis » Raw Data Plot.

Note: If no data are displayed, click Analyze.

Display all 384 wells in the Raw Data Plot screen by clicking the upper left corner
of the plate layout in the Plate Layout tab.

Click E Show a legend for the plot (default). The legend displays the color
code for each row of the reaction plate (see the legend in the Raw Data Plot shown
below).

Click and drag the Show Cycle pointer from cycle 1 to cycle 42. In the example
experiment, there is a stable increase in signal from filter 1, which corresponds to
the FAM™ dye filter.

Raw Data Plot <

700,000
850,000
500,000
550,000
500,000
450,000
400,000

350,000

Ampltude

300,000
250,000
200000
160,000 =
100,000 1
50,000 £

o

PP e B =

Raw Data Plot

©1m xa'm2 xama ot 5ms
Filter
Lo
HA s Wic Wp Me HF HWc HH ~
j1 ) Ec H. Hv Hn Ho Hr 3
Options
Show Cycle 42
1 5 10 15 20 25 30 35 40 42
Well Summary: In Plate: 384 Set Up: 96 Anstyzed: 96 Flagged: () Omitted by Anatysi: Omitted Manuslly: Samples Used: 30 SNP Assays Used: 2

The filters are:

PCR Filter

x1(470£15)

ml(520£15)

m2(558=11)

Ervission Filcer

m3(586x10) ma(623=14) m5(682x14) me(711£12)

x2(520+10)

x3(55011)

Excitation Filter

x4(580+10)

¥5(640+10)

X6(662+10)

Melt Curve Filter

x1(470+15)

m1(520+15)

m2(558+11)

Ermission Fiter
m3(586+10) m4(623+14) m5(682+14) mE(711+12)

%2(520+10)

x3(550+11)

Excitation Filter

x4(580+10)

x5(640+10)

X6(662£10)
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Review the flags in the QC Summary

Tips for When you analyze your own Genotyping experiment, look for the following in each
determining signal filter:

accuracy in your ¢ Characteristic signal growth

own experiment * No abrupt changes or dips

Review the flags in the QC Summary

The QC Summary screen displays a list of the QuantStudio™" 6 and 7 Flex Real-Time
PCR System Software flags, including the flag frequency and location for the open
experiment.

For Genotyping experiments, flag appearance is triggered by experiment data or the
assay. If a flag has been triggered by the assay, the Plate Layout does not display the
icon. The flag details appear in the QC Summary.

In the example experiment, there are no flags.

View the QC 1. From the Experiment Menu pane, select Analysis » QC Summary.
Summary Note: If no data are displayed, click Analyze.

2. Review the Flags Summary.

Note: A 0 displayed in the Frequency column indicates that the flag does not
appear in the experiment. If the frequency is >0, the flag appears somewhere in
the experiment; the well position is listed in the Wells column.

3. In the Flag Details table, click each flag with a frequency >0 to display detailed
information about the flag.

4. (Optional) For those flags with frequency >0, click each flag with a frequency >0 to
display detailed information about the flag.

locowrnry

Flag: Description Freguency Wells
BADROX ad passive reference signal
OFFSCALE Fluorescence is offscale
NOSIGNAL o signal in wel
CLUSTER# umber of clusters outside expected range
PCFAIL ositive control failed
SMCLUSTER Srmill number of samples in cluster
AMPHC Amplification in negative control
QAMP o amplification
QISE oise higher than others in plate
SPIKE oise spikes
EXPFAIL Exponential algorithm failed [
BLFAIL Baseline algorithm failed [
THOLDFAIL Thresholding algorithm failed [
CTFAIL Cr algorithm failed [
Total Wells: 384 | Processed Wells: 96 Manualy Omitted Wells: 0 | SNP Assays Used: 2
Walls Set Up: 96 Flagged Wells: 0 Analysis Omitted Wells: 0 | Samples Used: 30
‘Well Summary: In Plate: 384 Set Up: 96 Anaiyzed: 96 Flagged: 0 Omitted by Anatysis: ) Omitted Manualy: 0 Samples Ussd: 30 SNP Assays Ussd: 2
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For more information

Possible flags The flags listed below may be triggered by the experiment data or the assay.

Flag Description

Pre-processing flag

OFFSCALE Fluorescence is offscale

Primary analysis flags

BADROX Bad passive reference signal
NOAMP No amplification
NOISE Noise higher than others in plate
SPIKE Noise spikes
NOSIGNAL No signal in well
EXPFAIL | Exponential algorithm failed
BLFAIL . Baseline algorithm failed
THOLDFAIL . Thresholding algorithm failed
CTFAIL Ct algorithm failed

Secondary analysis flags
AMPNC Amplification in negative control
CLUSTER# Number of clusters outside expected range
PCFAIL Positive Control failed
SMCLUSTER# Small number of samples in clusters

For more information

For more information on... Refer to... e
number
Publishing data Chapter 2 in Booklet 1, Getting Started with QuantStudio™ 6 and 7 4489822

Flex Real-Time PCR System Software Experiments
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Adjust analysis settings

Section 5.2 Adjust parameters for re-analysis of your
own experiments

Adjust analysis settings

The Analysis Settings dialog box displays the analysis settings for the call, threshold
cycle (Cy), flags, and advanced options.

You can change the settings in the Analysis Settings dialog box, then reanalyze your

experiment.
View the analysis 1. From the Experiment Menu pane, select Analysis.
settings 2. Click Analysis » Analysis Settings to open the Analysis Settings dialog box.

In the example experiment, the default analysis settings are used for each tab:
¢ Call Settings
e (Cp Settings
¢ Flag Settings
* Advanced Settings

The following is an image of the Analysis Settings dialog box for a Genotyping
experiment:

13 Analysis Settings for QuantStudio_384-Well_SNP_Genotyping_Example

— Data Analysis Settings
(O Analyze Data from Post-PCR Read Only (®) Analyze Data from Pre-PCR Read and Post-PCR Read
(O Analyze Real-Time Rn Data (O Analyze Real-Time Rn - Median(Rna to Rnb)

) Analyze Real-Time dRn Data

~— Default Call Settings
Default call settings are used to make allele calls for SMP assays without custom settings. To edit the default settings, dick Edit Default Settings.

Autocaler Enabled: Yes Keep Manual Calls from Previous Analysis: No  Quality Value: 95 | Edit Default Settings

~— Select a SNP Assay -~ Call Settings for SNP Assay 1
SNP Assay Analysis Type Autocaller Keep Manual C... | Quality Value Apply Call Settings: Default Settings
SHP Assay 1 Defauft Yes No 05 b
SMP Assay 2 Default Yas Mo a5
v

Save to Library Load from Library Revert to Default Analysis Settings Apply Analysis Settings
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Adjust analysis settings

3.

View and, if necessary, change the analysis (see “Adjust analysis settings” below).

Note: You can save the changes to the analysis settings to the Analysis Settings
Library for later use. For more information, see About the Analysis Settings
Library in Booklet 1, Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR
System Software Experiments.

Click Apply Analysis Settings to apply the current analysis settings.

Note: You can go back to the default analysis settings, by clicking Revert to
Default Analysis Settings.

Adjust analysis Call Settings

settings

Use the Call Settings tab to:

Change the default data analysis settings. You can select from:

— Analyze data from Post-PCR Read only - Select if you do not want to use
data from the pre-PCR read to determine genotype calls.

— Analyze data from Pre-PCR Read and Post-PCR Read - If you included the
pre-PCR read in the run, select if you want to use data from the pre-PCR
read to determine genotype calls.

— Analyze Real-Time Rn Data - If you included amplification in the run, select
if you want to use the normalized reporter (Rn) data from the cycling stage
to determine genotype calls.

— Analyze data from Rn - Avg (Rna to Rnb) - If you included amplification in
the run, select if you want to use the subtracted median of the normalized
reporter (Rn) data from the cycling stage to determine genotype calls, where
Rna to Rnb refers to all the cycles from the Start Cycle Number to the End
Cycle Number. The average subtraction provides improved data accuracy.

Note: To activate the Reveal Traces feature on the Allelic Discrimination Plot
scree, select either Analyze Real-Time Rn Data or Analyze data from Rn -
Avg (Rna - Rnb).

Edit the default call settings. Click Edit Default Settings, then specify the default
settings:

— Autocaller Enabled - Select for the software to make genotype calls using the
autocaller algorithm.

— Keep Manual Calls from Previous Analysis - If the autocaller is enabled,
select to maintain manual calls after reanalysis

— Quality Value - Enter a value to use to make genotype calls. If the confidence
value is less than the call setting, the call is undetermined.

Use custom call settings for a SNP assay.

— Select one or more SNP assays in the table, then deselect the Default
Settings check box.

— Define the custom call settings.

Ct Settings

Data Step Selection

Use this feature to select one stage/step combination for Cy analysis when there is
more than one data collection point in the run method.

Algorithm Settings
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Use the Baseline Threshold algorithm to determine the Ct values.

The Baseline Threshold algorithm is an expression estimation algorithm that
subtracts a baseline component and sets a fluorescent threshold in the exponential
region for gene quantification.

e Default Cy Settings

Use the default Cr settings feature to calculate Cr for the alleles that do not have
custom settings. To edit the default settings, click Edit Default Settings.

® Cp Settings for Target
When you manually set the threshold and baseline, Life Technologies

recommends:
Setting Recommendation

Threshold Enter a value for the threshold so that the threshold is:
¢ Above the background.
¢ Below the plateau and linear regions of the amplification curve.
e Within the exponential phase of the amplification curve.

Baseline Select the Start Cycle and End Cycle values so that the baseline ends
before significant fluorescent signal is detected.

Note: This setting is applicable only to the Baseline Threshold algorithm.

Note: Selecting Automatic Threshold implies selection of automatic setting of the
baseline. However, if Automatic Threshold is deselected, then you can choose
between setting the baseline either automatically or manually.

Flag Settings

Use the Flag Settings tab to:

* Adjust the sensitivity so that more wells or fewer wells are flagged.

™

¢ Change the flags that are applied by the QuantStudio = 6 and 7 Flex Real-Time
PCR System Software.

To adjust the flag settings:
To adjust the flag settings:
1. In the Use column, select the check boxes for flags to apply during analysis.

2. (Optional) If an attribute, condition, and value are listed for a flag, specify the
setting for applying the flag.

Note: If you choose to adjust the setting for applying a flag, make minor
adjustments as you evaluate the appropriate setting.

3. In the Reject Well column, select the check boxes if you want the software to reject
wells with the flag.

Note: After you have rejected the flagged wells, analysis results depend on
factors such as the experiment type and flag type. For example, rejecting wells
flagged by HIGHSD in experiments using the Standard Deviation calculations
may change the result of Ct SD. For some flags, analysis results calculated before
the well is rejected are maintained.
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5 Chapter 5 Review Results and Adjust Experiment Parameters
Adjust analysis settings

4. Click Apply Analysis Settings in the Analysis Settings dialog box. If the run
status is complete, the data are reanalyzed.

The following is an image of the Flag Settings tab:

R oo s |
el you can enable, e, and configure flags, and indicate if a well is to be rejected when a flag is raised.

Flag Description Use Attribute Condition Value Reject Well
BADROX Bad passive referenc... Fluorescence = + |500.000 A
OFFSCALE Fluorescence is offscale O
NOSIGHAL Mo signal in well O
CLUSTER# Number of clusters o...
PCFAIL Positive control falled
SMCLUSTER Small number of sam... Mumber of data poin...|= w 2,000
AMPNC Amplification in nega... cr < w [35.000 O
NOAMP No amplification Amplification algorith... [< w (0.100 O
NOISE Moise higher than of... Relative noise = w [4.000 O
SPIKE Noise spikes Spike algorithm result | w (1.000 O
EXPFAIL Exponential algorith... O
BLFAIL Baseline algarithm fail... O L
THOLDFAIL Thresholding algorith... O v

Revert to Default Analysis Settings Apply Analysis Settings

Advanced Settings
Use the Advanced Settings tab to change baseline settings well-by-well.
To use custom baseline settings for a well-target combination:

1. Select one or more well-target combinations in the table.

2. Deselect the Use Ct Settings Defined for Target check box.

3. Define the custom baseline settings:

e TFor automatic baseline calculations, select the Automatic Baseline check
box.

¢ To define the baseline, deselect the Automatic Baseline check box, then enter
the baseline start cycle and baseline end cycle.
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Section 5.2 Adjust parameters for re-analysis of your own experiments

For more information

For more information

For more information on...

Refer to...

Publication
number

Amplification efficiency

Application Note.

Amplification Efficiency of TagMan® Gene Expression Assays 127AP05-03
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Chapter 5 Review Results and Adjust Experiment Parameters
For more information
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Export Analysis Results

1. Open the Genotyping example experiment file that you analyzed in Chapter 5.
2. In the Experiment Menu, click E Export.

Note: To export data automatically after analysis, select the Auto Export check
box during experiment setup or before running the experiment. Auto export is
unchecked for the example experiment.

3. Select QuantStudio™ 6 and 7 format.

4. Complete the Export dialog box as shown below:

Field or Selection Entry
Select Data to Results

export/ Select

Content

Export Data To One File

Export File Name QuantStudio_384-Well_SNP_Genotyping_Example_data

File Type * txt

Export File Location | C:\Applied Biosystems\QuantStudio 6 and 7 Flex
Software\User Files\Export

Your Export screen should look like this:

[] Auto Export Format : \QuantsStudio™ 6 and 7 w Export Data To: & One Fle ) Separate Files Open file(s) when export is complete

Export File Name: |QuantStudio_384-Well_SNP_Genotyping_Exa| File Type: |[Z} (=txt)

S A At Bl s \QuantStudio 6 and 7 Flex Software\User Files\Export]

Sample Setup [] Raw Data Amplification [] multicompaonent

Skip Empty 5 Skip Omitted W

Select Content
well Well Position Sample Name SNP Assay N... | Task Allelel Delta ... | Allele2 Delta ... | P
All Fields & 1A1 SNP Assay 1 NTC 0.034 0.062 A
3A3 Sarmple 3 SNP Assay 1 UNKNOWN 2.569 0.392
el 545 SNP Assay 1 NTC 0.035 0.058
el Position 7 A7 Sarmple 3 SNP Assay 1 UNKNOWN 2.273 0.286
oA SNP Assay 1 NTC 0.040 0.058
Sample Name 11 A11 Sample 3 SHP Assay 1 UNKNOWN 1.818 0.141
13 A13 SNP Assay 2 NTC 0.044 0.042
SHP Assay Name 15 A15 sample 1 SHP Assay 2 UNKNOWN 1.311 0.241
17 A17 SNP Assay 2 NTC 0.046 0.050
Task 19 419 Sarmple 1 SNP Assay 2 UNKNOWN 1.081 0.136
allelet Delta RN 21 A21 SNP Assay 2 NTC 0.044 0.039
23 A23 Sample 1 SNP Assay 2 UNKNOWN 1.000 0.170
Allele2 Delta Rn 49 C1 Sample 4 SNP Assay 1 UMKNOWN 0.153 2.520
5103 Sample 5 SNP Assay 1 UNKNOWN 2.463 0.343
Pass.Ref 53C5 Sample 4 SNP Assay 1 UNKNOWN 0.121 2.265
) 55 C7 Sarrple 5 SNP Assay 1 UNKNOWN 2.211 0.233
5
Qualty(%) 57Co Sample 4 SNP Assay 1 UNKNOWN 0.117 2.285
50 C11 Sample 5 SNP Assay 1 UNKNOWN 2.203 0.214  ~
Call
~ | | >

W Save Export Set As Load Export Set Delete Export Set
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H Chapter 6 Export Analysis Results

Your exported file when opened in Notepad should look like this:

84-Well_SNP_Genotyping Example data.txt - Notepad
File Edt Faormat View Help

Block Type = 384-well Block -~
Calibration Background is expired = =
Calibration Background performed on = DB 25-2010
calibration HRM MELTDOCTOR 15 expired = ves

Calibration HRM MELTDOCTOR performed on = 03—03—2010
Calibration Normalization FAM-ROX is expired = ve
Calibration Normalization FAM-ROX performed on = 07 22-2010
calibration Normalization VIC-ROX is expired = ye
calibration Normalization vIC-roX performed on = 07—22—2010
calibration Pure Dye aABY is expired = ves

Calibration Pure Dye ABY performed on = 03 31-2010
Calibration Pure Dye ABYQ is expired = ves

Calibration Pure Dye ABYQ performed on = 03—2?—2010
calibration Pure Dye ATTO 700 is expired = ves
calibration Pure Dye ATTO 700 performed on = 04-06-2010
Calibration Pure Dye DYE3 is expired = ve

Calibration Pure Dye DYE3 performed on = U? 22-2010
Calibration Pure Dye DYE4 is expired = Yves

calibration Pure Dye DYE4 performed on = 07-22-2010
calibration Pure Dye FAM is expired = yes

Calibration Pure Dye FAM performed on = 07-22-2010
Calibration Pure Dye FAMQ is expired = yves

calibration Pure Dye FAMQ performed on = 03-27-2010
calibration Pure Dye JUN is expired = Yes

calibration Pure Dye JUN performed on = 03-31-2010
calibration Pure Dye JUNQ s expired = ves

Calibration Pure Dye JUNQ performed on = 03- 2? 2010
Calibration Pure Dye MELTDOCTOR is expired = yes
calibration Pure Dye MELTDOCTOR performed on = 03 03-2010
calibration Pure Dye MP 15 expired = yes

Calibration Pure Dye MP performed on = 07-22-2010
Calibration Pure Dye MUSTANGP is expired = ves
Calibration Pure Dye MUSTANGP performed on = 06-16-2010
Calibration Pure Dye NED is expired =

calibration pure Dye NED performed on = 06 12-2010
calibration Pure Dye NPR is expired = yes

Calibration Pure Dye NPR performed on = 02—13—2010
Calibration Pure Dye Q705 is expired =

Calibration Pure Dye Q705 performed on = 07—14—2010
Calibration Pure Dye QUASAR 705 is expired = Yes
calibration Pure Dye quasar 705 performed on = 02-15-2010
calibration Pure Dye QUASARTOS 15 expired = ves
Calibration Pure Dye QUASAR705 performed on = 04-06-2010
calibration Pure Dye ROX is expired = yes

calibration Pure Dye ROX performed on = 07-22-2010
calibration Pure Dye SYBR is expired = ves

calibration Pure Dye sYBR performed on = 07-22-2010
Calibration Pure Dye TAMRA 15 expired = Yves

Calibration Pure Dye TAMRA performed on = 02-13-2010
Calibration Pure Dye VIC is expired = Yes

calibration pure pDye vIC performed on = 07-22-2010
calibration Pure Dye vICQ is expired = ves

Calibration Pure Dye VICQ performed on = 03-27-2010
calibration ROI is expired es

calibration ROI performed on = 07-22-2010

calibration uniformity is expired = yes

% K E R B E G F R F EEEE X G EEE E XK N EEEEKEDEEEHTEEEEEHEE LD EKENEEE R D
]
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About Presence/ Absence
Experiments

This chapter covers:

B Aboutdatacollection. .......... .. i 5

Setting up PCRreactions. ........ ... 6
B Abouttheinstrument run.............. ...ttt 6
B Abouttheanalysis .......... ... 7
B About the example experiment ........... ... ..o i i 7

IMPORTANT! First-time users of the QuantStudio™" 6 and 7 Flex Real-Time PCR System
Software please read Booklet 1, Getting Started with QuantStudio'" 6 and 7 Flex Real-Time
PCR System Software Experiments and Booklet 7, QuantStudio'" 6 and 7 Flex Real-Time
PCR System Software Experiments - Appendixes of this binder thoroughly. The booklet
provides information and general instructions that are applicable to all the
experiments described in this binder

Note: For more information about any of the topics discussed in this guide, access the
Help from within QuantStudio™ 6 and 7 Flex Real-Time PCR System Software by
pressing F1, clicking ) in the toolbar, or selecting Help » QuantStudio™ 6 and 7 Flex
Real-Time PCR System Software Help.

About data collection

End-point PCR
Data

Real-Time PCR
Data

QuantStudio™ é and 7 Flex Real-Time PCR System Software Getting Started Guide for Presence/Absence

Experiments

Presence/Absence experiments are end-point experiments that are performed to detect
a target nucleic acid sequence in a sample.

You can collect the experiment data at the end of the run or continuously in real time.

The QuantStudio™ 6 and 7 Instruments collect data at an end-point, that is after the
process has completed.

The data collected is the normalized intensity of the reporter dye, or Rn.

Note: Some end-point experiments also include pre-PCR (data collected before the
amplification process) datapoints. If so, the software calculates the delta Rn (ARn)
value per the following formula:

ARn = Rn (post-PCR read) — Rn (pre-PCR read), where Rn = normalized readings.

The QuantStudio™™ 6 and 7 Instruments provide the option of collecting real-time data,
during the PCR process.

Note: Real-time data collection is used only for troubleshooting, and not for Presence/
Absence analysis.



1 Chapter 1 About Presence/ Absence Experiments
Setting up PCR reactions

Setting up PCR reactions

IPC setup

No IPC, singleplex

setup

With Presence/Absence experiments, you prepare PCR reactions that contain primers
and probes to amplify the target and a reagent to detect amplification of the target. You
can set up the PCR reactions for the Presence/Absence experiments two different ways.

Note: The example experiment uses IPC setup for setting up the PCR reactions.

Use an internal positive control (IPC) to monitor the PCR progress and ensure that a
negative result is not caused by failed PCR in the sample. PCR reactions contain two

primer/probe sets: One to detect the unknown target (unknown target primer set and

TagMan® probe to detect the unknown target) and one to detect the IPC (IPC primer

set and a VIC dye-labeled TagMan® probe to detect the IPC template). With this setup,

there are three well types:

* Unknown-IPC wells contain sample template and IPC template; the presence of

the target is not known.

* Negative control-IPC wells contain IPC template and water or buffer instead of

sample template in the PCR reaction. Only the IPC template should amplify in
negative control-IPC wells because the reaction contains no sample template.
Also called IPC+.

* Negative control-blocked IPC wells do not contain sample template in the PCR

reaction. Amplification is prevented by a blocking agent. As a result, no
amplification should occur in negative control-blocked IPC wells because the
reaction contains no sample template and amplification of the IPC is blocked.
Negative control-blocked IPC is called no amplification control (NAC).

If the run method includes amplification, real-time data are plotted in an
amplification plot.

Omit the IPC from your Presence/Absence experiment. PCR reactions contain one

primer/probe set. PCR reactions do not contain the IPC. With this setup, there are two

well types:

* Unknown wells — Wells contain sample template; the presence of the target is not

known.

* Negative controls — Wells contain water or buffer instead of sample template.

About the instrument run

With Presence/Absence experiments, the instrument runs can include:

* Pre-PCR read - Perform the pre-PCR read on the QuantStudio™ 6 and 7 Flex
Real-Time PCR System Software before PCR amplification to collect baseline

fluorescence data.

* Amplification — Perform amplification on the QuantStudio'" 6 and 7 Flex Real-

Time PCR System Software to collect fluorescence data during PCR amplification.
If you do not include amplification in the run method, perform amplification on

another instrument.

* Post-PCR read — To determine the results for Presence/Absence experiments,
perform the post-PCR read on the instrument after PCR amplification to collect
endpoint fluorescence data.

QuantStudio™ é and 7 Flex Real-Time PCR System Software Getting Started Guide for Presence/Absence
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Chapter 1 About Presence/ Absence Experiments
About the analysis

Fluorescence data collected during the instrument run are stored in an experiment
data file (.eds).

About the analysis

Data from the instrument run are used to determine Presence/Absence calls. Results
are plotted in a Presence/Absence plot. If the experiment includes amplification,
results are plotted in an amplification plot.

Pre-PCR read - If included, the data collected from the pre-PCR read can be used
to normalize data collected from the post-PCR read.

Amplification - If included, the data collected from the amplification can be used
to troubleshoot.

Post-PCR read — The data collected from the post-PCR read are used to make
Presence/Absence calls:

— DPresence — The target amplified above the target’s threshold. The target is
present in the sample.

— Absence — The target did not amplify above the target’s threshold. The target
is absent in the sample.

— Unconfirmed - The data collected is below the target threshold, and the
intensity of IPC is below the IPC threshold.

With the IPC setup, the data collected form the post-PCR read are used to make the
following calls:

IPC Failed — The IPC target did not amplify in the IPC wells and/or the IPC target
amplified in the blocked IPC wells.

IPC Succeeded — The IPC target amplified in the IPC wells and the IPC target did
not amplify in the blocked IPC wells.

About the example experiment

To illustrate how to perform Presence/Absence experiments, this guide leads you
through the process of designing and performing an example experiment. The
example experiment represents a typical setup that you can use to quickly familiarize
yourself with a QuantStudio™" 6 and 7 Flex Real-Time PCR System Software.

The objective of the Presence/Absence example experiment is to determine if a
pathogen is present or absent in each batch of ground beef.

In the Presence/Absence example experiment:

DNA is extracted from samples using the PrepMan® Ultra Sample Preparation
Reagent (Part no. 4318930). The DNA is extracted from each of the four samples of
ground beef or from the bacteria found in the ground beef.

The target is a pathogen.

The experiment is designed for duplex PCR, where each reaction contains two
primer/probe sets. One set detects the pathogen sequence, TGFB (primer set and
FAM™ dye-labeled probe to detect the TGFB sequence). The other primer/probe
set detects the IPC primer set and VIC® dye-labeled TagMan® probe detects the
IPC template.
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About the example experiment
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Design the Experiment

This chapter explains how to design the example experiment from the Experiment
Setup menu.

This chapter covers:

B Define the experiment properties. ............ ... ... 9
B Define targets and samples. . ... 10
B Assigntargetsand samples.......... .. ... i i i 11
B Setuptherunmethod....... ... ... .. i 12
B For moreinformation. .......... ... ... i 13

Note: To automatically export the analyzed data to a specified location, select the Auto
Export task from the Export screen, before running the experiment. For more
information on Auto Export, refer to Chapter 2 in Booklet 1, Getting Started with
QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments.

Define the experiment properties

Click Experiment Setup » Experiment Properties to create a new experiment in the
QuantStudio™ 6 and 7 Flex Software. Enter:

Field or Selection Entry

Experiment Name QuantStudio_384-Well_Presence-
Absence_Example

Barcode Leave field empty

User Name Example User

Comments Presence/Absence example

Instrument type QuantStudio™ 6 Flex System

Block ' 384-Well Block

Experiment Type " Presence/ Absence

Reagents . TagMan® Reagents

Ramp speed Standard

Reagent information NA

Select all three data-collection check boxes: Pre-PCR, Amplification, and Post-PCR
collection methods:

Pre-PCR Read Checked

QuantStudio™ é and 7 Flex Real-Time PCR System Software Getting Started Guide for Presence/Absence 9
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Define targets and samples

Amplification Checked
Post-PCR Read Checked

Save the experiment.

Your Experiment Properties screen should look like this:

How do you want to identify this experiment?

* Experiment Name: |QuantStudio_384-Well_Presence-Absence Example Comments: [Presence/ Absence Experiment

Barcode: ||

User Mame: |Example User

Which instrument type are you using to run the experiment?

| QuantStudio™ 6 Flex System | [ QuantStudio™ 7 Flex System ]

Which block are you using to run the experiment?

s 384-well | [ 96-Well (0.2mL) ] [ Fast 96-Well (0.1mL) ]

[ Standard Curve ] [ Relative Standard Curve ] [ Comparative Cr (AACT) ] [ Melt Curve ]

[ Genotyping ] [~ Presence/Absence |

Which reagents do you want to use to detect the target sequence?

| TagMan® Reagents | [ Other ]

What properties do you want for the instrument run?

[~ Standard ! Fast ]

Include: Pre-PCR Read Armplification

What is the reagent information?

Maw

Type Name Part Number Lot Number Expiration Date

Define targets and samples

Click Define to access the Define screen. Enter:

1. Targets

Target Name Reporter Quencher Color

TGFB FAM NFQ-MGB .

IPC VIC NFQ-MGB

2. Samples

Sample Name Color

NTC .
NAC .

Sample (+)

Sample (-) ]

10 QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Getting Started Guide for Presence/Absence
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3. Dye to be used as a Passive Reference

ROX

4. Custom Task Name
Not applicable

Your Define screen should look like this:

Chapter 2 Design the Experiment

Assign targets and samples

Target Name

TGFB

Reporter Quencher

FAM ~ |NFQ-MGB

Sample Name

PC

VIC

<

NFQ-MGB

Color

v|. “ fwre |. v
"| 71 nac |. v
Sample (+) | ~
Sample (-) |. v

ROX

-

Mewr Crelete

Color

Icon Char

Assign targets and samples

Click Assign to access the Assign screen. Enter the targets and samples:

TNa:r?'::t Well Number Task Sample
TGFB A1 - P3 (Columns 1 - 3] Negative | NTC
IPC IPC
TGFB A4 - P12 (Columns 4 - 12) Unknown | Sample
IPC IPC )
TGFB A13 - P15 (Columns 13 - 15) NTC NAC
IPC Blocked

IPC
TGFB A16 - P24 (Columns 16 - 24) Unknown | Sample
IPC IPC )
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Set up the run method

Your Assign screen should look like this:

Targets

TGFB

PC v| :
]
=) =) C) =) E) k) L) =)
: C
Samples — (a7 |
REE—— ) | smRD) S0 0 | M) | smRD | kD) s
Oinac o
NTC |
O sample (+) |
[} Sample (-) =) =) -} =) -} L) ) =)
£} Bl E) Bl B} Bl B} £}
F ]
| >
] 0 Empty
ells:
wels: [ o [ 0 zaBH4a4a

Set up the run method

Click Run Method to access the Run Method screen. Set the thermal profile under the
Graphical View tab. Enter:

* Reaction Volume Per Well: 20 uL
* Thermal Profile

Ramp .
Stage Step rate Temperature Time

Pre-Read Stage Step 1 1.6°C/s 60°C 30 seconds
Hold Stage Step 1 1.6°C/s 95°C 10 minutes
PCR Stage Step 1 1.6°C/s 95°C 15 seconds
* Number of Cycles: 40 Step?2 1.6°C/s 60°C 1 minute

(default)
¢ Enable AutoDelta:

Unchecked (default)
e Starting Cycle: Disabled

when Enable AutoDelta is

unchecked
Post-Read Stage Step 1 1.6°C/s 60°C 30 seconds

12 QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Getting Started Guide for Presence/Absence
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Chapter 2 Design the Experiment
For more information

Your Run Method screen should look like this:

Run Method

Reaction Volurne per wel: | 20 pL
od  SaveRun Method ev
Include; ¥ Pre-PCR Read [ Amplification W Post-PCR Read
Pre-Read Stage Hold Stage PCR Stage Post-Read Stage
MNurmber of Cycles: |4D :I
7 Enable AutoDelta
Starting Cycle: |1 3:
95.0 °C 95,0 *C
10:00 18°C/s go:s
16 °Cfs £ 2 1ECfs
50.0 °C 50.0 *C 60.0 *C
00:30 0100 L& *Cis o0
16 o/
Step1 Step1 Step1 Step2 Step1
4 »
Legend
" Data Colection On ~ = Data Collection OFf A AutcDelta On A AutoDelta Off

For more information

For more information on... Refer to Publication
number

Consumables Chapter 3 in Booklet 1, Getting Started with QuantStudio™ é and 7 4489822
Flex Real-Time PCR System Software Experiments
Appendix A in Booklet 7, QuantStudio™ 6 and 7 Flex Real-Time PCR
System Software Experiments - Appendixes

Data collection Chapter 2 in Booklet 1, Getting Started with QuantStudio™ 6 and 7 4489822
Flex Real-Time PCR System Software Experiments

Amplification efficiency Amplification Efficiency of TagMan® Gene Expression Assays 127AP05-03
Application Note

Using Alternative Setup Chapter 3 in Booklet 1, Getting Started with QuantStudio™ 6 and 7 4489822

Flex Real-Time PCR System Software Experiments
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Experiments

13



Chapter 2 Design the Experiment

For more information
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Prepare the Reactions

This chapter explains how to prepare the PCR reactions for the Presence/Absence
example experiment.

This chapter covers:

B Assemble required materials ......... ... . i 15
B Prepare the reaction mix (“cocktail mix”)............... ... .o oo 15
B Preparethereactionplate.......... ... ... .. i 17
B For more information. ............oioiiiii it 18

Assemble required materials

e Items listed in Booklet 1, Getting Started with QuantStudio™ 6 and 7 Flex Real-Time
PCR System Software Experiments

¢ Samples - DNA extracted from ground beef (100 ng/uL)
¢ Example experiment reaction mix components:

— TaqMan® Universal PCR Master Mix

- 10X IPC Mix

- 50X IPC DNA

— 20X Primer/ Probe Mix

Note: Fast Universal Master Mix is not recommended to be used with the 96-well
(0.2 mL) reaction plates or reaction tubes and tube strips sealed with caps.

Prepare the reaction mix (“cocktail mix”)

For the Presence/ Absence example experiment, four cocktail mixes are used; one each
for:

e Sample (+)
e Sample (-)
e NTC/IPC+
* NAC/IPC-
The following tables list the universal assay conditions (volume and final

concentration) for using the TagMan® Universal PCR Master Mix for the four cocktail
mixes.

QuantStudio™ é and 7 Flex Real-Time PCR System Software Getting Started Guide for Presence/Absence 15
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Chapter 3 Prepare the Reactions

Prepare the reaction mix (“cocktail mix”]

Cocktail Mix

Reaction component

Volume for 1
reaction (pL)

Volume for 160
reactions (144
wells + 10%
excess) (pL)

Cocktail Mix 1 for Sample (+) | TagMan® Universal PCR Master Mix (2.0X) 12.50 2000.0
10X IPC Mix 2.50 400.0
50X IPC DNA 0.50 80.0
20X Primer/ Probe Mix 1.25 200.0
Water/ Buffer 5.75 920.0
Diluted unknown 1 2.5 400
Total reaction mix volume 25.0 4000.0
Cocktail Mix 2 for Sample (-] | TagMan® Universal PCR Master Mix (2.0X) 12.50 2000.0
10X IPC Mix 2.50 400.0
50X IPC DNA 0.50 80.0
20X Primer/ Probe Mix 1.25 200.0
Water/ Buffer 5.75 920.0
Diluted unknown 2 25 400
Cocktail Mix 3 for NTC/ IPC+ | TagMan® Universal PCR Master Mix (2.0X) 12.50 662.5
10X IPC Mix 2.50 132.5
50X IPC DNA 0.50 26.5
20X Primer/ Probe Mix 1.25 66.25
Water/ Buffer 8.25 304.75
Total reaction mix volume 25.0 1325.0
TagMan® Universal PCR Master Mix (2.0X) 12.50 662.5
Cocktail Mix 4 for NAC/ IPC- | TagMan® Universal PCR Master Mix (2.0X) 12.50 662.5
10X IPC Mix 2.50 132.5
50X IPC DNA 0.50 26.5
20X Primer/ Probe Mix 1.25 66.25
IPC Block 25 132.5
Water/ Buffer 5.75 304.75
Total reaction mix volume 25.0 1325.0

To prepare the reaction mix for each of the four types:

1.

Label four appropriately sized tubes for the reaction mixes:

Sample (+), Sample (-), NTC, NAC.

2. Add the required volumes of each cocktail mix component to the tube.

16 QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Getting Started Guide for Presence/Absence
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Chapter 3 Prepare the Reactions

Prepare the reaction plate

3. Mix the cocktail thoroughly by gently pipetting up and down several times, then
cap the tube.

4. Centrifuge the tube briefly to remove air bubbles.

5. Place the cocktail mix on ice until you prepare the reaction plate.

Note: You can separately add the sample to the reaction plate, as opposed to
preparing individual reaction mixes for each sample.

Prepare the reaction plate

The reaction plate for the Presence/Absence example experiment contains:
* A MicroAmp® Optical 384-Well Reaction Plate
e Reaction volume of 20 pL/well
¢ 144 Sample (+) wells |
¢ 144 Sample (-) wells ju
o 48 NTC/IPC+ [
e 48 NAC/IPC- il

The following is an image of the plate layout:

Plate Layout Well Table

[z s [ 4 [ s [ e [ 7 [ 8 | 9 [w [ 1 [z [ 15 | 14 [ 15 [ 16 [ 17 [ s |19 [ @ [z | 22 | 23 [ 2 |

i il v v i i i i v i i v T i i i

P P P e P P P R e P R R i i M s R s P e e M e
P P P e M e e e e e e T i i M i s i P i M i m rm
Fiia P P e e s P P e e e M i i i i i e o 1 e e . .
s P P e e s P P P e e P i e i i i e o 1 e e .
Fhiia P P P e s P Pl P i e i i i M i i e o e e e o .
> | P Phim P P M i P i P P P M i i M P i i i i o i
| e s S P P i PR s S PR PR A A i A P s P s s A i P
L | e e i P i Fhiin Fhiin s P P i M M M M P P M e s M P P
v | T i i i e i i e e i R i T i i i i i e e i i
| e i i i i i P P i i i i i i i i i i i e i i
© | i i i i e i i i e e e i i i e e s o T e . . .
P P P e P P P R e P R R i i M s R s P e e M e

wels: [ o []o =l e L 48 ' a8 0 Empty
I I L

To prepare the reaction plate:
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For more information

Chapter 3 Prepare the Reactions

1. Add 25 pL of Cocktail mix 1 to wells A16-P24.
Add 25 pL of Cocktail mix 2 to wells A4-P12.
Add 25 pL of Cocktail mix 3 to wells A13-P15.
Add 25 pL of Cocktail mix 4 to wells A1-P3.

Seal the reaction plate with optical adhesive film.

Centrifuge the reaction plate briefly to remove air bubbles.

S L B o

Confirm that the liquid is at the bottom of each well of the reaction plate. If not,
centrifuge the reaction plate again at a higher speed and for a longer period of
time.

8. Until you are ready to perform the run, place the reaction plate at 4°C, in the dark.

For more information

For more information on... Refer to... Publication
number
Assigning the reaction plate Chapter 2 in Booklet 1, Getting Started with QuantStudio™ é and 4489822
components 7 Flex Real-Time PCR System Software Experiments
Sealing the reaction plate Chapter 2 in Booklet 1, Getting Started with QuantStudio™ é and 4489822
7 Flex Real-Time PCR System Software Experiments
18 QuantStudio™ é and 7 Flex Real-Time PCR System Software Getting Started Guide for Presence/Absence
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Run the Experiment

This chapter explains how to run the example experiment on the QuantStudio™ 6 or 7
Instrument.

This chapter covers:
B o Startthe run. . ... e 19
B Monitor the run. . ... .. 19

IMPORTANT! Run the experiment at the same ambient temperature at which you
calibrated the instrument. Extreme variations in ambient temperature can affect the
heating and cooling of the instrument and influence experimental results.

IMPORTANT! Do not attempt to open the access door during the run. The door is
locked while the QuantStudio " 6 or 7 Instrument is in operation.

Start the run

1. Open the Presence/Absence example file that you created using instructions in
Chapter 2.

2. Load the reaction plate into the instrument.

3. Start the run.

Monitor the run

Monitor the example experiment run:

* From the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software using the
Run screen, while the experiment is in progress.

e From the Instrument Console of the QuantStudio™ 6 and 7 Flex Real-Time PCR
System Software (to monitor an experiment started from another computer or
from the QuantStudio™ 6 or 7 Instrument touchscreen).

e From the QuantStudio™ 6 or 7 Instrument touchscreen.

QuantStudio™ é and 7 Flex Real-Time PCR System Software Getting Started Guide for Presence/Absence 19
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Chapter 4 Run the Experiment
Monitor the run

From the
Instrument
Console of the
QuantStudio™ 6
and 7 Flex Real-
Time PCR System
Software

Amplification Plot

14
13
12
11
10
09
08
o7

ARN

06
o5
04
03
02
01

Amplification Plot

1. In the Instrument Console screen, select the instrument icon.
2. Click Manage Instrument or double-click on the instrument icon.
3. On the Manage Instrument screen, click Monitor Running Instrument to access
the Run screen.
View the Amplification Plot

You can view the progress of the run in real time. During the run, periodically view all
the three plots available from the QuantStudio™ 6 and 7 Flex Real-Time PCR System
Software for potential problems.

Click Amplification Plot from the Run Experiment Menu, select the Plate Layout tab,
then select the wells to view.

The following is an image of the Amplification Plot screen as it appears at the end of
the example experiment.
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View the Temperature Plot

Click Temperature Plot from the Run Experiment Menu.
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Chapter 4 Run the Experiment
Monitor the run

The following is an image of the Temperature Plot screen as it appears during the
example experiment.

Temperature Plot Current Temperatures
o P ) Ig Enﬂn ~ [l cover
~ Wsarpe
Temperature Plot - Block

Temperature Plot

00:33:20

00:37:30 00:41:40

00:45:50 00:50:00 00:54:10 00:58:20 01:02:30

Time

01:06:40 01:10:50 01:15:00 01:18:10 01:23:20 01:27:30

View 1 Hour &~

Fixed view [

Run Method

Note: The Sample temperature displayed in the Current Temperatures group is an
estimated value.

View the Run Method
Click Run Method from the Run Experiment Menu.

The following is an image of the Run Method screen as it appears in the example
experiment.

Edit Run Method

Pre-Read Stage Hold Stage PCR Stage Post| Adjust # of Cycles:
Mumber of Cycles: |4D :I [T &dd Melt Curve Stage to End
[T Enable AutoDelta [T 2dd Holding Stage ta End
Starting Cycke: Il 3 [T 2dd Infinite Hold to End
10:00 LE°C oois
75 °C__| = L) = L)
1.6 *C 1,520
G0.0 *C G0.0 *C
p— 00:30 01:00 16
G 2
1.6 “C
25 o0 _|
0°C_|
Stept Stept Stept Step2
4| | 3
Legend
Data Collection ©n * = Data Collection Off A AutoDelta On A AutoDelta Off
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Click View Run Data from the Run Experiment Menu.
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Chapter 4 Run the Experiment
Monitor the run

The following is an image of the View Run Data screen as it appears in the example
experiment.

Run Data Report
Experiment Mame: QuantStudio_384-Wel_Presence-Absence_Example

Start Time: 01-20-2010 18:35:18 56T
Stop Time: 01-20-2010 20:08:20 SGT
Run Duration: 91 minutes 1 seconds

User Mame: DEFAULT

Instrument Mame:

Firmware Version:

Software Version: N/A

Instrument Serial Number: 278880001
Sample Volume: 20.0
Cover Temperature: 105.0

Instrument Type:

Block Type: 384-Wel Block

Errors Encountered:

< >
From the You can also view the progress of the run from the QuantStudio™" 6 or 7 Instrument
QuantStudio™ 6 or  touchscreen.
7 Instrument The following are images of the Run Method screen on the QuantStudio™ 6 or 7
touchscreen Instrument touchscreen:

Experiment View

@ Time View Ht]  Experiment View

Run Started: July 06 2013 - 05:48PM Sample: 0.0 °C
Reaction Volume: 20 pL Heated Cover [Set Point): 105.0 °C (105.0 °C)
Time Remaining: 01:15:39

Stage 1 Stage 2
X1 3of40

95.0 °C 95.0 °C

10:00 0:15 N\ 60.0 °C

1:00
(c]

July:06 2013 - 05:48PM o

Heated cover reached target temperature.
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Chapter 4 Run the Experiment
Monitor the run

Time View
®© Time View t] Experiment View
Run Started: July 06 2013 - 05:48PM Sample: 95.0 °C
Reaction Volume: 20 pL Heated Cover [Set Point): 105.0 °C (105.0 °C)

Stage /Step /Cycle: 1/2/1

01:31:52

@ Remaining Time Elapsed Time

July 06 2013 - 05:48PM 0

Heated cover reached target temperature.
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Chapter 4 Run the Experiment
Monitor the run
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Review Results and
Adjust Experiment Parameters

In Section 5.1 of this chapter you review the analyzed data using several of the analysis
screens and publish the data. Section 5.2 of this chapter walks you through the process
of modifying experiment parameters to troubleshoot problems with experiment
results before rerunning an experiment.

This chapter covers:

Section 5.1 Review Results ..ottt ittt 27
B Analyze the example experiment. . .......... ... ..o i 27
View the Presence/Absence Plot .. ....... ... i, 27

B Assess amplification results using the Amplification Plot................... 29
B ViewtheWellTable ... ... ... i e 33
B Confirm accurate dye signal using the Multicomponent Plot................ 36
B Determine signal accuracy using the Raw DataPlot ....................... 38
B Review the flagsinthe QCSummary ............ ..o, 40
B Formore information. ... ....... ... .. i e 42
Section 5.2 Adjust parameters for re-analysis of your own experiments. ........ 43
B Adjust analysissettings. . ... 43
B Formore information. . ........ ..ottt 46
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Section 5.1 Review Results 5
Analyze the example experiment

Section 5.1 Review Results

Analyze the example experiment

1. Open the Presence/Absence example experiment file that you ran in Chapter 4.

2. Click Analyze. The software analyzes the data using the default analysis settings.

Note: You can also access the experiment to analyze from the Home screen.

View the Presence/Absence Plot

Purpose

To view and assess
the Presence/
Absence Plot

The Presence/Absence Plot displays the intensity of the fluorescence for each well
position. There are four Presence/Absence plot views available:

o AllCalls
* Presence calls only
* Absence calls only
* Unconfirmed calls
For each view you can choose to:
¢ Show IPC

¢ Show Controls

The purpose of viewing the Presence/Absence Plot for the example experiment is to
confirm that:

* The target is absent in samples NTC and Sample (-).
* The target is present in Sample (+).

¢ There are no unconfirmed wells.

* The IPC succeeded in all wells.

¢ There is no amplification in NAC wells.

From the Experiment menu pane, select Analysis » Presence/Absence Plot.
Note: If no data are displayed, click Analyze.

1. Display all 384 wells in the Presence/Absence Plot screen by clicking the upper
left corner of the plate layout in the Plate Layout tab.

2. Enter the Plot Settings:

Menu Selection
Target Reporter TGFB
Control Reporter IPC
Show Calls All Calls
QuantStudio™ é and 7 Flex Real-Time PCR System Software Getting Started Guide for Presence/Absence 27
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5 Chapter 5 Review Results and Adjust Experiment Parameters
View the Presence/Absence Plot

Menu Selection

= Check (default)

(This is a toggle button. When the legend
is displayed, the button changes to Hide
the plot legend.)

3. Click the Show IPC check box to view the fluorescence intensity of the IPC target
in the Unknown-IPC wells.

4. Click the Show Controls check box to view the fluorescence intensity of the IPC
target in the Negative Control-IPC wells and the Negative Control-Blocked IPC
wells.

5. To view the fluorescence intensity of:

* Presence calls- select Presence from the Show Calls drop-down menu.
* Absence calls- select Absence from the Show Calls drop-down menu.

* Unconfirmed calls- select Unconfirmed from the Show Calls drop-down
menu.

Note: The Presence/Absence example experiment does not contain any
unconfirmed calls.

The following is an image of the Presence/Absence Plot for the example experiment:
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L™ . . .
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Section 5.1 Review Results 5
Assess amplification results using the Amplification Plot

Tips for viewing * The IPC threshold is calculated from the Negative Control- Blocked IPC
presence/absence reactions.
plots in your own * The Target Threshold is calculated from the Negative Control- IPC reactions. If
experiments the target’s intensity is:
— Above the target threshold, the call is present (regardless of the intensity of
the IPC).

— Below the target threshold, and the IPC’s intensity is above the IPC
threshold, the call is absent.

— Below the target threshold, and the IPC’s intensity is below the IPC
threshold, the call is unconfirmed.

e Target Calls:
— Presence
— Absence
— Unconfirmed
e IPC Calls:
— IPC Succeeded
— [IPC Failed
¢ Control Well Calls:
— Negative Control - IPC
— Negative Control - Blocked IPC

Assess amplification results using the Amplification Plot

IMPORTANT! Amplification plots are not used to make presence/absence calls.
Examine the plots to help with troubleshooting and quality control.

Amplification plots = The Amplification Plot displays amplification of all samples in the selected wells.
available for There are three amplification plot views available:

viewing * ARn vs Cycle — ARn is the difference in normalized fluorescence signal generated
by the reporter between the pre-PCR read and the post-PCR read. This plot
displays ARn as a function of cycle number. You can use this plot to identify and
examine irregular amplification and to view threshold and baseline values for the
run.

* Rnvs Cycle — Rn is the fluorescence signal from the reporter dye normalized to
the fluorescence signal from the passive reference. This plot displays Rn as a
function of cycle number. You can use this plot to identify and examine irregular
amplification.

* Cgvs Well — Cyis the PCR cycle number at which the fluorescence meets the
threshold in the amplification plot. This plot displays Cr as a function of well
position. You can use this plot to locate outlying amplification (outliers).

Each plot can be viewed as a linear or log10 graph type.
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5 Chapter 5 Review Results and Adjust Experiment Parameters
Assess amplification results using the Amplification Plot

Purpose The purpose of viewing the amplification plot for the example experiment is to review
the target to identify:

e Correct baseline and threshold values

* Irregular amplification

¢ OQutliers
View the 1. From the Experiment menu pane, select Analysis » Amplification Plot.
Amplification Plot Note: If no data are displayed, click Analyze.

2. Display all 384 wells in the amplification plot by clicking the upper left corner of
the plate layout in the Plate Layout tab.

3. Expand the Plate Layout tab by clicking the left facing arrow that is left of the tab.

4, In the Amplification Plot screen, enter:

Menu Selection
Plot Type ARn vs Cycle
Plot Color Well
= Check (default]

(This is a toggle button. When the legend
is displayed, the button changes to Hide
the plot legend.)

5. View the baseline values:
a. From the Graph Type drop-down menu, select Linear.
b. Select the Baseline check box to show the start cycle and end cycle.

c. Verify that the baseline is set correctly: The end cycle should be set a few
cycles before the cycle number where significant fluorescent signal is
detected. In the example experiment, the baseline is set correctly.
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Section 5.1 Review Results

Assess amplification results using the Amplification Plot

Your screen should look like this:

Amplification Plot

Plot Settings

Plot Type: [4Rn vs Cyde = Graph Type: [inear =] Plot Color: [wel =l

¥ Sawve current settings as the default

. Y . o m
p P B 2 & E
Amplification Plot

125
1.00

- 075

o

<]
030
025
0.00 = Tar

2 4 6 8 L] 2 a 6 8 0 2 24 26 o3 30 32 34 k. 8 an
Cycle

Optiohs

Target: |sl VI Threshold: T 4utn IT &uto Baseline

Show: [T Threshold — B Baseline Start: well B0 Target 4. Baseline End: YWell (M Target £

well Summary: In Plate; 284 Set Up: 284 Analyzed: 284 Flagged: 144 Omitted by Analysiz: 0 Ormitted Manually: Samples Used: 4 Targets Used: 2

6. View the threshold values:
a. From the Graph Type drop-down menu, select Log.
b. Select the Threshold check box to show the threshold.
c. Verify that the threshold is set correctly.

Your screen should look like this:

Amplification Plot
Plot Settings

Plot Type: Ii\Rn vs Cycle =] Graph Type: JLog =] Plot Color: fwel =l

[V Save current settings as the default

Amplification Plot

1ED1

1E0D

ARn

Options

Target: |sl VI Threshald: T~ &uto [T &uto Baseline

Show: ¥ Threshold — [T Baseline Start: well B0 Target 4 Baseline End: Well [l Target 4

Well Summary: In Plate: 384 Set Up: 384 Anahyzed: 354 Flagged: 144 Omitted by Analysis: 0 Criitted Mamually: O Samples Used: 4 Targets Usech 2
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5 Chapter 5 Review Results and Adjust Experiment Parameters
Assess amplification results using the Amplification Plot

7. Locate any outliers:
a. From the Plot Type drop-down menu, select Ct vs Well.

b. Look for outliers from the amplification plot. In the example experiment,
there are no outliers for IPC.

Your screen should look like this:

Amplification Plot

Plot Settings
Plot Type: [C1 vs wel vl Graph Type: ILinear 'I Plot Color: IWeII vI
¥ Sawe current settings as the default
P L el E
Amplification Plot
40.0 e S— R ~————
75 1 - -
e 2k Ay L 4 T N A o -t
325 W= B S e T wE s Ryh A WA W
300
275 [ ) W — e 3 T Py - T A i | L
250
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17.5
15.0
125
100
7a
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0o 5 10 15 20 25 30 35 40 45 50 55 60 65 70 75 80 &5 90 95100105 100 151200 25 300 351401 450 501 55600651700 751 801 551 M R0 0 1(B 1 S22P 22300 PR R SCSDEPES TET RSP ERR00G0H 10815320 3 BE0
Well Mumber
well Summary: In Plate: 384 Set Up: 384 Analyzed: 384 Flagged: 144 Ornitted by Anabysis: 0 Omitted Manually: O Sarnples Used: 4 Targets Used: 2
Tips for viewing When you analyze your own Presence/ Absence experiment, look for:
amplification plots e Outliers
i . .o . « T™M
In your own * A typical amplification plot — The QuantStudio ~ 6 and 7 Flex Software

experiments automatically calculates baseline and threshold values based on the assumption
that the data exhibit a typical amplification plot. A typical amplification plot has
four distinct sections:

— Plateau phase

— Linear phase

— Exponential (geometric phase)
— Baseline
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Section 5.1 Review Results 5
View the Well Table

A following is an image of a typical amplification plot:

Amplification Plot
Plot Settings

Plot Type: |ARn vs Cycle -l Graph Type: ILDg LI Plot Color: |We|| ;l

¥ Save current settings as the default

T LY
Amplification Plot
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0001 =

Options
Target: I!-\H | Threshold: [T 2uto I IT &uto Baselne

Shaow: ¥ Threshold — W Baseline Start: well B0 Target 4« Baseline End: Wel [l Target 4

Well Summary: In Plate: 384 Set Up: 384 Analyzed: 284 Flagged: 144 Cmitted by Analysis: 0 Crriitted Manually: 0 Samples Used: 4 Targets Used: 2

IMPORTANT! Experimental error (such as contamination or pipetting errors) can
produce atypical amplification curves that can result in incorrect baseline and
threshold value calculations by the QuantStudio " 6 and 7 Flex Software. Life
Technologies recommends that you examine the Amplification Plot screen and review
the assigned baseline and threshold values for each well after analysis.

View the Well Table

The well table displays results data for each well in the reaction plate, including:
¢ The well number, sample name, target name, task, and dyes
e The calculated values: ARn, ARn mean, and ARn SD

Note: ARn, ARn mean, and ARn SD are calculated only when the analysis call
settings specify to analyze data from the pre-PCR read and the post-PCR read.

¢ Target and IPC thresholds, Call, Comments

¢ Flags
Purpose In the Presence/Absence example experiment, you review the well table for:
e Call
¢ ARn
¢ Flag
QuantStudio™ é and 7 Flex Real-Time PCR System Software Getting Started Guide for Presence/Absence 33
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Chapter 5 Review Results and Adjust Experiment Parameters
View the Well Table

To view the Well 1. From the Experiment Menu pane, select Analysis » Amplification Plot, then
Table select the Well Table tab.

Note: If no data are displayed, click Analyze.

2. Use the Group By drop-down menu to group wells by a specific category. For the
example experiment, group the wells by flag, call, and ARn value.

Note: You can select only one category at a time.

a. From the Group By drop-down menu, select Flag:

* 144 wells are listed under Flagged.

o 240 wells are listed under Unflagged.

»| Plate Layout Well Table

Show in Table ¥ Selectwisls ¥  Group By ¥ Expand 2l B Collapse all
# | wel | Omit Flag |Samp...| Target Name Task Dyes ARn ARN Mean ARN SO | Threshold... call Comments MOAMP ExXPFA]
4 Ad r 2 Sampl... IPC IPC WIC-MFQ-MGE 1.576 1.404 0.012 1.09 IPC Succe... j
4 Ad r 2 Sarnpl.. TGFE LINETCWN FAM-MNFOQ-MGE 0.38 0,381 0.006 0,414 Absence
5 AS o 2 Sarnpl... IPC IPC WIC-NFQ-MGE 1,395 1.404 0.012 1.09 IPC Succe...
5 A3 r 2 Sampl... TGFE UNEMOWN FaM-MNFO-MGE 0,373 0.381 0.006 0.414 Absence
& A5 r 2 Samgl... IPC IFC WIC-NFQ-MGE 1.403 1.404 0.012 1.09 IPC Succe...
& A6 r 2 Sarnpl... TGFE LMK FAM-MNFOQ-MGE 0.38 0,281 0.00& 0.414 Absence
7 A7 o 2 Sarnpl... IPC IPC WIC-NFQ-MGE 1.41 1.404 0.012 1.09 IPC Succe...
T A7 r 2 Sarnpl... TGFE UREMICARN FAM-MNFC-MGE 0.386 0.381 0.006 0.414 BAhsence
8 A8 r 2 Sarnpl... IPC IPC WIC-NFQ-MGE 1.401 1.404 0.012 1.09 IPC Succe...
g8 A8 r 2 Sarnpl... TGFE LINETHOWN FAM-MNFQ-MGE 0,389 0,281 0.00& 0,414 Absence
9 AQ r 2 Sampl... IPC IPC WIC-NFQ-MGE 1,395 1.404 0.012 1.09 IPC Succe...
9 A9 r 2 Sampl... TGFE UNEMICWAR FAM-MNFC-MGE 0.382 0.381 0.006 0.414 Ahsence
10 410 r 2 Sarnpl... IPC IPC WIC-NFQ-MGE 1.405 1.404 0.012 1.09 IPC Succe...
10 A10 o 2 Sarnpl... TGFE UNEMOWN FAM-NFO-MGE 0,382 0.381 0.006 0,414 Absence
11 811 r 2 Sampl... IPC IPC WIC-NFQ-MGE 1.407 1.404 0.012 1.09 IPC Succe...
11 411 r 2 Sampl... TGFE URKMICHAR FAM-MNFO-MGE 0.387 0.381 0.006 0.414 Absence
12 212 r 2 Sarnpl... IPC IPC WIC-NFQ-MGE 1.402 1.404 0.012 1.09 IPC Succe,..
12 812 o 2 Sarnpl... TGFB UNEMOWN FAM-NFO-MGE 0,382 0.381 0.006 0.414 Absence
28 B4 r 2 Sarnpl... IPC IPC WIC-MFQ-MGE 1.396 1.404 0.012 1.09 IPC Succe...
28 B4 r 2 Sarnpl... TGFE UMK FAM-MNFOQ-MGE 0.384 0.381 0.006 0.414 Absence
20B3 r 2 Sarnpl... IPC IPC WIC-NFQ-MGE 1.4 1.404 0.012 1.09 IPC Succe...
29B5 r 2 Sampl... TGFE UNEMOWN FAM-NFO-MGE 0,384 0.381 0.006 0.414 Absence
30 BS r 2 Sampl... IPC IPC WIC-MFQ-MGE 1.408 1.404 0.012 1.09 IPC Succe...
2N kR _I r armnl TrRFR [Ny NI T ) = (0 [ = T = =) n 29A n 221 oA ndia Abcanira I x
Al L4
well Summary: In Plate: 254 Set Up: 384 Analyzed: 384 Flagged: 144 Oritted by Analysis: 0 Omitted Manualky: 0 Samples Used: 4 Targats Usad: 2
b. From the Group By drop-down menu, select Call. Wells are listed in the
order:
e Absence
¢ Blocked IPC Control
e IPC Succeeded
o . . .
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Section 5.1 Review Results
View the Well Table

* Negative Control

e Presence

Target Name ARN Mean Threshald...
16 Al16 r LIMKMNOWMN FAM-MWFQ-MGE Presence
17 817 r Sampl... TGFB LIMKINOWT FAM-MNFQ-MGE 1789 1.706 0.034 0.414 Presence
12 Al18 r Sampl... TGFB LIMKMOW FAM-MFQ-MGE 1744 1.706 0.034 0.414 Presence
19 A19 r Sarnpl... TGFB LIMKMNCWM FAM-MFQ-MGE 1722 1,706 0,034 0.414 Presence
20 AZ0 r Sampl... TGFB LIMKMNOWMN FAM-MWFQ-MGE 1722 1.706 0.034 0.414 Presence
21 A21 r Sampl... TGFB LIMKMOWT FAM-MFQ-MGE 1738 1.706 0.034 0.414 Presence
22 a2z r Sampl... TGFB LIMKMOWH FaM-MFQ-MGE 1.695 1,706 0,034 0414 Presence
23 823 r Sarnpl... TGFB LIMKNCWM FAM-MFOQ-MGE 1,708 1.706 0,034 0.414 Presence
24 A24 r Sampl... TGFB LIMKMNOWM FAM-MWFQ-MGE 1718 1.706 0.034 0.414 Presence
40 B16 r Sampl... TGFB LIMKMOWT FAM-MFQ-MGE 1773 1.706 0.034 0.414 Presence
41 B17 r Sampl... TGFB LIMKMNCWM FAM-MFQ-MGE 1.773 1,706 0,034 0.414 Presence
42 B18 r Sampl... TGFB LMKMNOWHMN FAM-WFQ-MGE 1.745 1.706 0.034 0.414 Presence
43 E19 r Sampl... TGFB LIMKMNOWT FAM-MFQ-MGE 1737 1.706 0.034 0.414 Presence
44 B20 r Sampl... TGFB LIMKMOWT FAM-MFQ-MGE 1726 1.706 0.034 0.414 Presence
45 B21 r Sarnpl... TGFB LIMKMNCWM FAM-MFQ-MGE 1.688 1,706 0,034 0.414 Presence
46 B22 r Sampl... TGFB LIMKMNOWM FAM-WFQ-MGE 1711 1.706 0.034 0.414 Presence
47 B23 r Sampl... TGFB LIMKMOWT FAM-MFQ-MGE 1686 1.706 0.034 0.414 Presence
48 B24 r Sampl... TGFB LIMKMCWR FaM-MFQ-MGE 1.695 1,706 0,034 0.414 Presence
64 C16 r Sarnpl... TGFB LIMKMNCWM FAM-MFQ-MGE 1.751 1,706 0,034 0.414 Presence
AR 17 J — Samnl  TRER LI RIEAR EAR_LIECLIAGE: 1747 1 7A nnad ndid Dracanca | _bl_l
well Summary: In Plate: 384 Set Up: 384 Analyzed: 384 Flagged: 144 Critted by Analysis: O Omitted Manually: 0 Samples Used: 4 Targets Used: 2

c. From the Group By drop-down menu, select None. In the table, click the
column heading ARn. Wells are listed in order of increasing ARn. Click the
column heading again to reverse the sort order.

Plate Layout

in Table » xprannd / Callspse All

# | Well | Omit | Flag |Samp.‘.| Target Hame Task | Dyes | ARn - ~!| |ARn Mean ARn S0 | Threshald... Cal Comments | NOAMP | EXPI
o JiL - MNTC TGFE MNTC F&M-MFQ-MGE 0,33 0,371 0,016 MNegative C... ﬂ
. H1 r NTC TG NTC FaM-MFO-MGE 033 0,371 0015 Megative ..
.11 r NTC TGFE NTC FAM-MFQ-MGE 0.337 0,371 0.015 Megative ...
. H2 r MNTC TGFE MNTC FamM-MFQ-MGE 0.34 0.371 0.016 Megative C...
12 - MNTC TGFE MNTC F&M-MFQ-MGE 0.341 0,371 0.016 MNegative C...
L2 r NTC TGFE NTC FAM-MFO-MGE 0.345 0,371 0015 Megative ..,
.Gl r NTC TGFE NTC FaM-MFQ-MGE 0.349 0.371 0.016 Meqgative C...
. F1L r MTC TGFE MTC FaM-MFQ-MGE 0.349 0.371 0.016 Megative C...
. G2 - MNTC TGFE MNTC FaM-MFQ-MGE 0,334 0,371 0.016 MNegative C...
K1 r NTC TGFE NTC FAM-MFQ-MGE 0,356 0,371 0015 Megative ..,
L] r 2 Sampl.. TGFE UMKNOWI FaM-MFQ-MGE 0.363 0.381 0.006 0.414 Ahsence
. H13 r MAC TGFE MTC F&M-MFQ-MGE 0,363 0,331 0,007 Megative C...
. K2 r NTC TG NTC FaM-NFQ-MGE 0.364 0,371 0015 Megative ...
. F14 r MNAC TGFE NTC FAM-MNFQ-MGE 0.364 0,351 0,007 Megative ..,
] r NTC TGFE NTC FaM-MFQ-MGE 0.367 0.371 0.016 Megative C...
49 C1 r MNTC TGFE MNTC FaM-MFQ-MGE 0.367 0,371 0.016 Megative C...
ooo (AL r 2  Sampl... TGFE LIMKNOWH FAM-MFO-MGE 0.368 0,381 0,008 0.414 Absence
... F2 r MTC TGFE MTC FamM-MFQ-MGE 0.369 0.371 0.016 Meqgative C...
... L11 - 2 Sampl... TGFE UMKMNOW F&M-MFQ-MGE 0.369 0,381 0.006 0.414 Ahsence
. H2 r MNTC TGFE MNTC FaM-MFQ-MGE 0,369 0,371 0.016 MNegative C...
oo I r MNAC TGFE NTC FAM-MFQ-MGE 0.369 0,381 0,007 Megative ...
73Dl r MTC TGFE MTC FamM-MFQ-MGE 0.37 0.371 0.016 Megative C...
. Hig - MAC TGFE MNTC F&M-MFQ-MGE 0,37 0,381 0,007 MNegative C...
. Jin r 2 Sampl... TGFE LIMKMOWH FaM-MFO-MGE 0,371 0,381 0,005 0,414 Absence
K11 4| | - Sarnnl TrEFR LRI R AR FARLRIE SR n-27 n 221 nnns ndid Ahcarra I _}l;I
well Summary: I Plate: 384 Set Up: 284 Analyzed: 304 Flagged: 144 Ornitted by Analysiz: 0 Critted Manually: O Samples Used: 4 Targets Used: 2
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5 Chapter 5 Review Results and Adjust Experiment Parameters
Confirm accurate dye signal using the Multicomponent Plot

Tips for analyzing When you analyze your own Presence/Absence experiment, group the wells by:

your own .
experiments

Flag —The software groups the flagged and unflagged wells. A flag indicates that
the software has found an error in the flagged well. For a description of the
QuantStudio™ 6 and 7 Flex Software flags, see “Review the flags in the QC
Summary” on page 40.

Call - The software groups the wells by call: Negative Control, Blocked-IPC,
Presence, Absence, Unconfirmed, IPC Succeeded, and IPC Failed.

Confirm accurate dye signal using the Multicomponent Plot

The Multicomponent Plot screen displays the complete spectral contribution of each
dye in a selected well over the duration of the PCR run.

Pu rpose In the Presence/Absence example experiment, you review the Multicomponent Plot
screen for:

ROX™ dye (passive reference)
FAM™ dye (reporter)

VIC® dye (reporter)

Spikes, dips, and/or sudden changes

Amplification in the negative control wells

View the 1. From the Experiment Menu pane, select Analysis » Multicomponent Plot.
Multicomponent Note: If no data are displayed, click Analyze.
Plot
2. Display the wells one at a time in the Multicomponent Plot screen:
a. Click the Plate Layout tab.
b. Select one well in the plate layout; the well is shown in the Multicomponent
Plot screen.
Note: If you select multiple wells, the Multicomponent Plot screen displays
the data for all selected wells simultaneously.

3. From the Plot Color drop-down menu, select Dye.

4. Click ["] Show a legend for the plot (default).

Note: This is a toggle button. When the legend is displayed, the button changes to
Hide the plot legend.

5. Check the ROX dye signal. In the example experiment, the ROX dye signal
remains constant throughout the PCR process; a constant ROX dye signal
indicates typical data.
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Section 5.1 Review Results
Confirm accurate dye signal using the Multicomponent Plot

6. Check the VIC dye signal. In the example experiment the VIC dye signal should
not amplify for NC-Blocked IPC wells or if the IPC call for the Unknown-IPC well
is IPC Failed.

Multicomponent Plot
Plot Settings

Plot Color |Dye - l

™ Save current settings as the default

AP By &2 By
Multicomponent Plot
400,000

350,000

300,000

B

.EP =
[ -

8 — S——— R R 3 i a
c B
@ 250,000 { —
: s== = (.
S 200000
=]
o
150,000 |
100,000 _
R EEEEEE R EE R E E E EE E R
Cycle -
Lagend _lﬂ
WFa EERCK I VIC Al T »
I
U L] .. Bl 0 Empty
Wells:
Moo 233 43 43
well Summary: In Plate: 384 Set Up: 384 Analyzed: 384 Flagged: 144 Omitted by Analysis: O Crnitted Manually: O Samples Used: ¢ Targets Used: 2

7. Check the FAM dye signal. In the example experiment, for the Sample (+), the

FAM dye signal increases throughout the PCR process; increase in FAM dye

signal indicates normal amplification.

Multicomponent Plot
Plot Settings

Plot Color |Dye A l

™ Save current. settings as the default

£ P i = &
Multicomponent Plot
400.000

350,000

300,000

250000 | B

200,000

Fluorescence

150,000

100,000

50,000

o]
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Cycls

Legerd
Ml Fer Il ROx I VIC

LA L4 1
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=l
=l
“ B

=N
=[N

walls: [[ o o Izsa I43 I43

well Summary: In Plate: 304 Set Up: 304 Anslyzed: 304

QuantStudio™
Experiments

Flagged: 144

Smitted by Analysis: 0 Critted Manwally: 0 Samples Used: 4

é and 7 Flex Real-Time PCR System Software Getting Started Guide for Presence/Absence
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Chapter 5 Review Results and Adjust Experiment Parameters

Determine signal accuracy using the Raw Data Plot

8. Select the negative control (NAC) wells one at time and check for amplification. In
the example experiment, there is no amplification in the negative control wells.

well Table

Plate Layout

Multicomponent Plot

Plot Settings
Plot Color |Dye 'l intiels ¥ Gelectrells ¥ FiIEH) iew Legend :m:
™ Save current. settings as the default 11 ‘ 12 13 | 1% | 5
A L alp i = >
Multicomponent Plot . . s R E 7]
L)
400,000
350,000
2
300,000
3 ; ]
T 2s0000( _ i 1B N
% 200,000
v 150,000 [ |
2
100,000
L4
50,000 c N
Du245a|u|2|4|a|a2ﬂ22uzazan:akaaaaau4«
Cycle -
) : o
M For EEROx I VIC A I v
. I . 0 Empty
wells: [ o o zsa Em 43
well Summary: In Plate; 384 Set Up: 384 Analyzed: 354 Flagged: 144 Omitted by Analysis: O Cmitted Manually: 0 Samples Used: < Targets Used: 2
Tips for confirming  When you analyze your own Presence/Absence experiment, look for:
dye accuracy in e DPassive reference (ROX)- The passive reference dye fluorescence level should
your own remain relatively constant throughout the PCR process.
experiment e Reporter dye (FAM) — The reporter dye fluorescence level should display a flat

region corresponding to the baseline. If target is present in the sample (a Presence
call is made), the baseline will be followed by a rapid rise in fluorescence as the
amplification proceeds.

¢ Irregularities in the signal — There should not be any spikes, dips, and/or sudden
changes in the fluorescent signal.

¢ Negative control wells — There should not be any amplification in the negative
control wells.

Determine signal accuracy using the Raw Data Plot

The Raw Data Plot screen displays the raw fluorescence signal (not normalized) for
each optical filter for the selected wells during each cycle of the real-time PCR.

Purpose In the Presence/Absence example experiment, review the Raw Data Plot screen for a
stable increase in signal (no abrupt changes or dips) from the appropriate filter.

View the Raw Data 1. From the Experiment Menu pane, select Analysis » Raw Data Plot.
Plot Note: If no data are displayed, click Analyze.

38 QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Getting Started Guide for Presence/Absence
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Section 5.1 Review Results 5
Determine signal accuracy using the Raw Data Plot

2. Click = Show alegend for the plot (default). The legend displays the color code
for each row of the reaction plate (see the legend in the Raw Data Plot shown
below).

3. Display all 384 wells in the Raw Data Plot screen by clicking the upper left corner
of the plate layout in the Plate Layout tab.
4. Select wells corresponding to a replicate group:
* Sample (-) wells: From the Select Wells with drop-down menus, select
Sample (-).
¢ Sample (+) wells: From the Select Wells with drop-down menus, select
Sample (+).
* Negative control-IPC wells: Select wells A1 - P1, A2 - P2, and A3 - P3.
* Negative control-blocked IPC wells: Select wells A13 - P13, A14 -P14, and
Al5 - P15.

5. Click and drag the Show Cycle pointer from cycle 1 to cycle 42. In the example
experiment, there is a stable increase in signal from filter 1, which corresponds to
the FAM™ dye filter.

Raw Data Plot <

£ p Bl !
Raw Data Plot
500.000
750,000
700,000
650,000
600,000
550,000
500.000
o 450,000
=S 400,000
gasu.noo
300.000
250,000
200,000
150.000
100,000
50,000
0
x?‘-n? *3-m3 x4 I-r|=1 ®5-m5
Filter
e
’iA-ECDE.FIGH A‘
=
Options
Show Cycle 42 J
p o ¢ ¢ g ©°o 9o © 9o § o O O 0 g 0O © © O [ O O O O | 0 O O O ) O 0 0O 0O ] O © O O [ O
1 5 10 15 20 23 30 &3 40 42
well Summary: In Plate: 384 Set Up: 384 Analyzed: 354 Flagged: 144 Orvitted by Analysist Oritted Marually: 0 Sarnples Used: 4 Targets Used: 2
QuantStudio™ é and 7 Flex Real-Time PCR System Software Getting Started Guide for Presence/Absence 39

Experiments



5 Chapter 5 Review Results and Adjust Experiment Parameters
Review the flags in the QC Summary

The filters used for the example experiment are:

PCR Filter [

Emission Fifter
ml(520+15) m2(558+11) m3(586+10) m4(623+14) ms(682+14) m&(711+12)

Excitation Filter

Melt Curve Filter =

Emission Fiter

ml(520+15) m2(558+11) m3(586+10) m4(623=14) ms(582+14) me(711=12)
¥1(470+15)
z %2(520+10)
E x3(550+11)
;;; *4(580+£10)
¥5(640=£10)
¥6(562+10)
Tips for When you analyze your own Presence/ Absence experiment, look for the following in
determining signal  each filter:
accuracy in your * Characteristic signal growth
own experiments * No abrupt changes or dips

Review the flags in the QC Summary

The QC Summary screen displays a list of the QuantStudio™ 6 and 7 Flex Software
flags, including the flag frequency and location for the open experiment. In the
example experiment, 144 flags have been triggered.

Note: The flags triggered in the example experiment are seen in the Sample (-) wells.
The flags, NOAMP and EXPFAIL indicate that the wells containing the Sample (-) did
not amplify and that the software could not identify the exponential region of the
amplification plot (as amplification did not take place). The occurrence of these flags in
the example experiment is valid because it indicates the absence of the target in the

sample.
View the QC 1. From the Experiment Menu pane, select Analysis » QC Summary.
Summary Note: If no data are displayed, click Analyze.
40 QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Getting Started Guide for Presence/Absence
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QC Summary

Section 5.1 Review Results
Review the flags in the QC Summary

2. Review the Flags Summary

Note: A 0 displayed in the Frequency column indicates that the flag does not
appear in the experiment. If the frequency is >0, the flag appears somewhere in
the experiment; the well position is listed in the Wells column.

In the example experiment, there are 144 flagged wells.

3. In the Flag Details table, click each flag with a frequency >0 to display detailed
information about the flag. In the example experiment:
* The NOAMP flag appears 144 times, in the wells A4 - P4, A5 - P5, A6 -P6, A7
-P7, A8-P8, A9 - P9, A10 - P10, All - P11, and A12 - P12.
* The EXPFAIL flag appears 144 times, in the same wells as the NOAMP flag,
thatis, A4 - P4, A5-P5, A6-P6, A7-P7, A8-P8, A9 - P9, A10 - P10, A1l -
P11, and A12 - P12.
4. (Optional) For those flags with frequency >0, click the troubleshooting link to view

information on correcting the flag.

(T
Flag Details
Flag: Description Frequency el
BADRCH Bad passive reference signal 0
MNOSIGNAL Mo signal in weell (]
OFFSCALE Fluorescence is offscale 0
AMPINC Arnplification in negative control (]
MOAMP Mo arnplification 144 44, AS, AB, AT, AB, AQ, A10, A11, A1Z, B...
MNOISE Moise higher than others in plate (]
SPIKE Moise spikes (o]
EXFFAIL Exponential algorithm failed 144 A4, A5, A6, AF, AS, A3, A10, Al1, A12, B...
BLFAIL Baseline algarithm failed (o]
THOLDFAIL Thresholding algorithm failed (o]
CTFAIL CT algorithim failed 0
Flag: MOAMP—o amplfication =
Flag Detail: The sample did not amplify
Flag Criteria: Ampificaton algorithm resuit < 0.1
Flagged Wells: 44, A5, A8, A7 AS, A9, A10, A11, A12, B4, BS, B, B7,B8,B9,B10,B11,B12,C4, C5, C6, C7, C8, €9, C10, C11, C12, 04, DS, D6,
D7,08,09,010,011, 012, E4, ES, Es, E7, B8, ES,E10,E11, E12, F4,F5, F6, F7, F8, F9, F10,F11, F12, 54, G5, G5, G7, G5, G9,
510, 511,512, H4, H5, HS, H7, H3, HS, H10, H11, H12, 14,15, 16, 17,18, 19, 110, 111, 112, 34, 15, J&, 17, 15, 19, 110, 111, 112, K4,
K5, ke, K7, KB, K9, K10, K11, K12, 14,L5,L8,L7,L8,L9,L10,L11,L12, M4, M5, M5, M7, M8, M3, M10, M11, M12, N4, N5, MG, N7,
M3, NS, N10, M11, MN12, 04, 05, 06, OF, 08, 09, 010, 011, 012, P4, PS5, Pe, P7,PE,PS, P10, P11, P12
Yiemr NOAMP Troubleshooting Information =l
Total wells: 384 | Processed wels: 384 Manually Omitted wells: 0 | Targets Used: 2
wiells Set Up: 224 | Flagged wells: 144 Analysis Omitted Wells: 0 | Samples Used: 4
Well Summary: In Plate: 384 Set Up: 384 Analyzed: 384 Flagged: 144 Ornitted by Analysis: 0 Cmitted Manually: 0 Samnples Used: < Targets Used: 2

Possible flags

QuantStudio™ é and 7 Flex Real-Time PCR System Software Getting Started Guide for Presence/Absence
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For Presence/Absence experiments, the flags listed below may be triggered by the
experiment data.

Flag Description
Pre-processing flag
OFFSCALE Fluorescence is offscale
Primary analysis flags
BADROX Bad passive reference signal
NOAMP No amplification




Chapter 5 Review Results and Adjust Experiment Parameters
For more information

Flag Description

NOISE Noise higher than others in plate
SPIKE Noise spikes

NOSIGNAL No signal in well

EXPFAIL Exponential algorithm failed
BLFAIL Baseline algorithm failed
THOLDFAIL Thresholding algorithm failed
CTFAIL | Cy algorithm failed

Secondary analysis flags

AMPNC Amplification in negative control

Note: If the experiment does not include amplification, then the only flags are
BADROX, NOSIGNAL, and OFFSCALE.

For more information

For more information on... Refer to... A ERE
number
Publishing data Chapter 2 in Booklet 1, Getting Started with QuantStudio™ é and 7 4489822
Flex Real-Time PCR System Software Experimentss
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Section 5.2 Adjust parameters for re-analysis of your own experiments 5
Adjust analysis settings

Section 5.2 Adjust parameters for re-analysis of your
own experiments

Adjust analysis settings

The Analysis Settings dialog box displays the analysis settings for the call, threshold
cycle (Cy), flags, and advanced options.

If the default analysis settings in the QuantStudio'" 6 and 7 Flex Software are not
suitable for your own experiment, you can change the settings in the Analysis Settings
dialog box, then reanalyze your experiment.

View the analysis 1. From the Experiment Menu pane, select Analysis.

settings 2. Click Analysis » Analysis Settings to open the Analysis Settings dialog box.

In the example experiment, the default analysis settings are used for each tab:
¢ Call Settings
e (Cp Settings
¢ Flag Settings
* Advanced Settings

The following is an image of the Analysis Settings dialog box for a Presence/
Absence experiment:

13 Analysis Settings for QuantStudio_384-Well_Presence-Absence_Example

Cr Settings Flag Settings Advanced Settings

* Review the default se is of targets in this experiment. To use different settings for a target, select the target from the table, deselect Use Default
Settings, then chang

— Data Analysis Settings

(O Analyze Data from Post-PCR Read Only (%) Analyze Data from Pre-PCR Read and Post-PCR Read

~— Default Call Settings
Default call settings are used to make presence/absence calls for targets without custom settings. To edit the default settings, dick Edit Default Settings.

Confidence Value: 99%

— Select a Target — Call Settings for TGFB
Target Analysis Type Confidence Call Settings to Use: Default Settings
TGFB Default 09% &
IPC Default 99%
v

Save to Library Load from Library Revert to Default Analysis Settings Apply Analysis Settings

QuantStudio™ é and 7 Flex Real-Time PCR System Software Getting Started Guide for Presence/Absence 43
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Chapter 5 Review Results and Adjust Experiment Parameters

Adjust analysis settings

Adjust analysis
settings

44

3. View and, if necessary, change the analysis settings (see “Adjust analysis settings”

below).

Note: You can save the changes to the analysis settings to the Analysis Settings
Library for later use. For more information, see About the Analysis Settings
Library in Booklet 1, Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR
System Software Experiments.

. Click Apply Analysis Settings to apply the current analysis settings.

Note: You can go back to the default analysis settings, by clicking Revert to
Default Analysis Settings.

Call Settings
Use the Call Settings tab to:

Change the default data analysis settings. You can select from:
— Analyze data from Post-PCR Read only
— Analyze data from Pre-PCR Read and Post-PCR Read

e Edit the default call settings.

— Click Edit Default Settings, then select the confidence value to use to make
presence/absence calls. If the confidence value is less than the call setting, the
call is unconfirmed.

— Click Save Changes.

¢ Use custom call settings for a target.

— Select one or more targets in the table, then deselect the Default Settings
check box.

— Select the confidence value to use to make presence/absence calls for the
selected target(s).

Ct Settings
e Data Step Selection

Use this feature to select one stage/step combination for Ct analysis when there is
more than one data collection point in the run method.

Algorithm Settings
Use the Baseline Threshold algorithm to determine the Ct values.

The Baseline Threshold algorithm is an expression estimation algorithm that
subtracts a baseline component and sets a fluorescent threshold in the exponential
region for gene quantification.

Default Ct Settings

Use the default Cr settings feature to calculate Cr for the targets that do not have
custom settings. To edit the default settings, click Edit Default Settings.
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Section 5.2 Adjust parameters for re-analysis of your own experiments 5
Adjust analysis settings

® Cr Settings for Target
When you manually set the threshold and baseline, Life Technologies

recommends:
Setting Recommendation

Threshold Enter a value for the threshold so that the threshold is:
e Above the background.
¢ Below the plateau and linear regions of the amplification curve.
e Within the exponential phase of the amplification curve.

Baseline Select the Start Cycle and End Cycle values so that the baseline ends
before significant fluorescent signal is detected.

Note: This setting is applicable only to the Baseline Threshold algorithm.

Note: Selecting Automatic Threshold implies selection of automatic setting of the
baseline. However, if Automatic Threshold is deselected, then you can choose
between setting the baseline either automatically or manually.

Flag Settings
Use the Flag Settings tab to:

¢ Adjust the sensitivity so that more wells or fewer wells are flagged.
* Change the flags that are applied by the QuantStudio™™ 6 and 7 Flex Software.

To adjust the flag settings:
1. In the Use column, select the check boxes for flags to apply during analysis.

2. (Optional) If an attribute, condition, and value are listed for a flag, specify the
setting for applying the flag.

Note: If you choose to adjust the setting for applying a flag, make minor
adjustments as you evaluate the appropriate setting.

3. In the Reject Well column, select the check boxes if you want the software to reject
wells with the flag.

Note: After you have rejected the flagged wells, analysis results depend on
factors such as the experiment type and flag type. For example, rejecting wells
flagged by HIGHSD in experiments using the Standard Deviation calculations
may change the result of Ct SD. For some flags, analysis results calculated before
the well is rejected are maintained.

4. Click Apply Analysis Settings in the Analysis Settings dialog box. If the run
status is complete, the data are reanalyzed.
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Chapter 5 Review Results and Adjust Experiment Parameters
For more information

The following is an image of the Flag Settings tab:

-2 Analysis Settings for QuantStudio_384-Well_Presence-Absence_Example

Advanced Settings

can enable, e, e nd indicate if a well is to be rejected when a flag is raised.

Flag Description Use Attribute Condition Value Reject well
BADROX Bad passive referenc... Fluorescence < v (500.000
NOSIGNAL No signal in well O
OFFSCALE Fluorescence is offscale O
AMPNC Amplification in negat... cr < w (35.000 O
NOAMP No amplification Amplification algorith... |< w (0.100 O
NOISE Noise higher than ot... Relative noise = w (4.000 O
SPIKE Noise spikes Spike algorithm result |> w (1.000 O
EXPFAIL Exponential algorithm... O
BLFAIL Baseline algorithm failed O
THOLDFAIL Thresholding algorith... O
CTFAL Cr algorithm failed O

Save to Library Load from Library Revert to Default Analysis Settings Apply Analysis Settings W

Advanced Settings

Use the Advanced Settings tab to change baseline settings well-by-well.

To use custom baseline settings for a well-target combination:

1. Select one or more well-target combinations in the table.

2. Deselect the Use Ct Settings Defined for Target check box.

3. Define the custom baseline settings:

¢ For automatic baseline calculations, select the Automatic Baseline check

box.

¢ To define the baseline, deselect the Automatic Baseline check box, then enter
the baseline start cycle and baseline end cycle.

For more information

For more information on... Refer to Publication number
Amplification efficiency Amplification Efficiency of TagMan® Gene 127AP05-03
Expression Assays Application Note.
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[1 Auto Export

Exporting Analysis Results

1. Open the Presence/Absence example experiment file that you analyzed in

Chapter 5.

2. In the Experiment Menu, click E Export.

Note: To export data automatically after analysis, select the Auto Export check
box during experiment setup or before running the experiment. Auto export is
unchecked for the example experiment.

3. Select QuantStudio™ 6 and 7 format.

4. Complete the Export dialog box as shown below:

Field or Selection Entry
Select Data to Results

export/ Select

Content

Export Data To One File

Export File Name

QuantStudio_384-Well_Presence-Absence_Example_data

File Type

Export File Location

* txt

C:\Applied Biosystems\QuantStudio 6 and 7 Flex
Software\User Files\Export

Your Export screen should look like this:

Format : |QuantStudio™ 6 and 7 ~ Export Data To: & One File ) Separate Files Open file(s) when export is complete

Export File Location: [ms\QuantStudie 6 and 7 Flex Software\User Files\Export - Export File Name: | QuantStudio_384-well_Presence-Absence_E| File Type: [[F] (bd) v

Sample Setup

[] rawData Amplification [ Multicompanent Results

Select Content
All Fields
wel

well Position
Sample Name
Sample Color
Target Mame
Target Color
Task
Reparter
Quencher

Comments

Well Well Position Sample Name Sample Color Target Name Target Color Task R
1Al NTC RGB(255,0,0) IPC RGB(0,255,0) IPC VICA
1A1 NTC RGB(255,0,0) TGFB RGB(0,0,255) MTC FA
242 NTC RGB(255,0,0) PC RGB(0,255,0) IPC VIt
242 NTE RGB(255,0,0) TGFB RGB(0,0,255) NTE FA
3A3 NTC RGB(255,0,0) IPC RGB(0,255,0) IPC VI
3A3 NTC RGB(255,0,0) TGFB RGB(0,0,255) MTC FA
4 A4 Sample (-) RGB(0,0,255) PC RGB(0,255,0) jiele VIt
4 A4 sample (-) RGB(0,0,255) TGFB RGB(0,0,255) UNKNOWN FA
5 A5 Sample (-) RGB(0,0,255) IPC RGB(0,255,0) IPC VI
SAD Sample (-) RGB(0,0,255) TGFB RGB(0,0,255) UNKNOWWN FA
6 AB Sample (-) RGB(0,0,255) PC RGB(0,255,0) jiele VIt
B A Sample (-) RGB(0,0,255) TGFB RGB(0,0,255) UNKNOWWN FA
TA7 Sample (-) RGB(0,0,255) IPC RGB(0,255,0) IPC VI
7 A7 Sample (-) RGB(0,0,255) TGFB RGB(0,0,255) UNKNOWWN FA
848 Sample (-) RGB(0,0,255) PC RGB(0,255,0) jiele VIt
8 A8 Sample (-) RGB(0,0,255) TGFB RGB(0,0,255) UNKNOWWN FA
9 A9 Sample (-) RGB(0,0,255) IPC RGB(0,255,0) IPC VI
9 AQ Sample (-) RGB(0,0,255) TGFB RGB(0,0,255) UNKNOWWN FA o

v < >

W Save Export Set As Load Export Set Delete Export Set
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Chapter 6 Exporting Analysis Results

Your exported file when opened in Notepad should look like this:

_384-Well_Presence-Absence_Example_data.txt - Notep:
File Edit Format View Help

r Block Type = 384-well Block

* calibration Background is expired =

calibration Background performed on = 12 09-2009
calibration HRM MELTDOCTOR is expired = yes

calibration HRM MELTDOCTOR performed on = 01-14- 2010
calibration Normalization FAM-ROX is expired =

calibration Normalization FAM-ROX performed on = 12 09-2009
calibration Normalization vIC-ROX is expired =

calibration Normalization VIC-ROX perfurmed on = 12 09-2009
calibration Pure Dye FAM is expired =

calibration Pure Dye FAM performed on 12 09- 2009
Calibration Pure Dye MELTDOCTOR is expwred

Calibration pure Dye MELTDOCTOR performed on 01 14-2010
calibration Pure Dye NED is expired =

calibration Pure Dye NED performed on = 12 03-2009
calibration Pure Dye ROX is expired =

calibration Pure Dye ROX performed on 12 09-2009
Calibration Pure Dye SYBR 15 expired = ve

calibration pure Dye sYBR performed on = 12 09-2009
calibration Pure Dye TAMRA is expired =

Calibration Pure Dye TAMRA performed on = 12—03—2009
calibration Pure Dye VIC is expired = ves

calibration Pure Dye VIC performed on = 12-09-2009
cCalibration ROI is expired = ves

calibration roI performed on = 12-09-2009
calibration uniformity is expired = v

es
calibration uniformity performed on = 12-09-2009
Chemistry = TAQMAN

Date Created = 2013-07-05 14:47:30 PM SGT
Experiment Barcode
Experiment Comment = NA

Experiment File Name = C:\Program Files\Applied Biosystems‘\QuantStudio & and 7 Flex
uftware\examp'les\qSGF'\ex\qSG 384-well_Presence-absence_Example. eds

Experiment Name = Quantstudio_ 384-well_Presence-Absence_gxample

Experiment Run End Time = Not started

Experiment Type = Presence/Absence

INSTrument Name = NA

Instrument Serial Number = 278880001

Instrument Type quantstudio(TM) & Flex System

Passive REfEFEHCE =

quantification Cycle Method

signal smoothing on = tru

stage/ cycle where AnaTysws is performed = stage 3, step 2

User Name = NA

RN Ty

[sample setup]

well well position  sample Name sample Color Target Name Target Color Task Reporter
comments

1 AL NTC "RGE(255,0,0)" IPC "RGE(0, 255,0)" IPC VIC NFQ-MGE

1 AL NTC "RGB(255,0,0)" TGFB "rGE(0, 0, 255)" NTC FAM NFQ-MGB

2 A2 NTC "RGB(255,0,0)" IPC "RGE(0, 2550 VIC NFQ-MGB

2 A2 NTC "RGB(255,0,0)" TGFB “RGB(0, 0, 255 FAM NFQ-MGB

3 A3 NTC "RGE(255,0,0)" IPC “RGE(0, 255, 0 VIC NFQ-MGE

3 A3 NTC "RGE(255,0,0)" TGFB “RGE(O, 0, 255 FAM NFQ-MGE

4 Ad sample (-) "RGB(0,0,255)" IPC ”RGB(O 255, 0)" IPC VIC NFQ-MGE

4 Al sample (-) "RGB(0,0,255)" TGFB "RGB(0;0,2559"  UNKNOWN FAM NFQ-MGE

quencher
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About Melt Curve Experiments

This chapter covers:

B OV eIV W ottt e e e e 5
B Aboutthe Melt Curve reactionsS. .. ..o ii it e e 5
B About the example experiment ............ ... .. i i 6

IMPORTANT! First-time users of the QuantStudio™ 6 and 7 Flex Real-Time PCR System
Software, please read Booklet 1, Getting Started with QuantStudio™ 6 and 7 Flex Real-
Time PCR System Software Experiments and Booklet 7, QuantStudio™ 6 and 7 Flex Real-
Time PCR System Software - Appendixes of this binder thoroughly. The booklet provides
information and general instructions that are applicable to all the experiments
described in this binder.

Note: For more information about any of the topics discussed in this guide, access the
Help from within QuantStudio™ 6 and 7 Flex Real-Time PCR System Software by
pressing F1, clicking ) in the toolbar, or selecting Help » QuantStudio™ 6 and 7 Flex
Real-Time PCR System Software Help.

Overview

A Melt Curve, also known as dissociation curve, is a plot of data collected during the
Melt Curve stage of an experiment. Melt Curve experiments are performed to
determine the melting temperature (Tm) of a target nucleic acid sequence or to identify
nonspecific PCR amplification.

Melting temperature (Tm) is the temperature at which 50% of the target DNA is
double-stranded and 50% is dissociated into single-stranded DNA.

The melting temperature and non-specific PCR amplification can be identified as
peaks in the melt curve stage of an experiment.

About the Melt Curve reactions
With Melt Curve experiments, the reactions consist of completed PCR reactions that
contain amplified products and SYBR® Green dye to detect double-stranded DNA.

The QuantStudio™ 6 and 7 Flex Real-Time PCR System Software detects the number of
fluorescence peaks, determines the melting temperature (Tm) for each peak, and plots
the results in a melt curve.

The fluorescence data collected during the QuantStudio™" 6 or 7 Instrument run are
stored in an experiment data file (*.eds).
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Chapter 1 About Melt Curve Experiments

About the example experiment

There are two types of reactions in a Melt Curve experiment:

* Unknowns - Wells containing PCR product with unknown melting
temperature(s).

* Negative controls - Wells containing buffer or water instead of sample. Negative
controls should contain no double-stranded DNA.

About the example experiment

To illustrate how to perform Melt Curve experiments, this guide leads you through the
process of designing and performing an example experiment. The example experiment
represents a typical setup that you can use to quickly familiarize yourself with a
QuantStudio™ 6 and 7 Flex Real-Time PCR System Software.

The objective of the example Melt Curve experiment is to investigate the melting
temperature of Target 1, and verify that no extraneous peaks appear. The SYBR Green
reagent is used to detect the melting temperature stage.

Note: The example experiment performs a melt curve analysis on PCR products from
a PCR performed on the QuantStudio " 6 or 7 Instrument or on another thermal cycler.
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Design the Experiment

This chapter explains how to design the example experiment from the Experiment
Setup menu.

Define the experiment properties. . ... 7
Define targets and samples. .. ... 8
Assign targets and samples. .. ... 9
Setuptherunmethod ......... ... ... ... 10
For more information.......... ... . i 11

Note: To automatically export the analyzed data to a specified location, select the Auto
Export task from the Export screen, before running the experiment. For more
information on Auto Export, refer to Chapter 2 in Booklet 1, Getting Started with

QuantStudio

™

6 and 7 Flex Real-Time PCR System Software Experiments.

Define the experiment properties

Click Experiment Setup » Experiment Properties to create a new experiment in the
QuantStudio™ 6 and 7 Flex Software. Enter:

Field or Selection Entry

Experiment Name

QuantStudio_384-Well_SYBR_Green_Melt_Example

Barcode Leave field empty
User Name Example User
Comments Melt Curve example

Instrument type
Block
Experiment Type

QuantStudio™ 6 Flex System
384-Well Block
Melt Curve

Reagents SYBR® Green Reagents
Ramp speed Standard

Include PCR Unchecked

Reagent information NA

Save the experiment.
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Chapter 2 Design the Experiment

Define targets and samples

Your Experiment Properties screen should look like this:

How do you want to identify this experiment?

* Experiment Name: [QuantStudio_284-Well_SYBR_Green_Melt Example Comments: [Malt Curve Experiment ~
Barcode:
User Name: Exam;:le User o]

Which instrument type are you using to run the experiment?

v QuantStudio™ 6 Flex System | [ QuantStudio™ 7 Flex System ]

[~ 384-Well | [ a6-well (0.2mL) ] [ Fast 96-Well (0-1mL) ]

[ Standard Curve ] [ Relative Standard Curve ] [ Comparative CT (AACT) ] s Melt Curve

[ Genotyping J [ Presence/Absence ]

Which reagents do you want to use to detect the target sequence?

v SYBR® Green Reagents ) [ Other ]

What properties do you want for the instrument run?

[~ Standard ) Fast ]

O Include PCR

What is the reagent information?

Maw

Type Name Part Number Lot Number Expiration Date

Define targets and samples

Click Define to access the Define screen. Enter:

1. Targets
Target Name Reporter Quencher Color
Target 1 SYBR None ]

2. Samples

Sample Name Color

Sample 1

3. Dye to be used as a Passive Reference
ROX

4. Custom Task Name
Not applicable
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Chapter 2 Design the Experiment

Assign targets and samples

Your Define screen should look like this:

Import from Library — Delete

Target Name Reporter Quencher Color

Target 1 SYBR + |Hone ~H v

Sample Name

Sample 1

F!, Impart fram File

Passive Reference

ROX v

Custom Task Name

Color Icon Char

Assign targets and samples

Click Assign to access the Assign screen. Enter the targets and samples:

Target Name

Sample

Well Number

Task

SYBR Sample 1

A1 - P24 (Columns 1 -24)

Unknown

Your Assign screen should look like this:

Targets — 04— __[Ta] ¢

v .Target 1 IE!! ;

Samples ——o " "
ame

R
» CHEN N I N O O O O O
o [N (NN N (NN (N (I I I O e O

<[ NN N N N N O e (O O

Illomu-rs-n-n-__u-_n—n-|

W | |Samp|e 1

-

4

wels: [[] 384 [ o
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Chapter 2 Design the Experiment

Set up the run method

Set up the run method

Set the thermal Click Run Method to access the Run Method screen. Set the thermal profile under the
profile Graphical View tab. Enter:

* Reaction Volume Per Well: 20 uL

e Thermal Profile

Stage Step Ramp rate Temperature Time
Melt Curve Stage Step 1 1.6°C/s 95°C 15 seconds
Step 2 1.6°C/s 60°C 1 minute
Step 3 0.05°C/s 95°C 15 seconds
(Dissociation)
Edit the ramp Edit the ramp increment for a melt curve (dissociation) step.

increment 1

Select a melt curve ramp increment method:

Step and Hold — Increases or decreases the ramp temperature in 0.1°C
increments over the time (duration) for the melt curve ramp.

Continuous (default) — Increases or decreases the ramp rate in 0.005°C per
second increments.

2. If you selected the Step and Hold ramp increment method, edit the melt curve
ramp time:

To increase or decrease the time in 1-minute or 1-second increments, click the
Step and Hold field, select the minutes or seconds, then use the up or down
arrow keys or click the up or down buttons in the field until you reach the
desired time.

To enter the desired time, click the Step and Hold field, select the minutes or
seconds, then enter the desired time.

3. Edit the melt curve ramp increment:

To increase or decrease the ramp increment, click the melt curve
(dissociation) ramp increment in the thermal profile, then use the up or
down arrow keys or click the up or down buttons in the field until you reach
the desired value.

To enter the desired ramp increment, click the melt curve (dissociation) ramp
increment in the thermal profile, select the value in the field, then enter the
desired value.

Note: To view the maximum and minimum allowed values, place the cursor
over melt curve (dissociation) ramp increment in the thermal profile and
wait for the tooltip to pop up.
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Chapter 2 Design the Experiment
For more information
Your Run Method screen should look like this:

Run Method

Reaction Yolume per wel: I 20 {L

Gra Optical Filkers

Melt Curve Stage

€ Step and Hold ID:US 3:

& Continuous

180 *C—] 95.0 °C 95.0 °C
I
00:15
75 °C | = L)
1B s 0.05 °Cfs
50,0 °C
50 °C_| 01:00
25 "C |
0°"C_|
Stepl Step? Stepd (Dissnciation)

4
[ Legend

Data Collection On | = Data Collection Off A AutoDelta On A AutoDelta OFf

For more information

For more information on... Refer to Publication
number
Consumables Chapter 1in Booklet 1, Getting Started with QuantStudio™ 6 and 7 4489822

Flex Real-Time PCR System Software Experiments

Appendix A in Booklet 7, QuantStudio™ 6 and 7 Flex Real-Time PCR
System Software Experiments - Appendixes

Using Alternative Setup Chapter 3 in Booklet 1, Getting Started with QuantStudio™ 6 and 7 4489822
Flex Real-Time PCR System Software Experiments
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For more information
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Prepare the Reactions

This chapter explains how to prepare the reactions for running a PCR prior to running
a Melt Curve.

To perform a Melt Curve experiment without running a PCR, use the reaction plate
containing the PCR product.

Note: The example experiment performs a melt curve analysis on PCR products from
a PCR performed on the QuantStudio™ 6 or 7 Instrument or on another thermal cycler.

This chapter covers:

B Assemble required materials .......... ... .. o ool 13

Prepare the sample dilutions ........... ... ... ... i 13
B Prepare the reaction mix (“cocktail mix”)............ ..o i it 14
B Preparethereactionplate ........... ... i 14
B Formoreinformation. ........ ... .o i 15

Assemble required materials

e [Items listed in Booklet 1, Getting Started with QuantStudio™ 6 and 7 Flex Real-Time
PCR System Software Experiments

¢ Sample 1

¢ Example experiment reaction mix components:
— Power SYBR® Master Mix
— Target - Assay Mix Forward primer (10 uM)
— Target - Assay Mix Reverse primer (10 uM)

Prepare the sample dilutions

The stock concentration of each sample is 100 ng/uL. After you dilute the sample
according to the Sample Dilutions Calculations table, the sample will have a
concentration of 10 ng/pL. Add 2 uL to each reaction.

Stock Samole Diluent Total volume
Sample hame concentration volumep[ L) volume (pL) of diluted
(ng/pL) H H sample (L)

Sample 1 100.0 2 18 20

QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Getting Started Guide for Melt Curve Experiments 13



Chapter 3 Prepare the Reactions

Prepare the reaction mix (“cocktail mix”]

Prepare the reaction mix (“cocktail mix”)

Procedure

Calculations

The following table lists the universal assay conditions [volume and final
concentration for using the Power SYBR Master Mix (2X)].

Volume for 384

Reaction Component Volume for 1 reactions + 10%
P reaction (pL) excess (uL) = 424
reactions
Power SYBR®Green PCR Master Mix (2X) 10 4240
Forward primer (10 pM]) 0.1 42.4
Reverse primer (10 uM) 0.1 42.4
Water 7.8 3307.2
Total reaction mix volume 18 7632

1. Label an appropriately sized tube for the reaction mix: Power SYBR Reaction Mix.
2. Add the required volume of each cocktail mix component to the tube.

3. Mix the cocktail thoroughly by gently pipetting up and down several times, then
cap the tube.

4. Centrifuge the tube briefly to remove air bubbles.

5. Place the cocktail mix on ice until you prepare the reaction plate.

Determine the quantity of primer to be added to the reaction mix by performing the
following calculation:

Concentration (initial) C1 x Volume (primer stock) V1 = Concentration (final) C2 x
Volume (final reaction) V2

(10 uM) x (V1) = (0.05 uM) (20 pL)
V1 =(0.05x 20) /10 =0.1

Prepare the reaction plate

14

1. Add reaction mix and sample to a tube.

a. To an appropriately sized tube, add the volumes of reaction mix and sample

listed below.
Reaction
. Sample
Unknown . . mix

Tube . Reaction mix Sample volume

reaction volume (uL)

(L) H
1 Target 1 Power SYBR 7632 Sample 1 848
reaction mix

QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Getting Started Guide for Melt Curve Experiments
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Chapter 3 Prepare the Reactions

For more information

b. Mix the reactions by gently pipetting up and down, then cap the tubes.

c. Centrifuge the tubes briefly to remove air bubbles.
Pipet 20 pL of the unknown (sample) reaction to each well in the reaction plate.
Seal the reaction plate with optical adhesive film.
Centrifuge the reaction plate briefly to remove air bubbles.

Confirm that the liquid is at the bottom of each well of the reaction plate. If not,
centrifuge the reaction plate again at a higher speed and for a longer period of
time.

Until you are ready to perform the PCR run, place the reaction plate at 4°C, in the
dark.

Run the PCR.

After the PCR is completed, use the same reaction plate containing the PCR
product to run the Melt Curve as described in Chapter 4.

For more information

For more information on... Refer to... Publication
number
Assigning the reaction plate Chapter 2 in Booklet 1, Getting Started with QuantStudio™ é and 7 4489822
components Flex Real-Time PCR System Software Experiments
Sealing the reaction plate Chapter 2 in Booklet 1, Getting Started with QuantStudio™ 6 and 7 4489822
Flex Real-Time PCR System Software Experiments
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For more information
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Run the Experiment

This chapter explains how run the example experiment on the QuantStudio™" 6 or 7
Instrument.

This chapter covers:
B o Startthe run. . ... e 17
B Monitor the run. . ... .. 17

IMPORTANT! Run the experiment at the same ambient temperature at which you
calibrated the instrument. Extreme variations in ambient temperature can affect the
heating and cooling of the instrument and influence experimental results.

IMPORTANT! Do not attempt to open the access door during the run. The door is
locked while the QuantStudio " 6 or 7 Instrument is in operation.

Start the run

1. Open the Melt Curve example file that you created using instructions in
Chapter 2.

IMPORTANT! The example experiment includes the melt curve analysis of a PCR
product from PCR on the QuantStudio™ 6 or 7 Instrument, or another thermal
cycler. To run a Melt Curve on the example file you created in Chapter 2, ensure
that PCR has already been performed on the reaction plate you load into the
instrument. Absence of the PCR product will lead to no results in the Dissociation
Step of the Melt Curve Stage.

2. Load the reaction plate, containing the PCR product, into the instrument.

3. Start the run.

Monitor the run

Monitor the example experiment run:

* From the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software using the
Run screen, while the experiment is in progress.

e From the Instrument Console of the QuantStudio'" 6 and 7 Flex Real-Time PCR
System Software (to monitor an experiment started from another computer or

from the QuantStudio™" 6 or 7 Instrument touchscreen).

e From the QuantStudio™ 6 or 7 Instrument touchscreen.
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Chapter 4 Run the Experiment
Monitor the run

From the 1. In the Instrument Console screen, select the instrument icon.
Ig Strurlner}t th 2. Click Manage Instrument or double-click on the instrument icon.
onsotle o e
QuantStudio™ 6 3. On the Manage Instrument screen, click Monitor Running Instrument to access
and 7 Flex Real- the Run screen.
Time PCR System )
Software View the Melt Curve

You can view the progress of the run in real time. During the run, periodically view all
the three plots available from the QuantStudio™ 6 and 7 Flex Real-Time PCR System
Software for potential problems.

Click Melt Curve from the Run Experiment Menu, select the Plate Layout tab, then
select the wells to view.

The following is an image of the Melt Curve as it appears at the end of the example
experiment.

Melt Curve Plot

Plot Settings
Plot Target [All ~ | Color |Sample v 5 i Km’
p e
[] Save current settings as the defauft 1 2 3 4 5 & 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24
. e . m— AT T R R R R R R R R R TR R R TR R R R R R R R R
PP E G B atatatatatetatatatatatatatatetatatatatetatalals
Melt Curve Plot [ T [ o [ o e o e [ | | e e | e | e
D[ v ™ 7 o wm R i R TR e R R TR R e TR R R R R R e e
6.0
E[m m v o v o v v e m e e v e Pm em e e e e e e
& 50 Flmm v o o e e e R R R R TR R R R e R R R R e e
{7 o o o e S ) S S S e s e s (N | | £, Y Y T T A AT, T, AT, S, T, S, T, 6, 4, S, 4T, g, T, ST, S, S, S,
£ 40 G 7 T T e P P P T P e P P P P e P e P e e
a
2 A EOOOOOOOOOOOOOOOOOOOOOOE
2 a0
N T e R e TR I S T T I T I e
g
£ o 1| 7 v e e T e e P P T Pm e P e P P e P e
=
0 I e e e e I o S
L ™ wa e e m T e R T R R R R R R R R R R R R R e
00
M| 7= P R T P e P e P e e P e P e
8.0 0 7 a0 850 .o @0 N ™ v v v e e m R R R R eR R R R R R RR RR RR R R R R
Temperature (°C) | OOOOOOOOOOOOOOOHDOHOOOOOOE
e
Sample 1 P e v v o 7 o v v v T m e e v e P e e P e e e e
Wells: m 384 D 1] 0 Empty
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Chapter 4 Run the Experiment
Monitor the run

View the Temperature Plot
Click Temperature Plot from the Run Experiment Menu.

The following is an image of the Temperature Plot screen as it appears during the
example experiment.

Temperature Plot Current Temperatures

- 5 B #y # B [ cover
/O /O = 1 v .Sarnple
Temperature Plot

-+ Block
110
100 : B
B
°| e
&0 ~
~
» 70 /
g &0 L/
S = 1
- i
w .
30 \
20
10
o Temperature Plot
00:00:00 00:04:10 00:08:20 00:12:30 00:16:40 00:20:50 00:25:00 00:29:10 00:33.20 00:37:30 00:41:40 00:45:50 00:50:00 00:54:10 00:58:20 .
Time Wi 1 Hour -
Fixed Yigw [~
A L5
Note: The Sample temperature displayed in the Current Temperatures group is an
estimated value.
View the Run Method
Click Run Method from the Run Experiment Menu.
The following is an image of the Run Method screen as it appears in the example
experiment.
Adjust # of Cycles: I
Melt Curve Stage
7 &dd Melt Curve Stage to End
@ step and Haold ID:05 : I [T £dd Holding Stage to End

& Continuous

7 &dd Infinite Hold to End

400 °C |

05,0 =

-~ I

o015

f.05 “Cfs

Stept

Step2 Stepd (Dissociation)

4

’— Legend

Data Colection On ~ = Data Collection OFF A AutoDelta On A AutcDelta OFf
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Monitor the run

Run Data Report

Experiment Mame:
Start Time:

Stop Time:

Run Duration:

User Mame:
Instrument Name:
Firmware Version:
Software Version:
Instrument Serial Number:
Sample Volume:
Cover Temperature:

Block Type:

Errors Encountered:

Chapter 4 Run the Experiment

View run data

Click View Run Data from the Run Experiment Menu.

The following is an image of the View Run Data screen as it appears in the example

experiment.

QuantStudio_384-Wel_SYBR_Green_Melt_Example
04-30-2010 14:41:31 5GT
04-30-2010 14:56:52 5GT
15 minutes 20 seconds
DEFAULT

278880026

100

N/A

278880026

20.0

105.0

384-Wel Block

From the

QuantStudio™ 6 or
7 Instrument

You can also view the progress of the run from the QuantStudio'" 6 or 7 Instrument
touchscreen.

The following are images of the Run Method screen on the QuantStudio™" 6 or 7

touchscreen Instrument touchscreen:
Experiment View
® Time View Ht|  Experiment View
Run Started: July 06 2013 - 05:48PM Sample: 0.0 °C
Reaction Volume: 20 pL Heated Cover [Set Point): 105.0 °C (105.0 °C)
Time Remaining: 01:15:39
Stage 1 Stage 2
X1 3of40
95.0 °C 95.0 °C
10:00 0:15 \ 60.0 °C
1:00
o
July 06 2013 - 05:48PM 0
Heated cover reached target temperature.
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Chapter 4 Run the Experiment
Monitor the run

Time View
®© Time View t] Experiment View
Run Started: July 06 2013 - 05:48PM Sample: 95.0 °C
Reaction Volume: 20 pL Heated Cover [Set Point): 105.0 °C (105.0 °C)

Stage /Step /Cycle: 1/2/1

01:31:52

@ Remaining Time Elapsed Time

July 06 2013 - 05:48PM 0

Heated cover reached target temperature.
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Monitor the run
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Review Results and Adjust
Experiment Parameters

In Section 5.1 of this chapter you review the analyzed data using several of the analysis
screens and publish the data. Section 5.2 of this chapter walks you through the process
of modifying experiment parameters to troubleshoot problems with experiment
results before rerunning an experiment.

This chapter covers:

Section 5.1 Review Results ........ooiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiin, 25
B Analyze the example experiment. . .......... ... ..o i 25
View the Melt Curve Plot ....... ... . .. i 25

B Identify well problems using the Well Table .............................. 27
B Confirm accurate dye signal using the Multicomponent Plot................ 29
B Determine signal accuracy using the Raw DataPlot ....................... 30
B Review the flagsinthe QCSummary ............ ..., 32
B Formore information. ......... ... i 33
Section 5.2 Adjust parameters for re-analysis of your own experiments. . ....... 35
B Adjustanalysissettings.......... ... ... i 35
B Formoreinformation.......... ... .. i 38
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Section 5.1 Review Results

Analyze the example experiment

1. Open the example experiment file that you ran in Chapter 4.

2. Click Analyze. The software analyzes the data using the default analysis settings.

Note: You can also access the experiment to analyze from the Home screen.

View the Melt Curve Plot

View the Melt Curve Plot as the Derivative Reporter (-Rn) versus the Temperature Plot
generated by the target.

The Melt Curve screen displays the melt curve of the targets in the selected wells. Use
the Melt Curve plots to confirm the results of the experiment:

¢ Normalized Reporter (Rn) vs. Temperature — This plot displays the fluorescence
signal from the reporter dye normalized to the fluorescence signal of the passive
reference. You can use this plot to see the change in Rn with change in the
temperature. You cannot use this plot to determine the Tm of the target.

* Derivative Reporter (-Rn) vs. Temperature — This plot displays the derivative
reporter signal in the y-axis. The peaks in the plot indicate significant decrease in
SYBR® Green signal, and therefore the Tm of the target.

Purpose The purpose of viewing the Melt Curve Plot for the example experiment is to review
the melting temperature of the target.

To view and assess 1. From the Experiment menu pane, select Analysis » Melt Curve Plot.
the Melt Curve Note: If no data are displayed, click Analyze.

2. Enter the Plot Settings:

Menu Selection
Plot Derivative Reporter
Target All
Plot Color Target
E Check (default)

(This is a toggle button. When the
legend is displayed, the button
changes to Hide the plot legend.)

QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Getting Started Guide for Melt Curve Experiments 25



Melt Curve Plot

Chapter 5 Review Results and Adjust Experiment Parameters
View the Melt Curve Plot

The following is an image of the Melt Curve for the example experiment:

Plot Settings

Plot Derivative Report... v | Target |All

[] Save current settings as the default

w| Color [Target v

Melt Curve Plot

Derivative Reporter {(~Rn’)

Temperature (*C)

Leges
. Target 1

Well Summary: In Plate: 384

Tips for viewing
melt curves in your
own experiments

Set Up: 384 Anzhyzed: 384 Flagged: Omitted by Anahysis: (I Omitted Manually: 0 Samples Used: 1 Targets Used: 1

When you analyze your own Melt Curve experiment, look for wells with multiple
peaks, indicating non-specific amplifications or primer dimer formation.

If your experiment does not amplify properly or indicates non-specific amplification,
troubleshoot by manually adjusting the Melt Curve settings (see “Adjust analysis
settings” on page 35).
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Section 5.1 Review Results
Identify well problems using the Well Table

Identify well problems using the Well Table

Example
experiment values
and flags

View the well table

Review the details of the experiment results in the well table and identify any flagged
wells. The well table displays the assay-specific setup and analysis properties for the
experiment in a tabular format.

For the example experiment, confirm that no wells of the reaction plate triggered
QC flags

1. Select the Well Table tab.

2. Click the Flag column header to sort the data so that the wells that triggered flags
appear at the top of the table.

3. Confirm the integrity of the controls:

a. From the Group By menu, select Task to organize the table rows by their
function on the reaction plate.

b. Confirm that each of the controls do not display flags ( 1. ).

The following is an image of the well table of the example Melt Curve experiment.

e
Well Table

»| Plate Layout

Wels ¥  Group By ¥ Expand Al B Collapse All

# Wel Ot Flag |Samp...| Target Mame Task Dyes Tl Tm2 Tm3 Comments

1 Al r Sampl... SYER LMKV SvBR-Mone 79,894 j

2 A2 r Sampl... SYER LMKV SvBR-Mone 79,894

3 A3 r Sampl... SYER LMK SYBR-Mone 79,894

4 A4 r Sampl... SYER LMK SYBR-Mone 79,894

5 A5 r Sarmpl... SYBR UNKMOWN SYBR-Mone 79.894

6 AR r Sarmpl... SYBR UNKMOWN SYBR-Mone 80.06

7 A7 r Sarmpl... SYBR UMKMNOWN SYBR-Mone 79.894

8 AR r Sarmpl... SYBR UMKMNOWN SYBR-Mone 79.894

9 a9 r Sarmpl... SYBR UMKMNOWN SYBR-Mone #9.894

10 210 r Sarmpl... SYBER UMKMNOWN SYBR-Mone 80.06

11 Al11 r Sarmpl... SYBR UNKNOWN SYBER-Mone 80.06

12 A1z r Sarmpl... SYBR UNKNOWN SYBER-Mone 80.06

13 413 I Sarnpl... SYER UNKMOWEN SYBR-Mone 80.06

14 al14 I Sarnpl... SYER LMKV SYBR-Mone 80.06

15 a15 I Sarnpl... SYER LMKV SYBR-Mone 80.06

15 Al6 r Sampl... SYER LMKV SvBR-Mone 80.06

17 a17 r Sampl... SYER LMKV SvBR-Mone 80.06

18 a1s r Sampl... SYER LMK SYBR-Mone 79,894

19 &19 r Sampl... SYER LMK SYBR-Mone 79,894

20 A20 r Sarmpl... SYBR UNKMOWN SYBR-Mone 79.894

21 A1 r Sarmpl... SYBR UNKMOWN SYBR-Mone 79.894

22 A2 r Sarmpl... SYBR UMKMNOWN SYBR-Mone 79.894

23 A23 r Sarmpl... SYBR UMKMNOWN SYBR-Mone 79.894

24 A24 r Sarmpl... SYBR UMKMNOWN SYBR-Mone #9.894

— - i ey ey =
Well Summary: In Plate: 384 Set Up: 384 Analyzed: 334 Flagged: 0 Omitted by Analysis: 0 Omitted Manually: O Samples Used: 1 Targets Used: 1
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The following table gives the description of each column in the well table.

Column Description
Well The position of the well on the reaction plate.
Omit A check mark indicates that the well has been

removed from the analysis.
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Chapter 5 Review Results and Adjust Experiment Parameters
Identify well problems using the Well Table

Column Description

Flag A 41 indicates that the well triggered the number
of flags listed inside the symbol.

Sample Name The name of the sample.

Target Name The name of the target evaluated by the well.

Task The task assigned to the well (Unknown, Negative
Control, or Positive Control).

Dyes The name of the reporter and quencher dyes of the
associated sample for the target evaluated by the
well.

Tm1 The melting temperature of the target.

Tm?2 The second melting temperature (for targets with

multiple melting temperatures).

Tm3 The third melting temperature (for targets with
multiple melting temperatures).

Tips for viewing When you analyze your own experiment:
well tables your * Review the data for the Unknown samples. For each row that displays / in the
own experiments Flag column, note the data and the flag(s) triggered by the associated well.

28

* Select areas of the table or wells of a specified type by:

— Left-clicking the mouse and dragging across the area you want to select an
area of the table.

— Selecting Sample, Target, or Task from the Select Items menu in the Well
Table tab, then selecting the sample, target, or task name from the second
Select Items menu to select wells of a specific type using the well-selection
tool.

* Group the rows of the plate layout by selecting an option from the Group By
menu. You can then collapse or expand the lists either by clicking the +/- icon next
to individual lists, or by clicking [E Collapse All or [ Expand AlL

¢ Omit a well from the analysis by selecting the Omit check box for that well. To
include the well in the analysis, deselect the Omit check box.

Note: You must reanalyze the experiment each time you omit or include a well.
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Section 5.1 Review Results 5
Confirm accurate dye signal using the Multicomponent Plot

Confirm accurate dye signal using the Multicomponent Plot

The Multicomponent Plot screen displays the complete spectral contribution of each
dye in a selected well over the duration of the PCR run.

Purpose In the Melt Curve example experiment, you review the Multicomponent Plot screen

for:

View the 1.

Multicomponent
Plot

ROX™ dye (passive reference)
SYBR® dye (reporter)
Spikes, dips, and/or sudden changes

From the Experiment Menu pane, select Analysis » Multicomponent Plot.
Note: If no data are displayed, click Analyze.
Display the unknown wells in the plate layout to display the corresponding data
in the Multicomponent Plot screen:
a. Click the Plate Layout tab.

b. Select one well in the plate layout; the well is shown in the Multicomponent
Plot screen.

Note: If you select multiple wells, the Multicomponent Plot screen displays
the data for all selected wells simultaneously.

From the Plot Color drop-down menu, select Dye.

Click E Show a legend for the plot (default).

Note: This is a toggle button. When the legend is displayed, the button changes to
Hide the plot legend.

Check the ROX dye signal. In the example experiment, the ROX dye signal
remains constant throughout the PCR process; a constant ROX dye signal
indicates typical data.

Check the SYBR® dye signal. In the example experiment, because the PCR run has
already been completed, the SYBR® dye signal shows gradual decrease
throughout the run and a sudden dip in the fluorescence at one point; the sudden
drop in the SYBR® dye signal indicates the melting temperature of the target.
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5 Chapter 5 Review Results and Adjust Experiment Parameters
Determine signal accuracy using the Raw Data Plot

The following is an image of the Multicomponent Plot screen for the example
experiment:

Multicomponent Plot
Plot Settings

Flot Color |Dye -

[ Save current settings as the default

£ L B HBEEE

Multicomponent Plot
900,000
500,000
700,000
600,000

500,000

orescence

400,000

U

- 300,000

200,000

100,000 —

o

o 20 40 &0 80 100 120
Cycle

Legerd

Syor RO

Well Summary: In Plate: 384 Set Up: 384 Analyzed: 384 Flagged: 0 Cmitted by Analysis: 0 Omitted Manually: 0 Samples Used: 1 Targets Used: 1

Tips for confirming ~ When you analyze your own Melt Curve experiment, look for:

dye accuracy in * Passive reference — The passive reference dye fluorescence level should remain
your own relatively constant throughout the PCR process.
experiment * Reporter dye — The reporter dye fluorescence level should display a flat region

corresponding to the baseline, followed by a rapid rise in fluorescence as the
amplification proceeds. If the Melt Curve is being performed post-PCR, then
there should be a gradual decrease in fluorescence and a sudden dip indicating
the melting temperature of the target.

* Irregularities in the signal — There should not be any spikes, dips, and/or sudden
changes in the fluorescent signal.

Determine signal accuracy using the Raw Data Plot

The Raw Data Plot screen displays the raw fluorescence signal (not normalized) for
each optical filter for the selected wells during each cycle of the real-time PCR.

About the example  In the Melt Curve example experiment, you review the Raw Data Plot screen for a
experiment stable increase in signal (no abrupt changes or dips) from the appropriate filter.

View the Raw Data 1. From the Experiment Menu pane, select Analysis » Raw Data Plot.
Plot Note: If no data are displayed, click Analyze.

2. Display all 384 wells in the Raw Data Plot screen by clicking the upper left corner
of the plate layout in the Plate Layout tab.

30 QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Getting Started Guide for Melt Curve Experiments



Section 5.1 Review Results
Determine signal accuracy using the Raw Data Plot

3. Click E Show a legend for the plot (default). The legend displays the color
code for each row of the reaction plate (see the legend in the Raw Data Plot shown

below).

4. Click and drag the Show Cycle pointer from cycle 1 to cycle 130. In the example
experiment, the signal from filter 1, which corresponds to the SYBR® dye filter, is

stable throughout.

Note: The readings shown below are from the example experiment. Actual

results will vary with individual experiment setup.

Note: The cycle number in the Melt Curve represents the number of data

collection points for that experiment.

The following is an image of the Raw Data plot for the example experiment:

450,000
400,000
350,000
300,000
250,000
200,000
150,000
100,000

50,000

Raw Data Plot <
AP alh R
Raw Data Plot
950,000
900,000
850,000
800,000
750,000
700,000
650,000
600,000
$50,000
g 500,000

0

Filter

M. BB WC WD ME WF WG MWH ii
i ) B . Ey By Ho He =
Options
Show Cycle 130 )

] | \ \ \ \ 00 o
1 50 100 130

well Summary: In Plate: 384 Set Up: 384 Analyzed: 354

Flagged: ) Omitted by Analyss: 01 mitted Maruslly: 01 Samples Used: 1 Targets Used: 1

The filters used for the example experiment are:

PCR Filter

m1(520+15) m2(558+11)

x1(470+15)

Emission Fiter

m3(586+10) ma(623+14) mS(682+14) m6(711+12)

¥2(520+10)

x3(550+11)

¥4(580+10)

Excitation Filter

X5(640+10)

¥6(662+10)

Melt Curve Filter

ml(520+15) m2(558+11)

K1(470£15)

Emission Fizer

m3(586+10) ma(623+14) mS(682+14) m6(711+12)

x2(520+10)

¥3(550£11)

Excitation Fitter

x4(580+10)

¥5(640£10)

X6(562+10)

QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Getting

Started Guide for Melt Curve Experiments
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5 Chapter 5 Review Results and Adjust Experiment Parameters
Review the flags in the QC Summary

Tips for When you analyze your own Melt Curve experiment, look for the following in each
determining signal filter:

accuracy in your ¢ Characteristic signal growth

own experiments * No abrupt changes or dips

Review the flags in the QC Summary

The QC Summary screen displays a list of the QuantStudio™" 6 and 7 Flex Software
flags, including the flag frequency and location for the open experiment.

View the QC 1. From the Experiment Menu pane, select Analysis » QC Summary.
Summary Note: If no data are displayed, click Analyze.

2. Review the Flags Summary.

Note: A 0 displayed in the Frequency column indicates that the flag does not
appear in the experiment. If the frequency is >0, the flag appears somewhere in
the experiment; the well position is listed in the Wells column.

In the example experiment, there are no flagged wells.

3. In the Flag Details table, click each flag with a frequency >0 to display detailed
information about the flag. In the example experiment, the Frequency column
displays 0 for the three flags NOSIGNAL, OFFSCALE, and MTP.

4. (Optional) For those flags with frequency >0, click the troubleshooting link to view
information on correcting the flag.

The following is an image of the QC Summary for the example experiment:

Flag Details
Flag: Descrintion Frequency wiels
NOSIGMNAL Mo signal in well (]
(OFFSCALE Fluorescence is offscale 0
MTR Multiple Tm peaks o

Flag: MCSIGMAL—Mo signal in well
Flag Detail: The well produced very low or no flucrescence,
Flagged Wells: hone
Views MOSISHAL Troubleshooting Information

Total wels: 324 | Processed wells: 284 Manually Omitted wels: 0 | Targets Used: 1
wiels Set Up: 384 | Flagged wells: 0 Analysis Omitted els: 0 | Samples Used: 1
well Summary: In Plate: 384 Set Up: 384 Analyzed: 334 Flagged: 0 Ornitted by Analysic: 0 Ornitted Manwally: 0 Samples Used: 1 Targats Used: 1
Possible flags For Melt Curve experiments that do not include amplification, the flags listed below

may be triggered by the experiment data.
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For more information

Flag

Description

Pre-processing flag

OFFSCALE

‘ Fluorescence is offscale

Primary analysis flag

NOSIGNAL

‘ No signal in well

Secondary analysis flag

MTP

Multiple Tm peaks

For Melt Curve experiments that include amplification, the flags listed below may be
triggered by the experiment data.

Flag

Description

Pre-processing flag

OFFSCALE

Fluorescence is offscale

Primary analysis flags

BADROX

Bad passive reference signal

NOAMP
NOISE
SPIKE
NOSIGNAL

No amplification
Noise higher than others in plate
Noise spikes

No signal in well

EXPFAIL

Exponential algorithm failed

BLFAIL

Baseline algorithm failed

THOLDFAIL

Thresholding algorithm failed

CTFAIL

Ct algorithm failed

Secondary analysis flags

MTP

Multiple Tm peaks

OUTLIERRG

Outlier in replicate group

AMPNC

Amplification in negative control

HIGHSD

High standard deviation in replicate group

For more information

For more information on... Refer to... LU
number
Publishing data Chapter 2 in Booklet 1, Getting Started with QuantStudio™ é and 7 Flex 4489822
Real-Time PCR System Software Experiments
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For more information
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Section 5.2 Adjust parameters for re-analysis of your own experiments 5
Adjust analysis settings

Section 5.2 Adjust parameters for re-analysis of your
own experiments

Adjust analysis settings

The Analysis Settings dialog box displays the analysis settings for the Melt Curve and
flags.

If the default analysis settings in the QuantStudio™" 6 and 7 Flex Software are not
suitable for your own experiment, you can change the settings in the Analysis Settings
dialog box, then reanalyze your experiment.

View the analysis 1. From the Experiment Menu pane, select Analysis.

settings 2. Click Analysis » Analysis Settings to open the Analysis Settings dialog box.

In the example experiment, the default analysis settings are used for each tab:

Melt Curve Settings

Cr Settings

Flag Settings

Advanced Settings

Note: The Cp Settings and Advanced Settings tabs appear in the Analysis
Settings dialog box only if the Melt Curve experiment you are performing
includes the PCR process.

Note: Select the Include PCR check box on the Experiment Properties screen
to include amplification in your Melt Curve experiment.

The following is an image of the Analysis Settings dialog box for a Melt Curve
experiment:

4 Analysis Settings for QuantStudio_384-Well_SYBR_Green_Melt_Example

fferent settings for a target, select the target from the table, deselect Enable

~— Select a Target ~— Multi-Peak Setting for Target 1

Target Multi-Peak Calling Peak Level (%)
Enable Multi-Peak Caling

Target 1 Enabled 10.00 -

Peak level relative to the dominant peak (%) : [10.00

Save to Library Load from Library Revert to Default Analysis Settings Apply Analysis Settings W
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Adjust analysis settings

3.

View and, if necessary, change the analysis settings (see “Adjust analysis settings”
below).

Note: You can save the changes to the analysis settings to the Analysis Settings
Library for later use. For more information, see About the Analysis Settings
Library in Booklet 1, Getting Started with QuantStudio'" 6 and 7 Flex Real-Time PCR
System Software Experiments.

Click Apply Analysis Settings to apply the current analysis settings.

Note: You can go back to the default analysis settings, by clicking Revert to
Default Analysis Settings.

Adjust analysis You may change the following settings:

settings

Melt Curve Settings

Use this tab to:

Enable or disable multi-peak calling.

— Select the Enable the Multi-Peak Calling check box if you expect to amplify
more than 1 PCR product and you want to determine the Tm for more than
one peak.

— Deselect the Enable the Multi-Peak Calling check box if you expect to
amplify 1 PCR product and you do not want to determine the Tm for more
than one peak.

Enter a value (in percentage) for the peak level relative to the dominant peak.

Specify a fractional level value as the peak detection threshold. The detected
peaks are measured relative to the height of the tallest peak, which has a perfect
fractional level 100%. The default value is initially set at 10%.

For example, if you set a fractional level detection threshold value at 40, then only
peaks above 40% of the tallest peak are reported and the peaks at lower height are
regarded as noise.

Cr Settings

Data Step Selection

Use this feature to select one stage/step combination for Cy analysis when there is
more than one data collection point in the run method.

Algorithm Settings
Use the Baseline Threshold algorithm to determine the Ct values.

The Baseline Threshold algorithm is an expression estimation algorithm that
subtracts a baseline component and sets a fluorescent threshold in the exponential
region for gene quantification.

Default Ct Settings

Use the default Cr settings feature to calculate Cr for the targets that do not have
custom settings. To edit the default settings, click Edit Default Settings.
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Adjust analysis settings

® Cr Settings for Target
When you manually set the threshold and baseline, Life Technologies

recommends:
Setting Recommendation

Threshold Enter a value for the threshold so that the threshold is:
¢ Above the background.
¢ Below the plateau and linear regions of the amplification curve.
e Within the exponential phase of the amplification curve.

Baseline Select the Start Cycle and End Cycle values so that the baseline ends
before significant fluorescent signal is detected.

Note: This setting is applicable only to the Baseline Threshold algorithm.

Note: Selecting Automatic Threshold implies selection of automatic setting of the
baseline. However, if Automatic Threshold is deselected, then you can choose
between setting the baseline either automatically or manually.

Flag Settings
Use the Flag Settings tab to:

¢ Adjust the sensitivity so that more wells or fewer wells are flagged.

* Change the flags that are applied by the QuantStudio™ 6 and 7 Flex Software.
To adjust the flag settings:

1. In the Use column, select the check boxes for flags to apply during analysis.

2. (Optional) If an attribute, condition, and value are listed for a flag, specify the
setting for applying the flag.

Note: If you choose to adjust the setting for applying a flag, make minor
adjustments as you evaluate the appropriate setting.

3. In the Reject Well column, select the check boxes if you want the software to reject
wells with the flag.

Note: After you have rejected the flagged wells, analysis results depend on
factors such as the experiment type and flag type. For example, rejecting wells
flagged by HIGHSD in experiments using the Standard Deviation calculations
may change the result of Ct SD. For some flags, analysis results calculated before
the well is rejected are maintained.

4. Click Apply Analysis Settings in the Analysis Settings dialog box. If the run
status is complete, the data are reanalyzed.
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For more information

The following is an image of the Flag Settings tab:

sable, and configure flags, and indicate if a well is to be rejected when a flag is raised.
Flag Description Use Attribute Condition Value Reject Well
MTP Multiple Tm peaks
NOSIGHAL Mo signal in well [
OFFSCALE Fluorescence is offscale L]
Save to Library Load from Library Revert to Default Analysis Settings Apply Analysis Settings [m

Advanced Settings
Use the Advanced Settings tab to change baseline settings well-by-well.
To use custom baseline settings for a well-target combination:

1. Select one or more well-target combinations in the table.

2. Deselect the Use Ct Settings Defined for Target check box.

3. Define the custom baseline settings:

e TFor automatic baseline calculations, select the Automatic Baseline check
box.

¢ To define the baseline, deselect the Automatic Baseline check box, then enter
the baseline start cycle and baseline end cycle.

For more information

Publication

For more information on... Refer to
number

Amplification efficiency Amplification Efficiency of TagMan® Gene Expression Assays 127AP05-03
Application Note.
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[ Auto Export

Export Experiment Results

1. Open the Melt Curve example experiment file that you analyzed in Chapter 5.
2. In the Experiment Menu, click E Export.

Note: To export data automatically after analysis, select the Auto Export check
box during experiment setup or before running the experiment. Auto export is
unchecked for the example experiment.

3. Select QuantStudio™ 6 and 7 format.

4. Complete the Export dialog box as shown below:

Field or Selection Entry
Select Data to Results

export/ Select

Content

Export Data To One File

Export File Name

QuantStudio_384-Well_SYBR_Green_Melt_Example_data

File Type

* txt

Export File Location

C:\Applied Biosystems\QuantStudio 6 and 7 Flex
Software\User Files\Export

Your Export screen should look like this:

Format : |QuantStudio™ 6

and 7 v

Export Data To: (3 One File O Separate Files Open file(s) when export is complete

=Gl s R e s Bl s \QuantStudio 6 and 7 Flex Software\User Files\Export - Export File Name: [3_384-Well_SYBR_Green_Melt Example_data | Flle Type: |[F] (=) v

Select Content
All Fields
well

Well Position

Sample Mame
Sample Color
Biogroup Mame
Biogroup Color
Target Name
Target Color
Task

Reporter

[ Amplfication

Wwell

[ Multicomponent

Well Position
1A1
2A2
3A3
4 A4
S5A5
6 AG
T A7
8 A8
9 A

10Al10
11 A11
1z24a12
13 A13
14 A14
15A15
16 AlB
17 A17
18Al8

Results

Sample Name Sample Color Biogroup Name | Biogroup Color | Target Name T
Sample 1 RGB(0,255,0) Target 1 RG ~
Sample 1 RGB(0,255,0) Target 1 RG
Sample 1 RGB(0,255,0) Target 1 RG
Sample 1 RGB(0,255,0) Target 1 RG
Sample 1 RGB(0,255,0) Target 1 RG
Sample 1 RGB(0,255,0) Target 1 RG
Sample 1 RGB(0,255,0) Target 1 RG
Sample 1 RGB(0,255,0) Target 1 RG
Sample 1 RGB(0,255,0) Target 1 RG
Sample 1 RGB(0,255,0) Target 1 RG
Sample 1 RGB(0,255,0) Target 1 RG
Sample 1 RGB(0,255,0) Target 1 RG
Sample 1 RGB(0,255,0) Target 1 RG
Sample 1 RGB(0,255,0) Target 1 RG
Sample 1 RGB(0,255,0) Target 1 RG
Sample 1 RGB(0,255,0) Target 1 RG
Sample 1 RGB(0,255,0) Target 1 RG
Sample 1 RGB(0,255,0) Target 1 RG

b

w Save Export Set As Load Export Set Delete Export Set
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Chapter 6 Export Experiment Results

Your exported file when opened in Notepad should look like this:

_384-Well_SYBR_Green_Melt_Example_data.txt - Notepad

File Edit Format View Help
r Block Type = 384-well Block A
* calibration Background is expired = Yes 3

calibration
calibration
calibration
calibration
calibration
calibration

Background performed on = 04-28- 2010
Normalization FAM-ROX is expwred =
Normalization FaM-rOX performed on = 04—29—2010
Normalization VIC-ROX is expired =
Normalization VIC-ROX perfnrmed on
Pure FAM s expired =

Yes
= 04-29-2010

Calibration
calibration
calibration
calibration
calibration
calibration
calibration
calibration
calibration

pPure FAM performed on
Pure NED s expired =
Pure NED performed on
Pure ROX 15 expired =

Pure ROX performed on
Pure SYBR 15 expired

Pure
Pure
Pure

TAMRA is expired
TAMRA performed ol

SYBR performed on

04 28-2010
04 29-2010

04 28-2010
Y
= 04 28-2010
Ye:
= 04 29-2010

calibration
calibration
calibration
Calibration
calibration
calibration
Chemistry = SYBR_GREEN

Date Created = 2013-07-05 15:24:17 PM SGT

Experiment Barcode = NA

Experiment Comment = NA

Experiment File Name = C:“Program Files\Applied Biosystems‘\Quantstudio 6 and 7
Suftware\examp]es\QSGF'\ex\QSG 3B4-well_SYBR_Green_Melt_Example. eds

* Experiment Name = quantstudio_384-well_sYBR_Green Melt_Example

Experiment Run End Time = 2010-04-30 14:52:15 PM SGT

Experiment Type = Melt Curve

Instrument Name = 278880026

Instrument Serial Number = 278880026

INsTrument = uantstudio(TM) & Flex system

Passive Reference = ROX

quantification cyc?e Method =

signal smoothing on = true

User Name = NA

Pure VIC is expired =
pure Dye VIC performed on
ROL is expired = ves

ROI performed on = 04-28-2010
uniformity is expired = ves
uniformity performed on = 04-28-2010

n
Ye:
L 8a23-2010

R

Flex

3

R

[sample setup]

well well position sample Name sample color Biogroup Name piogroup Color Target Name Target color Task
Reporter quencher Quantity comments

1 Al sample 1 "RGB(0, 255,0)" Target 1 "RGB(0,0,255)" UNKNOWN SYBR None
2 A2 sample 1 "rGB(0,255,0)" Target 1 "RGB(0,0,255)" UNKNOWN SYBR None
E A3 sample 1 "rGB(0,255,0)" Target 1 ”RGB(O a, 255)” UNKNOWN SYBR None
4 Ad sample 1 "RGB(0,255,0)" Target 1 " UNKNOWN SYBR None
5 A5 sample 1 "RGB(0,255,0)" Target 1 UNKNOWN SYBR None
[ A6 sample 1 "RGB(0, 255,0)" Target 1 UNKNOWN SYER None
7 7 sample 1 "RGB(0,255,0)" Target 1 UNKNOWN SYBR None
8 A8 sample 1 "rGB(0,255,0)" Target 1 UNKNOWN SYBR None
9 AQ sample 1 "RGB(0,255,0)" Target 1 UNKNOWN SYBR None
10 ALD sample 1 "RGB(0,255,0)" Target 1 UNKNOWN SYBR None
11 All sample 1 "RGB(0,255,0)" Target 1 UNKNOWN SYBR None
12 Al2 sample 1 "RGB(0, 255,0)" Target 1 UNKNOWN SYER None
13 Al3 sample 1 "RGB(0, 255,0)" Target 1 "RGB(0,0,255)" UNKNOWN SYBR None

QuantStudio™
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A
adjusting analysis settings adjusting 35
adjusting parameters, re-analyzing own
experiments 35
Advanced Settings tab 38
Algorithm Settings, Baseline Threshold 36
amplification efficiency 38
amplification, include PCR 35
amplified products 5
AMPNC flag 33
analysis settings 35, 36
Advanced Settings 35
Cr Settings 35
Flag Settings 35
Melt Curve Settings 35
Analyze 25
Melt Curve Plot 25
Multicomponent Plot 29
QC Summary 32
Raw Data Plot 30
Auto Export 7, 39
Automatic Baseline 38
Automatic Threshold 37

BADROX flag 33
BLFAIL flag 33

C

cocktail mix 14
Cr settings
algorithm settings 36
data step, selecting 36
default 36
target 37
Cr Settings tab 36
CTFAIL flag 33

D

designing experiment
assigning targets and samples 9
defining experiment properties 7
defining targets and samples 8
setting up run method 10

dissociation curve 5

dye accuracy

Index

irregularities in the signal 30
passive reference 30
reporter dye 30

E

Enable the Multi-Peak Calling 36
example experiment 6
experiment properties, defining 7
EXPFAIL flag 33

Export 39

extraneous peaks 6

F

Flag Settings tab 37

flags, QC
AMPNC 33
BADROX 33
BLFAIL 33
CTFAIL 33
EXPFAIL 33
HIGHSD 33
MTP 33
NOAMP 33
NOISE 33
NOSIGNAL 33
OFFSCALE 33
OUTLIERRG 33
SPIKE 33
THOLDFAIL 33

fluorescence peaks 5

H
HIGHSD flag 33

include amplification, Pre-processing flag
OFFSCALE 33
include amplification, Primary analysis flags
BADROX 33
BLFAIL 33
CTFAIL 33
EXPFAIL 33
NOAMP 33
NOISE 33
NOSIGNAL 33
SPIKE 33
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Index

THOLDFAIL 33

include amplification, Secondary analysis flags

AMPNC 33
HIGHSD 33
MPT 33
OUTLIERRG 33

M

melt curve experiments
melt curve reactions 5
overview 5
Melt Curve Plot 18, 25
assessing 25
Derivative Reporter 25
Normalized Reporter 25
reactions type, negative controls 6
reactions type, unknowns 6
tips for analyzing own experiment 26
viewing 18, 25
Melt Curve Settings tab 36
melt curve stage 6
Melting temperature (Tm) 5
MTP flag 33
multicomponent plot
confirming dye accuracy 29
tips for analyzing own experiment 30
viewing 29

N

no PCR, Pre-processing flag
OFFSCALE 33

no PCR, Primary analysis flags
NOSIGNAL 33

no PCR, Secondary analysis flags
MPT 33

NOAMP flag 33

NOISE flag 33

NOSIGNAL flag 33

0]

OFFSCALE flag 33
omit wells 28
OUTLIERRG flag 33

P

preparing reactions
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reaction mix 14
reaction plate 14
required materials 13
sample dilutions 13

Q

QC Summary 32
QC Summary, reviewing flags 32

R

ramp increment 10
editing 10
method, continuous (default) 10
method, step and hold 10
Raw Data Plot 30
raw data plot
determining signal accuracy 30
tips for analyzing own experiments 32
viewing 30
reaction mix
components 13
preparing reactions 14
reactions, assembling materials for 13
review results 25
run
monitoring 17
starting 17
run method
reaction volume per well 10
setting up 10
thermal profile 10
viewing 19
Run Screen
Melt Curve Plot 18
Run Method 19
Temperature Plot 19
View Run Data 20
Run screen 18

S

sample dilutions, preparing reactions 13
Sample temperature 19

samples, defining 8

single-stranded DNA 5

SPIKE flag 33



T

target DNA 5
targets and samples
assigning 9
defining 8
targets, defining 8
temperature plot, viewing 19
thermal profile, setting up 10
THOLDFAIL flag 33
touchscreen, running the experiment from
Experiment View 20
Time View 21
troubleshooting
multiple peaks 26
non-specific amplification 26

W

well table
identifying well problems 27
tips for viewing own experiments 28
viewing 27
well table, column
Dyes 28
Flag 28
Omit 27
Sample Name 28
Target Name 28
Task 28
Tml 28
Tm2 28
Tm3 28
Well 27
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Ordering Information

This appendix covers:

How to order from the Life Technologies website .......................... 6
Reagents and consumables. . ......... ... .. 7
Calibration reagents and consumables . ............... ... .. ... oo L 7
Experiment consumables. ......... ... .. o 9
QuantStudio™ 6 or 7 Instrument acCesSOTIES . . . .. oo oo 10
Experiment reagents ........... ... ... . 11
General-use materials and consumables. . .............. ... ... ... L 12
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A Appendix A Ordering Information
How to order from the Life Technologies website

How to order from the Life Technologies website

You can order materials accessories directly from the Life Technologies store over the
internet.

Note: Product availability and pricing may vary according to your region or country.
Online ordering through the Life Technologies store is not available in all countries.
Contact your local Life Technologies representative for help.
To order through the website:

¢ Confirm that your computer has an Internet connection.

* We recommend the following browsers and Adobe® Acrobat® Reader® Software
versions to use the Life Technologies website:

H ® ®
_ Microsoft Apple® Mozilla® Adobe o
Operating system Internet -® . ® Acrobat
® Safari Firefox ®
Explorer Reader
Microsoft® Windows® | vé.x or later None' v2.x or later | v4.0 or later
Macintosh® None™ ' v2.0.4 or later

T Browser not available for this platform.

Note: Confirm that cookies and Javascript® are turned on for the website to function
correctly.

To purchase reagents, accessories, and calibration Kkits:
1. Go to www.lifetechnologies.com

2. Under “I Want to Buy,” select the product of interest.
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Reagents and consumables

Appendix A Ordering Information
Reagents and consumables

The reagents and consumables listed below are required for calibrating and for
performing experiments with the QuantStudio'" 6 and 7 Flex Software.

Note: For reagent or consumable shelf-life expiration date, see the package label.

Calibration
reagents and

consumables QuantStudio™ 6 and 7 Flex Software.

384-well sample block

The following table shows the reagents and consumables required to calibrate and
verify the performance of the QuantStudio'" 6 and 7 Instruments when run with the

Shelf-life at

Part . Storage
Consumable environmental o
number conditions (°C)
temperature
384-Well Spectral Calibration Plate with FAM™ Dye 4432271 | Use the -15°C to -25°C
384-Well Spectral Calibration Plate with VIC® Dye 4432278 | Consumable by
the expiration
384-Well Spectral Calibration Plate with ROX™ Dye 4432284 | date mentioned
T . ® on the package
384-Well Spectral Calibration Plate with SYBR® Green Dye 4432290
384-Well Spectral Calibration Plate with TAMRA™ Dye 4432296
384-Well Spectral Calibration Plate with NED™ Dye 4432302
384-Well Region of Interest (ROI) and Background Plates 4432320
384-Well Normalization Plates with FAM™/ROX™ and VIC®/ROX™ Dyes | 4432308
TagMan® RNase P Fast 384-Well Instrument Verification Plate 4455280
96-well (0.2 mL) sample block
Shelf-life at Storage
Part - L
Consumable environmental conditions
number
temperature (°C)
96-Well Spectral Calibration Plate with FAM™ Dye 4432327 | Use the -15°C to -25°C
96-Well Spectral Calibration Plate with VIC® Dye 4432334 | consumable by
the expiration
96-Well Spectral Calibration Plate with ROX™ Dye 4432340 | date mentioned
th k
96-Well Spectral Calibration Plate with SYBR® Green Dye 4432346 | 0N e Package
96-Well Spectral Calibration Plate with TAMRA™ Dye 4432352
96-Well Spectral Calibration Plate with NED™ Dye 4432358
TagMan® RNase P 96-Well Instrument Verification Plate 4432382
96-Well Region of Interest (ROI) and Background Plates 4432364
96-Well Normalization Plates with FAM™/ROX™ and VIC®/ROX™ Dyes 4432370
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Reagents and consumables

Fast 96-well (0.1 mL) sample block

Shelf-life at

Part . Storage
Consumable environmental L °
number R conditions (°C)
Fast 96-Well Spectral Calibration Plate with FAM™ Dye 4432389 | Use the -15°C to -25°C
Fast 96-Well Spectral Calibration Plate with VIC® Dye 4432396 | Consumable by
the expiration
Fast 96-Well Spectral Calibration Plate with ROX™ Dye 4432402 | date mentioned
S . ® on the package
Fast 96-Well Spectral Calibration Plate with SYBR® Green Dye 4432408
Fast 96-Well Spectral Calibration Plate with TAMRA™ Dye 4432414,
Fast 96-Well Spectral Calibration Plate with NED™ Dye 4432420
Fast 96-Well Region of Interest (ROI) and Background Plates 4432426
Fast 96-Well Normalization Plates with FAM™/ROX™ and VIC®/ROX™ | 4432432
Dyes
TagMan® RNase P Fast 96-Well Instrument Verification Plate 4351979
Array card sample block
Shelf-life at
Consumable Part environmental S_ttfrage °
number temperature conditions (°C)
Array Card Spectral Dye Calibration Kit 4432376 | Use the -15°C to -25°C
Array Card RNase P Instrument Verification Kit 4432464 | COMSUmable by

the expiration
date mentioned
on the package

Note: To prepare calibration plates, refer to the instrument user guide.

Note: The Array card sample block is applicable only to the QuantStudio™" 7 Flex

System.
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Appendix A Ordering Information
Reagents and consumables

The following table shows the consumables required to perform experiments with the

QuantStudio™ 6 and 7 Flex Software.

96-well (0.2 mL) sample block

Consumable nupnirl;ter
MicroAmp® Optical 8-Cap Strip 300 strips 4323032
MicroAmp® Optical 8-Tube Strip (0.2 mL) 125 strips 4316567
MicroAmp® Optical Tube without cap (0.2 mL) 2000 tubes | N8010933
MicroAmp® 946-Well Tray/Retainer Set (Blue) (for 0.2 mL) | 10 pairs | 4381850
MicroAmp® Optical 96-Well Reaction Plate (0.2 mL) 10 plates N8010560
MicroAmp® Optical 96-Well Reaction Plate with Barcode | 10 plates 4306737
(0.2 mL)
Fast 96-well (0.1 mL]) sample block
Consumable nuPr:Il;ter
MicroAmp® Fast 8-Tube Strip (0.1 mL) 125 strips 4358293
MicroAmp® Fast Reaction Tube with cap (0.1 mL) 1000 tubes | 4358297
MicroAmp® 96-Well Tray (Black) (for 0.1 mL) 10 plates 4379983
MicroAmp® Fast Optical 96-Well Reaction Plate (0.1 mL) | 10 plates 4346907
MicroAmp® Fast Optical 96-Well Reaction Plate with 10 plates 4346906
Barcode (0.1 mL]
Array card sample block
Consumable nuPna1'l;ter
Array Card 4-pack 4334812
1-pack 4351471

Note: The Array card sample block is applicable only to the QuantStudio™™ 7 Flex

System.

Miscellaneous

Consumable Part
number
MicroAmp® Multi-Removal Tool 1 tool 4313950
MicroAmp® Cap Installing Tool (Handle) 1 tool 4330015
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Reagents and consumables

Consumable nuP:'nll;ter
MicroAmp® Optical Adhesive Film 25 films 4481193
MicroAmp® Adhesive Film Applicator 5 applicators 4481196
RT-PCR Grade Water - AM9935

QuantStudio™ 6 or The accessories listed in the following table are for the QuantStudio™ 6 or 7 Instrument
7 Instrument when run with the QuantStudio™" 6 and 7 Flex Software.

accessories

Accessory Part number

384-Well Plate/Array Card Heated Cover 4453555
384-Well Plate Sample Block 4453553
96-Well Plate Heated Cover 4453560
96-Well Plate Sample Block 4453556
Fast 96-Well Plate Heated Cover 4459838
Fast 96-Well Plate Sample Block 4453559
Array Card Buckets/Clip Set 1st Generation 4337762

2nd Generation 4442571
Array Card Sample Block 4453554
Array Card Staker/ Sealer 4331770
Handheld Barcode Scanner 4453271
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Reagents and consumables

Experiment The following table lists the reagents that can be ordered for performing experiments
reagents with the QuantStudio'" 6 and 7 Flex Software.
To perform Recommended reagent kits Part number
Reverse Transcription SuperScript® VILO™ cDNA Synthesis Kit 4453650
TagMan® PCR TagMan® Fast Advanced Master Mix 4444557
TagMan® GTXpress™ Master Mix 4401892
TagMan® Fast Virus 1-Step Master Mix LALLAZ2
TagMan® Gene Expression Master Mix 4369016
TagMan® Genotyping Master Mix 4371355
TaqMan® Universal Master Mix Il, with UNG 4440038
TagMan® RNA-to-CT™ 1-Step Kit 4392938
SYBR® Green PCR Fast SYBR® Green Master Mix 4385612
Power SYBR® Green PCR Master Mix 4367659
Power SYBR® Green RNA-to-CT™ 1-Step Kit 4389986
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General-use materials and consumables

General-use materials and consumables

The following general-use materials and consumables are required to calibrate,
maintain, and perform experiments with the QuantStudio™" 6 and 7 Flex Software.
Unless indicated otherwise, all materials shown below are available from major
laboratory suppliers (MLS). The materials are applicable to all sample blocks.

Material/Consumable Source
Bleach, 10% solution MLS
Lint-free lab tissues MLS
Cotton or nylon swabs and lint-free cloths MLS
Centrifuge with buckets appropriate for your consumable type MLS
Ethanol, 95% solution MLS
Glasses, safety MLS
Gloves, powder-free MLS
Permanent marker or pen MLS
Pipettors: 100-pL and 200-pL (with pipette tips) MLS
Screwdriver, flathead MLS
Optical clear adhesive film for PCR MLS
Deionized water MLS
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[Optional] Libraries for designing your own experiments

Dye library

The QuantStudio™ 6 and 7 Flex Software allows you to save information to libraries,
so you can easily use the information again when setting up an experiment. The
libraries include:

Dye Library

Targets Library

Samples Library

Control Library

SNP Assay Library (only available for Genotyping experiments)
Run Method Library

Analysis settings Library

You can access the Dye library from the Tools menu to add new custom dyes, edit
existing dyes, and delete dyes.

To add a new dye to the Dye Library:

1.
2.

Go to Tools » Dye Library....
Click New at the bottom of the Dye Library dialog box.
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(Optional] Libraries for designing your own experiments

3. In the New Dye dialog box, enter the name and wavelength (optional) of the
custom dye in the respective fields.

IMPORTANT! Ensure that you perform a custom dye calibration with the new dye
before you run an experiment using this dye.

4. Select the Type of dye: Reporter, Quencher, or Both.
The new dye gets added to the Dye Library.

43 Dye Library le
Add new dyes, edit existing dyes, delete dyes. ?1
Name Creation Type Wavelength (...

CY3 Default Reporter A

CY5 Default Reporter i

FAM Default Reporter

10E Default Reporter

MELTDOCTOR Default Reporter

MNED Default Reporter

NFQ-MGBE Default Quencher

OTHER Default Reporter

ROX Default Reporter =

SYBR Default Reporter

TAMRA Default Both v

5. Click OK.

12 New Dye rz|

Perform a custom dye calibration with this dye before you run an
experiment using this dye.

For HRM experiments, also perform an HRM calibration before
running and analyzing an HRM experiment using this dye.

Name: |ND-0s |

Wavelength (Optional): | ||nm v|

Type
(O Reporter

o o

6. To edit or delete any of the dyes in the Dye Library, select the dye and click Edit
or Delete respectively.

7. Click Close to exit the Dye Library.

Target, Sample, You can access the Targets, Samples, and SNP Assay libraries from the Tools menu to
Control, and SNP add, edit, delete, and import or export items. You can also access a library by clicking
Assay libraries Import from Library in the Define screen when you are setting up an experiment.

Run Method library  You can use the Run Method library from the Run Method screen to:
* Save a new run method for later use.

¢ To select an existing run method for an experiment.
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Analysis Settings
Library
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(Optionall Libraries for designing your own experiments

To add a run method to the Run Method Library:

1. Click Save Run Method in the toolbar of the Graphical View tab on the Run
Method screen.

2. Enter a name and description (optional) for the run method, then click Save.
To select a run method from the Run Method Library:

1. Click Open Run Method on the Run Method screen.

2. Select one from the saved run methods.

3. Click OK.

Analysis Settings are different for each experiment type. If the default analysis settings
in the QuantStudio™ 6 and 7 Flex Software are not suitable for your own experiment,
you can change the settings in the Analysis Settings dialog box, then reanalyze your
experiment.

You can save the changed analysis settings to the Analysis Settings Library so that you
can use them in other experiments.

To access the Analysis Settings Library, go to Tools » Analysis Settings Library. The
Analysis Settings Library dialog box looks like this:

12 Analysis Settings Library

Select analysis settings or delete analysis settings. Apply a filter to reduce the number of analysis settings displayed. *J

( Enter a fitter query, then click "Apply Fitter.”

F !Ana\ysws Settings v‘ |= v||

[0 - R

Analysis Settings Experiment Type _| Comments Created On Last Modified

RNaseP

Standard Curve

07-04-2013 16:27:29 5GT

07-04-2013 16:27:48 5GT

GT-7

Genotyping

07-04-2013 16:28:15 5GT

07-04-2013 16:28:30 5GT

MC-90

Melt Curve

07-04-20132 16:28:50 5GT

07-04-2013 16:29:01 5GT

Exit Analysis Settings Library

Note: In the Analysis Settings Library dialog box you can apply a filter to reduce the
number of settings protocols displayed.

To change the analysis settings and to save them to the Analysis Settings Library:
1. From the Experiment Menu pane, select Analysis.

2. On the Analysis screen, click Analysis Settings to open the Analysis Settings
dialog box.

3. Change the analysis settings according to your requirement.
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(Optional] Libraries for designing your own experiments

4. Click Save to Library to save the changes you have made to the Analysis Settings
Library.

Note: You can import the analysis settings you have previously saved to the
Analysis Settings Library, by clicking Load from Library in the Analysis Settings
dialog box.

Changing default analysis settings in Preferences

(Optional) For real-time data collection, you can change the default analysis settings in
the Preferences for the following:

* Automatic analysis
¢ Automatic save

* Baseline settings
To change the default analysis settings:
1. Go to Tools » Preferences.

2. Click the Experiment tab. Select the Auto Analysis and Auto Save check boxes for
the QuantStudio™ 6 and 7 Flex Software to automatically analyze and save
experiment results.

You can also edit the following default baseline settings:

Field Entry
Start Cycle Number 3 (default)
End Cycle Number 15 (default)

Note: By default, the Auto Analysis and Auto Save check boxes are selected.
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Instrument Console

Instrument Console

The Instrument Console displays all the QuantStudio™ 6 and 7 Instruments

discovered on a network.

a Add to -
Rafres! Aszzign to Grou
Refrash O etruments ign to Groupy

Display Group: FRelfIiT] B9 Fitered by: ARSI v

My Instruments (1)

‘u QS7_0009

Instrument Type:
Instrument Status:
Run Status:

Calibration Status

Group: On the Network

0S6_0008 Maintenance Info (&=}
READY
Lamp Life 208 hours
o 0 e
Total Degrees for Block
Instrument Properties /=
]
7 Instrument: Label ruo
Qf)’p’ﬂzgf’ Serial Number 287880009
Instrument Firmware Ve... 1.0.3
P Address 172.28.1.122

Block Type

Controller Firmware Versi...

Optics Firmware Version

Thermal Block Firmware ...

Heated Cover Firmware ...
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Instrument Console

Left panel

Right panel
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The features on the left panel of the Instrument Console allow:

 Instrument access: Open and close the QuantStudio™" 6 or 7 Instrument door from

the QuantStudio™ 6 and 7 Flex Software user interface.
Group management:
— Create, rename, and delete groups and assign instruments to the groups.

— Add and remove instruments to and from My Instruments.

Note: To add instruments, select the icon of the QuantStudio™ 6 or 7
Instrument that you want to add to the My Instruments list. Then click Add
to My Instruments. Similarly, click Remove from My Instruments to
remove an instrument from the My Instruments list. You can also drag and
drop the instrument icon into My Instruments or into the group created by
you.

Display instrument groups from the Display Group drop-down menu.
according to their activity. Select the status from the Filtered By drop-down
menu. For more information on the status of an instrument, see Monitor the
experiment, in Chapter 1, Booklet 1 Getting Started with QuantStudio™ 6 and 7
Flex Real-Time PCR System Software Experiments.

Instrument management:

— Monitor experiments (check the run status or monitor a temperature plot or

amplification plot during a run). For more information on monitoring
experiments, see Monitor the experiment, in Chapter 1, Booklet 1 Getting
Started with QuantStudio'™ 6 and 7 Flex Real-Time PCR System Software
Experiments.

Maintain instruments (check the calibration status of instruments and
perform different calibrations). For more information on instrument
maintenance, refer to the instrument user guide.

Manage files (upload setup files; download completed experiments; and
create, rename, and delete experiment files and plate setup folders).

Note: Completed experiments are downloaded into the default folder
Completed Experiments.

Note: To manage files, click Manage Instrument.

Use the File Manager to create, rename or delete folders for holding setup
files for starting a run or completed experiments for analysis.

To move setup files from one folder to the other, click Move and select the
setup folder you want to shift the setup file into.

IMPORTANT! To Manage and Monitor, you must move instruments from On
the Network to My Instruments or a custom group. You can start a run and
calibrate instruments present only in the My Instruments group or the
custom group(s) that you created.

The right panel of the Instrument Console displays:

The name of the instrument whose instrument icon is selected.
The run status of the selected instrument.
The group the instrument belongs to.

The calibration status, maintenance reminders and instrument properties of the
selected instrument.
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Instrument Console

The calibration status is indicated by the & icon. The icon appears in the Status
column of the Calibration Status table after the last reminder date before the
calibration expires.

You can monitor the instrument status and view calibration and other information in
the Instrument Console.

The status of an instrument is represented by an icon in the top-right corner of the
thumbnail representation of the instrument on the Instrument Console. An instrument
displays the status when you place the instrument icon under My Instruments or
under the Group(s) that you created.

QuantStudio™ 6 or 7 Instrument status icon
To monitor the instrument status:

1. On the Home tab ( ﬁ ), select Instrument Console. If you do not see an
instrument, click Refresh in the instrument console toolbar.

2. Ifneeded, move the instrument from the On the Network group to a group which
can be monitored:

a. Click the instrument of interest, then click Assign to Group in the
instrument console toolbar.

b. Select the My Instruments or a personal group in the drop-down list. The
instrument is now monitored.

Icon Instrument status
Ready
ﬁ'6
Q56_0008
READY
(no icon) Available on the network but cannot be monitored because that
instrument is not under My Instruments or a group you
created.

Run in process
(The time remaining for the run is shown to the left of the icon.)

Unavailable

Incompatible firmware version

No longer connected to the network

Error occurred during run

0% %€
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About the reagents

About the reagents

TagMan® Reagents  Description

TagMan® reagents use a fluorogenic probe to enable detection of a specific PCR
product as it accumulates during PCR cycles.

Advantages
¢ Increased signal specificity with the addition of a fluorogenic probe.
¢ Multiplex capability.

* Optional preformulated assays, optimized to run under universal thermal cycling
conditions, are available.

* Can be used for either 1- or 2-step RT-PCR.

Limitations

Require synthesis of a unique fluorogenic probe.

TagMan® Reagents detection process
PCR and detection of cDNA

a. Assay components
Ne®
e Probe / Reverse prim
Forward primer ‘D T T @I S
BQ;"T CDNA template #25
gl [T,
= ?55 ~— cDNA
3 5
v
b. Denatured template and annealing of assay components IRTTRTTTN
3% LU LU L L L U L I L I T ys Reverse prmer LEGEND
N Probe /MGB G rvmaye
T G Ty *J
Forward primer @ Quencher
s -,
c. Signal generation AmpliTag Gold®
DNA Polymerase
3 5
p\\— ; —
L Y | TR Probe
i Reverse primer N
— @&~ == Primer
 Forward primer /% B !
— I P N === Template
A e A A
3 5 Extended primer
SYBR® Green Description
reagents i
9 SYBR Green reagents use SYBR® Green I dye, a double-stranded DNA binding dye, to

detect PCR products as they accumulate during PCR cycles.

Advantages
¢ Economical (no probe needed).
e Allow for melt curve analysis to measure the Tm of all PCR products.

¢ Can be used for either 1- or 2-step RT-PCR.
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About the reagents

Limitations

Bind nonspecifically to all double-stranded DNA sequences. To avoid erroneous
information signals, check for nonspecific product formation using melt curve or gel
analysis.

SYBR® Green detection process

o 0. 0 6 o Step 1: Reaction setup
The SYBR® Green | dye
fluoresces when bound to
double-stranded DNA.

) ® Step 2: Denaturation

@ ® When the DNA is denatured into
single-stranded DNA, the
SYBR® Green | dye is released and
the fluorescence is drastically reduced.

e Step 3: Polymerization

-0 During extension, primers
() (<) anneal and PCR product

L. .
® -@- is generated.
o 0 o o o Step 4: Polymerization completed
SYBR® Green | dye binds to the

o e e e o

T double-stranded product,
resulting in a net increase in
fluorescence detected by the
instrument.
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Related documentation

The following related documents are shipped with the instrument:

Document

Pub. no.

Description

QuantStudio™ é and 7 flex Real-Time PCR System
Software Getting Started Guide

4489822

Contains seven individual booklets that explain
how to perform the six different experiments on
the QuantStudio™ 6 and 7 flex Real-Time PCR
System Software.

The experiments include Standard Curve, Relative
Standard Curve and Comparative Cy, Genotyping,
Presence/ Absence and Melt Curve. Each Getting
Started Guide booklet functions as both:

¢ A tutorial, using example experiment data
provided with the QuantStudio™ 6 and 7 flex
Real-Time PCR System Software.

e A guide for your own experiments.
Intended for laboratory staff and principal
investigators who perform experiments using the

QuantStudio™ 6 and 7 flex Real-Time PCR System
Software.

QuantStudio™ 6 and 7 Flex Real-Time PCR Systems
Maintenance and Administration Guide

QuantStudio™ 6 and 7 Flex Real-Time PCR Systems
Site Preparation Guide

4489821

4489824

Explains how to use and maintain the
QuantStudio™ 6 and 7 Flex Real-Time PCR
Systems

Intended for laboratory staff responsible for the
use and maintenance of the QuantStudio™ 6 and 7
Instruments.

Explains how to prepare your site to receive and
install the QuantStudio™ 6 and 7 Instruments
Intended for personnel who schedule, manage,
and perform the tasks required to prepare your
site for installation of the QuantStudio™ é and 7
Instruments.

QuantStudio™ 6 and 7 Flex Real-Time PCR System
Software Programming Supplement

4489825

Provides IT administrative personnel with
sufficient information to integrate the instrument
and software with a LIS/LIMS.

Intended to be used with the QuantStudio™ 6 and 7
Flex Real-Time PCR System Software Getting Started
Guide.
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Other related documents

Document Pub. no. Description
Applied Biosystems® Twister® Robot Automation 4468146 Provides abbreviated instructions for operating an
Accessory Quick Reference Applied Biosystems® Twister® Robot Automation

Accessory that has been installed with the
QuantStudio™ 6 or 7 Flex Real-Time PCR System.

Intended for laboratory staff and principal
investigators who perform experiments using the
QuantStudio™ 6 or 7 Flex Real-Time PCR System.

QuantStudio™ é and 7 flex Real-Time PCR System NA Explains how to use the QuantStudio™ 6 and 7 flex
Software Help Real-Time PCR System Software to:

e Set up, run, analyze, audit, sign, export, and
print experiments.

¢ Monitor networked QuantStudio™ 6 and 7
Instruments.

e Calibrate and verify the performance of the
QuantStudio™ é and 7 Instruments.

¢ Intended for laboratory staff and principal
investigators who perform experiments using
the QuantStudio™ 6 and 7 flex Real-Time PCR
System Software.

Note: For additional documentation, see “How to obtain support” on page 25.

Other related documents

Documents related
to Standard Curve Document Pub. no.

experiments Amplification Efficiency of TagMan® Gene Expression Assays Application Note 127AP05
Custom TagMan® Gene Expression Assays Protocol 4334429
Primer Express® Software Version 3.0 Getting Started Guide 4362460
TagMan® Gene Expression Assays Protocol 4333458
User Bulletin #2: Relative Quantitation of Gene Expression 4303859

Documents related
to Relative Document Pub. no.

Standard Curve

) Amplification Efficiency of TagMan® Gene Expression Assays Application Note 127AP05

and Com_p arative Applied Biosystems® High-Capacity cDNA Reverse Transcription Kits Protocol 4375575
Ct experiments

Custom TagMan® Gene Expression Assays Protocol 4334429

Primer Express® Software Version 3.0 Getting Started Guide 4362460

TagMan® Gene Expression Assays Protocol 4333458

User Bulletin #2: Relative Quantitation of Gene Expression 4303859

24 QuantStudio™ é and 7 Flex Real-Time PCR System Software Experiments - Appendixes



Documents related
to Genotyping
experiments

Documents related
to Presence/
Absence
experiments

Documentation and Support
How to obtain support

Document Pub. no.

Allelic Discrimination Pre-Developed TagMan® Assay Reagents Quick Reference 4312212

Card

Custom TagMan® Genomic Assays Protocol 4367671
Custom TagMan® SNP Genotyping Assays Protocol 4334431
Ordering TagMan® SNP Genotyping Assays Quick Reference Card 4374204
Pre-Developed TagMan® Assay Reagents Allelic Discrimination Protocol 4312214
TagMan® Drug Metabolism Genotyping Assays Protocol 4362038
TagMan® SNP Genotyping Assays Protocol 4332856

Document Pub. no.

DNA Isolation from Fresh and Frozen Blood, Tissue Culture Cells, and Buccal Swabs | 4343586

Protocol
NucPrep® Chemistry: Isolation of Genomic DNA from Animal and Plant Tissue 4333959
Protocol
PrepMan® Ultra Sample Preparation Reagent Protocol 4318925

How to obtain support

Obtaining
information from
the Help system

For the latest services and support information for all locations, go to:

www.lifetechnologies.com/support

At the Life Technologies web site, you can:

Access worldwide telephone and fax numbers to contact Life Technologies
Technical Support and Sales facilities.

Search through frequently asked questions (FAQs).
Submit a question directly to Technical Support.

Order Life Technologies user documents, SDSs, certificates of analysis, and other
related documents.

Download PDF documents.
Obtain information about customer training.

Download software updates and patches.

The QuantStudio™™ 6 and 7 flex Real-Time PCR System Software has a Help system
that describes how to use each feature of the user interface. Access the Help system by
doing one of the following:

Click @ in the toolbar of the QuantStudio™ 6 and 7 flex Real-Time PCR System
Software window.

Select Help » QuantStudio™ 6 and 7 flex Real-Time PCR System Software Help.
Press F1.
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Documentation and Support
Limited Product Warranty

You can use the Help system to find topics of interest by:
¢ Reviewing the table of contents

¢ Searching for a specific topic

Limited Product Warranty

Life Technologies Corporation and/or its affiliate(s) warrant their products as set forth
in the Life Technologies” General Terms and Conditions of Sale found on Life

Technologies’ website at www.lifetechnologies.com/termsandconditions. If you have
any questions, please contact Life Technologies at www.lifetechnologies.com/support.
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AlF

AIX

allele

aligned melt curve
plot

allelicdiscrimination
plot

amplicon

amplification

amplification
efficiency (EFF%)

amplification plot

amplification stage

Glossary

See assay information file (AIF).

XML version of the assay information file.

See also assay information file (AIF).

In a diploid organism, one of two DNA sequences found at the same locus (for
example, a particular gene), but located on homologous chromosomes. Two
corresponding alleles may have the identical sequence, or they may differ somewhat,
often at one or more single-base sites (SNPs).

Plot of the re-scaled melt curve.

Display of genotyping data collected during the post-PCR read. The allelic
discrimination plot is a graph of the normalized reporter signal from the allele 1 probe,
plotted against the normalized reporter signal from the allele 2 probe.

A segment of DNA amplified during PCR.

Part of the instrument run in which PCR amplifies the target. Fluorescence data
collected during amplification are displayed in an amplification plot, and the data are
used to calculate results.

Note: Only quantitative real-time PCR experiments, not end-point experiments, take
amplification data into account.

Calculation of the efficiency of the PCR amplification in an experiment. EFF% is
calculated using the slope of the regression line in the standard curve. A slope close to
-3.32 indicates optimal, 100% PCR amplification efficiency.

Display of data collected during the cycling stage of PCR amplification. The
amplification plot can be viewed as:

* Baseline-corrected normalized reporter (ARn) vs. cycle

* Normalized reporter (Rn) vs. cycle

* Threshold cycle (Ct) vs. well

Part of the instrument run in which PCR amplifies the target. The amplification stage,

called a cycling stage in the thermal profile, consists of denaturing, primer annealing,

and extension steps that are repeated. Fluorescence data collected during the extension
stage are displayed in an amplification plot, and the data are used to calculate results.
With TagMan® chemistry, the last two steps of a PCR stage are typically combined.

See also cycling stage.
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Analysis Settings
Library

assay

Assay ID

assay information
file (AIF)

assay mix

AutoDelta

automatic baseline

automatic threshold

background
calibration

baseline

baseline-corrected
normalized reporter
(ARN)
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In the software, a collection of analysis settings to use in experiments. You can save
settings and reuse them. You cannot edit or import settings into the library.

In a PCR reaction mix, two target-specific primers or two primers and a probe used to
amplify a target.

Identifier assigned by Life Technologies to TagMan® assays.

Tab-delimited data file on a CD shipped with each assay order. The AIF contains
technical details about all assays in the shipment. It includes information about assay
concentrations; reporters and quenchers used; part and lot numbers; and assay, vial,
and plate ID numbers. The file name includes the number from the barcode on the
plate.

PCR reaction component in Applied Biosystems® TagMan® assays. The assay mix
contains primers designed to amplify a target and a TagMan® probe designed to detect
amplification of the target.

In the run method, a setting to increase or decrease the temperature and/or time for a
step with each subsequent cycle in a cycling stage. When AutoDelta is enabled for a
cycling stage, the settings are indicated by an icon in the thermal profile:

e AutoDelta on: &
e AutoDelta off: &

An analysis setting in which the software calculates the baseline start and end cycles
for the amplification plot.

See also baseline.

An analysis setting in which the software calculates the baseline start and end cycles
and the threshold in the amplification plot. The software uses the baseline and
threshold to calculate the threshold cycle (Cy).

See also threshold cycle (Cr).

Type of calibration in which the instrument performs reads of a background plate,
averages the spectra recorded during the run, and extracts the resulting spectral
component to a calibration file. The software then uses the calibration file during
subsequent runs to remove the background fluorescence from the run data.

In the amplification plot, a cycle-to-cycle range that defines background fluorescence.
This range can be set manually on an assay-by-assay basis, or automatically to set each
individual well.

The magnitude of normalized fluorescence signal generated by the reporter. In
experiments that contain data from real-time PCR, the magnitude of normalized
fluorescence signal generated by the reporter at each cycle during the PCR
amplification. In the ARn vs Cycle amplification plot, ARn is calculated at each cycle as:

ARn (cycle) = Rn (cycle) —Rn (baseline), where Rn = normalized reporter
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baseline threshold
algorithm

biological replicates

blocked IPC

calibrator
chemistry

comparative Ct
(AAC+) method

Cr

Cy algorithm

cycle threshold

cycling stage

Cq

Glossary

In genotyping experiments and presence/absence experiments, the difference in
normalized fluorescence signal generated by the reporter between the pre-PCR read
and the post-PCR read. In the allelic discrimination plot (genotyping experiments) and
the presence/absence plot (presence/absence experiments), ARn is calculated as:

ARn = Rn (post-PCR read) —Rn (pre-PCR read), where Rn = normalized reporter

See also normalized reporter (Rn).

Expression estimation algorithm (Cp) which subtracts a baseline component and sets a
fluorescent threshold in the exponential region for gene quantification.

Reactions that contain identical components and volumes, but evaluate separate
samples of the same biological source (for example, samples from three different mice
of the same strain, or separate extractions of the same cell line or tissue sample).

When an experiments uses biological replicate groups in a gene expression study, the
values displayed in the Biological Replicates tab are calculated by combining the
results of the separate biological samples and treating this collection as a single
population (that is, as one sample). For ACt computations (normalizing by the
endogenous control) in a singleplex experiment, the software treats separate biological
samples as unpaired data when computing variability estimates of the single
biological replicate. Individual contributions of the separate biological samples to the
single biological replicate results are observed in the Technical Replicates tab.

See also technical replicates.

In presence/absence experiments, a reaction that contains IPC blocking agent, which
blocks amplification of the internal positive control (IPC). In QuantStudio™ 6 and 7
Flex Real-Time PCR System Software, also the name of the task for the IPC target in
wells that contain IPC blocking agent. See also negative control-blocked IPC wells.

See reference sample.
See reagents.

Method for determining relative target quantity in samples. The software measures
amplification of the target and of the endogenous control in samples and in a reference
sample. Measurements are normalized using the endogenous control. The software
determines the relative quantity of target in each sample by comparing normalized
target quantity in each sample to normalized target quantity in the reference sample.

See threshold cycle (Cy).

Algorithm used to determine the threshold cycle. The software provides the Baseline
Threshold Cr algorithm.

See threshold cycle (Cy).

In the thermal profile, a stage that is repeated. A cycling stage is also called an
amplification stage. See also amplification stage.

See quantification cycle (Cg).
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data collection

delta R, (AR,

derivative reporter
(-Rn’)

diluent
dilution factor

dye calibration

EFF%

efficiency correction

endogenous control

endpoint read

error

experiment
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During the instrument run, a process in which an instrument detects fluorescence data
from each well of the reaction plate. The instrument transforms the signal to electronic
data and saves the data in the experiment file. In the QuantStudio™ 6 and 7 Flex Real-
Time PCR System Software, a data collection point is indicated by an icon in the

thermal profile:
¢ Data collection on:
e Data collection off:

See baseline-corrected normalized reporter (ARn).

The rate of change in fluorescence as a function of temperature. Rn” is used to plot a
melting curve. Significant decrease of the fluorescent signal generates a positive peak
on the derivative view of the melting curve.

A reagent used to dilute a sample or standard before it is added to the PCR reaction.
See serial factor.

Type of calibration in which the software collects spectral data from a series of dye
standards and stores the spectral information for the dye standards in a pure spectra
calibration file. This file is used during experiment runs to characterize and distinguish
the individual contribution of each dye in the total fluorescence collected by the
instrument.

See amplification efficiency (EFF%).

In Comparative Ct experiments, a feature that allows you to manually enter
previously-determined amplification efficiencies for each experiment, following the
experimental run. The real-time software mathematically compensates for differences
in efficiency between each target assay and the endogenous control when calculating
sample-to-sample relative quantities. This method can be employed as a substitute for
the Relative Standard Curve Method.

A gene that is used to normalize template differences and sample-to-sample or run-to-
run variation.

See post-PCR read.

The standard error of the slope of the regression line in the standard curve.

The error can be used to calculate a confidence interval (CI) for the slope. Because the
amplification efficiency (EFF%) is calculated from the slope, knowing the error allows
a CI for the amplification efficiency to be calculated.

Refers to the entire process of performing a run, including setup, run, and analysis.
You can perform the following types of experiments:

¢ Quantification - Standard curve
¢ Quantification - Relative standard curve

* Quantification - Comparative Ct (AACr)

QuantStudio™ é and 7 Flex Real-Time PCR System Software Experiments - Appendixes
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Experiment Setup

experiment type

export

filter

flag

forward primer

genotyping
experiment

heterozygote

Glossary

* Melt Curve
* Genotyping

¢ Presence/Absence
Entered during experiment setup, the name that is used to identify the experiment.

A software feature that allows you to set up an experiment according to your
experiment design. Experiment Setup provides you with maximum flexibility in the
design and setup of your experiment.

The type of experiment to perform:
e Standard curve
* Comparative Cp (AACy)
¢ Relative standard curve
¢ Genotyping
e Presence/Absence

e Melt curve

The experiment type that you select affects setup, run, and analysis.

A software feature that allows you to export experiment setup files, experiment
results, instrument information, and security and auditing settings to spreadsheet,
presentation, or text files. You can edit the default location of the exported file.

Dye excitation and emission filter combination that you select for an experiment. The
QuantStudio™™ 6 and 7 Instruments include a five-color filter set and six-color filter set,
respectively, that support FAM™, SYBR® Green, VIC®, JOE™, NED"™, Cy®3,
TAMRA™, ROX™, and Texas Red® dyes.

A quality control (QC) indicator which, when applied by the software to a well during
analysis, indicates a possible issue with that reaction. For example, a flag may be
issued if no amplification is detected in a well. Flags indicating potential problems are
displayed in the Quality Control tab of the plate layout, well table, and QC Summary
screens.

Oligonucleotide that flanks the 5 end of the amplicon. The reverse primer and the
forward primer are used together in PCR reactions to amplify the target.

An experiment used to identify known mutations in a DNA sample. With this
experiment type, you can determine if a DNA sample is:

¢ Homozygous (samples having only allele 1). Also called wild type homozygote.
* Homozygous (samples having only allele 2). Also called variant homozygote.

* Heterozygous (samples having both allele 1 and allele 2).

Samples having both allele 1 and allele 2.

See also genotyping experiment.
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holding stage

homozygote

housekeeping gene

import

Instrument Console
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internal positive
control (IPC)

inventoried assays

IPC

IPC blocking agent

IPC+

made-to-order
assays

manual baseline
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In the thermal profile, the stage that holds the temperature constant for a defined
period of time. A stage that includes one or more steps. You can add a holding stage to
the thermal profile to activate enzymes, to inactivate enzymes, or to incubate a
reaction.

Samples having only allele 1 or only allele 2. See also genotyping experiment.

A gene that is involved in basic cellular functions and that may be constitutively
expressed. Housekeeping genes may be candidates for use as endogenous controls;
however, their constancy should always be validated experimentally.

See also endogenous control.

A software feature that allows you to import plate setup information or security
settings before an experiment run. You can also import information into some libraries
in the software.

A software feature that allows you to view information about instruments on the
network. In the Instrument Console, you can monitor the status of any instrument on
the network; view calibration, maintenance, and instrument properties for a selected
instrument; and open and close the instrument drawer.

A software feature that allows you to view information about instrument available on
the network. In the Instrument Manager, you can monitor the status of an instrument;
monitor amplification plots and temperature plots in real time; view the calibration
status, perform calibrations and manage files on the instrument, including
downloading completed experiments to your computer.

In presence/absence experiments, a short synthetic DNA template that is added to PCR
reactions. The IPC can be used to distinguish between true negative results (the target
is absent in the samples) and negative results caused by PCR inhibitors, incorrect assay
setup, or reagent or instrument failure.

TagMan® Gene Expression Assays and TagqMan® SNP Genotyping Assays that have
been previously manufactured, passed quality control specifications, and stored in
inventory.

See internal positive control (IPC).

Reagent added to PCR reactions to block amplification of the internal positive control
(IPC).

See negative control-IPC wells.

TagMan® Gene Expression Assays that are manufactured at the time of order. Only
assays that pass manufacturing quality control specifications are shipped.

An analysis setting for the Baseline Threshold algorithm. You enter the baseline start
and end cycles for the amplification plot.

See also baseline.
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manual threshold

melt curve

melt curve
characteristics

melt curve stage

melt curve plot

melting temperature
(Trr)

multicomponent plot

negative control (NC)

negative control-
blocked IPC wells

negative control-IPC
wells

no amplification
control (NAC)

no template control
(NTC)

nonfluorescent
quencher-minor
groove binder (NFQ-
MGB)

Glossary

An analysis setting for the Baseline Threshold algorithm. You enter the threshold value
and select whether to use automatic baseline or manual baseline values. The software
uses the baseline and the threshold values to calculate the threshold cycle (Cr).

A plot of data collected during the melt curve stage. Peaks in the melt curve can
indicate the melting temperature (T},,) of the target, or they can identify nonspecific
PCR amplification. In the software, you can view the melt curve as normalized
reporter (R,,) vs. temperature or as derivative reporter (—R,,” ) vs. temperature. In a
high resolution melting experiment, you can view the melt curve as fluorescence vs.
temperature. Also called dissociation curve.

The melt curve shape and the difference in melting temperature (T ) values.

In the thermal profile, a stage with a temperature increment to generate a melt curve.

The default view of the melting curve. It plots the negative derivative data (-Rn’) vs.
temperature.

The temperature at which 50% of the DNA is double-stranded and 50% of the DNA is
dissociated into single-stranded DNA. In a melt curve experiment, the melt curve plot
displays the melting temperature.

A plot of the complete spectral contribution of each dye for the selected well(s) over
the duration of the PCR run.

The task for targets or SNP assays in wells that contain water or buffer instead of
sample. No amplification of the target should occur in negative control wells.
Previously called no template control (NTC).

In presence/absence experiments, wells that contain IPC blocking agent instead of
sample in the PCR reaction. No amplification should occur in negative control-blocked
IPC wells because the reaction contains no sample and amplification of the IPC is
blocked. Previously called no amplification control (NAC).

In presence/absence experiments, wells that contain IPC template and buffer or water
instead of sample. Only the IPC template should amplify in negative control-IPC wells
because the reaction contains no sample. Previously called IPC+.

See negative control-blocked IPC wells.

See negative control (NC).

Molecules that are attached to the 3’ end of TagMan® probes. When the probe is intact,
the nonfluorescent quencher (NFQ) prevents the reporter dye from emitting
fluorescence signal. Because the NFQ does not fluoresce, it produces lower
background signals, resulting in improved precision in quantification. The minor
groove binder (MGB) increases the melting temperature (T,,,) of the probe without
increasing its length, allowing for the design of shorter probes.
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normalization
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normalized quantity

normalized quantity
mean

normalized quantity
SE

normalized reporter
(Rn)

omit well

outlier

passive reference

plate layout

plate setup file

point

positive control
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Type of calibration in which the software collects data from the normalization
standards, then stores it in a normalization calibration file. This file is used in
comparisons of data from multiple instruments within a study.

Either the C Avg. of the target gene minus the Cp Avg. of the endogenous control
(Comparative Cy experiments), or the Q Avg. of the target divided by the Q Avg. of the
endogenous control (Relative Standard Curve experiments).

The relative standard curve equivalent of the ACt mean value found in Comparative
Cr experiments (computed as the geometric mean).

The relative standard curve equivalent of the ACt SE value found in Comparative Ct
experiments (computed as the geometric standard error of the mean).

Fluorescence signal from the reporter dye normalized to the fluorescence signal of the
passive reference dye (usually ROX™ dye on Life Technologies instruments).

An action that you perform before reanalysis to omit one or more wells from analysis.
Because no algorithms are applied to omitted wells, omitted wells contain no results.
You can add wells back in to the analysis; no information is permanently discarded.

A measurement (such as a Cr) that deviates significantly from the measurement of the
other replicates for that same sample.

A dye that produces fluorescence signal independent of PCR amplification, and that is
added to each reaction at a constant concentration. Because the passive reference
signal should be consistent across all wells, it is used to normalize the reporter dye
signal to account for non-PCR related fluorescence fluctuations caused by minor well-
to-well differences in volume. Normalization to the passive reference signal generally
results in data with noticeably high precision among technical replicates.

An illustration of the grid of wells and assigned content in the reaction plate. The
number of rows and columns in the grid depends on the sample block that you use.

In the software, you can use the plate layout as a selection tool to assign well contents,
to view well assignments, and to view results. The plate layout can be printed,
included in a report, exported, and saved as a slide for a presentation.

A file (.txt, .csv, .xml, or .sds) that contains setup information such as the well number,
sample name, sample color, target name, dyes, and other reaction plate contents.

One standard in a standard curve. The standard quantity for each point in a standard
curve is calculated based on the starting quantity and serial factor.

In genotyping and presence/absence experiments, a DNA sample with a known
genotype, homozygous or heterozygous.

In the software, the task for the SNP assay in wells that contain a sample with a known
genotype.
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primer mix
primer/probe mix

pure dye
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(cy)

quantification
method

quantity

quencher

QuickStart

R?2 value

ramp

Glossary

In genotyping and presence/absence experiments, the part of the instrument run that
occurs after amplification. In genotyping experiments, fluorescence data collected
during the post-PCR read are displayed in the allelic discrimination plot and used to
make allele calls. In presence/absence experiments, fluorescence data collected during
the post-PCR read are displayed in the presence/absence plot and used to make
detection calls. Also called endpoint read.

In genotyping and presence/absence experiments, the part of the instrument run that
occurs before amplification. The pre-PCR read is optional but recommended.
Fluorescence data collected during the pre-PCR read can be used to normalize
fluorescence data collected during the post-PCR read.

PCR reaction component that contains the forward primer and reverse primer
designed to amplify the target.

PCR reaction component that contains the primers designed to amplify the target and
a TagMan® probe designed to detect amplification of the target.

Fluorescent compound used to calibrate the instrument.

See system dye.

The fractional PCR cycle used for quantification, according to the Real-time PCR Data
Markup Language (RDML) data standard. Cy is the algorithm-specific calculations of
Cq
In quantification experiments, the method used to determine the quantity of target in
the samples.

In quantification experiments, the amount of target in the samples. Absolute quantity
can refer to copy number, mass, molarity, or viral load. Relative quantity refers to the
fold-difference between normalized quantity of target in the sample and normalized
quantity of target in the reference sample.

A molecule attached to the 3’ end of TagMan® probes to prevent the reporter from
emitting fluorescence signal while the probe is intact. With TagMan® reagents, a
nonfluorescent quencher-minor groove binder (NFQ-MGB) can be used as the
quencher.

A feature that allows you to run an experiment without entering plate setup
information, if your instrument and computer are in the same network. QuickStart
requires an experiment template file.

Regression coefficient calculated from the regression line in the standard curve. An
important quality value, the R? value indicates the closeness of fit between the
standard curve regression line and the individual Ct data points from the standard
reactions. A value of 1.00 indicates a perfect fit between the regression line and the
data points.

The step at which the temperature changes during the instrument run. The ramp rate
is defined as °C per second. In the graphical view of the thermal profile, the ramp rate
is indicated by a diagonal line.
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Speed at which the temperature ramp occurs during the instrument run. Available
ramp speeds include fast and standard.

A plot of raw fluorescent signal as detected through each emission filter, used to view
raw data for individual wells and at individual cycles.

A solution that contains all components to run the PCR reaction, except for the
template (sample, standard, or control). Also called a “PCR cocktail”.

The PCR reaction components used to amplify the target and to detect amplification.

Process of collecting fluorescence data during PCR. Data from the real-time PCR are
used to calculate results for quantification experiments or to troubleshoot results for
genotyping or presence/absence experiments.

A reporting format that is compliant with the Minimum Information for Publication
for Quantitative Real Time Experiments (MIQE) guidelines.

In relative standard curve and Comparative Ct (AACt) experiments, the sample used
as the basis for relative quantification results. Also called the calibrator.

The reference SNP (refSNP) cluster ID. Generated by the Single Nucleotide
Polymorphism Database of Nucleotide Sequence Variation (dbSNP) at the National
Center for Biotechnology Information (NCBI). The refSNP ID can be used to search the
Life Technologies Store for an Applied Biosystems® SNP Genotyping Assay. Also
called an rs number.

Type of calibration in which the software maps the positions of the wells on the sample
block of the instrument. The software uses the ROI calibration data to associate
increases in fluorescence during a run with specific wells of the plate. A calibration
image for each individual filter must be generated to account for minor differences in
the optical path.

Values calculated from the regression line in standard curves, including the R2 value,
slope, and y-intercept. You can use the regression coefficients to evaluate the quality of
results from the standards. See also standard curve.

In standard curve and relative standard curve experiments, the best-fit line from the
standard curve. Regression line formula:

Cr=m[log (Qty)] +b
where m is the slope, b is the y-intercept, and Qty is the standard quantity.

See also regression coefficients.

An action that the software performs during analysis to remove one or more wells
from further analysis if a specific flag is applied to the well.
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Glossary

An experimental method to determine relative quantities. This method compensates
for target and endogenous control efficiency differences within each run. In all
experiments, unknown samples and dilution series of template (such as cDNA) are
amplified. Following a run, the instrument software interpolates relative quantities for
each unknown sample from the appropriate dilution curve, then normalizes the data
for each sample (or set of replicates) as follows: target Qay, + endogenous control

QAVg'

A user-defined biological grouping. A replicate group may be a set of identical
reactions in an experiment.

Total number of identical reactions containing identical components and identical
volumes.

A fluorescent dye used to detect amplification. With TagMan® reagents, the reporter
dye is attached to the 5 end. With SYBR® Green reagents, the reporter dye is SYBR®
Green dye. SYBR® dyes are DNA-binding dyes.

An oligonucleotide that flanks the 3 end of the amplicon. The reverse primer and the
forward primer are used together in PCR reactions to amplify the target.

An enzyme that converts RNA to cDNA.

See normalized reporter (Rn).

A dye supplied by Life Technologies, which is used as a passive reference in some
experiments.

See refSNP ID.

Definition of the reaction volume and the thermal profile for the instrument run. The
run method specifies the temperature, time, ramp, and data collection points for all
steps and stages of the instrument run.

The biological tissue or specimen that you are testing for a target gene.

A tab-delimited file (*.txt or *.csv) that contains the following setup information: well
number, sample name, and custom sample properties.

In the software, an editable collection of sample names to use in experiments. The
samples in the library contain the sample name and the sample color. The samples in
the library may also contain comments about the sample.

In genotyping experiments, the combination of the sample to test and the SNP assay to
perform in one PCR reaction. Each PCR reaction can contain only one sample and one
SNP assay.

In quantification experiments, the combination of the sample to test and the target to
detect and quantify in one PCR reaction.
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An optional software module that provides:

e System Security — Controls user access to the software. Provides a default
Administrator user account. You can define additional user accounts and
permissions.

* Auditing — Tracks changes made to library items, actions performed by users, and
changes to the Security and Audit settings. The software automatically audits
some actions silently. You can select other items for auditing and specify the audit
mode. Provides reports for audited library items, Security and Audit changes,
and actions.

* Electronic Signature (eSignature) — Controls whether users are permitted,
prompted, or required to provide a user name and password when accessing
certain software features. You can select which features are controlled and the
number of signatures required for access. When authorized persons use this
feature, they are creating a legally binding signature.

In the software, a numeric value that defines the sequence of quantities in the standard
curve. The serial factor and the starting quantity are used to calculate the standard
quantity for each point in the standard curve. For example, if the standard curve is
defined with a serial factor of 1:10 or 10%, the difference between any 2 adjacent points
in the curve is 10-fold.

Regression coefficient calculated from the regression line in the standard curve. The
slope indicates the PCR amplification efficiency for the assay. A slope of —3.32
indicates 100% amplification efficiency.

See also amplification efficiency (EFF%) and regression line.

Single nucleotide polymorphism. The SNP can consist of a base difference or an
insertion or deletion of one base.

Used in genotyping experiments, a PCR reaction that contains primers to amplify the
SNP and two probes to detect different alleles.

In the software, an editable collection of SNP assays to add to genotyping experiments.
The SNP assays in the library contain the SNP assay name; SNP assay color; and for
each allele, the allele name or base(s), reporter, quencher, and allele colors. The SNP
assays in the library may also contain the assay ID and comments about the SNP assay.

In the thermal profile, a group of one or more steps. Examples: PCR stage, cycling
stage (also called amplification stage), and hold stage.

A sample that you dilute and amplify along with unknown samples. This dilution
series can contain known starting quantities of the target of interest (absolute standard
curve) or it can be of known dilution factor (relative standard curve). Following the
run, the software interpolates the Ct values of the unknowns to this curve, yielding
either specific quantities of the target (for absolute curves) or relative quantities (for
relative dilution curves).

See also standard curve.
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Glossary

In standard curve and relative standard curve experiments:

* The best-fit line in a plot of the C values from the standard reactions plotted
against standard quantities. See also regression line.

* A set of standards containing a range of known quantities. Results from the
standard curve reactions are used to generate the standard curve. The standard
curve is defined by the number of points in the dilution series, the number of
standard replicates, the starting quantity, and the serial factor.

Method for determining absolute target quantity in samples. With the standard curve
method, the software measures amplification of the target in samples and in a
standard dilution series. Data from the standard dilution series are used to generate
the standard curve. Using the standard curve, the software interpolates the absolute
quantity of target in the samples.

See also standard and standard curve.

In standard curve and relative standard curve experiments, a set of standards
containing a range of known quantities. The standard dilution series is prepared by
serially diluting standards. For example, the standard stock is used to prepare the first
dilution point, the first dilution point is used to prepare the second dilution point, and
so on. In the software, the volumes needed to prepare a standard dilution series are
calculated by the number of dilution points, the number of standard replicates, the
starting quantity, the serial factor, and the standard concentration in the stock. See also
standard curve.

In the PCR reaction, a known quantity. In standard curve experiments, the quantity of
target in the standard. In the software, the units for standard quantity can be for mass,
copy number, viral load, or other units for measuring the quantity of target. Standard
quantity can also refer to dilution factor.

When defining a standard curve in the software, the highest quantity.

A component of the thermal profile. For each step in the thermal profile, you can set
the ramp rate (ramp increment for melt curve steps), hold temperature, and hold time
(duration).You can turn data collection on or off for the ramp or the hold parts of the
step. For cycling stages, a step is also defined by the AutoDelta status.

PCR reaction components that consist of two primers designed to amplify the target
and SYBR® Green dye to facilitate detection of the PCR product.

Dye supplied by Life Technologies. Before you use system dyes in your experiments,
make sure the system dye calibration is current in the Instrument Console.
The system dyes are:

e FAM" dye

e JOE™ dye

e ROX™dye

e NED"dye

* SYBR® Green dye

* TAMRA™ dye
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e VIC®dye
e Cy®3dye
* Texas Red® dye

PCR reaction components that consist of primers designed to amplify the target and a
TagMan® probe designed to detect amplification of the target.

The nucleic acid sequence to amplify and detect.

In the software, a color assigned to a target to identify the target in the plate layout and
analysis plots.

In the software, an editable collection of targets to use in experiments. Targets in the
library contain the target name, reporter, quencher, and target color. The targets in the
library may also contain comments about the target.

In the software, the type of reaction performed in the well for the target or SNP assay.
Available tasks:

¢ Unknown

* Negative Control

¢ Standard (standard curve and relative standard curve experiments)
¢ DPositive control (genotyping experiments)

e [PC (presence/absence experiments)

* Blocked IPC (presence/absence experiments)

Wells containing identical reaction components, including sample; important for
evaluating precision.

In the software, a display of temperatures for the instrument cover and instrument
block during the instrument run.

The type of nucleic acid to add to the PCR reaction.

A user-created file that contains experiment setup information (experiment type,
sample names, target name, and thermal conditions) to be used as a starting point for
new experiment setup. Template files have an .edt extension.

Part of the run method that specifies the temperature, time, ramp, and data collection
points for all steps and stages of the instrument run.

¢ In amplification plots, the level of fluorescence above the baseline and within the
exponential growth region. For the Baseline Threshold algorithm, the threshold
can be determined automatically (see automatic threshold) or can be set manually
(see manual threshold).

* In presence/absence experiments, the level of fluorescence above which the
software assigns a presence call.
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Glossary

The PCR cycle number at which the fluorescence meets the threshold in the
amplification plot.

See melting temperature (T},).
Instrument display that you touch to control the instrument.

Type of calibration in which the software measures sample block uniformity. The
calibration generates data that compensate for the physical effects of the
QuantStudio™ 6 and 7 Instruments’ filters on data collected during an experiment.

In the software, the task for the target or SNP assay in wells that contain the sample
being tested. In quantification experiments, the task for the target in wells that contain
a sample with unknown target quantities. In genotyping experiments, the task for the
SNP assay in wells that contain a sample with an unknown genotype. In presence/
absence experiments, the task for the target in wells that contain a sample in which the
presence of the target is not known. In melt curve experiments, the task for the target
in wells that contain a sample with an unknown melt curve profile.

In presence/absence experiments, wells that contain a sample and internal positive
control (IPC).

A sample (or group of samples) with a unique melt curve (that is, the melt curve is
different from the melt curves of other samples or controls used in the experiment).
The software determines melt curve differences by the melting temperature (Tm) and
the shape of the melt curve.

In the standard curve, the value of y where the regression line crosses the y-axis. The y-
intercept indicates the expected threshold cycle (Ct) for a sample with quantity equal
to1.
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A

AIF 27

AIX 27

aligned melt curve plot 27
allele 27

allelic discrimination plot 27
amplicon 27

amplification 27
amplification efficiency (EFF%) 27
amplification plot 27
amplification stage 27
analysis options, setting 15, 16
Analysis Protocol Library 28
analysis settings library 15
assay 28

Assay ID 28

assay index file 27

assay information file (AIF) 28
AutoDelta 28

automatic baseline 28
automatic threshold 28

background calibration 28

baseline 28

baseline-corrected normalized reporter (DRn) 28
biological replicate 29

blocked IPC 29

C

calibration 19
Calibration and verification consumables
384-well 7
96-well (0.2 mL) 7
array card 8
Fast 96-well (0.1 mL) 8
calibrator 29
comparative CT method 29
console, instrument 17
Ct algorithm 29
cycle threshold 29
cycling stage 29

D

data collection 30

default analysis settings
Automatic analysis 16
Automatic save 16
Baseline settings 16

delta Rn 30

derivative reporter (—-Rn‘) 30

diluent 30

dye calibration 30

dye library 13

E

efficiency correction 30
endogenous control 30
endpoint read 30
error 30
experiment
consumables 9
reagents 11
experiment name 31
experiment type 31
expiration date 7
export 31

F

filter 31

flag 31

fluorogenic probe 20
forward primer 31

G

genotyping experiment 31

H

Help system 25
heterozygote 31
holding stage 32
homozygote 32
housekeeping gene 32

I

import 32

Instrument Console 32
Instrument Manager 32
internal positive control (IPC) 32
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Index

inventoried assays 32
IPC blocking agent 32

L

libraries, using in your own experiments
Analysis settings library 13
Control library 13
Dye library 13
Run Method library 13
Samples library 13
SNP Assay library 13
Targets library 13

M

made-to-order assays 32
manual baseline 32

manual CT 33

melt curve 33

melt curve plot 33

melting temperature (Tm) 33
multicomponent plot 33

N

negative control (NC) 33

negative control-blocked IPC wells 33
negative control-IPC wells 33

no amplification control (NAC) 33

no template control 33
nonfluorescent quencher-minor groove binder 33
normalization calibration 34
normalized quantity 34

normalized quantity mean 34
normalized quantity SE 34
normalized reporter (Rn) 34

NTC 33

0]

omit well 34

order
from the website 6
how to 6

outlier 34

P
package label 7
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plate layout 34

plate setup file 34
positive control 34
post-PCR read 35
pre-PCR read 35
primer mix 35
primer/probe mix 35
pure dye 35

Q

quantification method 35
quantity 35

quencher 35

QuickStart 35

R

ramp 35
ramp speed 36
raw data plot 36
RDML 36
reaction mix 36
reagents 36
reagents, about 20
reagents, selecting
SYBR® Green Reagents 20
TagMan® Reagents 20
real-time PCR 36
reference sample 36
refSNP ID 36
region of interest (ROI) calibration 36
regression coefficient 35
regression line 36
reject well 36
relative standard curve method 37
replicate group 37
replicates 37
reporter 37
reverse primer 37
reverse transcriptase 37
ROX™ dye 37
run method 37
run method library 14
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sample 37

sample definition file 37

Sample Library 37

sample/SNP assay reaction 37

sample/target reaction 37

security and auditing 38

serial factor 38
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